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1.1

1.2

1.3

1. Navigation

This document provides an overview of the basic template, navigation, common operations
that can be performed, and keyboard short cuts available in Oracle Financial Services
Lending and Leasing. Since this section details the general options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing.

The document is organized into below topics:
e Logging In
e Template and Navigation

e Common Operations
e Hot Keys

Note

The application can be best viewed in 1280 x 1024 screen resolution.

Audience

This document is intended to all Prospective Users who would be working on the application.

Conventions Used

Term Refers to

The system/application Oracle Financial Services Lending and Leasing

Mnemonic The underlined character of the tab or button

Logqging In

The pre-requisites to log into the system are a valid user ID and a password, defined by the
system administrator in Administration > User screen.

You can login to the system using a valid user ID and a password defined by the system

administrator, in Administration > User screen. A User ID is disabled automatically by the
system if it is inactive for a specified number of days.
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When you invoke the application, the Sign In screen is displayed.
opacLe: B O

Financial Services Lending and Leasing

sign In
Please enter userid and passviord

*User1d

Password

e User ID — Specify a valid User ID.
e Password — Specify a valid password for the specified User ID.

The system accepts the User ID and password in upper case only. After specifying valid
credentials, click Sign In to sign into the application.

1.4 Template and Navigation

This section provides a brief input on the template and navigation of the system. Details are
grouped into two categories to enable easy understanding. These include:

e Home screen
e Screens

141 Home Screen

Once you login to the application with valid credentials, the system authenticates the details
and displays the Home screen.

The Home screen consists of the following components:

e Header
e Left Pane
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e Right Pane/Work Area

ORACLE" B vATDYA iy S
Financial Services Lending and Leasing

 Origination
> Servicing
> Collections
 WFP

> Tools

> setup

You can view the application version details and copyright information by clicking About link
at the right corner of the screen.

reement or allowed by lav, you may ot use, copy, repr
in any form, or by any means. Reverse engieering, d

be errorfree. Ifyou find any errors, please reportthem o us i wrting.

behaf of the U.S. Government, the follwing notice s

Header
In the Header, system displays the following:

e User ID that you have currently logged/Signed in. Click the adjoining drop-down arrow,
the system displays the following options:

Y Accessibility ESneE <~

Change Password

m  UserInfo 3]
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Change Password — Click to change the current password.

ORACLE. . G o]

Specify the current password in the Current Password field and a valid password,
you wish to maintain as a new password, in the New Password field. Re-enter the
password in Confirm Password field and click Submit to change the password.

User Info — Click to view the current user info.

Oracle Financial Services Lending and Leasing ®
User Info
Organization DMC Time Zone |JSER TIME ZONE ¥
Division US01 Level
First Name VARSHA User Time Zone UNDEFINED
Last Name VAIDYA Company US/CENTRAL (CENTRAL STANDARD

Branch Time TIME)
Responsibility SUPERUSER S

GLFost Date 02/10/2016 Server Time  ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)

Session Language DEFAULT v Skin Family Skyros (Default) v
Debug Enabled Ind

|_—|5 Submit 7% Close

In this screen, apart from viewing the user info, you can also set Session Language,
enable error log, and specify the time zone preference.

Session Language — Select a language that you need to set for the session, from
the drop-down list.

Debug Enabled Ind — Check this box to enable the debug indicator.

On selection, system records all the debugs into logs files depending on the
following two types of system parameters:

System Parameter Condition to record debug data

CMN_DEBUG_METHOD If parameter value is 1, then debug data is
recorded into a file in Database Server.

If parameter value is 4, then debug data is
recorded into the table LOG_FILES HEADER.

CMN_DEBUG_LEVEL If parameter value is greater than 0, only then the
debug data is recorded.

The debug data can be viewed from Dashboard > System Monitor > Database
Server Log Files.

You can click on = List Files button to view the list of logged files.
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ORACLE’
Financial Services Lending and Leasing

DashBoard 3 System Monitor [3] Close
Batch Jobs = Jobs | Services Database Server Log Files  Parked Transactions | Users o~
Database Server Log Files
View v Format~ Freezz i Detach Wrap W) :=Svstries [ Download File
File Name File Type File Size File Time
JSVPRC_EN_000_01 DB12C_2084400 fob 5706 02/18/2016 06:14:11 A) »
ALERT lob 395 02/22/2016 03:59: 15 A_|
CSYPRC_EN_100_01_DB12C_3794335 lob 6390 02/22/2016 04:53:00 AP =
CSVPRC_EN_100_01 DB12C_3854338 lob 116750 02/22/2016 05:36:42 AP
IJSVPRC_EN_000_01_DB12C_2004362 lob 5706 02/18/2016 10:57:09 Al =
P - ‘ .
v
File Content
View * Format v Freeze  CfiDetach ol Wrap B} ©Begring@End #oflines 50 [E] Show File
Text i
0
o :11: cmnsyp cl 000 Ol.get syp parameter value value: weblogic
0

:11: 45:FLL:1v_use BI::Y [

:11: cmnsyp cl .get_syp parameter value value: http://ofss2221142.in.oracle.com:.

.get_syp_parameter_value valus: http://ofss2221142.in.oracle.com:

111: cmnsyp_

t11: cmnsyp cl 000 _Ol.get syp parameter valu : JSV_BI_USER
¢ J5V_REPORT_ARCHIVE_DIRECTORY
:11: cmnsyp_cl_000_0l.get_syp parameter value parameter: JSV_REPORTS_SERVER TIMECUT

:11: cmnsyp_cl 000_Ol.get_syp parameter value value: /scratech/work area/DEV/QA14SREL/r. |~
:11: cmnsyp cl_000_0Ol.get_syp_parameter_valus parame

o oo oo

Click on & Show File button to view the selected file contents in the ‘File Content’
section. You can also click & Download File button to extract a copy of debug
details.

Time Zone Level - Select the time zone preference as User/Company Branch/
Application Server Time Zone from the adjoining options list.

For more details on time zone selection, refer to Time Zone Preference section of
this user manual.

Click Submit to save the changes or Close to close the screen without changes.
Accessibility — Click the link to view accessibility features of the system.
Refer accessibility document for further details.

Sign Out — Click the link to sign off from the application. You can also click on
icon to sign off from the application.
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Left Window

In the left pane, system lists and provides drop-down links for various modules available in
the product. Click 2/ to expand the Module Master Tabs and ¥ to collapse them.

> DashBoard
> Origination

Servicing

[Esenicing
Customer Senvice
Securitization
Transaction Autherization
Post Date Checks
Escrow Transactions
Account Documents
Collateral Management
Reports
Producers
Vendors

DEatch Transactions
» Mnterfaces |

»» Collections
> WFP

> Tools

» Setup

To open a screen, navigate to Module Master Tab to which the screen belongs, expand the
tabs, and click the screen link you wish to open.

Right Window

The Right Window can also be termed as work area. When you click the screen link on left
pane, system displays the corresponding screen in the right pane.

ORACLE
Financial Services Lending and Leasing

% Welcome, VAVAIDYA +  pccessioiry  NSNRIGE =

12/08/1987

> sarviang
> Collections
> wep
> 1o0ls

> Setup

You can open a maximum of 15 screens at a go. Once the maximum limit is reached, the
system displays an error message.

In origination, only one among the three screens namely, Application Entry, Underwriting,

Funding can be opened at a time. If ‘Application Entry’ screen is open and you click on
Underwriting or Funding, the system retains the same screen.
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ORACLE"
Financial Services Lending and Leasing
5

2 Edt || Blview || 2 avsie

i petach

S Feror o . :
2012 1000010580, BROWIY PALL/ PAULA 02/09/2015 crianceD orF cRroR VeRoUTH 02/09/2015 UNDEFNED
20100100014000:000 SULGAN c2/0a/2010 Criareco orr chror VeRouTIL o2/0v/201c UNpErIED
Parameters
- Fomare B Llreee ) vetach wee | @
Parametes Velus Srriz
THOATE osiosr0te v

4 Transaction processing Detalls

[PRe— 8 vetacn wee | @

> Collections.
> wrp.
> Tools

> sctup

Each active screen is displayed as a tab at the top of right pane, across its width. To view a
screen, click the screen tab. You can identify the active screen with its white background.
Also, operation on any of the screen will not affect the data in other screens.

Right Splitter/Action Window

The Right Splitter/Action Window has quick access to search and other options to avoid
switching between tabs or navigating into sub tabs periodically. You can access the Right
Splitter/Action Window while working on an Application or Customer Service screens. You
can click ﬂ and |: to toggle the view of Right Splitter/Action Window.

Origination Screens

In Origination — Application screens, you can use the Right Splitter/Action Window to do the

following:

ORACLE’ i & Welcome, VAVAIDWA ~  ccessibily - [ EOIIGE] O
Financial Services Lending and Leasing

rigination Close
> DashBoard Originatis &
Fr—— Search/Task | Funding: 0000000378 | Review Requests (Pending: 0) )
L Quick Search
o
Application: 0000000378: TIFFANY RUSSEL / GRACE B view || &2 audt o
Vieww Format~ B 1] Freeze i Detach wap | @) OvemdeOK ¥ WamingOK ¥ =
Y oo dentification
Underviriting " . = Origination Stage Duplicate %
o oo Sub Unit Status Ot Producer Name Co Bistng Customer  DUNALE Contact
I [ submt | @ clear
01/01/2012 0000000378 UNDEFINED /APPROVED - FUNDED FUNDED GA-00004 : ADVANCE LEA. N N
» Summary
Requested  Approved
Advance 150000 1500000
Summary Applicant = Request Decision Contract Collateral ~Comments Tracking Document Verification —Correspondence Tools Fate 89900 43900
Term 36 3
> Applicant Grade  DGRADE Score 0
v s
Stated PTI054
! Mt Book 10,000
2012 CHEVROLET MONTE CARLO
5 8
> Bureau
Quese FUNDED APPLICATIONS QUEUE
] Change Status
Collateral
Collateral Add Comment
Asset Type subType Primary  vear vake Vodel Mileage New Whalesale Value G
> Servicing VEHICLE car ¥ w2 cHEVROLET MONTE CARLO on 1000000 Bl
> Collections Tvpe A
N “sub -
CAWER) Trade-In Tive
> Tools * Comment
& Sebup Trade-In v E

e Use Quick Search to search for an application based on application number, last 4
digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”.

e Summary section displays critical information that has to be referred repeatedly during
origination like — DTI, PTI, Book Value, Grade, FICO Score, Approved Advance, Rate
and Term.

e Use Change Status section to change the application status to next level. If the
application edit status is restricted, then the ‘Change Status’ will be read-only.

e Use Add Comment section to post an alert or comment during Underwriting and
Funding stages.
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For detailed information on the above options, refer to respective sections in the
document.

Servicing and Collection Screens

In Servicing and Collection — Customer Service screens, you can use the Right Splitter/
Action Window to do the following:

ORACLE"
Financial Services Lending and Leasing

3 Welcome, VAVAIDYA ~  accessibilty [=)

ustomer Service x (3] Close
> DashBoard CLEAmeEr S8 L]
> Origination | © 0} =
L Quick Search
Servicing N
e Account(s): 20120200010231: YUTAKA OZAKA / AKANE Ewew || 2 aust
Vieww Fomat~ P ] Frecze i Detach o @ G © curent © showall O Group Follov-up
Company Eranch Sub Unit Days Past Due Currency
usor use1 UNDEFINED 2012020010231 LEASEVEHICLE 0 UsD
[B submit | | & Clear
Summary | Customer Sendce | Account Details || Customer Details || Transaction History | Pt Modes || Bankruptcy | RepojForeclosure | Deficiency | Collate > ~
Collateral Management QueiniSenduen
Repo Alerts Conditions i
unt
Alerts Conditions
Alert start ot Followup Dt
o data to display. LIEN DATA CHANGE 02/10/2016 02/10/2016
Account Details Other Information
4
Dues Collateral Information 12 ey Wi e
01/10/2015 12102014 14102084 10/10/2084 Description Ientification = Vear  Asset Class _
000 o0 000 000 2012 MERCEDESEXO04DR  2GWSS2ISILA0RL 2012 NEW Add call Activity
Delq Due 0.00 Total Due 0.00 Future Pt 02/10/2015 A =
elq Due otal Due uture Pt 02/ s
e e 000 ’ Customer Information Result .
1i5F Due 000 Gldast Due: 0c/10/2013 | |REREE e Relation ssh Contact i
QD B Amt paid 0.00 000000... OZAKA A YUTAKA PRIMARY a3t Z]
Excess D00000... AKANE B YUTAKA SPOUSE  eonocs 3399
Pay »
Delinquency Information <
£ 20 1m0 1 Email MARIEC@SSC.COM v
o 0 ) o 0 0 ) Language ENGLISH
tal By
ep(life) 0 NSF(Life) 0 Collector GIRI Status Coresp n .
s Bp(Year) 0 NsF(vear) 0 [
> wep e AMERICA NN A postcallacy | | @ clear
> Tools Woy2  App 000000 L
> Las 12/24/2045  paid Off ot ch .
> Setup el i Address Information =
Copyright © 199 2016, Oradle andjor s affates. Allights reserved “about

e Use Quick Search to search for an account based on account number, or customer Id,
or last 4 digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”. You can also select the Queue Condition and Auto Run options during search.

e Use Add Comment section to post an alert or comment based on Type and Sub Type.

e Use Add Call Activity section to post all types of call activities including promise to pay,
account conditions and so on, irrespective of the screen you are working on. This is
similar to the option available in ‘Call Activities sub tab’ under Customer Service tab.

For detailed information on the above options, refer to respective sections in the
document.

The height of Header and width of the Left and Right Panes do not change, with resizing of
application screen.

The system facilitates toggling Header and Left and Right Panes of the home screen to
increase the visible area of the screens. Click ==u to toggle upper pane and j to toggle left
pane. To un-toggle click /= and |: respectively.

Few screens in Origination, Servicing and Collection are identical and are linked. Hence, you
can open only one screen at a time from the group. A sample of the grouping structure is given
below, based on stages of the screens:

Origination:
e Simple Application Entry
e Application Entry

e Underwriting
e Funding

Collection:
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1411

e Collection

e Bankruptcy

e Repossession
e Deficiency

WFP:

e Producers

e Credit Lines

e Units
As per the above listing, you will be able to open only one screen in the corresponding listi.e.
if you have opened the ‘Application Entry’ screen in ‘Origination’, you are not allowed to open
any of the other 3 screens until you exit the ‘Application Entry’ screen.

Time Zone Preference

Oracle Financial Services Lending and Leasing *
User Info
Organization DMC Time Zone (JSER TIME ZONE v
Division U501 Level
First Mame VARSHA User Time Zone  UNDEFINED
Last Name VAIDYA Company US/CENTRAL (CENTRAL STANDARD
) A Branch Time TIME)
Responsibility SUPERUSER D 10K
6ot Date- A0 07201 Server Time ASLA/CALCUTTA (INDLA STANDARD
Last Login Date  02/10/2016 03:21:07 AM Zone TIME)
Session Language  DEFALLT X Skin Family  Skyros (Default) v

Debug Enabled Ind

E@éuhmit 4 Close

You can select any of the following three time zones from the User Info screen:

e Application Server Time Zone
e Company Branch Time Zone
e User Time Zone

The time zones set up at each of these levels are displayed in the user info screen. However,
data is always stored in the application server time zone and based on the user preference of
time zone, the display time would be User or Company or Application Server time zone. Any
time zone related changes done at Ul does not impact the other time bound activities which
are dependant on database time.

Application Server Time Zone (Server Time Zone)

The Application Server Time Zone by default is the Production Server Time Zone. Selecting
this time zone will have all date and time fields defined as per the time stored in application
server. There is no offset in time if both storage (database server) and display (application
server) are in the same time zone.

Company Branch Time Zone (Organization - Division Time Zone)

This is the Company time zone and is setup at the organization - division definition level. The
various divisions defined under an organization can be set up with different time zones
depending on geographical locations. This time can be modified as per requirement.
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1.4.2

1.5

To modify the Company Branch Time Zone:

e Navigate to Setup > Administration > User > Organization and select the company or
division listed under 'Division Definition'.

e Inthe Display Formats tab, select Time Zone and click ‘Edit’.

e Inthe Format field, select the required time zone from the adjoining options list and click
‘Save’.

If'Company Branch Time Zone'is selected as the time zone in User Info screen, then on save,
all the time and date fields are automatically updated with the time zone of the company
branch.

User Time Zone

User Time Zone or User Preference Time Zone can be set up at the User Level in the User
Definition screen. Various Users under same divisions defined under an organization can be
set up with different time zones depending on geographical locations.

To modify the User Time Zone:
e Navigate to Setup > Administration > User > Users.
e Select the required User record listed in “User Definition” section and click Edit.

e Inthe Time Zone field, select the required time zone from the adjoining options list and
click Save.

If 'User Time Zone' is selected as the time zone in User Info screen, then on save, all the time
and date fields are automatically updated with the current updated time.

Screens

Details in few main screens are grouped into different sections. These sections are displayed
as tabs, horizontally within the screen. In turn, details in few of these tabs are again grouped
horizontally. The details are displayed when you click the tab under which they are grouped.
As similar to the main screen tabs, you can identify the active tab with its white background.

For example, Customer Service main screen has four main tabs. When you click on
‘Customer Service’ tab, the corresponding tabs are displayed.

Customer Service x Mcho
‘ Search  Customer Service: 20120200010231  Review Request (Pending: n)‘
Account(s): 20120200010231: YUTAKA OZAKA |/ AKANE Elview | o Audt
Vieww Formatv Freeze i Detach ap | B B @ Curent O showAll O Group Follow-up
Company Branch Sub Urit Account # Product Days Past Due Currency Pay OFf Amt Amount Due Status Oldest Due Dt
Us01 UsR1 UNDEFINED 20120200010231  LEASE VEHICLE 0UsD. 0.0 0.00 ACTIVE 02/10/2015
‘ Summary | Customer Service | Account Details | Customer Details | Transaction History | Pmt Modes | Bankruptcy | RepojForeclosure | Deficiency | Collateral | Bureau C\nz:,‘LpSe\Mrt\\,'\tiez‘
‘ CGall Activities | Maintenance Comments Promises | Checklists Tracking Attributes | References Correspondence | Letters  Document Tracking
Call Activities qpadd || ZEit | [E]view | of dudit
View= Formatv [ Freeze ] Detach Wrap ®
Action Result Contact Reason Cancel Promise Dt Promise Amt Condition Appointr Follovup Dt Time Zone Adj Folloviup Dt Conr
AT PH ANSWERING MACHINE ] 12/30/2015 1,000.00 NONE N 1202015 12/29/2015 12:30:00 P}

AT PH ANSWERING MACHINE N 12302015 1,000.00 NONE N 12/30/2015 12/29/2015 12:30:00 PM
»

You can click # to view the hidden tabs, if any.

Common Operations

Some of the operations are common to most of the screens. These are grouped into three
categories, based on their features.
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e Basic Operations
e Basic Actions

e Personalization Options

Basic Operations

All the screens contain buttons to perform all or few of the basic operations. The four basic
operations available are:

e Add
e Edit
e View
° Audit
¢ Add || S Edit

E] view | < Audit

When you click any of the operation tabs, system displays the corresponding records inline,
below the respective setup tables.

The table below gives a snapshot of them:

Basic Operation

Description

Add

Click to add a new record. When you click Add, the system displays
a new record enabling you to specify the required data. It is
mandatory to specify details for the fields marked with “*’ symbol.

Edit

Click to edit an existing record. Select the record you want to edit
and click ‘Edit’. The system displays an existing record in editable
mode. Edit the required details.

View

Click to view an existing record. Select the record you want to view
and click ‘View’. The system displays the record details in display
mode.

Audit

Click to view audit info. If an audit is set for a field, then the system
tracks the changes for that field. Select the record for which you
want to view the audit info and click ‘Audit’. The system displays the
details tracked for that field.

Close

Click to close a screen or a record. When you try to close an
unsaved, modified record, then the system alerts you with an error
message. You can click ‘Yes’ to continue and ‘No’ to save the
record.

Basic Actions

Most of the screens contain buttons to perform all or few of the basic actions.

All or few of these actions are enabled when you select any of the Basic Operations.

4 save and Add

[ save and stay

[ save and Return

<3 Return
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The table below gives a snapshot of them:

Basic Actions Description

Save And Add Click to save and add a new record. This button is displayed when
you click ‘Add’ button.

Save and Stay Click to save and remain in the same page. This button is displayed
when you click 'Add/Edit' button.

Save And Return Click to save and return to main screen. This button is displayed
when you click ‘Add’ or ‘Edit’ buttons.

Return Click to return to main screen without modifications. This button is
displayed when you click ‘Add’, ‘Edit’ or ‘View’ buttons.

The summary screens consist of the following navigations. The table below gives a snapshot
of them:

Basic Actions Description

Click to navigate to the first record.

Click to navigate to the previous record.

[k

Click to navigate to the next record.

b

Click to navigate the last record.

| M

Along with the basic actions, the following buttons are available for specific actions. The table
below gives a snapshot of them:

Basic Actions Description

Ij Show File - Click to view the details of selected file.

List Files - Click to generate and view the list of files maintained in
the system.

|__|ﬁr Download File - Click to download the details of selected data.

1.5.3 Personalization Options

You can personalize the data displayed in setup tables. Once personalized, system saves the
settings for that User ID until next personalization.

|'l!'iBWv Format « % Freeze HEDetach o] hirap E’al
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The table below gives a snapshot of them:

Options Description

View Click to personalize your view. The drop-down list provides the
following options of customization:

e Customize columns you wish to view
e Sort the order of displayed data
e Reorder columns

Additionally, the drop-down list provides selection of options
adjoining ‘View’.

M Format ~ | [&p Freeze pfiDetach

LI b showal
| Freez= + Product |
Detadh + Description ,
#ork » ¥ StartDt
Reorder Columns... + End Dt
Query By Example + Direct
+ Enabled

+ Collateral Type

+ Collateral Sub Type

+ Credit Bureau Portfolio Type
+ Credit Bureau Account Type

Manage Columns...

Format Click to resize columns or wrap a data in the table cells.
| e
Select the column you need to resize and select Resize Columns
option from the Format drop-down list.

Resize Column = I

Column DESCRIPTION

width | 100 ] [pixels [=]
OK. Cancel

Specify the Width and unit for the selected column. Click OK to
apply changes and Cancel to revert.

Query by Example | Click to query for the data by an example. When this option is
selected, the system displays an empty row above column heads.
You can specify all or any of the details of the record you wish to

query.
View » Format{ Freeze i Detach o1l Wrap o)
¢ | | @) %) i_
Freeze Select the column at which you need to freeze the table and click

Freeze. Function is similar to the freeze option in MS excel.

Detach Click to detach the setup table from the screen. An example of the
detached table is provided below.
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Options

Description

Wrap

Select the column in which the data needs to be wrapped and click
Wrap.

loan | Lne | Lease

Product Definition

Jpadd | JEdt | [Fven | o Audt

vew - [ | © | Mrrece gtococr | QM| @ vewrodct st copy
I I I I I Cotateratsub Ty |CredtBureat
prosuct et encoe |orect Fxive Repayment Enabled Jocdateraype  |cotatera subype [hedtBuens |
o+ LOANHOME (R)  p1/01/1800 12/31/4000 ¥ Y 2 HOME COLLATERAL - REAL PROPERTY HON INSTALLMENT
LOAN SECURED
Loans6 12/31/4000 N N v HOUSEHOLD GOODS PERSONAL PROPERT INSTALLMENT
WR)
Loanam oy SR b o1/1500 12/31/4000 v v ¥ UNSECLRED COLLATIUNSECLRED INSTALLMENT
Loanve LOANVEHICLE ()1 b1/01/1800 12731/42000 N v v VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT
MoP1 wopL 3/08/1863 12/31/4000 v N v VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT
MURABAHA B povse 031372013 v N v HOME COLLATERAL  REAL PROERTY HON INSTALLMENT
nDs1 NORM DSER 3/11/1853 1273174000 v N ¥ UNSECLRED COLLATIUNSECLRED ISTALLMENT
o1 et 1017201 12/31/4000 v N 2 HOME COLLATERAL REAL PROPERTY HOMMORTGAGE

Click to refresh the data in the table.

Print option in Customer Service screen

The Print button option in Customer Service/Collection screen facilitates you to print the
contents on the screen as is without scroll bars. This button is available along with other
options in the Action block. Clicking on this provides a browser print functionality and a new
tab is opened where the print content is displayed.

Detach

ORACLE'

Financial Services Lending and Leasing

&, Welcome, VAVAIDVA »  pccessibilty TSRO

N

Close
T Customer Service @
* Origination Search|| 2 quest (Pending: 0) .
Servicing
senicing Account(s): 20120200010231: YUTAKA OZAKA / AKANE [El view || <2 audt
Ctboics: Sl Viewv Formatw [5 Freeze 5 Detach o wrap W & @ curent O ShowAll C* Group Follow-up
Securtization Company Branch Sub Uit Account £ Product Days Past Due Currency Pay Off Ant Amount Due Status Oldest Due D
Transaction Authorization usot USRL UNDEFINED 2010200010231 LEASEVEHICLE 0.00 ACTIVE 10015
Post Date Checks
SOy Tadioe Summary | Customer Service | Account Details | Customer Details | Transaction History | PmtHodes || Bankruptcy | RepojForeclosure | Deficency | Collateral | Bureau | GrossUp el Activities
Account Documents
Collateral Management Call Activities  Maintenance Comments Promises ChecKists Tracking Attributes  References Corespondence Letters Document Tracking
Reports
Producers i i
Vendors Transaction Batch Information padd | At || Fview | & Auit
Batch Transactions View~ Formatv [ Freeze 5 Detach Wrap o 5 po % Voi
Advances Date Monet Transaction Status Batch
Payments 021072015 ADD CUSTONER ADDRESS PHONE POSTED "
Fees oot TERMIIATE ERROR N
Interfaces 01062016 TERMINATE voI N “
QusD0LS EXEvIO) von "
Detached Table x
View~| Format v [ Freeze [[EBetadh vap @ ot [5hvoid
Date Wonetary Transaction Status Batch
01of201s " ADD CUSTOMER ADDRESS PHONE POSTED "
03072016 ¥ TERMINATE ERROR N
01/05/2015 ¥ TERMINATE vo N
01/06/2016 Y EXTENSION Vo N
12472015 ¥ PAYOFF QUOTE LEASE POSTED [
Viewv Formatv [ Freeze Bl Detach @
> Collections Transaction Processing Details
swe ||| mE= Diret Record Update, Transaction Postng Successful “*+*%
> Tools
> Setup

Click ‘Add’, ‘Edit’ or ‘View’ button to open a new screen in expanded mode with details.

Drop-down List

The system provides an option to select the required data from LOV, for few fields. You can

either select the record from list or enter first alphabet of the value you want. When you
provide the alphabet, system limits the selection to the values starting with the specified
alphabet. These lists are grouped into two types:

o
list or enter first alphabet of the required value.

Drop-down list — Provides the selection option. You can either select a record from the

ORACLE



e Combo drop-down list — The LOV contains huge data and prov

ides both selection and

search option. These drop-down arrows are smaller in size, when compared to normal

drop-down arrows, thus enabling easy identification.

ORACLE"
Financial Services Lending and Leasing

= Welcome, VAVAIDYA ~  Accessibility o

Casa Recondliation

Conversion Accounts 3 .
Transaction Batch Information

ustomer Service x Close.
> DashBoard Gt Ll
> Origination ~~ Seard gl C 8
Servicing
m—— Account(s): 20151200010012: MADHU BOBBURI B view || & auat
Customer Service Vieww Fomatv B3 [ Freeze i Detsch Wrap & ® curent O showall © Group Follov-up
Securitization Company Branch Sub Unit Account # Days Past Due Currency Pay Off Amt. Amount Due Status. 0ldest Due Dt
Transaction Autharization usot uskg 2015120001012 LOAN VEHICLE (FR) 21 usp 5031881 2,19:30 [T ET AT 01/01/2016.
Summary | Customer Service | Accourt De ory || Pt Modes| | Bonkiuptey | RepojForedos o =
;:EZ“E‘“”‘“”““”‘E“‘ Gall Adtvities | Maintenance | Comments || Promises | Cheekists || Tracking Attributes || References || Correspondence || Letters [ Zsaarch ]
Prod ) . ® Al O any
ven Transaction Batch Information Add |/ Edit ] vi £ Audit
Batch View v Fomatv [ Freeze EfiDetach ¢l wrap W post [ veid
Advances .
ot Date Vonetary Transaction accounTeL e
L o2f10f2016 ¥ Pt arch: Transacti
o= . 03/25/2016 n ACCOUNT SUB UNIT TRANSFER e
Interface: 0y/22/2016 n ACH HAINTENANCE pomdtily . Search e
AP Transactions 03/07/2016 r, 'ACH ONE TIME PHONE PAY e o DAY i @
GLTransactions 12/15/2015 v ADJUSTMENT TO ADVANCE / PRINCIPAL - ADD >

Parameters
View v Format +
> Collections
Parameter
> WP o data to display,
> Tools
> setup

Result

Reset | | AddFields || Reorder

Date 02/10/2016

* Monetary @) 0K || Cancel

&

Freeze i Detach

Value

Required

Click the arrow button available before ‘Search’ to toggle the search options.

Buttons/Menu Do this

Basic Click ‘Basic’ for normal search.

Advanced Click ‘Advanced’ for advanced search. In this mode, you can select
the search option from drop-down list adjoining the search criteria.
Selected record will be highlighted (Hover to select).

Match Select ‘All’ to display results exactly matching the specified
characters. Select ‘Any’ to display results matching any of the
specified characters.

Search Click to search for values based on the specified search criteria.
The search results are displayed below with the details in respective
columns.

Reset Click to reset the search criteria.

Add Fields Click to add additional fields to search criteria.

The search criteria are provided below the ‘Match’ field. These criteria vary based on the Field
for which the search is executed.

Also, the system remembers your recent search options and demarcates them from the actual

ones.
| * Channel | WEB ENTRY = * Producer Name [
NY-02: PR HOLTSVILLE 43125313212
MT-00001 : SGFSADDF RAMEY 23132132
LR} SR e 1
TIF-OUOO L T TEST-00T RTINS T 1
MN-00001 : TERMINATE AGUADA a
MT-00001 : SGFSADDF RAMEY 23132132
NY-02: PR HOLTSVILLE 43125313212
Search...
Comments

In all the user input screens wherever comments are accepted, the system allows an input of
4000 characters of information in the comment(s) field.
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1.6 Keyboard Compatibility

The system facilitates keyboard compatibility. You can perform most of your tasks using
keyboard short cuts also termed as ‘Hot Keys’. These hot keys are single keyboards or a
combination of keyboards. The available options are listed below:

1. Shift + Alt + mnemonic to activate buttons in the screen. For example, to open
‘Accessibility’ screen, press ‘Shift + Alt + y’.

2. Tab for forward navigation in the application. Shift + Tab for backward navigation in the
application. When the required link/tab/button/field is highlighted, press enter on the
keyboard to edit.

Space bar to check or uncheck ‘Check Box'.

4. Arrow Keys to hover within the drop-down list.

1.6.1 Keyboard Compatibility

The application is made compatible with keyboard only-operations. However, there is a
change in key combination based on the browser on which the application is running.

Browser Operating Key Combination Action
System

Google Chrome Linux Alt + mnemonic Click

Google Chrome Mac OS X Control + Option + mne- | Click
monic

Google Chrome Windows Alt +mnemonic Click

Mozilla Firefox Linux Alt + Shift + mnemonic Click

Mozilla Firefox Mac OS X Control + mnemonic Click

Mozilla Firefox Windows Alt + Shift + mnemonic Click

Microsoft Internet Windows Alt + mnemonic Set focus

Explorer 7

Microsoft Internet Windows Alt + mnemonic Click or set focus

Explorer 8

Apple Safari Windows Alt + mnemonic Click

Apple Safari Mac OS X Control + Option + mne- | Click
monic

Also, one can use the following keyboard shortcuts in order to increase or decrease the zoom

level.
Shortcut Action
Ctrl++ To increase zoom level.
Ctrl+- To decrease zoom level.
Ctrl+0 To set zoom level to default level.
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1.7

1.8

1.8.1

1.8.2

1.8.2.1

Tool Tips

The system is facilitated with tool tip option. When the cursor is moved to any of the field in
the screen, a popup is displayed with a tip on the action to be performed.

Accessibility

Application

Understanding Accessibility

Accessibility is making the application usable for multiple user groups, which includes users
with physical challenges. One of the most important reasons to make the application
accessible is to provide them the opportunity to work. The four main categories of disabilities
are visual, hearing, mobility and cognitive.

A person with disability might encounter one or more barriers that can be eliminated or
minimized by making the electronic information user-friendly and approachable.

Application Accessibility Preferences

Oracle Financial Services Lending and Leasing is facilitated with the feature of Accessibility
to make the application more usable for the people who are differently abled. You can set the
accessibility preferences after login. On the landing screen using 'Accessibility’ link on the
right end of the header set the following preferences as required

Screen Reader

Screen reader provides assistance to the visually impaired users. It interprets the screen
elements by reading them aloud.

High Contrast

High contrast feature increases contrast level to make the screen more appealing for the
reader with low vision.

Large Fonts

Large fonts feature increases font size to ensure clear display and appropriate spacing. This
benefits the reader with low vision.

For Visual Challenges

The visual challenges varies widely, however it generally includes, blindness, low vision or
color blindness. To make the application more accessible, following features are provided.

Blindness:

In order to interpret the visual display information in the audible form, Screen reader
compatibility is provided.
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1.8.2.2

1.8.2.3

1.8.3
1.8.3.1

In places where Screen reader technology cannot obtain information from images, text
equivalents for images are provided.

For Users with difficulty in using mouse, since it requires hand and eye coordination,
Keyboard navigation is provided. Details of keyboard navigation is provided in ‘Section 1.8.3.2
Keyboard Compatibility’.

Low vision:

For Users who cannot view the content that has small font size and cannot be enlarged,
Software magnifier is provided to enlarge text and images beyond normal font enlargement.

Also, there is no information presented using attributes such as depth, size, location, font etc.

For high contrast requirements Screen setting can be adjusted.

Color blindness:

Oracle Accessibility guidelines have been followed and hence accessibility issues relating to
color blindness are addressed.

Also, high contrast colors have been used to address difficulty in identifying shades of colors.
For example, Black text in white background.

For Hearing Challenges

People with hearing challenges or hard of hearing might encounter problems accessing the
information presented using sounds. Some application features minimize their concerns.

Visual representations of audible information is provided so that Users with this challenge do
not miss information presented using audio.

For Age-related Challenges

Apart from the above, there can be aging issues like week eye-sight or hearing.

Issues related to week eyesight can be addressed through Application features for Visual
Challenges provided in ‘Section 1.8.2.1 For Visual Challenges’.

Issues related to hearing can be addressed through Application features for hearing
challenges provided in ‘Section 1.8.2.2 For Hearing Challenges’.

For Users who are less familiar with computers, the simplified user interface with easy
navigation options, uniform layout and design and commonly used terminology in the
application is of great advantage.

To address issues relating to understanding complex information, User manuals are provided
for online help and tool tips at all required places are provided. In addition, system messages
like error, warning or information helps you through.

Other Accessibility Considerations

Documentation Accessibility

Apart from assigning the logical sequence and organizing topics, the following techniques are
used to enhance the accessibility of documentation.

e Addition of text equivalent to all graphics
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1.8.4

e Usage of standard fonts and avoiding shadow or reversed text

e Usage of strong foreground and background color contrast

e Color usages as per Oracle Accessibility guidelines have been ensured
e Usage of styles and formatting elements

e Documentation in simple language to ensure easy understanding

e Including accurate and effective navigational features, such as cross-reference, tables
of content and bookmarks as appropriate

Setting up Accessibility Preferences

You can setup or change the accessibility preferences.

To edit accessibility settings

1. Click Accessibility in the header part of application. The system displays the following
screen:

Oracle Financial Services Lending and Leasing L]
Accessibility Preferences

Edit Accessibility Settings

Any setting made is saved untl changed here again.’ : "Any setting must be
made for each browser session.

Screen reader
High contrast
Large fonts

Submit Cance|

2. Select any or all of the required options to edit or change the accessibility settings.

3. Click Submit.

Note

You need to define the required Settings for each browser session and defined settings
are saved until next modification.
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2.1

2. Search Function

Oracle Financial Services Lending and Leasing allows you to search for an account, customer
or application using specific search criteria. Since this section details the general search
options available in the User Interface, some or all the parts of this section are applicable to
you as per access provisions & licensing. The following sections explain the Search options
in detail.

Search Criteria

Search criteria has a list of parameters which enables to query the application / account from
the database by providing one or more parameter values. There are 15 parameters whose
values can be specified in combination with comparison operators which are described in the
table below. The Reset button enables to clear the comparison values for a fresh search.
Apart from this, Search can also be performed using wild card characters.

ORACLE
Financial Services Lending and Leasing

2, Welcome, PRAKRRAO »  Accessibilty [=)

Customer Service [E3f=
Search | | Customer Service | | Review Request (Pending: 0)
> Quick Search

Search Criteria

&P Reset Criteriz || @8 Search
Vieww Formatv [EH| [Fesze fivewmch | o wrap o))

e =]
Lixe ] =
LIKE [~]

EQU [~
LIKE =2
Lie vl
EQUAL =
Like I~
Lixe =l
Eau [~
LIKE [~]
e ~]
LIKE [~
Lixe ~]
LIKE ~l
Lixe = =

) Lixe ~1
ke

<

Search Results
View  Fommat~ | B Freeze B Detach oo | @R
> Collections Company Branch Account 7 Date Title Product Status Sokequency amount Due S
> WEP N data ta display.
<
> Tools
> Setup

Description | Example Expression

LESS THAN | APPLICATION DATE < 01/22/2002
Result: The system searches for all applications created before Jan.
22, 2002.

LESS THAN | APPLICATION DATE <= 01/22/2002

gg EQUAL Result: The system searches for all applications created on or before
Jan. 22, 2002.

EQUAL APPLICANT SSN = 111-22-3333
Result: The system searches for all applications with applicant social
security number 111-22-3333.

NOT APPLICANT SSN <> 111-22-3333

EQUAL . o .
Result: The system searches for all applications except those with an
applicant whose social security number is 111-22-3333.
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Description | Example Expression

GREATER APPLICATION DATE > 01/22/2002

THAN Result: The system searches for all applications created after Jan. 22,

2002.

GREATER APPLICATION DATE >= 01/22/2002

THAN Result: The system searches for all applications created on or after
OR EQUAL | Jan. 22, 2002

IN ACCOUNT NUMBER IN (20001000012512°, <20010100012645°,
£20010300012817°)

IN is used with values that are within parenthesis.

Result: The system searches for the applications with the account num-
bers of 20001000012512”, <20010100012645”, and 20010300012817.)

NOT IN ACCOUNT NUMBER NOT IN (‘20001000012512°, 20010100012645°,
€20010300012817°)

NOT 1IN is used with values that are within parenthesis.

Result: The system searches for all applications except those with the
account numbers of 20001000012512°, <20010100012645°, and
120010300012817°.)

IS VIN IS NULL

IS is only used with a value of “NULL”. It enables you to search for crite-
ria that has no value; that is, fields where no information is present.

Result: The system searches for all applications without a vehicle iden-
tification number.

ISNOT VIN IS NOT NULL

ISNOT is only used with a value of “NULL". It enables you to search for
criteria that has any value; that is, fields where information is present.

Result: The system searches for all accounts with a VIN, vehicle identi-
fication number.

LIKE ASSET TYPE LIKE VEH%

LIKE enables you to search for close matches using wildcard charac-
ters.

Result: The system searches for all applications with asset type begin-
ning with the characters “veh” such as “vehicle car” or “vehicle van.”

NOT LIKE ASSET TYPE NOT LIKE VEH%

NOT LIKE enables you to search for close matches using wildcard
characters.

Result: The system searches for all applications with asset type other
than those starting with the characters “veh.”

Using Wildcard Characters

e Wildcard characters can only be used with the operator LIKE and NOT LIKE.
e % (percent) represents any number of characters, including no characters.
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e _ (underline) represents any single character.

Using Criteria Value

Search criteria values of 1234% will locate character strings of any length that begin with
“1234” for example,

e 1234ACB
e 12345678
e 1234

e 12348

e 12340980988234ABIL230498098

Search criteria values of 1234_ will locate character strings of five characters that begin with
“1234” for example,

o 12345
e 1234A
e 12340

Search criteria values of %1234 will locate character strings of any length that end with
“1234” for example,

e 1234
o 01234
e (098908LKJKLJLKJI000988071234

Search criteria values of _1234 will locate five character strings that end in “1234” for
example,

e A1234
e 11234

Search criteria values of %1234% will locate character strings of any length that contain
“1234” for example,

e 1234
e 01234
e 12340

e AKJLKJ1234128424

Search criteria values of _1234_ will locate character strings of 6 characters that contain
“1234” for example,

e A1234B
e 012341
e A12341

Using Search Criteria examples

Result: The system searches for all applications with application date May 1, 2001.

Criteria Comparison Operator Value
APPLICATION EQUAL 05/01/2001
DATE
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2.2

Criteria Comparison Operator Value
APPLICATION DATE EQUAL 05/01/2001
APPLICATION NUMBER | GREATER THAN OR EQUAL 0000000278

Result: The system searches for all applications with application date May 1, 2001 and an
application number greater than or equal to 0000000278.

Criteria Comparison Operator | Value

FIRST NAME EQUAL

JAN

Result: The system searches for all applications with applicant whose first name is “JAN”

e JAN ARBOR
e JAN FISHER

Criteria Comparison Operator | Value

FIRST NAME LIKE

JAN%

Result: The system searches for all applications with applicant’s first name starting with “JAN”

e JAN ARBOR

e JAN FISHER

e JANE MEYERS

e JANETTE NORDSTROM

Searching for an Application

Oracle Financial Services Lending and Leasing allows you to search and retrieve a particular

application.
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2.21

During application entry, queues can be created based on your user id and your user
responsibility. You can view the assigned queues in the Origination screen of DashBoard.

ORACLE

Financial Services Lending and Leasing

e Y— o

DashBoard
Dashgoard
DashBoard
Users Productivity
System Monitor
Producer Analysis
Process Files

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

DashBoard 3
Origination Setup
My User Queues Product Expiring in Next One Month

Description Count Froduct End Date
No data to display. No data to display.

My Pending Review Requests By Applications
App # Friority
No data ta display.

My Pending Review Requests By Priority
Priority Count
No data to display.

Servicing Producer

Number of Queues Hard Assigned
Queus Description Count
No data to display.

A Producers Count By Status
Status Count
ACTIVE 82

Number of Accounts
Quaus Description Count
No data to display.

Producers Expiring in Next One Month
Producer End Date
No dats to display.

My Pending Review Requests By Accounts
Acc# Priority
No data to display.

My Pending Review Requests By Priority
Priority Count. v
Na data to display.

(3] Close.
Admin

Critical Batch Job Status
Batch Job Status
No data to display.

Vendor

Vendors Count By Status
Status Count
ACTIVE 35

Vendors Expiring in Next One Month
Company Name End Date
No data to display.

In each stage of application, the queue name to which the selected application is assigned,
appears in Queue name field in Result screen.

You can begin processing the applications in the order in which they are listed. Select the
record and click Submit.

Search/Task tab

To view the Search/Task screen during Lease origination

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Origination master tab.
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Depending on the task to be performed and the link clicked, the respective screen opens
in the Search Results/Task screen.

ORACLE’
Financial Services Lending and Leasing

jinati Close
mET Origination » )
Origination Search[Task Application Entry ~ Review Requests (Pending: 0)
Quick Search
Simple Application Entry . N B = -
Application Entry App # sSN Identification # [ submit
Underwriting
Funding Queue [~] | [ next Application
Application Retrieval
Scenario Analysis * search Criteria
Application Documents
Image Maintenance A New application | | (L) Open Application || (5] View Application Unlock Application
Reports.
Producers Search Results/Task
Vandars View~ Format~ R freeze [fiDetach | ol wrap W viewan [
Crit Loc Allo Company Branch App # Date Title: Product Status Sub Status Qu
No data to display.
< >
Columns Hidden 1
1
> Servicing
> Collections
> WFP
> Tools
> Setup

2. Click the Search Criteria tab.

ORACLE"
Financial Services Lending and Leasing

Origination

DashBoard

Scarde/Task || Auplication Entiy || Rein Rexuets (Persdin: 0)
> Quick search
Search Criteria
& Reset Criteio || @ Search

view - rormatw  [E¥] [ Fresss EfiDamon ol wrep =
e L)

Criteria Comparison Oparator B vaive
vEAR EQUAL ~
EQuAL L~
TSI = =S
[ET3 =3 =
i =~ 3]
Like <1
i =]
e 1
ke L]
e 3]
ke &
ke L]
Like 1]
[ET =1
i =
ke <1
@ New appiicarion | | (O anen anpticarion | | (5] wiew appiicanon Linieck applicaion
Search Results/Task
View v rormat~ B Freeze i Detach 0 wrap @ veewan O]
Branh A et Titke Product Statea Suls Status au

> Servicing
> Collections.
> wre

> Tools

> Setup

The search tab enables you to locate an application using a broad range of search criteria.

e During Lease origination, the results are sorted according to the priority of application
and application identification number. However you can sort the records using any
criteria.

e If you try to open an application which is already opened by another user, system
displays an alert message indicating “Application is locked by <User Name> Phone
<phone number>".

The Search Results/Task screen.

3. On the Results screen, select the application you want to load and click Open
Application.
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The system loads the application on the respective screen.

ORACLE
Financial Services Lending and Leasing
R Close
DashBoard Origination EE
Origination Search/Task | Application Entry: 0000001537 || Review Reauests (Pending: 0) ~
Application: 0000001537: RODRIGUEZ ROBINSON Bl iew || <2 audt
View v Format~ | P Frecze [ Detach Wrop Override OK ¥ Warning OK v
Origination Stage Producer Contact 5 Duplicate
ot App = Sub Unit Status i Producer Name  RTOdUCe! Bxsting Customer  DURICR® Contact
0s/05/2015 0000001537 APPROVED - FUN... FUNDED CA-00003 : ACE H.. (818)-761-2277 N N
>
Summary || Applicant || Business || Request || Dedision || Contract || Collateral || Comments || Tracking || Document | | Verification || Correspondence || Toals
Vendors > Applicant
> Ratios
> Bureau
4
“
> Checkdist
Collateral
Collateral
Asset Type Sub Type Primary  Year rake Model Mileage New Wholesale Volue  Retail
VEHICLE car ¥ 2015 Aupr A oy 12,000.00 13,500
< >
Trade-In
Trade-In
Asset Type Asset Sub Type Description Identification Year Make Model BaseRetail Amt  Addons
P vERICLE 2015 DODGE RAM... 3GCPCRECSEG145156 2015 DODGE RAM PICKUP 2500  5,300.00 200.00
verICLE 2012 CHEVROLET .. 3GCPCRECSEG145647 2012 CHEVROLET camaro 1,600.00 0.00
> Collections < >
> WFP
> Tools e
> Reque: -
> Setup

You are now ready to begin work on the application.

2.2.2 Quick Search section

Quick Search enables to search for an account using any one of the following values -
Account Number, Customer ID, SSN, Identification Number or Queue.

To load an account using the Quick Search section:

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Servicing master tab.

2. In the Quick Search section’s Acc # field, specify the account number you want to load
and click Submit.

You can also load the account by specifying the last 4 digits of the SSN Number. System
retrieves only those accounts where the searched SSN is of the Primary Applicant. If multiple
matches are found, system displays an error message as ‘Multiple Matches found for the
SSN, Please use normal Search’.

Note

Search cannot be performed using wild card characters in the Quick Search section.
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ORACLE
Financial Services Lending and Leasing

% Welcome, PRAKRRAQ ~  Accessibility [=

nation 36 Cloce.
e ongination x 3]
Ori Search/Task | Application Entry: 0000001536 || Review Requests (Pending: 0)

Quick Search

> Search Criteria

& New Application | | (L) Onen application | | [5] Miew Application | | T Linkock Application

Search Results/Task

> Servicing
> Collections
> WEP

> Tools

> Setup

The system loads the selected application.

To load an account from a queue during application entry

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Servicing master tab.

2. In the Quick Search section’s Queue field, select the queue you want to work with and
click Next Account.

2.2.2.1 Other Features on the Results screen

The Results screen on the Applications screen has below listed common features (these
features are not present on the Result screen on Customer Service screen):

What is it? What does it do?

View All If you select View All check box, all applications in the system acces-
sible with your user id appear in the Results screen under search sec-
tion.

Queue Name This display only field indicates the queue in which the selected appli-
field cation is currently in. (This in normally related to one or more of the
following, based on setup: producer, state, or status.)

Secured box Indicates that the selected application is secured (that is, that the
applicant is an employee of the organization) and may only be loaded
by authorized users.

Copy Applica- | Creates a copy of the selected application. This feature is usually
tion button used when an applicant has submitted a previous application or when
an applicant submits a second application and you don’t want to
retype the information.

New Applica- | Opens a screen where a user can create a new application by provid-
tion ing required details.

Open Applica- | Displays the application details for the selected application.
tion
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What is it? What does it do?
Unlock Appli- | Unlocks the selected application locked by another user.
cation

Copying an Application

Once the application clears the pre-qualification edits successfully, it moves to the
underwriting queue. In the Underwriting/Funding screen, you can copy the information of an
existing application into a new application. using Results screen. The new application will
contain duplicated data of application information, the requested Lease information, credit
bureau data, and collateral information. The new application will have status/sub status as
NEW - REVIEW REQUIRED.

To copy an application

1. Open the Underwriting/Funding screen and use Quick Search screen to locate the
application you want to copy.

2. Select the application you want to copy on the Search Results/Task screen.

3. Click Copy Application.

ORACLE & Welcome, PRAKRRAO v  Accessibility o
Financial Services Lending and Leasing

[ Close

DashBoard
Origination

Origination

Origination

(@ Information
Application copy succassful. New application # success

Sales Lead

Simple Application Entry
Application Entry
Underwriting

Funding App # | 0000001537 =
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports

Producers

Vendors

Search/Task | Undervriting: 0000001537 | Review Requests (Pending: 0)
Quick Search

Identification #

B submit

Queue [~] | [B next Application

> Search Criteria

[El view Appiication

(2] Open Application Unlock Application | {
Search Results/Task
View v Formatw [ Freeze [t Detach Wrap W Viewan [
Crit Loc Alla Company Branch App # Date Title Product Status
No data to display.

< >

Sub Status Qu

> Servicing
> Collections
> WFP

> Tools

> Setup

An Information message is displayed as “Application copy successful. New application # (new
application number).”

System creates a new application with details of the copied application with status NEW -
REVIEW REQUIRED. The new application can be accessed from the underwriting screen
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irrespective of whether it is copied in Underwriting/Funding screen. The system also notes

that this is a copied application with a system generated comment.

ORACLE" . . 8 Welcome, PRAKRRAO ~  Accessibility (52
Financial Services Lending and Leasing
tginath Close
e Origination x 7]
Origination Search/Task  Underwriting: 0000001533  Review Requests (Pending: 0)
‘Onigination
SelesLead Application: 0000001533 SIGG MARK Zedt | Evew | o aude
simple Application Entry _—
Application Entry View - Format~ [ Freeze i Detach Wrap W overrideok v Waming Ok v
Underriting Origination Stage Producer Contact 3 Duplicate
i Dt App # Sub Unit Status. Code Producer Nama N Existing Customer application ‘Contact
Apglication Retrieval 05/05/2015 0000001533 REJECTED - AUTO.. NEW CA-00003 : ACE H... (B18)-761-2277 N N
Scenario Analysis < >
Application Documents
Image Maintenance
Reports Summary | Applicant || Business | Request| Decision  Bureas | Collstersl Comments | Tracking | Document | Verification || Comespondence | Tools
Producers
Vendors
Comments
i Bl saveandstay | [ save and Retum || G Retum
View v Format~ [ Freeze (i Detach 1l Wrap @
Alert Type Sub Type ‘Comment Comment By Comment Dt
O REGULAR [v] | LOAN GRIGINATION [v] PRAKRRAQ 02/04/2016 04:35:38 AM
‘
DECISION_MULTI_OFFER LETTER GENERATED, ~ i
O SYSTEM GENERATED SYSTEM GENERATED {(CORRESPONDENCE: INTERNAL 02/01/2016 08:33:04 AM
CNLNCE_DEC_MULTIOFFER_FAX_VR JOB REQUEST 1D: ¥
'CONTRACT_FUNDING LETTER GENERATED.
O SYSTEM GENERATED SYSTEM GENERATED (CORRESPONDENCE: CNLNCE_CON_LTR_VR 3OB REQUEST VEROUTHU 01/30/2016 12:30:35 AM
1D: 41039)
DECISION LETTER GENERATED. (CORRESPONDENCE:
O SYSTEM GENERATED SYSTEM GENERATED CNLNCE_DEC_FAX_VR JOB REQUEST ID: 41038) VEROUTHU 01/30/2016 12:06:18 AM
HAVING GOOD REFERRAL
O REGULAR LOAN ORIGINATION VEROUTHU ©£1/29/2016 11:24:13 PM
> Servicing
> Collections
> WEP
> Tools
> Setup

2.2.2.3 Unlocking an Application

When an application is opened by a user, the same would be locked for other users. Using

Results screen in the Applications screen user can unlock the application.

To unlock an application

1. Open Applications Entry screen and use Quick Search screen to locate the application

you want to work with.

Submit.

On Search Results/Task screen, select the application you want to load and click

An Information message appears with the message: “An application is locked by another
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user.”

ORACLE" . . & Welcome, PRAKRRAD +  Accessibity o
Financial Services Lending and Leasing

i Close
TR Origination x 5]

Origination Search/Task | Undenwriting | Review Requests (Pending: 0)

Origination

Sales Lead Qb panh

Simple Application Entry . _ ,, B =
Apolication Entry App ¥  DO00001622 E=Y Identification # EB submit
Underwriting & Warning *

Funding Queus v By

Bpplication Resial ] [ Application is locked by: KGOUDU Phone: 0 - Ext.: 0

A (i > search Criteria ok

Application Dacuments |||~ e -

Image Maintenance (] Cpen Application | | [5] View Application Unlock Application Copy Application
Reports

Producers Search Results/Task

Vendors View » Format v [EF Freeze FfiDetach | ol wrap W viewan []

Critical Locked  Allowed  Company Branch  App # Dat= Title Product Status Sub Status Qu
No data to display.
<

> Servicing
> Collections
> WFP

> Tools
 Setup

3. Click Unlock Application.

4. Click Open Application. The system loads application on the Underwriting screen.

2.2.2.4 View Application

2.3

The View Application button is available in all origination screens (Application Entry,
Underwriting and Funding). You can view a selected application in the search results by
clicking on the View Application button even when the application is locked by another User.

The application will be opened in ‘View Mode’ only and no edits are allowed. However in Tools

sub tab, the 'Initialize' and 'Calculate’ buttons will be enabled allowing you to use the calculator
options.

Searching for an Account and Customer

You can search or retrieve a particular account or customer through Customer Service

screen. The search tab available in the screen enables you to locate an account or customer

using a broad range of search criteria.

To view the Search screen during Lease servicing

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Servicing master tab.

2. If you want to perform a customer service task on the application, click Customer
Service link.
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Depending on the link clicked, Customer Service screen appears, opening at Results

screen.
ORACLE
Financial Services Lending and Leasing
e Customer Service (%] Cose
5 Origination Search | Customer Service || Review Request (Pending: 0) =
Servicing Quick Search
Servicng
Custorner Service Acc # Customer 1d SSN Identification # Submit
Seauritization
Fransaction Kathuzation Quete/ Condition [=] Auorun [ | [ NextAccount
Post Date Checks
Escron Transactions > Search Criteria
Account Documents =
Collateral Management () Open Account
Reports
Producers Search Results
Vendors View v Format + Freeze i Detach ¢l wrap (5]
Batch Transactions & B
Advances Del
Payments 1 Company Branch Account # Date Title Product Status oy Aot DuE E
Fees usoL UsHQ 0150100010023 DL01/2015 ‘BABL MADHU LOAN VEHICLE (FR) ACTIVESTIP 17 0.00 -
Interfaces usoL UsHQ 20151200010012  12/07/2015 MADHUBOBBURI  LOAN VEHICLE (FR) ACTIVE:DELQ:NON PERFORMING 77 4,786.60 |
4 Transactions uso1 usHQ 0150200010030 024012015 KARTHICRAGHAY... LOAN VEHICLE (FR) PAID OFF 0 0.00
GL Transactians usoL usHQ 0160200015310 02/24/2016 SDFSD SDFS LOAN VEHICLE (FR) ACTIVE 17 0.00
Conversion Accounts usoL UsHQ 0160200015584 02232016 K SAIKRISHNAN  LOAN VEHICLE (FR) ACTIVE:DELQ 16 443,80
usoL usHo 0160100015593 01/02/2016 SALE_TRAN_IAMAC LOAN VEHICLE (FR) ACTIVE:DELQ 15 107,54
usn1 USHQ MIE000015071  02/16/2016 EWFEWFRWQ  LOAN VEHICLE (FR) ACTIVE 17 0.00
usn1 USHQ 0160100015568 01/02/2016 MONTANDCN QUA... LOAN VEHICLE (FR) ACTIVE:DELQ 45 2,114.08
uso1 UsHQ 0160100015303 0120/2016 BROADSTUART /.. LOAN VEHICLE (FR) ACTIVE:DELQ 27 900.06
uso1 usHQ 0151200015062 12/10/2015 MAC RAJESH LOAN VEHICLE (FR) ACTIVEIDELQ 77 13,214.31
usoL usHQ 0160200015089 02f16/2016 GSDFGSGDFGSF  LOAN VEHICLE (FR) ACTIVE 16 0.00
N N2 NHQ 0120700016200 07/10/2012 EEVERGREEN SADL... LOAN HOME (VR) PENDING 0 0.00
usoL usHQ 0160100015113 01/20/2016 EROAD STUART /.. LOAN VEHICLE (FR) ACTIVE:DELQ 27 450.03
> WEP usn1 USHQ 160100015163 01/12/2016 SARANGULA PRAD .. LOAN VEHICLE (FR) ACTIVE 35 0.00
> Tools usn1 USHQ MIE0I00015171 01122016 SARANGULA PRAD... LOAN VEHICLE (FR) ACTIVE 35 0,00 = |4
< . ] [
> Setup )l
3. Click the Search Criteria tab.
ORACLE’
Financial Services Lending and Leasing
> DashBoard Cstumer seoce X [#Close
> Origination Search Customer Service  Review Request (Pending: 0) =
Servidng " Quick Search
Serviding
Customer Service ‘Search Criteria
Securitzation Search Options: (@) Account ) Custamer ) Business
Transaction Autherization
Past Date Checks & Resct Criteria | @8 Search
Escrow Transactions View > Format > B Freeze  {fiDetach W R
Account Documents Criteria Comparisan Operatar Value i
Collateral Management: N & e =
REpats ACCOUNT STATUS LiE [=] [=]
Producers
Vendors PRODUCT i [=] ALOAN%
- cusroven s B F
Advances i CUSTOMER LAST NAME LKE [=]
Payments CUSTOMER FIRST NAME Lxe [=] £
re CUSTOMER D EQUAL [=]
Interfoces
P Treneactons BUSINESS NAME LIKE [«
6L Transactions N e =
CASA Recondiiation YEAR EQUAL [=]
Conversion Accounts MAKE e &
MODEL Lxe [=]
ASSETTYPE Lxe [=]
PRODUCER # LIKE =]
> Collections PRODUCER NAME LKE =
b WP ACCOUNT CONDITION it [=] [+
> Tools 'QUEUE NAME {UNDEFINED FOR DEFALLT) LIE [=]
> Setup. QUEUE DESCRIFTION LKE [=] .

Using the

Search tab

1. Create a search criteria by specifying the required details in Comparison Operator and
Value columns.

2. Click Search. System displays all accounts that meet the search criteria in the Results

tab.

3. Onthe Search Results/Task screen, select the account you want to load and click Open
Account.
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The system loads account on Customer Service screen.

ORACLE’
Financial Services Lending and Leasing
i Close.
T Customer Service x E]
> Origination Search  Customer Service: 0150900014267 | Review Request (Pending: 0) A
Servicing
Sericing Account(s): 20150900014267: SIGG MARK E] view || o aude
Customer Senvice View v Formatw [ i Detach 4l Wirap W@ & @ curentO show Al Group Follow-up
;E“‘""_’: o horastin Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt
Lt oD usot usHg 0150900014267  LOAN VEHICLE (FR) 118 UsD 19,387
Past Date Checks >
Escrow Transactions
‘Account Documents
Collateral Management Summary | Customer Service | Account Detzils | Customer Details || Transaction History | Pmt Modes | Bankruptcy || Repofforeclosure || Deficiency || Collateral | Bun >
Alerts Conditions
Batch Tr s s
et Trensacton Alerts Conditions
Advances
) Alert Condition Start Dt Followup Dt
el No data to display. DELINQUENT 10/09/2015 014302016
Interfaces
4P Transactions
GL Transactions
CASA Reconiliation
Conversion Accounts ) 7
Account Details Other Information
Collateral Information
Dues Description Identification = Year AssstClass A
02/01/2016 01/01/2016 12/01/2015 13/0/2015 000 05 aupr as WAUAFTSEZSAII9502 2015 MEW v
1,302 1,302 1,302 1,302 1,302 < >
< >
Delq Due 5,208 Total Due 5,320 Future Fmt Bt 10/01/2015  ‘Customer Information
LCDue 120 19,397 Oldest Due Dt 10/01/2015 Customer e o
NSFDue 0 19,423 AmtPaid 0O
Other Due 0 Future Payoff 02/06/2016 Excess 000001... MARK DOUGLAS SIGG IR PRIMARY 300-300e-8660
Date >
Delinquency Information ~
Late 20 0 % 120 150 180 Categ Email TAR‘{?DFELL.(QM usali\hl‘f N Pn./;;! Y
3 1 5 5 o 3 i £ Language ENGLISH skp N 0P
< > Marital UNDEFINED Stop N N
Status Comespondence Active N
silitary
> Collections NSF(Life) 0 Collector DEMOCOLL Duty
> WEP NSE(vear) O Time AMERICAINEW_YORI
> Tools Activities v
> Setup Active Dt 01/27/2016 App # 0000001533  LastPmtAmt O Address Information

Quick Search section

The Quick Search section in Customer Service screen enables you to load accounts using
any one of the fields Account Number, Customer Id, SSN, Identification #, or Queue/
Condition.

To load an account using the Quick Search section
On the Oracle Financial Services Lending and Leasing Application home screen, click the

1.

Servicing master tab.

If you want to perform customer service task on the application, click Customer

Service.
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2.3.2

3. Inthe Quick Search section’s Acc#/Customer Id/SSN/Identification # fields, specify the
corresponding Account number, or Customer Id, or last four digits of SSN or complete

SSN in the respective fields and click Submit.

ORACLE
Financial Services Lending and Leasing

DashBoard Customer Service
2 Ofgination Seandi || Customer Service: 2015090014275 || Review Request (Pending: 0

Servicing Quick Search

c= 0150500014275

Queue/ Condition ~] At

> Search Criteria

Search Results
View ~ Format~ | B Frocze fifivomeh | ol wrap W@
Company Branch

N dats to display.

> Collections
> wep
> Tools

> Setup

Customer 1d ssn

run O ([ R Aot

Tide

denufication =

ne, PRAKRRAO +  Accessibility (=
36 Clowe
[ subme
() Open Account
status Dolieauency  pmount
>

4. When the request to access an application comes from an external system, user needs
to check ‘Auto Run’ and click ‘Next’ button. System displays the customer service screen

for the respective Account.

To load an account from a queue

In the Quick Search section’s Queue field, select the queue you want to work with and click

Next Account.

Search Using Customer Details

There are different ways to search a customer account using the customer details.

To search for and load the customer details with the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click
Servicing— Servicing— Customer Service—> Search Criteria

Select Customer as a search option.

ORACLE’
Financial Services Lending and Leasing

Customer Service x

» DashBoard

> Ongination Search | Customer Service | Review Request (Pending: 0)
Seicag > Quick Search

Servicng

Customer Service Search Criteria
Seaitzation
Transaction Authorization

Post Date Checks

Escrow Transactions view * Fomat~ [ Freeze i Detach Wrap @
Account Dacuments Criteria
Collateral Management i e
e CUSTOMER FIRST NAVE
Producers
; CUSTOMER LAST NAME
Vendors
Batch Transactions CUSTOMER S5N

Advances CUSTOMER NATIONAL ID

«

et CUSTOMER PASSPORT NUMBER

s CUSTOMER PHONE NUMBER
Interfaces

4P Transactions CUSTOMER ZIP CODE

GL Transactions
Conversion Accounts

Search Results

View v Format~ [} Freeze [l Detach Virap 5]
Customer 1d National ID
No data to display.
> Collections
YL Vewr Fomst~ B Freere ] Detach wep @
> Tools Company Branch Account # Product Currency
> Setup No data to display.

Comparison Operator
LIKE

LIKE

LIE

EQUAL

LIE

LIE

EQUAL

LIKE

First Name

Pay Off Amt

(k| en] En{ EWNEN) N

[

Last Name

Amount Due

(3 Close
Search Options: ) Account @ Customer ©) Business
& Reset Ciiteria || @@ Search
value
() @pen Account
ssn Passport # zn

Status OdestDueDt  Type

ml |

2-14

ORACLE



1. On Search Criteria screen, use Comparison Operator and Value columns to create a
search criteria to find the account using customer details. You can click Reset Criteria at
any time to clear the Comparison Operator and Value columns.

2. Click Search.

The system locates and displays all the accounts that meet your search criteria on Search

Results screen.
ORACLE

Financial Services Lending and Leasing

> DashBoard Customer Service x

Senvcng Quick Search
Servicng
Customer Service hccx
Securitization
Transaction Authorization
Post Date Chedks

Queue/ Condition

Account Documents
Callateral Management

Reports
Producers Search Results
vendars View = Format ~
Batch Transactions Customer 1d
Advances 31030
Fayments g
Fees
Interfaces
AP Transactions
GL Transactions

View v Format +
Company

Converson Accounts ~eul

»» Collections
> WFP

> Tools

> Setup

> Origination Search | Customer Service | Review Request (Pending: 0)

Escrow Transactions b Search Criteria

[ ose

Customer 1d ssiu Identfication = (B Submit

[=] Autorun ] | (B NextAccount

(2] 0pen Account

B Freeze i Detach rap 7]
National ID First Name Last Name SN Passport & Zp
45632-1789 SATKRISHNAN K 00003356 00775

B Freeze  Efi Detach rap 5t
Branch Account # Product Currency Pay OFf Amt Amount Due Status Oldest Due Dt Type
usH 0160200015584 LOAN VEHICLE (FR)  LSD 5,037.08 42278 ACTVEDELG 03/01/2016 PRIMARY

3. On the Search Results/Task screen, view the following information for each account:

In this field:

View this:

Company The company of the account.

Branch The branch of the account

Account # The account number

Date The date the account was created.

Title The primary and other applicant(s) attached to the account.
Product The Lease product of the account.

Status The status of the account.

Delinquency days

The number of days the account has been delinquent.

Amount Due

The total amount due for the account.

Outstanding Balance

The total outstanding balance for the account.

Producer

The producer of the account.

Secured

If selected, indicates the account is secured and may only be
loaded by authorized users.

4. On the Search Results/Task screen, select the customer you want to retrieve. The
system displays all the accounts pertaining to that customer Id. Select an account and

click Open Account.
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The system displays the account details on Customer Service tab.

2.3.3 Search Using Account Details

To search for and load an account using the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click
Servicing— Servicing— Customer Service—> Search Criteria

1. Select Account as a search option.

ORACLE'
Financial Services Lending and Leasing

o Deoart] Customer Service [ close
> Origination Search | Customer Service | Review Request (Pending: 0) “
Servicing > Quick Search
Senvidng
Customer Service Search Criteria
Securtzation Search Options: @ Account () Customer () Business
Transaction Authorization
Post Date Checks & ResetCritens | (@ Search
Esaron Transactions view = Formatw [ Freeze  pfiDetach | gl wrap ® L
Actount Documents Criteria Comparison Operator value 1
Collateral Management N prn &
Reparts ACCOUNT STATUS i = =
Producers
Jendors PRODUCT LIKE =] %LOAN%
Advances it CUSTOMER LAST NAME LiKE =]
payments CUSTOMER FIRST NAVE LiE [=]
Fees CUSTOMER 1D EQUAL =
Interfaces =
AP Transactons BUSINESS NAVE LiE -
6L Transactions v L [=
CASA Recondliation YEAR EQUAL =]
Conversion Accounts MAKE Lie =
MODEL LKE [=]
ASSETTYPE LiE [=]
PRODUCER # LKE =
- Collections PRODUCER NAME LKE [=]
> WP ACCOUNT CONDITION LKE [+ [+
> Tools QUELE NAME {UNDEFINED FOR DEFAULTY LIKE =
> Setup ‘QUEUE DESCRIPTION LIE [= J

2. On the Criteria screen, use the Comparison Operator and Value columns to create a
search criteria to find an account. You can click Reset Criteria at any time to clear the
Comparison Operator and Value columns.

3. Click Search.

The system locates and displays all the accounts that meet your search criteria on Results
screen.

ORACLE’
Financial Services Lending and Leasing

> DashBoard ‘Customer Service [2g] Clos=
> Origination Search | Customer Service | Review Request (Pending: 0) =
Serviding Quick Search
Senicing i
Customer Service Acc £ Customer Id = Identification # [ submit
Securitzation
Transaction Authorization Queue/ Condiion [2] AR E1 [ B extaccount
Post Date Checks
Escrow Transactions > Search Criteria
Account Documents =
Collateral Management (L) Open Account
Reports
Producers Search Results
Vendors View v Format~ B} Freeze pietach | gdwap @
Bat:;:::z:mm g Company Branch Account # Date Title Froduct Status D:‘Y‘Z""E"EV Amount Due :;:f:d‘”g Producer =
Payments usoL UsHQ 20151200011060  12/10/2015 NATH NATH LOAN VEHICLE (FR) PENDING 0 0.00 0.00 CA-00002 : RAND" »
Fees usot usHQ MISI00L1331  12/18/2015 MADELLA SURESH  LOAN VEHICLE (FR) ACTIVE:DELQ 1 147182 2503000  CA-00002:RANDY |
Interfaces usoL usHQ 151200012331 12/10/2015 KNAVIN LOAN VEHICLE (FR) PENDING 0 0.00 0.00 CA-00002 : RAND'
— usot usHQ 015100012348 12/17/2015 SOF SOF LOAN VEHICLE (FR) FENDING ] 0.00 0.00 AK-00001 ; HELL
s usot usHQ DI51200012612  12/18/2015 KNAVIN LOAN VEHICLE (FR) PENDING 0 0.00 0.00 CA-00002 : RAND'
S usoL usHQ 151200012894 12/24/2015 ASHOKPADMA  LOANVEMICLE (FR) ACTIVE 2 0.00 2000000 CA-00001:DEMO
Converson Accounts usot usHg DISI00L3008  12/30/2015 ume LOAN VEHICLE (FR) ACTIVE -1 0.00 100,000.00  CA-DODS : HARR"
usor usHQ 0160100013092 01/06/2016 SPARROV/ MARYY  LOAN VEHICLE (FR) ACTIVE 20 0.00 S0,000.00  CA-00001: DEMO
usoL usHg MDI60100013216  01/14/2016 JONES ANGELINA  LOAN VEHICLE (FR) ACTIVE -16 0.00 S0,000.00  CA-00001: DEMO
usot usHQ 0160100013274 01/18/2016 RANADE SHWETA  LOAN VEHICLE (FR) ACTIVE 31 0.00 500,000.00  CA-00001 : DEMO
usaL usHQ DI60100013414  01/19/2016 DALE ALAN LOAN VEHICLE (FR) ACTIVE a1 0.00 42,000.00  CA-00002: RAND'
 Collections usot usHQ 0160100013969 01/20/2016 0 LOAN VEHICLE (FR) ACTIVE -30 0.00 15,000.00  GA-000D2: ADVAT
e usoL usHQ 0151200014064 12/17/2015 KNAVIN LOAN VEHICLE (FR) PENDING 0 0.00 0.00 CA-00002 : RAND'
usot usHQ MDI60100014149  01/20/2016 HEGDE SUBHASH /... LOAN VEHICLE (FR) ACTIVE 24 0.00 15,000.00  GA-D00D2 : ADVAT
> Tools usot usHQ 2160100014206 01/20/2016 HEGDE SUBHASH f... LOAN VEHICLE (FR) ACTIVE 24 0.00 1500000 GA-00002: ADVAN +
> Setup ik n | ’ =

4. On the Search Results/Task screen, view the following information for each account:

In this field: View this:

Company The company of the account.
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In this field: View this:

Branch The branch of the account

Account # The account number

Date The date the account was created.

Title The primary and other applicant(s) attached to the account.

Product The Lease product of the account.

Status The status of the account.

Delinquency days The number of days the account has been delinquent.

Amount Due The total amount due for the account.

Outstanding Balance | The total outstanding balance for the account.

Producer The producer of the account.

Secured If selected, indicates the account is secured and may only be
loaded by authorized users.

5. On the Results screen, select the application you want to retrieve and click Open
Account.

The system loads the account under the Customer Service tab
ORACLE. g i

i Close
> DashBoard Customer Service ®
> Origination Search | : 2015100011054 «Request (Pending: 0)

Servicing
Seidng Account(s): 20151000011054: K NAVIN Elview | o2 audt
Customer Service Vieww Formatv B Freeze Efivetach  dwap @) & @ Current O ShowAll © Group Follov-up
Securtization Company Branch Sub Unit Account # product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Ot
Transaction Autherization uso1 UsHy UNDEFINED 0151000011054 LOAN VEHICLE (FR) 227 U0 531452 0.00 ACTIVE 10/01/2016
Post Date Checks
Escron Transactions
Summary | Customer Service | Account Details | Customer Details | Transaction History | Pt Modes | Bankuptcy | RepoForeclosure | Deficency | Collateral | Bureau | Crossfup Sell Activities
Account Documents
Collateral Management
Reports Alerts Conditions
Prodiucers
Vendors Alerts Conditions
Batch Transactions Alert Condition Start Ot Follovup Dt
Advances TEST o data o display.
Payments
Fees
Itefaces
AP Transactions
GLTransactions
CASA Reconlation
b Account Details Other Information
Conversion Accounts ‘
Dues Collateral Information
Description entiication Year AssetClass AssetTpe  SubType
000 000 000 000 000 0 0 New I 1
0 0 New 1 i
Delg Due 0.0 Total Due 2000 Future Pmt Dt 10/01/201 0 o New I 1
LCDue 000 Todays Payoff 4531462 Oldest Due Dt 10/01/2016
S Due 2000 Future Payoff 4537630 Amt Paid Excess 0.00 2
& Customer Information
Other Due 0.00 Future Payoff Date 02/27/2016
" . Customer e Relation s irth Ot Gender
Delinquency Information #
e 30 & ) 20 50 180 Category Da 000000... NAVINK FRIMARY G577 02/12/1987
0 0 0 0 ' ' 0 07 000000... RECHARD MURRAY JR PRIMARY o933 12/08/1985 UNDEFINED
»
epllife) 0 NSF(ufe) 1 Collector DEMOCOLL
ep(vear) 0 SF(Year) 1 Emai Disabily N Privacy Opt Out ¥
_ Lenguage ENGLISH skip N Active Miltary Duty N
T Activities Marital Status ! ditc; N Time Zone
ActiveDt 12/10/2015 App# 0000001013 Last Pt Amt. 0.00 Correspondence
> WEP Last Activty Dt 02/17/2016 Paid Off Dt Charge OFf Dt
Due Day 1 Effecive Dt 10/12/2015 iltary Duty N
> Tools y yOuly i
LastPmt Dt Current Pt 338180 Customer Score 800 Address Information -
PRl Customer Grade B Last Bl At 0.00 Behaviour Score 0 Tree curtent, P giing. Address Phone 7

e —
Copyright © 1998,2016, Oradle and/or its afilates. All rights reserved. K About

You are now ready to begin work on the account.

You can view the accounts pending for your review by selecting Receiver in the Review
Request tab.
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3.1

3.2

3. Dashboards

Introduction

This document is designed to help acquaint you with the features of Dashboard, on the
landing screen of Oracle Financial Services Lending and Leasing. Information from multiple
products is integrated and displayed as Dashboard on home screen of the application.

This manual explains the functionality of Dashboard facility and various Dashboards present
in the system. Since this section details the general dashboard options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing. Besides providing these details, the manual also provides a brief description of
other features associated with Dashboard link. The Dashboard main Menu further provides
links to the following screens:

e Dashboard

e Users Productivity
e System Monitor

e Producer Analysis

Dashboards

Dashboards are the tiny windows displayed on landing screen of the Application. Dashboard
renders quick and crisp information of specific transactions or tasks mapped to the ‘User
Role’, who logs on to the system.

The system facilitates integration of Information from different levels and displays it as
Dashboard on home screen, also called the landing screen of the application.

Navigating to Dashboards

Click Dashboard— Dashboard— Dashboard.

ORACLE’ & Welcome, PRAKRRAD ~  Accessibility (w]
Financial Services Lending and Leasing

DashBoard [ Close

Origination Setup Admin

My User Queues Product Expiring in Next One Month Critical Batch Job Status
Description ‘Count. Product End Date Batch Job Status
No data to display. No data to display. No data to display.

My Pending Review Requests By Applications
App 2 Priority
No data to display.

My Pending Review Requests By Priority
Priority Count
o data to display.

Servicing Producer Vvendor

Number of Queues Hard Assigned A Producers Count By Status 'Vendors Count By Status
Queus Description Count. Status Count Status Count
No data to display. ACTIVE a2 ACTIVE 35

Number of Accounts Producers Expiring in Next One Month 'Vendors Expiring in Next One Month
Quaue Description Count Producer End Date Company Name End Date
No data to display. No data to display. No data to display.

My Pending Review Requests By Accounts
Acc # Priority
No data to display.

> Origination My Pending Review Requests By Priority
> Servicing Priority Count

> Caollections o -

> WEP

> Tools

> Setup

3-1 ORACLE



3.3

3.3.1

3.3.1.1

Features

Following are the features of Dashboard:

e The system organizes Dashboards to provide comprehensive and consolidate snapshot
in tiny windows, to access information easily. Thus, helping to; analyze, monitor and
make better decisions which in turn help save time and cost.

e The screen is designed to display six Dashboards, distributed in two rows with three
Dashboards per row, without scroll bars.

e The height and width of all Dashboards are fixed; however, you can expand or collapse
the Dashboards. Click the arrow heads at the top left corner of the Dashboard windows
to expand or collapse the dashboard windows.

e Each section in Dashboard is hyperlinked to home screen of the respective section. The
main screen will present descriptive information of details shown in Dashboard only.

User Productivity

Oracle Financial Services Lending and Leasing User Productivity Setup screen is a
supervisor feature that allows you to monitor the daily performances of users completing
Lease origination and servicing tasks.

These tasks are categorized as customer service/collection tasks. The system updates these
details on daily basis.
Using the User Productivity Setup screen, you can review the following daily tallies:

e Number of accounts worked and call activities, by user
e Number of accounts worked and call activities, by queue

This chapter explains how to use the User Productivity Setup screen to view this information.

Navigating to User Productivity Screen
1. On the Oracle Financial Services Lending and Leasing home screen, click
Dashboard— Dashboard— User Productivity.

2. The system displays the User Productivity screen. You can view the tasks related to:
e Underwriting/Funding
e Customer Service/Collection

Viewing the Customer Service/Collection tasks

Daily tallies from the Customer Service module appear on screens opened from the following
tabs on User Productivity Screen:

e Collector Activity
e Queues Status

Collector Activity

The Collector Activity screen displays the number of accounts worked and call activities by
collector for the day. It also displays details regarding calls and total number of calls per
queue.

To use the Collector Activity

1. Click Dashboard— Dashboard—> User Productivity— Collector Activity. The details
on this screen are grouped into two:
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e Users

e Activity Details

2. In the Users section, you can view the following information.

ORACLE

Financial Services Lending and Leasing

& Welcome, PRAKRRAQ ~  Accessibility o

DashBoard

Process Files

> Origination
> Servicing
> Collections
> WEP

> Tools

> Setup

User
No data to display.

Users Productivity x

DashBoard Application Entry || Underwriting | Funding || Grigination Queuss | Collector Activity: | Service/Collection Quess
DashBoard
Users Productivity
System Monitor Users
Producer Analysis View Formaty [ freeze EfiDetach | ol Wiap 3]

Activity Details
View~ Formatv (B Freeze [} Detach ] Wrap 5]
Queue Name Left Messoges  Promise To Pay
No data to display.

Neme

Mo Answer

5 Cose
Accounts Call Activities
Other Total

A brief description of the fields is given below:

Field: View this:

User Displays the user code.

Name Displays the user name.

Accounts Displays the number of accounts worked.
Call Activities Displays the number of call activities.

3. In the Activity Details section, you can view information for the selected user. A brief
description of the fields is given below:

Field:

View this:

Queue Name

Displays the queue name.

Left Messages

Displays the left message activity count.

Promise To Pay

Displays the promise to pay activity count.

No Answer Displays the no answer activity count.
Other Displays the other activity count.
Total Displays the total activity count.
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3.3.1.2

Service/Collection Queues

The Service/Collection Queues Status tab displays daily information regarding queues, such
as the number of accounts worked, number of call activities, number of accounts pending, and
totals number of accounts in the queue. It also displays information about the users who
worked on these queues and details of the call activities.

To use the Queues Status tab

1. Click Dashboard— Dashboard—> User Productivity— Service/Collection Queues
tab. The details are grouped into two:

e Service/Collection Queues
e Activity details

2. In the Service/Collection Queues section, you can view the following information.

ORACLE’ & Welcome, PRAKRRAO ~
Financial Services Lending and Leasing

i Close
T Users Productivity x o
DashBoard Apglication Entry | Underwriting | Funding | Origination Queues || Collector Activity | Service/Collection Queues
DashBoard B
Users Productivity ) }
System Monitor Service/Collection Queues
Producer Analysis View v Formatw B Freeze i} Detach Wrap (5]
Process Files Company Branch Queue Name Accounts Activities Pending Total
No data to display.
Activity Details
View v Formatw  Ep Freeze ot Detach ol wrap 5]

User Name Left Messages  Promisa To Pay. No Answer Other Total
No data to display.

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

A brief description of the fields is given below:

Field: View this:

Company Displays the company name.

Branch Displays the branch.

Queue Name Displays the queue name.

Accounts Displays the number of accounts worked.
Activities Displays the number of call activities.
Pending Displays the number of accounts pending.
Total Displays the number of total accounts.
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In the Activity Details block, you can view information for the selected queue. A brief
description of the fields is given below:

Field: View this:

User Displays the user code.

Name Displays the user name.

Left Messages Displays the left message activity count.
Promise To Pay Displays the promise to pay activity count.
No Answer Displays the no answer activity count.
Other Displays the other activity count.

Total Displays the total activity count.

System Monitor

The System Monitor screen is the one stop place to check all the activities in and around the
system. It maintains the progress of;

e Batch Jobs

e Jobs

e Services

e Database Server Log Files
e Parked Transactions

e Users

Navigating to System Monitor

On the Oracle Financial Services Lending and Leasing home screen, click Dashboard—
Dashboard— System Monitor.

Monitoring Batch Jobs

The system tracks the success of each batch process on the Batch Job. If either a set of batch
jobs or specific batch job should fail, you can resubmit it on this screen and review the results
in Request Details section.

The Monitor Batch Jobs screen is only a display screen that contains the following sections:

e Batch Job Sets

e Batch Jobs

e Batch Jobs Threads
e Request Details

e Request Results

To Monitor Batch Job
1. Click Dashboard— Dashboard— System Monitor— Batch Jobs.
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2. Inthe Batch Job Sets section, you can view the following information

ORACLE" ) . # Welcome, PRAKRRAO +  Accessibilty (=]
Financial Services Lending and Leasing

: Close
DashBoard System Monitor =i

Batch Jobs | Jobs | Services | Database Server Log Files | Parked Transactions | Users

Users Productivity

System Monitor Batch Job Sets
Producer Analysis Vieww Formatw [} Fresze i Detach Wrap T BB Re-submit Job Set
Process Files Set Code Job Set Description  Status Frequency Frequency Value  Start Time Encbled Critical Last Run Dt Next Run DI
SET-AAD ACCOUNT CREATL.. READY DAILY DAILY 10:00 AM N N 08/08/2003 08/09/2003 A
SET-ACR ACCRUALS AND D... READY DAILY DAILY 10:30 PM N ¥ 08/07/2003 08/08/2003
< >
Batch Jobs
Vieww Format~ [ Freeze {7} Detach &l wrap @) BB Re-submit Job
Seq Job Type Job Code Status Job Description Threads Commit Count Errors Allowed Weskend Holiday
1 PROCEDURE AAIPRC_B1_100_01  COMPLETED APPLICATION TO. i ¥
2 PROCEDURE TXNACT_E]_100_01 COMPLETED ACCOUNT ACTIVA 1 100 50Y Y
< >
Batch Job Threads
§| vew- Fomatr [ Fresze  EfiDetach | < Wrep @
Thread Status Errors Records Trace Level Enzbled
1IDiE 0 ] ok
Request Details
View ~ Format+ [ Fresze ) Detach Wrap (5]
Request Type Stotus Start Dt End Dt Run Start Dt Run End Dt Process Dt
No data to display.
>
Request Results
Vieww Fomate [ Frezze ! Detach Wrap i)
Requast Result Description
> Origination No datz to display.
> Servicing
> Collections
> WEP
> Tools
> Setup

A brief description of the fields is given below:

Field: View this:

Set Code Displays the code for batch job set.

Job Set Description | Displays the description for batch job set.

Status Displays the job set status.
Frequency Code Displays the frequency at which the job set is to be executed.
Frequency Value Displays the value of frequency code chosen for the job set.

Start Time Displays the start time for the job set.

Enabled Displays if the job set is enabled or not.

Critical Displays if this job set is critical or not.

Last Run Dt Displays the date of last run of the job set.

Next Run Dt Displays the next run date for job set.
Parent Displays the preceding job set.
Dependency Displays the type of dependency on predecessor.

To resubmit a batch job set
Whenever a batch job set fails, it is best to resubmit it after correcting the errors that caused

the failure. Resubmitting a set causes system to re-perform the batch job set and dependent
batch jobs.
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e Inthe Batch Job Sets section, choose the batch job set to resubmit (only a batch job
set with a status of FAILED can be resubmitted), then click Resubmit Job Set button.

The Batch Jobs section lists the batch jobs within a job set. The status, threads, commit
count, dependencies, enabled indicator and the holiday and weekend runtime indicators are
shown for each job.

A brief description of the fields is given below:

Field: View this:

Seq Displays the batch job sequence number.

Job Type Displays the batch job request type.

Job Code Displays the batch job request code.

Status Displays the job status.

Job Description Displays the batch job description.

Threads Displays the number of threads used by the job.

Commit Count Displays the number of rows after which auto-commit is
triggered.

Errors Allowed Displays the number of errors allowed.

Weekend Displays if the batch job will execute job on weekend or
not.

Holiday Displays if the batch job will execute job on a holiday or
not.

Enabled Displays if the job is enabled or not.

Parent Displays the preceding job.

Dependency Displays the type of dependency on predecessor.

Command Displays the command line for the job.

Rollback Segment Displays the rollback segment for job.

To resubmit a batch job
Whenever a batch job fails, it is best to resubmit it after correcting the errors that caused
failure. Resubmitting a set will cause system to re-perform the batch job.

e Inthe Batch Jobs section, choose the batch job to resubmit (only a batch job with a
status of FAILED can be resubmitted), then choose Resubmit Job Set.

e The Batch Job Threads section displays the status of individual threads.

A brief description of the fields is given below:

Field: View this:
Thread Displays the name of thread.
Status Displays the status of thread.
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Field: View this:

Errors Displays the number of errors in the thread.

Records Displays the number of records in the thread.

Trace Level Displays the SQL trace level (0, 1, 4, 8, 12).

Enabled Displays if the job thread is enabled or not.

The Request Details section displays the status and runtimes for each time the selected job
ran.

A brief description of the fields is given below:

Field: View this:

Request Type Displays the job request type.

Status Displays the job request status.

Start Dt Displays the job request is valid from this date and time.

End Dt Displays the job request is valid till this date.

Run Start Dt Displays the date and time on when the job run started.

Run End Dt Displays the date and time at which the job run ended.

Process Dt Displays the transaction is posted with this General Ledger effec-
tive date.

Description Displays the job request description.

If a particular job requires that a result message be created, then that message appears in the
Request Results section. A message is usually created in the event of an error.

A brief description of the fields is given below:

Field: View this:

Request Results | Displays the result of job request.

Description Displays the result details.

3.4.2 Monitoring Jobs

The Monitor Jobs screen provides another view of monitoring all system processes, including
credit bureau requests and payment posting. This screen displays the data in reverse
chronological order of the Run Start Date/Time, whereas the Monitor Batch Jobs screen
provides the historical data about each job and job set.

To Monitor Job Details

1. Click Dashboard— Dashboard— System Monitor— Jobs.

2. On the Job screen, select the type of jobs you want to view in the Job Details section.
You can select any of the following jobs:

e Batch
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e Back Ground
e Credit Request
ORACLE’

Financial Services Lending and Leasing

& Welcome, PRAKRRAO »  Accessibility (e

DashBoard

DashBoard
Dash8oard

Batch Jobs

¢

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

System Moni

Batch | Back Ground

Job Details

No data t

View » Fomat~ [P Freeze o Detach 9 View Last @ 1 payO 2 DaysO) 5 Days O All Days View () Failed @) Al
2/1/2016 £
Request Type Status Job Set Job Description Thread Errors Records g‘;:;ﬁ;e Run End D:
o display.
>
Job Detail Description
Job Results
View e Fomatv 5 Fresze i Detach @

jest Result
o display.

i Requ
No data t

itor

Jobs  Serices  Database Server Log Files  Parked Transactions

Credit Request

Description

A brief description of the different jobs available is given below:

Select:

System Displays:

Batch

Batch jobs (used primarily for the nightly processes).

Back Ground

User submitted requests, such as reports and payment posting.

Credit Request

Credit bureau requests.

3.

In the Job Details section, select the time frame of the contents of Job Details section.

You can select any of the following options:

Select:

System Displays:

1 Day

All the types of jobs selected in Jobs Type section in last one-day.

2 Days

All the types of jobs selected in Jobs Type section in last two days.

5 Days

All the types of jobs selected in Jobs Type section in last five days.

All Days

All the types of jobs selected in Jobs Type section.

4.

If you select Failed option in the View section, the system displays failed jobs on the type

and time frame you have selected.

In the Job Details section, you can view the following information about jobs matching

the contents of Job Type, View Last and Failed boxes:
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A brief description of the fields is given below:

Field: View this:

Request Type Displays the job request type.

Status Displays the job request status.

Job Set Displays the job set code.

Job Displays the job description.

Thread Displays the job thread.

Errors Displays the number of errors.

Records Displays the number of records processed by the job.

Run Start Date/Time

Displays the job run start date time.

Run End Date/Time

Displays the job run end date time.

Description

Displays the job request description.

Process Dt

Displays the job process date.

Valid Execution Period

Start Date/Time

Displays the job start date/time.

End Date/Time

Displays the job end date time.

6. Inthe Job Results section, you can view the following information about the Job selected

in Job Details section:

A brief description of the fields is given below:

Field: View this:
Request Type Displays the job request type.
Description Displays the job request description.

Monitoring Services

The Services screen allows you to track and maintain the system’s processing services,
including credit bureaus, fax-in and batch job scheduler. The system administrator can start
or stop the service on this screen using the action buttons respectively.

To stop, start or refresh a processing service
1. Click Dashboard— Dashboard— System Monitor— Services.
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2. Inthe Services section, you can view the following information about the system’s

processing services:

ORACLE’
Financial Services Lending and Leasing

% Welcome, PRAKRRAO v Accessibility o

DashBoard System Monitor

DashBgard

> Origination
> Servicing
> Collections
> WEP

> Tools

> Setup

Baich Jobs | Jobs || Services| Database Server Log Files | Parked Transactions | Users
Database Server Log Files
View v Formatv [ Fresze i Detach W iSustFles [} Download File
File Name File Type
No data to display.

File Size File Time

File Content
View v Format v Freeze i Detach Nrap @ O Beginning® End # of Lines 50

No data to display.

A brief description of the fields is given below:

Field: View this:

Service Display the service name.
Company Display the service company.
Branch Display the service branch.
Description Display the service description.
Status Display the service status.

3. Inthe Action section, select the processing service you want to work with and choose
one of the following commands in Action section.

Choose: System:

Status Refreshes (updates) the status of service. The Service screen does
not update the status in real time. You must choose Status after
choosing Start or Stop to perform that command.

Start Starts the job service.

Stop Stops the job service.

Data Server Log Files

Various processes in the system create reports in different log files with regards to what tasks
they performed and what they encountered (for example, errors, failures, erroneous data and
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so on). The Database Server link lists and describes all such log files within the system on the
database server.

To view a log file on the database server
1. Click Dashboard— Dashboard— System Monitor— Database Server Log Files.

2. Inthe Database Server Log Files section, click List Files.

ORACLE
Financial Services Lending and Leasing

% Welcome, PRAKRRAQ ~  Accessibility [e]

: Close.
DashBoard System Monitor x -

Bachjobs Jobs  Services  Database Server Log Files | Parked Transactions  Users

Database Server Log Files
Vieww Fomate [ Fraeze  Hfi Detach Wrap W) Sustrles [ pownload File

File Name File Type File Size File Time
No data to display.

File Content
View v Format = Freeze 5! Detach Wrap @ O Beginning® End # of Lines |50

Text
No data to display.

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

3. Then in the Database Server Log Files section, you can view the following information.
A brief description of the fields is given below

Field View this:

File Name Displays the name of file.

File Type Displays the type of file.

File Size Displays the size of file.

File Time Displays the time stamp of file.

4. In the File Content section you can view the content of the file selected in the Database
Server Log Files.

5. Click Show File. A File Download - Security Warning dialog box is displayed with the
confirmation message “Do you want to save this file?”

6. Click Save.

7. In Save As dialog box, select the location you want to save the file, and click Save.

Monitoring Users

The Users Logins section allows you to view all users who have logged on to the system,
along with the log on time stamp and logout time stamp. The information appears in reverse
chronological order of the log on time stamp.
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To monitor users who have logged on to the system
1. Click Dashboard— Dashboard— System Monitor— Users.

2. Inthe User Logins section, you can view the following information

Financial Services Lending and Leasing
i Close.
e System Monitor s B3]
DashBoard Batch Jobs || Jobs | Services || Database Server Log Files || Parked Transactions || Users
DashBoard
Users Productivity B
System Manitor User Logins
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Time Time
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SARAMAN SARAVANAN RAMAN
NARESH NARESH CHAMARTHI
VINOARUM VINOTH ARUMUGASAMY 03/09/2016
VINOARUM VINOTH ARUMUGASAMY 02/09/2016 10: 02/09/2016 10:52.
VAVAIDYA VARSHA VAIDYA 02/09/2016 10:47... 02/09/2016 10:52
VINOARUM VINOTH ARUMUGASAMY 02/09/2016 10:46.. 02/09/2016 10:52.
NVINNAKO NAGAVENKATA VINNAKOTI f:
VINOARUM
PRAKRRAO
VINOARUM VINOTH ARUMUGASAMY
PRAKRRAO PRAKRUTI RAO
PRAKRRAQ PRAKRUTI RAO
NARESH NARESH CHAMARTHI
« VINOARUM VINOTH ARUMUGASAMY
HMACHA HARISH MACHA
VIBHATIA VINAY BHATIA 02/09/2016 01:04
MADHUKARAN MADHUKARAN R 02/09/2016 09:18... 02/ v
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> Servicing
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> WFP
> Tools
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A brief description of the fields is given below:

Field: View this:

User Displays the user ID.

User Name Displays the user name.

Details Displays the details.

Login Date and Time | Displays the login date time for the user.

Logout Date and Time | Displays the logout date time for the user.

3.5 Producer Analysis

The Producer analysis screen enables you to view and know the status of all applications
sourced by different Producers.
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Navigating to Producer Analysis
Click Dashboard— Dashboard— Producer Analysis.

ORACLE" 2 Welcome, PRAKRRAO »  Ac

Financial Services Lending and Leasing

Producer Analysis 5

oard

Select Criteria
Users Productivity
System Monitor Company ALL [] Territory =2 Funder ALL ]
Producer Analysis Branch ALL[¥] Salles Agent ALL [v] Status >
Process Files

Region AL [v] Undenwriter ALL [v] zp -
Producers | Terrtories Activity | Volume || Mix
> Dealer

Recent Activity
No data to display. e Roiad Approved Funded
No data to display.

Recently Approved Applications
Applicant Name  Application # Amt. Collateral Desc
No data to display.

Recently Funded Applications
Applicant Name Application # Amt Collateral Desc
No data to display.
4

Recent Comments
& Detach
Date Comment Desc
o data to display.

> Origination
> Servicing
> Collections
> WEP

> Tools

> Setup

B submit

Comments

You can filter producer details based on any or all of the following criteria:

e Company

e Branch
e Region
e Territory

e Sales Agent
e Underwriter
e Funder

You can select the values from the adjoining drop-down list. Click ‘Submit’ button. System

displays the Producer details satisfying the criteria, you selected.

The following details are displayed under Producer Details section:

e Producer #
e Name

e Company
e Branch

e Type

Select the producer you need to view the statistics. The system displays the statistics under

‘Summary’ sub tab and the status and sub status of various applications under ‘Applications’

sub tab, of the selected producer.

The system displays the following details under ‘Summary’ sub tab:

e Year
e Total Apps
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e Approved
e Conditioned

e Rejected

e Withdrawn
° Funded

e Amount

The system displays the following details under ‘Applications’ sub tab:

e Company

e Branch
e App#

° Date

° Title

e Product
e Status

e Sub Status

Process Files

The Process files interface allows you to view the incoming and outgoing files exchanged with
other systems for processing and also perform a bulk upload of required files.

The Process files interface also provide information on the type of files uploaded with other
attributes. In-order to facilitate the process files handling, the following parameters has to be
enabled in Setup—> Administration— System— System Parameters screen.

For more information on enabling system parameters, refer to ‘System Parameters’ section
in Setup Guides.

e CMN_FILE_PROCESS_TO_LOB

On enabling the above parameter, system stores the incoming / outgoing documents in
the relevant tables and not in the file system.

o UIX_INCOMING_FILE_PATH

On enabling the above parameter, the incoming file path of application server is defined
to the following default path ‘/scratch/work_area/DEV/OFSLLQA/input’.

o UIX_OUTGOING_FILE_PATH

On enabling the above parameter, the outgoing file path of application server is defined
to the following default path ‘/scratch/work_area/DEV/OFSLLQA/output’.

Incoming Process File

The incoming process file screen displays the list of files being shared from an external
system along with other attributes such as directory path, file name, type, size, date and
status. You can select the file required and upload it into the system for immediate processing.
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View the list Incoming Process File

1. Click Dashboard—> Process Files—Incoming Process File.

2. Inthe Incoming Process File section, click List Files. System displays the list of incoming

files.

A brief description of the fields is given below:

Field:

Description:

Select All

Select this option to select all the listed files.

Directory Name

View the directory path where incoming file is
stored.

File Name

View the name of the file.

File Type

Select the type of file with the option available
in the drop-down list.

File Size(bytes)

View the size of incoming file.

File Date View the date and time when the incoming file
was placed in the directory.
Status View the status of the file.

Upload Incoming Process File

1. Click Dashboard— Process Files—Incoming Process File.

2. Inthe Incoming Process File section, click List Files. System displays the list of incoming
files. You can click L2l to refresh the grid data.

3. Select the check box adjacent to the required file and click Upload. You can also click
Select All check box to perform a bulk upload of all the listed files.

The uploaded files are listed in below ‘Uploaded Files’ section and the status of the files
are changed from ‘Generated’ to ‘Uploaded’. In case of a processing error, the status of
the file is indicated as ‘Processed Error’.

3-16

ORACLE



3.6.1.1

3.6.2

Uploaded Files

The uploaded files section displays the list of incoming files uploaded into the system. You
can sort and view the list of files depending on the number of days based on Last 1 Day / 2
Days / 5 Days / All Days. You can click 2 to refresh the grid data.

On selection, you can view the following information:

Field: Description:

File Name View the name of file uploaded.

File Type View the type of file uploaded.

File Dt View the date when the file was uploaded.
Status View the status of upload.

In the Uploaded Files section, you can do the following:

e Click Download Bad Data to download the list of uploaded files which had processing
errors due to bad data.

e Click Download Log Data to download a log of all the files uploaded.

Outgoing Process File

The outgoing process file section displays the list of files being shared for upload to other
system for processing and allows you to download the required file for inspection.

ORACLE % Welcome, PRAKRRAO v  Accessiilty o
Financial Services Lending and Leasing

DashBoard ProcEes e x [ close

Incoming Process Fle  Outgoing Process File

Outgoing Process File

Download to << OUTGOING PROCESS FILE PATH >>

View v Formatw g Freeze & Detach Wrap @) Viewlest @ 1Day () 2Days () 5Days ) All Days

selectAl [ File Name File Date File Size(bytes) Status
Mo data to display.

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

You can sort and view the list of files depending on the number of days based on Last 1 Day
/ 2 Days / 5 Days / All Days.

On selection, you can view the following information:

Field: Description:

Select All Select this option to select all the listed files.

317 ORACLE



Field: Description:
File Name View the name of upload file.
File Date View the date when the file was shared for

upload.

File Size(bytes)

View the size of upload file.

Status

View the status of upload file.

Download Outgoing Process File

1. Click Dashboard—> Process Files— Outgoing Process File.
System displays the list of files shared for upload. You can click Ll to refresh the grid

data.

2. Select the check box adjacent to the required file and click Download. You can also click
Select All check box to download all the listed files.
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4. Customer Service

Introduction

After an application has cycled through the Lease origination process, it becomes an account.
Account maintenance and collections tasks can be performed with Oracle Financial Services
Lending and Leasing’s Customer Service screen.

The Customer Service screen enables you to view and manage all customer information in a
centralized location to ensure data integrity and provide better service. Oracle Financial
Services Lending and Leasing provides online real-time information about the applicant(s),
contract, account balances, dues, transactions, call activities, and comments. Oracle
Financial Services Lending and Leasing also supports back-dating of financial transactions till
the account’s opening date.

Activating an Account

An account is automatically activated when you fund the contract using Funding main tab or
convert from a legacy system. You cannot activate an account using the Customer Service
screen.

Posting and Reversing Payments

A payment can be posted and reversed on the Payments screen. You cannot post and
reverse the payment in Customer Service screen. (For more information, see the Payment
Processing chapter.)

Account Mask

After an application completes the Lease origination cycle and is funded or is ported into the
system, it becomes an account and receives an account number. The system assigns
account numbers using the following logic:

YYYYMMNNNNNNNX

where:

YYYYMM = contract date

NNNNNNN = serial number

X = check digit

The system sorts accounts using the NNNNNN portion only. That portion is referred to as the
account ID.

Quick Search section

Conditions and Queues

During the Lease application process, Accounts do not have sub statuses; instead, accounts
use conditions. Conditions further define the status of an account; for example: delinquent,
bankruptcy, scheduled for charge off, Do Not Charge Off. Conditions can be applied
automatically by the system based on set up, and manually by the system users using
Customer Service screen.
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The system can assign accounts to specific users by way of queues. Queues are a work flow
management tool that allow the users to work on accounts sequentially from a prioritized list,
rather than having to manually search for and load them. Queues are created and sorted
during nightly processing. Examples of customer service queues include due date change
requests, delinquent accounts, deferment requests, and title and insurance follow-up.

Account conditions serve as default queues; that is, an account’s condition determines which
queue the account is in.

In the following example, account has a condition of DELINQUENT, noted in the Conditions
section and Status field. The account was loaded from delinquent queue, DELQ (D).

A queue can be associated with only one condition. In the following example, the Delinquent
queue is associated with the Delinquent condition. However, an account can have more than
one condition, so an account can be in more than one queue. Multiple queues can be created
for a single condition. Account attributes (such as number of days delinquent and product
code) can be used for assigning accounts to a queue and sorting accounts within a queue.

You can quickly load an account from a queue using Next Account button in the Quick
Search section.

Customer Service screen

Most of the screens on Customer Service screen contain Account(s) and Customer(s)
sections as a header. The Account(s) section provides a quick overview of an account by
displaying its company, branch, account number, product, payoff amount and amount due,
status, and oldest due date. The information on Customer Service screen always refers to the
account selected in this section.

The Customer(s) section displays information about customer(s) attached to the account. The
information on Customer Service screen always refers to the customer selected in this
section.

To view account details in Account(s) and Customer(s) sections, open Customer Service
screen and load the account you want to work with.

On Customer Service screen’s Account(s) section, view the following information: The
system filters and displays information based on your selection:

Command

Button: Action Performed:

Current Displays the current search account only. It does not matter how that
account was searched like using account search screen or selected
a queue from drop-down and pressed ‘Next’ button or account num-
ber was directly pasted in Acc# text box and pressed Submit but-
ton.This is the default option.

Show All Displays the related accounts based on current selected customer’s
customer Id. To view the details of account number(s) other than
current account, select the account in Account(s) section and click
Submit.
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Command Action Performed:

Button:
Group Follow- Displays the set of accounts that share same account condition as
up the selected account and bear same Customer Id. Other than hav-

ing same account condition and Customer Id, the queue currently
selected should have the Group Follow-up Indicator enabled in
queue setup and follow-up date should fall in range of organization
level system parameter UCS_GROUP_FOLLOWUP_DAYS.

In Account(s) section, click View to view the following information:

In this field: View this:

Company The company of the account.

Branch The branch of the account.

Account # The account number.

Product The product for the account.

Currency The currency for the account.

Pay Off Amt The current payoff amount for the account.
Amount Due The current delinquent amount due for the account.
Status The account’s status.

Oldest Due Dt The oldest due date.

The system allows quick search of an account through Quick Search section in the right hand
side of screen irrespective of the customer service screen on which you are working on. This
is available in addition to the Quick Search section available in Results tab.

For more details on Quick Search refer ‘Search Functions’ chapter.

Comments can be added using Add Comment section in the right hand side of screen
irrespective of screen you are working on. This is available in addition to the Comments sub
tab available under Customer Service tab. This facilitates quick and easy reference.

For details on Comments refer Comments sub tab section in this chapter.

Call Activity functionality can be performed using Add Call Activity section in the right hand
side of screen irrespective of the screen you are working on. This is available in addition to

the Call Activities sub tab available under Customer Service tab. This facilitates quick and
easy reference.
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For details on Call Activity refer Call Activities sub tab section in this chapter.
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4.3

Customer Service screen’s Summary tab

Open Customer Service screen and load the account you want to work with. By default the
Customer Service screen opens the Summary tab.
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Alerts section

Any comment posted as an alert, are displayed in the alert section of Summary tab.

Conditions section

You can view any conditions like Bankruptcy, Repossession, Foreclosure etc posted on an
account. The condition is posted in the account with a start date which is the effective date
and follow up date which indicates the next follow-up date for further process.

Dues section

Unpaid dues and the dates are displayed in a tabular form. Details of payment amount due,
fee due, payoff are also displayed.

In this field: View this:

Delq Due The total delinquent amount that is due so far in the account.

LC Due The total amount of non-sufficient fee due in the account.

NSF Due The non sufficient funds fee due.

Other Due The total of any other dues pending in the account.

Total Due The total of all dues including payment amount and all applicable
fees.

Today’s Pay- If the account is to be paid off as per the current date and the

off amount payable by the borrower.

Future payoff | The total Amount due on a future date. The borrower can know the
total pay off amount for a future date, say 10 days from today.

Future Payoff | The date on which the future payoff is due.
Date

Future Pmt Dt | The date till which the future payoff quote is valid.

Oldest Due Dt | The due date.

Amt Paid The excess amount paid.
Excess

Delinquency Information Section

View the following information in the Delinquency Information section:

In this field: | View this:

Late Total number of times the account was delinquent for less than 30 days
since start date.

30 Total number of times the account was delinquent for over 30 days
since start date.

60 Total number of times the account was delinquent for over 60 days
since start date.
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In this field: | View this:

20 Total number of times the account was delinquent for over 90 days
since start date.

120 Total number of times the account was delinquent for over 120 days
since start date.

150 Total number of times the account was delinquent for over 150 days
since start date.

180 Total number of times the account was delinquent for over 180 days
since start date.

Category The delinquency category.

Days The number of days delinquent. A negative number in this fields
denotes the number of days until a payment is due.

BP (Life) Total number of broken promises since the account start date.

BP (Year) Total number of broken promises since this year.

NSF (Life) Total number of non sufficient funds since the account start date.

NSF (Year) Total number of non sufficient funds since this year.

Collector The default collector working on the account.

Activities Section

View the following information in the Activities section:

In this field: View this:

Active Dt The date account was made active.

Last Activity Dt | The date on which most recent activity was performed in the

account.

Due Day The due day for payment.

Last Pmt Amt The last payment amount.

Customer The customer grade.

Grade

App# The application number from which this account was created.
Paid Off Dt The date on which account was paid off.

Note: Filed has value only if account has Paid-off condition.

Effective Dt The date account became effective.

Current Pmt The current payment amount.

Last Bill Amt The last bill amount.

Last Pmt Amt The last payment amount.
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In this field: View this:

Chargeoff Dt The Date on which account was charged off.
Note: This is applicable only if account has Charged-off condition.
Else, no value displayed.

Military Duty If selected, indicates that at the time of billing, the customer was in

active military duty and qualifies for rates in accordance with Ser-
vice members Civil Relief Act (SCRA) of 2003.

Customer Score

The customer score.

Behaviour The behavior score.
Score
Producer The producer through which the account was sourced.

Due Date Change section

The Due Date Change section displays the remaining number of transactions available for the
account in the Summary tab. You can view the following information under Due Date Change

section.
In this Field: Do This:
Last Txn Dt The last date on which the due date was changed.

Rem. Txn. Limit
(Life)

Remaining number of due date changes allowed till account clo-
sure.

Rem. Txn. Limit
(Year)

Remaining number of due date changes in the account for current
calendar year.

Extensions section

The Extensions section displays the remaining number of transactions available for the

account in the Summary tab. You can view following extension details as per the conditions

maintained in the contract.

In this Field:

Do This:

Rem. Txn. Limit
(Year)

Remaining number of extensions in the account for current calen-
dar year.

Rem. Txn. Limit
(Life)

Remaining number of extensions in the account till closure.

Last Txn Dt

The date when last extension was made.

Exten. Gap
Rem. (Months)

The number of months remaining before you can post Extensions
for an account.

Collateral Information section

You can view the Collateral Information in this section:

In this field:

View this:

ORACLE



Description A brief description on the collateral.

This is a hyper-link which when clicked opens Collateral Management
screen with relevant collateral details.

Identification # The identification number of the collateral.

This is a hyper-link which when clicked takes you to the collateral man-
agement screen with the relevant asset details.

Year The year of manufacture of the collateral.
Asset Class The asset class of the collateral.

Asset Type The type of collateral.

Sub Type The sub type of the collateral.

Customer Information section

On Customer Service screen’s Customer Information section, select the record you want to
work with and view the following information:

In this field: | View this:

Customer # | Customer identification number (unique customer identifier).

Name Customer’s full name.
Relation Customer’s relationship to the account.
SSN Customer’s social security number.

If the organizational parameter UIX HIDE RESTRICTED DATA is set to
Y, this appears as a masked number; for example, XXX-XX-1234.

Birth Dt Customer’s date of birth.

Gender Customer’s gender.
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Customer Details section

In this field: | View this:

Email Customer’s e-mail address.

Language Language spoken by the customer.

Marital Sta- | Customer’s marital status.

tus

Disability Customer’s disability indicator If selected, this indicates that the cus-
tomer is disabled.

Skip Customer’s skip indicator. If selected, this indicates that the customer is
a skip debtor. This is selected using the Maintenance screen.

Stop Corre- | Stop correspondence indicator. If selected, Oracle Financial Services

spondence Lending and Leasing will not send correspondence to customer. This is
selected using the Maintenance screen.

Privacy Opt- | Privacy opt-out indicator. If selected, indicates that customer does not

Out want the FI to share his /her information with any other body, other than
regulatory requirements. (optional).

Active Mili- Customer’s Active Military Duty indicator. If selected, this indicates that

tary Duty the customer is serving Military Duty. This is selected using the Mainte-
nance screen.

Time Zone Customer’s time zone.

Address Information section

In this field: | View this:

Type Address type.

Current If selected, indicates that this is the current address.
Permission | If selected, indicates that you can contact the customer.
to Call

Mailing If selected, indicates that this is the mailing address.
Address Address details.

Phone Phone number.

Employment Information section

In this field: | View this:

Type Address type.

Current If selected, indicates that this is the current address.
Permission If selected, indicates that you can contact the customer.
to Call
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Employer Employer Details

Address Address details.

Phone Phone number.

Telecom Information Section

In this field: | View this:

Type The type of phone contact such as Home / Office / Car / Mobile phone.

Permission Permission as either Yes Y’ or No ‘N’ to contact the customer over
to Call phone.

Phone The customer’s phone number.

Extn The customer’s phone extension.

Time Zone The customer’s time zone.

Best Time Preferred time to contact the customer, if specified.
To Call

Customer Service screen’s Customer Service tab

Open the Customer Service screen and load the account you want to work with. Click the
Customer Service tab to view the sections under it.

Call Activities sub tab

Call activity section includes calls from customer, calls you make regarding the account or
changes to the condition of the account. Entries in the Call Activities section are listed in
reverse chronological order of follow-up date.

Each action and result has a code and description. The code for the call action and call result
is what appears on the Call Activity sub screen. The Call activity action codes (Action field)
and call activity results codes (Results field) are user-defined.

The Call Activities sub tab displays all the call activities defined by users in both “Customer
Service > Call Activities tab” and in “Right Hand Splitter > Add Call Activity section”,

Recording a Call Activity

To record a call activity
1. Open the Customer Service screen and load the account you want to work with.
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2. Click Customer Service sub tab and then click Call Activities tab under it. Click Add.
The system displays the following screen.

ORACLE"
Financial Services Lending and Leasing

ccccccccc

......

3. You can complete the following optional fields:

4. Perform any of the Basic Operations mentioned in Navigation chapter.

In this field: Do this:

Action Select the action performed.

Result Select the result of the action

Contact Select who you contacted.

Reason Select the reason for the communication.
Promise Date Select the promise date.

Promise Amt Specify the promise amount.

Condition Select the condition or queue type.

LOV that is used in the Condition field is the intersection of list of
condition set ups for what is entered into Action and Result fields
and open conditions on the account.

Appointment Check this box to take an appointment.

If Appointment is checked, then system allows you to select date
and appointment time as per customer request. If appointment flag
is not checked, then you can only enter the date with date picker.

Followup Dt Specify the next follow-up date.
The date when FLS will place the account in queue next time.

(The system defaults this date automatically based on setup.)

Time Zone Select the time zone for the customer.

Group Followup | Check this box to enable group followup.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Click to Save and Add to add a new record. Click to Save and Return to return to the
main screen.

The system creates two entries on Customer Service screen for the call activity.
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The codes for Action and Result appear as a record on the Account Detail screen, under Call
Activities tab. The description for Action and Result appear as a system generated comment
on the Account Detail screen, under Comments tab.

Making an Appointment

The Appointment box on Call Activities section enables you to schedule an account to
appear in a particular queue at a future date and time. When you make an appointment,
account will appear in the front of queue listed in the Conditions field at the time listed in the
Follow Up Dt field.

In order to view the account, you must be working in that queue at follow up time. Refer the
‘Recording a Call Activity section’.

To make an appointment
1. Open Customer Service screen and load the account you want to work with.
2. Click Customer Service sub tab and then click Call Activities tab under it.

3. Click Add and specify the field details on Call Activities section (Refer, Recording a call
activity section).

4. In Condition field, select the condition for queue you want the account to appear in.

In Follow Up Dt field, select the date and time you want account to appear using the
calendar. This can be either current day or a day in future.

6. Select the Appn’mt box.
7. Click Save And Add / Save And Return.
If account is not worked within the queue on day of the appointment, nightly jobs will cancel

the appointment. If the account’s queue condition changes during nightly batch jobs, the
outstanding appointments are cancelled.

Cancelling an Appointment

Using the Call Activities screen, you can cancel an appointment for an account. The account
will still appear in the queue on follow up date, but no longer receive a priority.

To cancel an appointment

1. Open Customer Service screen and load the account you want to work with.

2. Click Customer Service sub tab and then click Call Activities tab under it.

Click Add. The system displays Call Activities screen. If you need to change time for the
appointment, create a new entry on account’s Call Activities section with the same condition,
but enter a new follow up date. If you need to cancel the appointment, create a new entry on
account’s Call Activities section with same condition, but don’t check the Appointment
check box.

(To create a new entry, refer Recording a Call Activity section.)

3. Click Save.

Recording a Promise to Pay

If you record an action on Call Activities screen as a ‘promise to pay’, it appears as a record
on the Account Details screen’s Promises section. The Promises section enables you to
quickly view these actions without searching for them individually.

To record a promise to pay
1. Open Customer Service screen and load the account you want to work with.
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2. Click Customer Service sub tab and then click Call Activities tab under it.

Click Add. The system displays the Call Activities screen. In Action field, select the
action which is already performed, such as DC - DEALER CALLED

4. Inthe Result field, select a result involving a promise to pay, such as PP - PROMISE TO
PAY.

5. You can complete the following optional fields:

In this field: | Do this:

Contact Select the contact type. (Who was the person you communicated
with?).
Reason Select the reason, as stated by the contacted person. (What is the

reason for this contact?).

6. Inthe Promise Dt field, record date when the person you spoke with promises to make
payment.

7. Inthe Promise Amt field, record amount of payment the person you spoke with promises
to pay.

8. Inthe Condition field, select the condition or queue type.

9. Inthe Follow up Dt field, enter next follow-up date for the promise-to-pay or accept the
default date.

10. Click Save.

The system automatically notes this information as an entry on the Promises and Com-
ments sub screens.

Note

If payment amount is within the tolerance limit, promise is considered to be kept. If the pay-
ment amount is not within tolerance limit, promise is considered to be broken. During this
validation, only percentage tolerance is considered and not the contract tolerance amount.

4.41.5 Cancelling a Promise to Pay

Oracle Financial Services Lending and Leasing enables you to cancel promises to pay using
the Account Detail’'s screen Call Activities section. You might do this when a customer
informs you prior to the promise date that he or she cannot make the payment.

To cancel the existing promise to pay

1. Open the Customer Service screen and load the account you want to work with.
2. Click Customer Service sub tab and then click Call Activities tab under it.

3. Click Add. The system displays the Call Activities screen.

4. Select the call activity entry for the promise to pay you want to cancel.

Click the Cancel box. The promise is marked as cancelled and will not be considered when
processing promises; in other words, it will not be counted as either satisfied or broken.

4.41.6 Posting Offline Call Activities

The system facilitates posting of offline call activities against an account.
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4.4.2

To Post Offline Call Activities:

1.

The source file is provided in CSV format (pre-determined for fields & size). Each field in
the file is separated by a comma (,) and each line is separated by return (New Line).

A batch job Offline call activity posting, loads the provided flat file in the specified format
and system will process it line by line.

For each line, the system posts Call Action Code and the corresponding Call Result Code,
for a given account number with SYSDATE.

The system will perform respective call activities and sets the follow-up date as SYSDATE
+ Follow up Days (As provided in the feed file)

During offline call activity, you can specify comments, if any, in the comments field. The
system defaults comments received from offline call activity in the comments section sub
tab under Customer Service screen.

Maintenance sub tab

The Customer Service screen’s Maintenance screen acts as a single command stations that
enables you to post a wide array of monetary and non monetary transactions for any given
account. Transaction available is based on the account’s Lease produce and the user’'s
responsibility. This section explains how to complete the following tasks:

Monetary tasks

Lease:

Apply, adjust, or waive servicing expenses
Adjust or waive late charges

Adjust or waive non-sufficient funds

Apply, adjust, or waive repossession expenses
Apply, adjust, or waive bankruptcy expenses
Apply or adjust phone pay fees

Change an index/margin rate

Apply, adjust, or cancel financed insurance
Generate a payoff quote

Payoff an account

Charge-off an account/Do Not Charge-Off an account.
Close an account

Change a due date

Apply, adjust, or waive a disposition fee

Apply, adjust, or waive a termination fee
Record selling an asset

Apply, adjust, or waive an excess usage fee
Apply, adjust, or waive other fees and taxes

Non-Monetary tasks

Lease:

Update a customer’s name
Maintain customer details
Mark a customer as a skipped debtor
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Change a customer’s Privacy Opt-Out indicator

Stop correspondence

Modify financed insurance information

Start or stop an ACH

Reprint a statement (batch only)

Add or stop servicing of accounts with post dated checks as a repayment method
Re-order coupon books

Adjust Dealer Compensation

The system enables you to post a monetary transaction immediately or submit it for nightly
processing. The transaction is identified as either a ‘real-time’ or nightly batch transaction in
Oracle Financial Services Lending and Leasing’s transaction setup codes. The system also
enables you to cancel the future dated transactions or transactions those have been
submitted for nightly processing. All activities in the account, including who performed it, date
and time stamp, are captured in the audit trail.

Creating Monetary and Non monetary Transactions

All monetary and non monetary tasks listed in the appendix Transaction Parameters are
available for use on Maintenance screen. Each task requires a Transaction value and a

Parameter value.

To use the Maintenance screen to complete monetary transaction

1. Open Customer Service screen and load the account you want to work with.

2. Click Customer Service sub tab and then click Maintenance tab under it.

ORACLE . i 2 Welcome, VAVAIDYA v Accessibility o
Financial Services Lending and Leasing
=z Close
S Customer Service . g
* Origination Search  Customer Service: 0150900014283  Review Request (Pending: 0)
Servicing
Senvicing Account(s): 20150900014283: RODRIGUEZ ROBINSON Elﬂe‘g\!ﬂ o audit
Customer Service View v Formatw [ Freeze [ Detach B & © curentO show Al O Group Follow-up
;E:“”‘f”"l horzsto Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt Amount DU
ooy uUsoL USHQ UNDEFINED 2015090014283 LEASE VEHICLE 114 USD 15,158.10 4296

Post Date Checks
Escrow Transactions
Account Documents
Callateral Managzment
Reparts

Producers

Vendors

Batch Transactions

No data to display.

> Collections
> WFP

> Tools

> Setup

Transaction Processing Details

Summary  Customer Service | Account Details | Customer Details

Transaction History

Pmit Modes || Bankruptcy || RepofForeclosure | Deficiency

Call Adtivities || Maintenance | Comments  Promises || Checkists || Tracking Attributes | References | Correspondence | Letters | Document Tracking

Transaction Batch Information o add || 2 Edit ] view || &7 sudi
Advances .
— View v Format~  [E Freeze i) Detach Wrap (5] % Post [} Vo
Fees Date Manetary Transaction Status Batch
Interfaces 02/01/2016 ¥ ¥
AP Transactions
ot 7’5"555“”‘”5 Transaction Batch Information
'CASA Reconciliation
e (B B saveandadd | [ save and Stay || [ Save and Retum || (@ Retum !
Date 02/01/2016 * Transaction ® Status
= Menetary ] ik @
Parameters
View v Fomate [ Freeze B Detach rap 5]
Parameter Value Required
No data fo display.
Result
View -~ Format= [ Freeze G Detach e, ]

Collateral | Bureau | Cross/UpSe > ¥

3. On the Maintenance screen’s Action section, click AddIn the Transaction Batch
Information Section section:

— Select the Monetary box to complete a monetary transaction.

_O r‘_

— Clear the Monetary box to complete a non monetary transaction.
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4.4.31

4. Inthe Transaction field, select transaction for the task you want to complete. Transaction
availability depends on the type of Lease account, whether the transaction is monetary or
non monetary, and user responsibility.

Note that, during set up, all transactions are configured to be processed either in real
time or as a batch transaction. Accordingly, the ‘Batch’ check box is selected only if the
selected transaction is to be performed through batch execution.

5. Click Load Parameters.

6. Specify all the required parameter values and click Post.
The system displays result (success or failure) in the Results section.

You can cancel a transaction by selecting the record and clicking Void. The parameter
‘TPE_TXN_POST_DEFAULT_GLDATE’ is used to default the transaction date to GL date. If
the ‘Default Transaction Date to GL Date’ is Yes, then GL date will be defaulted as transaction
date. If the value is ‘No’, then the transaction date will not be defaulted and you can specify
the transaction date manually.

When transaction date is not equal to or less than the system date, transaction is considered
to be back dated. System Date is ‘OFSLL System Date’ which is the GL Date. When user
posts the back dated transaction, system displays warning message as “Confirm to post the
back dated transaction” with YES/NO. If user selects 'Yes', then transaction proceeds. If user
selects 'No', then the transaction gets cancelled.

System displays back dated posting warning message only if the parameter
‘TPE_SHOW_BACKDATE_WARNING' is set to ‘Y’

When an ‘ON MILITARY DUTY TRANSACTION' is posted in an account:

e The system restricts users from bankruptcy /repossession/foreclosure conditions.

e System posts DO NOT CHARGE OFF condition on that account to exclude the account
from Auto Charge Off process.

e The DO NOT CHARGE OFF condition is removed when 'OFF Military Duty' transaction
is posted.

Comments sub tab

Oracle Financial Services Lending and Leasing enables you to record comments on the
Customer Service screen using Comments tab. These comments also appear under the
Comments sub tab.

All the user added Comments in either Customer Service > Comments tab or in Right Hand
Splitter > Add Comment section, are displayed in the Comments sub tab including system
generated comments.

Recording an Additional Comment

To record an additional comment
1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Service sub tab and then click Comments tab under it.
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3. Click Add. The system displays the Comments screen.
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4. If you want

to tag this comment as important, select the Alert box. If selected, the

comment appears on Customer Service screen’s Alerts section, after clicking Save.

© N o o

screen.

Comments can

In the Type field, select what type of comment you are adding.
In the Sub Type field, select what sub type of comment you are adding.
In the Comment field, specify your comment.

Click Save and Add to add a new record. Click Save and Return to return to the main

be viewed under the Comments tab View the following:

In this field:

View this:

Alert

If selected, Oracle Financial Services Lending and Leasing to recog-
nizes this comment as an alert and displays in Customer Service >
Summary Tab, in Alerts section.

Type

The type of comment.

SubType

The sub type of comment.

Comment

The text message entered in the Add Comments section.

Comment By

The user ID of person who entered comment in the Add Comments
section.

Comment Dt

The date on which comment was entered in the Add Comments sec-
tion.
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444 Promises sub tab

The system automatically updates promise to pay request information as an entry under the
Promises sub tab based on value defined in parameter at setup level.

In this field: View this:

Promise Amt The amount promised.

Promise Dt The date by which customer promises to pay the said
amount.

Taken By The user who took promise.

Taken Dt The date promise was taken.

Collected Amt | The amount collected against the promise.

Broken ind If selected, indicates that this is a broken promise.

Cancelled If selected, indicates that this is a cancelled promise

If a call was recorded as a PROMISE TO PAY on the Call Activities section, it will appear
under the Promises sub tab. The Promises sub tab enables you to quickly view details about
the call and subsequent actions and displays 25 most recent promises to pay.

If system does not receive promised amount before the promised time, it notes broken
promise on the Delinquency Information section of the Account Details screen. View the
following information in the Promises sub tab.

Create Multiple Promises

In the Promises sub tab, you can capture more than one Promise at a go and track all
promises, instead of adding multiple call activities to capture multiple promises.

To record multiple promises related to call activity, Click Create Multiple Promises. The
system displays the ‘Promises’ section with the following fields:

In this field: View this:
Action Select the type of action from the drop-down list.
Result Select the required result of action from the drop-down

list. The Result field drop-down list displays only
“Promise to Pay” related results based on the action

selected.

Contact Select the type of person you contacted from the drop-
down list.

Reason Based on the account condition and the reason stated

by the contact, select the appropriate reason from the
drop-down list.

Promise St Dt | Select the date from which the first promise is made
from the adjoining calendar icon.

Frequency Select the frequency of payment from the drop-down
list.
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In this field: View this:

Promise Amt Specify the amount promised by the contact. Ensure
that you do not enter zero or a decimal value.

No. of Prom- Specify the total number of promises made by the con-
ises tact. A minimum of one promise need to exist.

Appointment Select the check box if a prior appointment is to be
taken for future follow-up.

Comment Specify additional details of the promise, if any.

Click Create to record the promise details. Based on the number of promises, equivalent
records are created in the section below with the following information:

In this field: View this:

Promise Dt The first record indicates the promise start date and
subsequent records will have dates incremented
based on frequency and number of promises.

Promise Amt View the amount promised.

Reason Indicates the reason stated by the contact.
Contact Indicates the contact selected.
FollowUp Dt Indicates the followup date which is auto calculated by

the system by adding 2-3 additional days from the
promise date.

Appointment Indicates if a prior appointment is required for future
follow-up.
Comment Specify additional details of the promise, if any.

If required, You can further modify the details of each record.

Click Save and Return. The recorded promises are populated in Call Activities tab for
tracking.

For more information on Call Activities, refer Customer Service > Call Activities sub tab
section.
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4.4.51

Checklists sub tab

In this field:

View this:

Promise Amt

The amount promised.

Promise Dt

The date by which customer promises to pay the said
amount.

Taken By The user who took promise.

Taken Dt The date promise was taken.

Collected Amt | The amount collected against the promise.

Broken If selected, indicates that this is a broken promise.
Cancelled If selected, indicates that this is a cancelled promise

Oracle Financial Services Lending and Leasing enables you to use checklist to ensure that
procedures are followed to complete various tasks. This instructional information appears

under the Checklist sub tab.

Completing a Checklist for an Account

To complete a checklist for an account

1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Service tab, Click Checklist sub tab.
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3. Inthe Check List Type field, select the type of checklist you want to complete and then

click Load Checklist.

The system loads checklist in the Checklist and Checklist Action sections.

complete.
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5. Under Action - Document tab, Click Edit. In Document tab, you can track documents
pertaining to the checklist type and update the status.

6. Note your work with the Yes/No/NA option buttons. You can also add comments to each
action on the checklist in the Comment column.

7. Click Save and Add to add a new record. Click Save and Return to return to the main

screen.

Tracking Attributes sub tab

The Tracking Attributes screen enables you to link information to an account that is not
tracked by default in the system, but is part of your company’s business practices; for
example, the location of important documents, how customers receive pay checks, or the hint
questions for remembering a PIN. Such attributes are defined during system setup.

To use the Customer Service screen’s Tracking Attributes screen

1. Open the Customer Service screen and load the account you want to work with.

2. Click the Customer Service tab, then click Tracking Attributes sub tab.

3. Click Load Tracking. The system loads the tracking parameters.
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4. Complete Tracking section by entering the requested parameter in the Value field.

5. Save any changes you made to the account.

References sub tab

The References sub tab enables you to view/add/edit references attached to the account
during Lease origination cycle.

To use the Customer Service screen’s References screen

1. Open the Customer Service screen and load the account you want to work with.

2. Click the Customer Service tab, then click References sub tab.
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3. Click Add.

RACLE
Financial Services Lending and Leasing

& Welcome, VAVAIDYA v gcesibiity o

AP Transactions
GLTransactions
CASA Reconiliation
Conversion Accounts

2 Collections
> WFP

> Tools
 Setup

Close

% DashBoand Customer Serviee y a
 Origination Search  Customer Service: 20120200010231  Review Request (Pending: 1)
Servicing
enicg Account(s): 20120200010231: YUTAKA OZAKA / AKANE G | o nait

Customer Service View v Formatw (5 freze Hfidetach  wap @) & @ Cuent O Showl O Group Follow-up

Secuitzation Branch Sub Uit Account £ Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt

Transaction Athorization UsR1 UNDEFINED 2012000000231 LEASE VEHICLE 005 000 0,00 ACTVE /102015

Pust Date Checks

Escrow Transactions - :

Tl Summary | Customer Service | Account Details|  Customer Detalls  Transaction History Pt Modes  Bankruptey | RepofForeclosure  Deficency  Collteral  Bureau | Cross/Up Sel Actiites

ol pandgenend Call Adtivities  Maintenance ~Comments ~Promises = Checklists ~TrackingAttributes = References | Correspondence  Letters = Document Tracking

Reports

Producers

Vendors References Fadd | St | 5 vien | o audt

Batch Transactions View Fomatv [ Frezze i Detach W @

i m_"“[ Relationship~ Name Country City State Address 7 Years Norths Phone Eitn Phon

Payments I 0 0

i ( JCKLSINON U5 5 5 ()85747

Interfaces 1

References

Hseandndd | H saveandstay | B saveandretn | aretm

*Relatioship v i 5 Phone
“Name oy Bt
* Country UNITED STATES v State v Phone
Address Ve 0 B

*Months 0 Comment

Specify the following:

In this field:

Specify this:

Relationship

Referee's relationship with borrower.

Name

Referee's name and details in the following fields.

Country

The country.

Address

The address line.

Zip

The zip code.

City

The city.

State

The state.

Years

Number of years or months that the reference is known by the bor-
rower.

Months

The number of months.

Phone

The reference’s primary phone number.

Extn

The reference’s primary phone extension.

Phone

The reference’s secondary phone number.

Extn

The reference’s secondary phone extension.

Comment

The comments regarding the reference.
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4. Click Save and Add to add a new record. Click Save and Return to return to the main

screen.

Correspondence sub tab

Ad-hoc correspondence enables you to include information from accounts in document
templates you create yourself without manually transferring the data. Ad-hoc documents can
be generated as either Microsoft Word or PDF files.

Ad-hoc correspondence can be viewed on the Correspondence screen when you have

opened an account. The screen enables you to generate a new letter or view a previously
generated letter.

To generate an ad hoc correspondence

1. Open the Customer Service screen and load the account you want to work with.

2. Click the Customer Service tab, then click Correspondence sub tab.
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3. Inthe Correspondence section, click Add. In the Correspondence section, use
Correspondence field to select type of correspondence you want to generate.

The system displays following information in the Correspondence screen for selected type
of correspondence:

In this field:

View this:

Id

The correspondence id.

Correspondence

The correspondence which is to be generated.

Date

The correspondence generation date.

4. Inthe Correspondence section, click Save.

The Documents section displays all types of documents available for the type of corre-

spondence you selected.

4-23

ORACLE



5. In the Documents section, click View.View the following information for each document:

In this field: View this:

Document Id The document Id.

Document The document description.

Recipient The recipient description.

E-Form The e-form source.

Source

Source Type The source type.

Generated 'Y’ indicates that Oracle Financial Services Lending and
Leasing generated the document.

Selected 'Y’ indicates that this document is selected to be included in
the correspondence.

6. Inthe Documents section, select the correspondence you want to view.

7. The Document Elements section displays elements of the system used to generate
correspondence.

Click All to view all elements in the correspondence.
- or -

8. Click User Defined, to view user-defined elements in the correspondence. In the
Document Elements section, view the following information:

In this field: Do this:

Element Type

View the document element type.

Element

View the element description.

Content

Enter/view value of the element.

9. Inthe Document Elements section, click User Defined and complete Content fields for
Element fields you want to include in the correspondence.

10. In the Document Elements section, click Save.

11. In the Document Elements section, click View.
The system displays a PDF of the ad hoc correspondence.

4.4.8.1 Recipient Details Sub Tab

The recipient details sub tab facilitates you to send ad-hoc correspondence to Customers,
Producers, and Others as an email.

To add recipient details

1. Open the the Customer Service screen and load the account you want to work with.
2. Click Correspondence—> Recipient Details.

3. Perform any of the Basic Operations mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Recipient Select the recipient from the drop-down list. The list displays the
following options:

- Applicant
- Customer
- Producer
- Others

Mode Select the mode of correspondence from the drop-down list. The
list displays the following options:

- Fax

- Email

Type Based on the recipient selected, the following type of correspond-
ence is listed for selection:

When the recipient is selected as Customer / Producer, the Type
is defaulted as ‘Email’ and associated email ID is selected for cor-
respondence. You can also change the Type to ‘Adhoc’ and spec-
ify the required email ID.

When the recipient is selected as ‘Others’ you can specify the
email ID in Type field for correspondence.

FAX/Email View the status of FAX/Email selected.

Comments Specify additional information as comments.

4. In the Recipient Details section, click Save.

5. Click Send to email the correspondence details to the specified recipients.

System validates the correspondence details and generates a PDF document through
Bl Publisher with the Correspondence details. The same is emailed to the specified
recipient as an attachment and a system generated comment is updated in ‘Comments’
Tab. The correspondence consists of following header details::

Alert Type & Comment Comment Comment Date
Subtype By
N System <Type> <Correspondence Logged in | Current System
Generated type> sent to <Recipient Type> | user date with time
through < Mode> to <'Email' id> stamp

Letters sub tab

The Oracle Financial Services Lending and Leasing Customer Service screen’s
correspondence address matters regarding customer service and collections for accounts.
They also enable financial organizations to manage bulk mailings. The Letters screen enables
you to create and view the following types of correspondence:

— Welcome letter
— Paid in Full letter
— PayOff quote letter
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— Rate change intimation letter
— PDC renewal letter
e Collection:
— Collection Letter - 1
— Collection Letter - 2
— Collection Letter - 3

You can view format of all the above letter types by clicking ‘View Letter’ button. In case, the
correspondence to a particular customer has been stopped using the Maintenance, ‘View
Letter’ button will not be displayed and only Letters screen will be available.

To use the Letters screen
1. Open the Customer Service screen and load the account you want to work with.

2. Click the Customer Service tab, then click Letters sub tab.
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Recipient Details

In the Recipient Details section, you can maintain the recipient details to whom the letter
should be sent. You can specify the following recipient details:

Field: Do this:

Recipient Select the recipient from the drop-down list. The list displays the
following options:

- Applicant
- Customer
- Producer
- Others

Mode Select the mode of correspondence from the drop-down list. The
list displays the following options:

- Fax

- Email
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Field:

Do this:

Type Based on the recipient selected, the following type of correspond-
ence is listed for selection:
When the recipient is selected as Customer / Producer, the Type
is defaulted as ‘Email’ and associated email ID is selected for cor-
respondence. You can also change the Type to ‘Adhoc’ and spec-
ify the required email ID.
When the recipient is selected as ‘Others’ you can specify the
email ID in Type field for correspondence.

FAX/Email View the status of FAX/Email selected.

Comments Specify additional information as comments.

3. In the Recipient Details section, click Save.

4. Click Send to email the correspondence details to the specified recipients.

System validates the correspondence details and generates a PDF document through
Bl Publisher with the Correspondence details. The same is emailed to the specified

recipient as an attachment and a system generated comment is updated in ‘Comments

Tab. The correspondence consists of following header details:

through < Mode> to <'Email' id>

Alert Type & Comment Comment Comment Date
Subtype By

N System <Type> <Correspondence Logged in | Current System
Generated type> sent to <Recipient Type> | user date with time

stamp

Collections: Collection letter 1

The predefined Collection letter 1 is automatically sent a configurable number of days after
an account becomes delinquent (receives a condition of active: DELQ on the Customer
Service screen).

The Collection letter 1 is available for Lease fixed and variable rate).

To generate the Collection letter 1

1. Open the Customer Service screen and load the account you want to work with.

Click the Customer Service tab, then click Letters sub tab.

2
3. On the Letters section, select Collection Letter - 1.
4

Click View Letter to generate Collection Letter - 1.

Collection Letter ORACLE’
Financial Services Lending and Leasing

DEMO BANK USA

LINE1
LINE2

MINNEAPOLIS MN 55344 7255
Phone: s##gszasszass Exm: 101
Fax:  ##sppng

Account number : 20150000014275
Amount past due: USD 7,527 99

nnnnnnnnn
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4410

The predefined Collection letter 2 is automatically sent after a configurable number of days
for a delinquent account (one with a condition of active: DELQ on the Customer Service
screen).

The Collection letter 2 is available for Lease (fixed and variable rate).

To generate the Collections letter 3

1.

2
3.
4

Open the Customer Service screen and load the account you want to work with.
Click the Customer Service tab, then click Letters sub tab.
On the Letters section, select Collection Letter - 3.
Click View Letter to generate Collection Letter - 3.
Collection Letter ORACLE
Financial Services | nnding and | easing
DEMO BANK USA
LINE1
LINE2
MINNEAPCLIS MN 55344 7255

Phone: s Exm 101
Fax: ssessses

Date;2/9/2016

INTERSHELL INTERNATIONAL CORP

100 CORPORATE N PL STE 404 ANX E # 160
FAIRGATE

CANTON MA 02021

Account number; 0150900014267

Amount past due: USD 5,329.00

Dear SHARF,

Qur records indicate that you are past due on your loan in the amount of USD 5,329.00. This
amount includes monthly payments together with all applicable fees due pursuant to your
contract

Several attempts have been made to contact you conceming this matter. In an effort to assist you
in attaining a current status on your account, we would like to speak with you immediately. Please
contact our office at #EFEHEEE B 101 to make suitable amangements to bring your
account current

Thank you in advance for your anticipated cooperafion.

Sincerely,

DEMO BANK USA

Document Tracking sub tab

You can view the documents attached to a particular account by loading the account on
Customer Service screen, then clicking the Document Tracking sub tab. You can also open
the Document Tracking screen and select from a list of all accounts with documents attached
on the Document Tracking screen.
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To use the Document Tracking screen

1.

Open the Customer Service screen and load the account you want to work with.

2. Click the Customer Service tab, then click Document Tracking sub tab.
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3. In the Documents section, select the document you want to view and view the following

information:

In this field: Do this:

Document

View the document type.
Type

Comment Specify comment.

4. Inthe Account Document Details section, select the document you want to view and

click Show in the Details column.

5. Inthe Account Document Details section, click View to view the following information:

In this field:

Do this:

Document Type View the document type.

Document Sub Type | View the document sub type.

Version View the version. Version numbers will be incremental by batch

job, first version will start with 1.0.

Page # View the page number. In multiple paged documents, choose 1

in the Page # field on Account Document Details section to
view all the pages in the document.

Choose a specific page number to view only that page.

Document File Type

View the document file type.
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4.5.1

In this field:

Do this:

Status View the status of the document.

Tracker # View the tracking number of the document.
Docket # View the docket number of the document.
Location View the location of the document.
Received Dt View the received date of the document.

Effective Dt

View the effective date of the document.

Expiry Dt

View the expiration date of the document.

Comment

Specify comment.

6. Click View Document.

The system opens a File Download dialog box.

— Click Open to view the document in the browser screen

_o r_

— Click Save to download the document to a location of your choice.

7. If you want, add comments to the Comments field in the Documents and Account
Document Details sections.

8. Save your entry.

Customer Service screen’s Account Details tab

Open the Customer Service screen and load the account you want to work with. Click the
Account Details tab to view the sections under it.

Account Details sub tab

Oracle Financial Services Lending and Leasing enables you to view account details using

Account Details sub tab.
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4.5.2

In the Account Information section click View.
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View the following information for Lease servicing product.

Statements sub tab

The Statements screen contains three display only sections. The Statements section
displays a list of all statements generated during life of the account. The Transaction section
displays monetary transactions applied to the account from closing date of the previous
statement through closing date of the current statement. The Messages section displays
user-defined message that appears in the statement.

To view the Statements screen

1. Open the Customer Service screen and load the account you want to work with.
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2. Click the Account Details tab, then click

ORACLE’
Financial Services Lending and Leasing

Statements sub tab.
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3. In the Statements section, click View.

4. View the following information:

In this field:

View:

Closing Dt

The statement closing date.

Due Dt

The statement due date.

Generation Dt

The statement generation date.

In the Statements Details section, select the statement you to view and click View.

5. View the following:
6. Click Transactions sub tab and click View

7. View the following information:

In this field:

View:

Txn Dt

The transaction effective date.

Transaction
Type

The type of transaction.

Amount

The transaction amount.

Click Messages sub tab and click View.

8. View the following information:

In this field:

View:

Sequence

The sequence number.
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453

In this field

: View:

Message

The message.

Rate Schedule sub tab

The Rate Schedule section contains information about rate adjustments, such as the
sequence and number of adjustments.

To view the Rate Schedule screen

1. Open the Customer Service screen and load the account you want to work with.
2. Click the Account Details tab, then click Rate Schedule sub tab.
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The Rate Schedule section only applies to variable rate loans.

3. In Rate Schedule section, click View.

4. View the following information:

In this field:

View this:

Seq

The sequence number for rate adjustment.

Adjustment
Type

Frequency The rate adjustment frequency type.

Period

The rate adjustment period for the frequency.

# of Adjustments

The number of rate adjustments for the frequency.
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454 Insurances sub tab

If insurance information was entered on Funding screen during Lease origination, you can
view financed insurance information on the Customer Service screen’s Insurances screen.
The Insurances screen displays the details of all financed insurances, including cancellation
and refund information whenever applicable. It also displays the insurances that were
financed after funding of Lease using the Customer Service screen’s Maintenance screen.

To view the Insurances screen
1. Open the Customer Service screen and load the account you want to work with.

2. Click the Account Details tab, then click Insurances sub tab.
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3. On the Insurances screen, view the following information in Insurance Information
section:

In this field: View:

Contractual If selected, indicates that the insurance policy is required by
contract.
Insurance The insurance type.

Type

Company The insurance company.
Policy# The insurance policy number.
Effective Dt The insurance effective date.

Premium Amt | The insurance premium amount.

Term The insurance term.

Status The insurance status.
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Click View and view the following information:

In this field:

View:

Policy Information secti

on:

Contractual

If selected, indicates that the insurance policy is
required by contract.

Insurance Type

The insurance type.

Insurance Plan

The insurance plan.

Company

The insurance company.

Policy#

The insurance policy number.

Effective Dt

The insurance effective date.

Premium Amt

The insurance premium amount.

Commission Rule

The rule of commission.

Primary Beneficiary

The primary beneficiary of the insurance.

Secondary Benefi-
ciary

The secondary beneficiary of the insurance.

Status

The status.

Sub Status

The sub status.

Insurance Mode

The insurance mode.

Phone The insurance company’s primary phone number.
Phone 2 The insurance company’s alternate phone number.
Itemization The contract itemization.

Expiry Dt The insurance expiry date.

Term The term of insurance.

Commission Amt

The insurance commission amount.

Comments

The comments regarding the insurance policy.

Cancellation/Refund section:

Policy Cancellation Dt

The insurance cancellation date.

Refund Allowed

If selected, a refund is allowed. A selected box indicates
that the insurance premium can be rebated to the cus-
tomer in case of early payoff.

tion Fee Allowed

Grace Days Cancella-

If selected, indicates that cancellation fees during grace
period is allowed.

Cancellation Fees

View amount of the cancellation fee to be charged when
the insurance is cancelled.
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In this field: View:

Complete Refund If selected, a complete refund is allowed.

Term Remaining The remaining term on the insurance at cancellation.
Refund Calculation The refund calculation method.

Method

Grace Days View the number of grace days allowed for cancellation

without charging a cancellation fee.

Estimated Refund Amt | The estimated insurance refund.

Received Refund Amt | The insurance refund received.

Itemization The contract itemization.

4. Inthe Insurance Tracking section, click Create Tracking.
The system loads insurance tracking parameters in the Insurance Tracking section.

5. If you want to reduce the list of parameters, select a sub attribute in the unlabelled Sub
Attribute box next to Create Tracking button.
If your system has been configured to use the Sub Attribute field, only attributes in a
particular group appear in the parameter display.

6. Click Edit and complete the Parameter and Value fields.

7. Click Save.

455 Contract Information sub tab

The Customer Service screen Contract sub tab enables you to view contract and truth-in-
lending information recorded during the funding process. It's a display only version of the
same information found on the Funding screen’s Contract screen.

To view an account’s contract information
1. Open the Customer Service screen and load the account you want to work with.
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2. Click Account Details tab, then click Contract Information sub tab.
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If you selected a Lease account with escrow, Escrow Analysis tab is available.

3. Use the following sub tabs to view more information about the contract, if available:
e Contract
e Repayment
e Itemization
e Trade-In
e Insurances
e ESC
e Compensation
e Subvention
e Proceeds
e Disbursements

e Fees
e ACH
e Coupon

e PDC
e References
e Real Estate

For more information on the sub tabs of the Contract tab, refer the section Contracts tab in
Funding chapter of the Origination User Guide.

Customer Service screen’s Customer Details tab

Open the Customer Service screen and load the account you want to work with. Click the
Customer Details tab to view the sections under it.
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Customer Details screen displays the information gathered on application entry process
regarding the customer and customer’s address, employment data, and phone numbers.
Using this screen, you can update or add to a customer’s address, employment information,
or phone listing. Whenever you add or edit the customer details, a system generated
comment will be posted in the account to keep record of old and new details.

Note that the ‘Edit’ option on this screen has user level security defined and based on your
responsibility, you can either edit a few or all of the fields. The difference is that, you may
either have access to edit only non-PII (Personal Identifiable Information) fields or edit all
possible fields as per the customer maintenance transaction.

The list of possible editable fields in both these scenarios is given below:

Edit non-PlIl fields

All editable fields

Marital Status

Birth Date

Language Marital Status
Education Language
Mother's Maiden Name Education

Class Type Mother's Maiden
Email Class Type
Stop Correspondence Email

Disability Stop Correspondence

Skip Disability

Privacy opt out Skip

Existing CIF Privacy Optout
Existing CIF

Identification Details like

Passport

Issue Date

Expiry Date

Visa #

Nationality

National ID

SSN

License #

License State

To view or edit customer information

1. Open the Customer Service screen and load the account you want to work with.
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2. Click Customer Details sub tab.
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3.

In the Customer Information section, click View the following information:

In this field:

View this:

Customer Information section

Customer #

Customer number.

Relation

Customer ‘s relation with the bank.

ECOA

The Equal Credit Opportunity Act code.

Name

Customer’s name.

Birth Dt

Customer’s date of birth.

Marital Status

Customer’s marital status.

Enabled

Status of the account.

Language

Customer’s language.

Education

Customer’s education.

Mother’s Maiden
Name

Customer’s mother’s maiden name.

Class Type

Customer’s class type.

Email

Customer’s e-mail address.
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In this field:

View this:

Stop Correspond-
ence

Customer’s stop correspondence indicator. If selected, this indi-
cates that the system will not send the customer any correspond-
ence, such as monthly statements. This is selected using the
Maintenance screen.

Disability Customer’s disability indicator.

Skip Customer’s skip indicator. If selected, this indicates that the cus-
tomer is a skip debtor. This is selected using the Maintenance
screen.

Bankruptcy Customer’s bankruptcy indicator.

Privacy Opt-Out

Privacy opt-out indicator. If selected, indicates that the applicant
has elected to refrain from the non-public sharing of information.

Existing CIF

If selected, indicates that the customer is an existing CIF.

Identification Details

section

Passport # Customer’s passport number.

Issue Dt Passport issue date.

Expiry Dt Passport expiry date.

Visa # Customer’s visa number.

Nationality Customer’s nationality.

National ID Customer’s national identification.

SSN Customer’s social security number. If the organizational parame-
ter UIX_HIDE RESTRICTED DATA is set to Y, this appears as a
masked number; for example, XXX-XX-1234.

License # Customer’s licence number.

License State

State where the licence was issued.

Military Service
Active Military Active military duty indicator. If selected, indicates that customer is
Duty on active military duty and may qualify for rates in accordance with

the Service members Civil Relief Act of 2003 (SCRA).

Effective Dt

The effective date

Order Ref # The order reference number.
Release Dt The release date.
Customer The deceased date of the customer.

Decease Date

When military duty transaction is posted on an account, the system does the following:
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e Restricts the user from posting repossession/ foreclosure and bankruptcy activities on
the account.

e Posts “DO NOT CHARGE OFF” condition on that account to exclude the account from
Auto Charge Off process.

4.6.1 Customer sub tab

Click Customer to view the sections under it.

4.6.1.1 Address sub tab

Click Address sub tab to view address information for the customer in the following section:

In this field: View this:

Type The address type.

Current If selected, indicates that this is the customer’s current address.

Confirmed If selected, indicates that the address if confirmed by the cus-
tomer.

Mailing If selected, indicates that this is the customer’s mailing address.

Permission to Check this box if customer has provided permission to contact

Call through the specified phone number.

Atleast one phone number for every application should have
the permission to call (flagged as "Y') for the successful pre-
qualification of the application. Else, an error message is dis-

played.
Country The country.
Postal Address The postal address type.
Type
Address # The address.
Street Pre The street pre.
Street Name The street name.
Street Type The street type.
Street Post The street post.
Apt # The apartment number.
Address 1 The customer’s address.
Address 2 The customer’s address.
Address 3 The customer’s address.
Zip The zip code.
Zip Extn The zip code extension.
City The city.

4-41 ORACLE



In this field:

View this:

State The state code.

Phone The phone number.

Address The address.

Census Tract/ The census tract/BNA code.

BNA Code

MSA Code The metropolitan statistical area (MSA) code.
Comment Comments regarding the address.

4.6.1.2 Telecoms sub tab

1. Click Telecom sub tab to View/edit the Telecom information for the customer:

In this field: Do this:

Type Select the telecommunication type.
Phone Specify the phone number.

Extn Specify the phone extension.

Current Select if this telecom number is current.

Permissionto | Check this box if customer has provided permission to con-

Call tact through the specified phone number.
Atleast one phone number per application should have the
permission to call (flagged as 'Y") for the successful pre-
qualification of the application. Else, an error message is
displayed.

Time Zone Select the applicant’s time zone.

Start Time Specify the best time to call start time.

End Time Specify the best time to call end time.

Period Specify the time period.

4.6.1.3 Employment sub tab

1. Click Employment sub tab, in Employment Information section, click View to View/edit
the employment information for customer in the following section:

In this field: View this:

Current If selected, indicates that this is the customer’s current address.
Permission Check this box if customer has provided permission to contact
to Call through the specified phone number.

Atleast one phone number per application should have the permis-
sion to call (flagged as "Y') for the successful pre-qualification of the
application. Else, an error message is displayed.
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In this field: View this:

Type The occupation.

Employer The employer’s name.

Occupation The occupation.

Title The title.

Department The department of the employment.

Country The country.

Address # The address line.

Address The employer’s address.

Line 1

Address The employer’s address.

Line 2

Zip The zip code.

Zip Extn The zip code extension.

City The city.

State The state.

Phone The work phone number.

Extn The work phone number extension.
Comment Comments regarding the employment.

4.6.1.4 Tracking Attributes sub tab

4.6.2

You can add tracking attribute information to an application at any time on the Customer
Details screen’s Customer Tracking Attributes section

In the Tracking Attributes section, click Edit

When you click Create Tracking, the system loads the tracking parameters.

e If you want to reduce the list of parameters, select a sub-attribute in the Sub Attribute
box.

e If your system has been configured to use the Sub Attribute field, only attributes in a
particular group appear in the Parameter display.

e specify the requested parameter in the Value field and click Save.
Save any changes you made to the account.

Business sub tab

If this is a SME Lease, information gathered on the application entry process regarding the
business and business’s address, partners and affiliates data, and phone numbers appears
on the Customer Service screen’s Business screen. Using the Business screen, you can
update or add to a business’s address, partners and affiliates information, or phone listing.
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To view or edit business information

1. Open the Customer Service screen and load the account you want to work with.

2. On the Customer Service link bar, click the Customer Service drop-down link, then click

Business.
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3.

In the Business Details section, click View

4. On Business screen, load the business whose information you want to view in the
Business section using First, Previous, Next, and Last buttons.

In this field:

View this:

Organization Type

Organization type.

Type of Business

Type of the business.

Name of the Business

Name of the business.

Legal Name

Legal name of the business.

Tax Id #

Tax identification number.

Start Dt

Business start date.

# of Employees (Curr)

Current number of employees at the business.

# of Employees

Number of employees at the business after financing.

Contact Person

Contact person at the business.

Business Checking
Bank

Bank name of the business’s checking account.

Bank Account #

Bank account number.

Avg Checking Balance

Average checking balance.
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In this field:

View this:

# of Locations

Number of locations of the business.

Management Since

Year the current management was established.

4.6.2.1 Addresses sub tab

Click Addresses sub tab and then click View. In the Address section, load the address
information you want to view.

In this field: View this:

Type Address type.
Country Country code.
Address # Address number.
Postal Type Postal type.

Pre Pre

Street Name

Name of street.

Street Type Type of street.
Post Post box number.
Apt # Apartment number.
Address 1 Address.

Address Line 2

Address Line 2

Zip Zip code.

Zip Extn Zip extension.

City City.

State State.

Phone Phone number.
Ownership Ownership type.
Comment Additional comments.

4.6.2.2 Telecom sub tab

Click Telecoms sub tab and then click View. In Telecom section, view the following

information:

In this field:

View this:

Telecom Type

Telecommunication type.

Phone

Phone number.
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In this field: View this:

Ext Phone extension.

Current If selected, indicates that this is the current record.

4.6.2.3 Partners sub tab

Click Partners sub tab and then click View. In the Partners section, load the business partner
information you want to view or edit using First, Previous, Next, and Last buttons.

In this field: View this:

First Name Partner’s first name.

Mi Partner’s middle name.

Last Name Partner’s last name.

Suffix Partner’s suffix.

SSN Partner’s social security number.

Birth Dt Partner’s birth date.

Birth Place Partner’s birth place.

Director Ind If selected, indicates that partner is the director of the business.
Networth Partner’s net worth.

Gross Income

Partner’s gross income.

Language Partner’s language.

Nationality Partner’s nationality.

Title Partner’s title.

Ownership Percentage of ownership held by the partner.
(%)

Email Partner’s e-mail.

Phone Partner’s phone.

Extn Partner’s phone extension.

4.6.2.4 Affiliates sub tab

Click Affiliates sub tab, in the Affiliates section, load the business affiliate information you

want to view using First, Previous, Next, and Last buttons.

In this field:

View this:

Organization
Type

Affiliate’s organization type.

Legal Name

Affiliate’s legal name.
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4.7

4.7.1

In this field:

View this:

Name of the Busi-
ness

Affiliate’s business name.

Tax ID #

Affiliate’s tax identification.

Ownership (%)

Affiliate’s percentage of ownership.

# of Employees

Affiliate’s number of employees.

NAICS CODE

Affiliate’s North American Industry Classification System code.

Customer Service screen’s Transaction History tab

Open the Customer Service screen and load the account you want to work with. Click the
Transaction History tab to view the sections under it.

ORACLE , PRAKRRAO v  Accessibiity (O
Financial Services Lending and Leasing
DashBoard Customer Service x 3 Qose
*» Origination Search  Customer Service: 20150900014283  Review Request (Pending: 0)
servicing
Servicing Account(s): 20150900014283: RODRIGUEZ ROBINSON [El view || o audit
Customer Service View~ Fomat~ [ eze (i Detach Wrap M & @ curentO show Al O Group Follow-up
SeriERCalon Company Branch Sub Unit Account = Product Days Past Due Currency Pay OF Amt.
Transaction Authorization
uso1 USHQ 'UNDEFINED 20150900014283 LEASE VEHICLE 114 UsD 15,158
Post Date Checks < >

Escrow Transactions
Account Documents
Collateral Managzment

Conversion Accounts

> Collections
> WFP

> Tools

> Setup

Summary || Oustomer Service|| Account Details || Customer Details | Transaction History, | Pmt Modes || Bankruptcy | RepofForeclosure || Deficiency || Collateral || Burea » ~

(@ Current Balance () Deficiency Balance () Non-Performing Balance () Terminate Balance (@ 1TD/CTD() YD

Reports
S hiens Balances | Transactions || Payment Rating | Due Date History || Repayment Schedule | Work Orders
Vendors
Batch Transactions Balance Group
Advances Balance Group
Payments
Feas
Interfaces View v Format~  [Ep Freeze i Detach Al wrap
ap
LI’E”SKE‘””S Balance Type Opening Balance Posted Paid | Terminate
GL Transactions
0 16112 1074
(CASA Reconciliation 120 0

Woived Charge OFF Adjusted ()
(] o [
4

Txn Period

>7
Current Balance 15,158
Total

Balances sub tab

Details of an account balance can be viewed on the Balances sub tab.

The Balance Group in Balances section consists of the following four action buttons:

e Current Balance
e Deficiency Balance

e Non-Performing Balance

e Terminate Balance

By default, the Current Balance option is selected. In case the status of an account is
‘Charged Off’, then the system defaults to ‘Deficiency Balance’ option.
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Depending on which one you select, a different set of balance information appears. In all
cases, the Balance screen can be viewed in the following two transaction period modes:

e |ITD/CTD (Inception-to-date/Cycle-to-date)

e YTD (year-to-date)
To view account balance information
1. Open the Customer Service screen and load the account you want to work with.
2. Click Transaction History tab, then click Balances sub tab

3. Inthe Balance Group section, select the balance you want to view.

Current Balance displays the current balances for accounts with an status of ACTIVE.

In this field: View:

Balance Type The balance type.

Opening Balance The opening balance amount.

Posted The amount posted (in addition to the opening balance).

Paid Balance The amount paid.

Waived The amount waived.

Charged Off The amount charged off.

Adjusted (-) The amount adjusted (negative adjustments).

Adjusted (+) The amount adjusted (positive adjustments).

Balance The current (closing) balance. The total active balance of
the account is displayed at the bottom.

Deficiency Balance displays the current balances for accounts with an status of CHARGED
OFF. If you click Deficiency Balance, the following information appears:

In this field: View:

Balance Type The balance type.

Opening Deficiency The opening deficiency balance.

Chg off Posted The additional charged off amounts posted.

Recovery The amount of deficiency balance paid.

Deficiency Balance The current (closing) deficiency balance. The total defi-
ciency balance of the account is displayed at the bottom.

Non-Performing Balance displays the current balance for accounts with status as NON-
PERFORMING. Non-Performing accounts fall between CHARGED OFF accounts and ACTIVE
accounts. These accounts are treated as active when dealing with the customer, but for
accounting purposes are treated differently as they are expected to charge off in the future.
Fee and interest balances are not expected to be collected in full and therefore are not
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recognized as income. If you click Non-Performing Balance, the following information

appears:
In this field: View:
Balance Type The balance type.

Opening Non-Performing | The opening non performing balance.

Paid / Terminate The amount of non performing balance paid or termi-
nated.

Paid Excess The additional non performing amounts posted.

Waived The amount waived.

Adjusted (-) The amount adjusted (Negative adjustments).

Adjusted (+) The amount adjusted (Positive adjustments).

Balance The current (Closing) non performing balance. The

total non-performing balance of the account is dis-
played at the bottom.

Terminate Balance displays the current balance for accounts with a status of TERMINATE.
Selecting Terminate Balance option displays the following account details.

In this field: View:

Balance Type The balance type.

Opening Balance The opening non performing balance.

Paid / Terminate The amount of non performing balance paid or terminated.
Waived The amount waived.

Charge Off The additional charged off amounts.

Adjusted (-) The amount adjusted (Negative adjustments).

Adjusted (+) The amount adjusted (Positive adjustments).

Terminate The balance amount to terminate.

4. Inthe Txn Period Balance section, select how you want to view the balance:
Select ITD/CTD to view transactions by Inception-to-date /Cycle-to-date:
-or-
Select YTD to view the transactions by year to date.

4.7.2 Transactions sub tab

The Transactions screen displays all transactions that have occurred over the life of account.
Transactions can be sorted by when the transaction was created (Post Dt) or the effective
date of transaction (Txn Dt). You can also choose to view all transactions or reverse certain
transactions. This information comes from the payments and advances applied to the
account, maintenance tasks, and nightly processes such as billing.
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To view the transaction history of an account

1. Open the Customer Service screen and load the account you want to work with.

2. Click Transaction History tab, then click Transactions sub tab.

ORACLE’ c, PRAKRRAO v Accessibility (w]
Financial Services Lending and Leasing
= Close
DachBoard Customer Service 3]s
>+ Origination Search  Customer Service: 20150900014283  Review Request (Pending: 0)
Servicing
Servicing Account(s): 20150900014283: RODRIGUEZ ROBINSON B view ||« Audit
Customer Service View v Formate B Freeze i Detach B & ® curentO show Al O Group Follow-up
f“‘”"_’: A Company Branch Sub Unit Account # Product Days Past Due Cumency Pay OFf Amt
(e a usol UsHa UNDEFINED 2015090014283 LEASE VEHICLE 114 USD 15,158.10
Fost Date Checks < >
Escrow Transactions
Account Documents
Collteral Management Summary || Customer Service | Account Details || Customer Details | Transaction History | Pmt Modes | Bankruptcy || RepofForeclosure || Deficiency | Collateral | Burea > ¥
Reports
i Balances | Transactions | PaymentRating | Due Dats History | Repayment Schedule | Work Orders
Vendors
ch Tr s 2
E’:L ransacan Transactions
pa;’r‘";i SortBy (® PostDt()TxnDt View Options (8 Good Payment Payments () Good Fees () All Fees () Good Txns () All Txns
Fees
View » Format » eeze Detach
Interfaces & E o
T — Post Dt Txn Dt Description Amaunt: Details Balance Amt Payment Cu
i 01/30/2016 09/05/2015 FIRST PAYMENT (Y) usp 1,074.15 LSR PD= §1,074.15 POSTED ON. 15,038.10 USD
GL Transactions.
CASA Reconciliation >
Conversion Accounts i i
Transactions
<3 Retun
Post Dt 01/30/2016 Details LSR PD=$1,074.15 Reference
Txn Dt 08/05/201 D ON 01/27/2016 Mode
Description FIRST PAYMENT (1) Bokince find. 15,038.10 Reason
Cumency USD. Payment Currency USD
Amount 1,074.15 Payment Amt
Payment Type
Allocation Details Elview || o audit
View ~ Format~ [ Freere  bff Detach rap (5]
Transaction Amount.
LEASE RECEIVABLE BILLED 1,074.15
> Collections
> WEP
> Tools
> Setup

3. Inthe View Options section, select type of transactions in this account’s history you want

to view on the Transactions screen.

If you select this:

The system displays:

Good Payments

All valid payments that was neither voided nor reversed.

All Payments

All transaction involving payments.

Good Txns

All transactions that was neither voided nor reversed.

All Txns

All transactions.

order of when the transaction was made effective.

_o r_

In the Sort Option section, choose Post Dt to sort entries on in Transactions section in

Select Txn Dt to sort the entries on in Transactions section in order of when the transac-

tion was created.

In View Option section, click View to view the following information:

In this field: View:

Transactions section

Post Dt The transaction posting date.

Txn Dt The transaction effective date.

Description The transaction details.
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4.7.21

4.7.2.2

In this field: View:

Currency The currency of the transaction.
Amount The transaction amount.
Details The transaction details.

Balance Amt

The balance amount. This is the principal balance, not the total
balance amount.

Payment Currency

The payment currency.

Payment Amount

The payment amount.

Payment Type The payment type.

Reference The reference number associated with the transaction.
Mode The mode of the transaction.

Reason The reason for the transaction.

Allocation Details

Txn

The transaction allocation details.

Amt

The transaction allocation amount.

To Reverse (or Void) a Transaction

1. Open the Customer Service screen and load the account you want to work with.

2. On the Customer Service link bar, click Customer Service drop-down link, then click

Transactions.

In the Transactions section, select the transaction you want to reverse.

4. Click Reverse. A confirmation dialog is displayed.

Click ‘Yes’ to reverse the transaction. On confirmation, the reversal is posted for

processing.

Some transactions cannot be reversed. If a transaction cannot be reversed, the Reverse
button will be dimmed when transaction is selected. If the Reverse button is unavailable, the
transaction anniversary cannot be reversed.

Access to the Reverse button can be restricted by user responsibility and account’s product
type using the PAYMENT REV transaction code (Super Group: ACCOUNT MONETARY
TXN) on the Administration screen.

(For more information, see Txn Codes tab (Transaction Super Group screen) section of
the Administration (System) Setup chapter in the Oracle Financial Services Lending and
Leasing Setup Guide).

Voiding an Account

To void an account

Oracle Financial Services Lending and Leasing can be configured to void an account using
the Reverse button on the Transaction screen.
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4.7.3

1. Open the Customer Service screen and load the account you want to work with.

2. On the Customer Service link bar, click Customer Service drop-down link, then click
Transactions.

In the Transactions section, select ACTIVE entry in the Description field.

4. Click Reverse.

On the Transactions screen, Oracle Financial Services Lending and Leasing creates an entry
of REVERSE ACTIVE and reverses all transactions. The system also changes status of the
account to CLOSED: VOID and changes status of the application to APPROVED-VOID (or
whatever the account’s last status was before funding).

To use this feature, ACTIVE REV transaction code must be enabled and set to manual on
the Transaction Super Group screen for your user responsibility and account’s product type.
(For more information, see the Txn Codes tab (Transaction Super Group screen) section
of the Administration (System) Setup chapter in the Oracle Financial Services Lending
and Leasing Setup Guide).

Payment Rating sub tab

|ORACLE"
| Financial Services Lending and Leasing

y @ smout &

Close
> DashBoard Customer Service 3 (3]
» Origination Search  Customer Service: 2016020001007  Review Request (Pending: 1)
Servicing
Servidng Account(s): 20160200010047: TEST FIRST [ElYew | o Audt

Customer Service view v Formatv  [Ep Freeze it Detach Wrap W & @ Curent Show Al ) Group Follon-up
Secuitization Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt
Transaction Authorization usoL usta SUBUNIT2 20150200010047  LOAN VEHICLE (FR) -4 UsD 50,048.51
. = | R SR koo el B8

v
Escrow Transactions

Account Documents Summary | Customer Service | AccountDetails = Customer Detsils | Transaction History | PmtModes | Bankruptcy | RepofForedosure | Defidency | Colateral | Bureau | € > 7

Collateral Management

Reports Balances | Transactions | Sale Transfer Transactions; | PaymentRating  Due Date history  RepaymentSchedue | Work Orders

Producers

;E::'s Sale Transfer Transactions View | Audit

b dT’E”sa[“”“S i View Options @ Good Txns @) AllTxns

:E:;r:: view~ Format > Ep Freeze i Detach Nrap (o] i
i PastDt Tun Ot Description Amount Previous Sub Unit New Sub Unit

Interfaces 02/22f2016 02/22/2016 ADVANCE / PRINCIPAL-CONTRA TRAN. 50,000.00 UNDEFINED SUBUNIT2
4 Transactions 02/22/2016 02/22/2016 ADVANCE / PRINCIPAL-SALE TRANSAC. 50,000.00 UNDEFINED SUBUNIT2
& e 022212016 02/22/2016 INTEREST-CONTRA TRANSACTION 20,79 UNDEFINED SUBUNIT2
b coctbitton 02/22/2016 02/22/2016 INTEREST-SALE TRANSACTION 20.79 UNDEFINED SUBLINIT2 ]
Conversion Accounts L = L

> Collections
> WEP

> Tools

> Setup

To view the transaction history of an account
1. Open the Customer Service screen and load the account you want to work with.
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2. Click Transaction History tab, then click Payment Rating sub tab.

ORACLE’

RACL ; . F P — o
Financial Services Lending and Leasing
DashBoard Customer Service 5 [ Close:
» Origination Search ~ Customer Service: 20150900014283  Review Request (Pending: 0)
Servicing
Servicing Account(s): 20150900014283: RODRIGUEZ ROBINSON B view || o2 audit
Customer Service View~ Fomatv [ Freeze  Ef Detach Wrap M & @ curentO show Al O Group Follow-up
iE:“”t‘:"D’l oz Company Branch Sub Unit Account £ Product Days Past Due Currency Pay OFf Amt
i usat usta UNDEFINED 2015090014289 LEASE VEHIOLE 114 USD 15,£58.40
Post Date Checks < >
Escrow Transactions

Account Documents
Collateral Management
Reports . ;

e o Balances || Transactions = Payment Rating | Due Date History || Repayment Schedule || Work Orders
Vendors

Summary || Customer Service | Account Details | Customer Details | Transaction History | Pmt Modes || Bankruptcy || Repo/Foreclosure || Deficiency | Collateral | Burea » ~

Batch Transactions

Payment Rating

Advarces
Payments
Fecs Pmt Rating Rating Description Acc Status Status Description
Interfaces 3 90-119 DAYS PAST DUE DATE 80 ACCOUNT 90 DAYS PAST THE DUE DATE
AP Transactions
‘GL Transactions Month/Year 01/2016 12f2015 11/2015 10/2015
'CASA Reconciliation Rating 3 2 1 o
- i i
Conversion Accounts T g
Rating
Month/Year
Rating
MonthYesr
Rating
> Collections
> WFP
> Tools
> Setup

The Payment Rating section displays month and year of payment and rating reported to
credit bureaus through Metro 2 file for the past 24 months, including the following:

In this field: View this:

Pmt Rating The payment rating.

Rating Description The payment rating description.

Acc Status The credit bureau account status.

Status Description The credit bureau account status description.
Month/Year Rating The month/year of payment rating.

4.7.4 Due Date History sub tab

The Due Date History tab provides a delinquency history, by payment, by displaying a history
of all due dates, along with when actual payment was made for that due date and the
subsequent balance. If a payment was delinquent, Due Date History section displays the
number of days the customer was delinquent against each due date.

Due Date History sub tab displays all the dues that have crossed the system date and also
the history that is currently available in Transaction History > Due Date History sub tab.

1. Open the Customer Service screen and load the account you want to work with.
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2. Click Transaction History tab, then click Due Date History sub tab.

ORACLE
Financial Services Lending and Leasing

# Welcome, PRAKRRAO ~  Accessibility (O

ustomer Service | Close
DashBoard et x -
- Origination Search  Customer Service: 20150900014283  Review Reguest (Pending: 0)
Servicing
Servicing Account(s): 20150900014283: RODRIGUEZ ROBINSON Elview || o2 Audit
Cu View ~ Format~ R Freeze 5 Detach | wrap B & @ curentO show alC Group Follow-up
Company. Branch Sub Unit Account = Product Days Past Due Currency Pay OFF Amt
usoL usHQ UNDEFINED 2015090014283 LEASE VEHICLE 114 USD 15,158
< >
Account Documents
okl MaraoararE Summary || Customer Service || Account Details || Customer Details | Transaction History | Pt Modes | Bankruptcy | RepojForeclosure || Deficiency | Collateral || Burea > ~

Balarces | Transactions || Payment Rating | Due Date History | Repsyment Schedule | Work Orders

Due Date History

View v Format~ [ Freeze G Detach vrap 2}
Due Dt Due Amt Last Pmt Dt Pmt Amt Balance Amt. Days Past Due Pt
Received
02/05/2016 1,074 o 1,074
01/05/2016 1,074 ] 1,074 2N ~
12/05/2015 1,074 0 1,074 3N
q 11/05/2015 1,074 [ 074 83N ~
10/05/2015 1074 ° 1,074 14N «
Due Date History
< getum

Due Dt 02/05/2016
Due Amt 1,074
Last Pmt Dt

> Collections
> WFP

> Tools

> Setup

In Due Date History section, click View

View the following:

In this field: View this:

Due Dt The due date.

Due Amt The due amount.

Last Pmt Dt The last payment date.

Pmt Amt The payment amount.

Balance Amt The balance amount.

Days Past Due | The days past due.

Pmt Received | If selected, indicates the payment was received.

4.7.5 Repayment Schedule sub tab

The Repayment Schedule section contains information about schedule of repayment such
as the date and payment amount.

1. Open the Customer Service screen and load the account you want to work with.
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2. Click Transaction History tab, then click Repayment Schedule sub tab.

ORACLE . . 2 Welcome, PRAKRRAQ +  Accessibility o
Financial Services Lending and Leasing
T Customer Service [3) Close
> Origination Search | Customer Service: 20150900014283 | Review Request (Pending: 0)
Servicing
Senvicing Account(s): 20150900014283: RODRIGUEZ ROBINSON [El vew || < audit
Custamer Senvice View v Format~ [ ez i Detach B & @ arentO show Al O Group Follow-up
;H“m‘i‘_’"”l — Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt.
e e usot sty UNDEFINED 2015030014283 LEASE VEHICLE 114 USD 15,158.10

Post Date Checks
Escrow Transactions
Account Documents

Collateral Management Summary | Customer Service | Account Details | Customer Details | Transaction History | PmtModes | Bankruptcy

Reports
e Bslances | Transactions | PaymentRating | Dus Date History  Repayment Schedule | Work Orders
Vendors
ch T s
Balzh Jranenct o Repayment Schedule
Advances -
Payments View v Format+ | [ Freeze ) Detach irap 5]
Fees Seq Date £ of Pits Pt Amt Generated
I b No data to display.
AP Transactions
GL Transactions Repayment Schedule
(CASA Reconcilistion
Conversion Accounts #
B
Date
# of Pmis
Repayment Schedule Details
View » Format- [ Freeze i Detach Wrap ®
Date Payment Amt Principal Amt Interest

No data to display.

> Caollections
> WFP

> Tools

> Setup

RepofForedlosure | Deficiency | Collateral | Burea > ~

G Betum

Pmt Amt

Generated

(5] view || < audit

Balance Principal

View the following information:

In this field: View this:

Repayment Schedule section

Seq The payment sequence number.

Date The repayment date.

# of Pmts The number of payments.

Pmt Amt The payment amount.

Generated
generated.

If selected, indicates that the repayment schedule has been

Repayment Schedule Details section

Date The repayment date.

Payment Amt The payment amount.

Principal Amt The amount paid to principal.

Interest The amount paid to interest.

Balance Princi-
pal

The balance of the principal.
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4.7.6 Work Order sub tab

To expedite repossessions and foreclosures, the display only Vendor Work Order screen
enables you to view all the work orders issued to different vendors for an account.

To view the vendor work order screen

1. Open the Customer Service screen and load the account you want to work with.

2. Click Transaction History tab, then click Work Order sub tab.

ORACLE - i
Financial Services Lending and Leasing

ey — =)

Customer Service x (38 Qiose
Search | Customer Service: 20150900014283 | Review Request (Pending: 0)
Accouni(s): 20150900014283: RODRIGUEZ ROBINSON Bl vew || # Aude
View v Format~ [P Freeze i Detach wrap W & @ cumentO show all O Group Follow-up

Company Branch Sub Unit Account = Product Days Past Due Currency Pay OFf Amt
usor usHa UNDEFINED 20150900014283  LEASE VEHICLE 114 USD. 15,158.10
< >

Summa ount Detalls

saction History | Pt Modes | Bankruptcy | RepofForeciosure | Deficlency | Collatersl | Surea > <

didule | Work Orders

Vendor Work Order
View v Fomalv | B fresze i Detach wrap @ - create work Order
ot

Type Estimated Vendor Status
No data to display.
Total Amt

Vendor Work Order

< Beturn

> Collections
> WP

> Tools

> Setup

In the Vendor Work Order section, click View

View the following display only information:

In this field: View this:

Type The assigned type.

Dt The assignment date.

Estimated The estimated dollar amount of work order.

Vendor The vendor number and name.

Status The assigned status.

Total Amt The total estimated dollar amount of all work orders.

You can create/view and maintain vendor work orders related to an account.

e To create and maintain vendor work orders, click Create Work Order. The system
opens Vendor Management screen. You can perform tasks and record additional
information, such as changing the work order’s status and adding comments in the Work
Orders section.

If vendor screen is already opened in the main screen and user tries to create new work order
or open an existing work order, system displays the warning message as “Vendor
management screen is already open. Please close it and retry”.

e To view more detailed information about vendor work order, select the work order you
want to view and click View Work Order. The View Work Order button appears faded
if the responsibility does not allow access to the Vendor Work Order screen.

4-56 ORACLE



4.8

4.8.1

3. Click Close on the Vendor Management screen to return to the Customer Service screen.

For more information about using the Vendor Management screen, please refer to the Vendor
chapter in the User Guide.

Customer Service screen’s Pmt Modes tab

Open the Customer Service screen and load the account you want to work with. Click the
Pmt Modes sub tab to view the sections under it.

ACH sub tab

If used, the ACH section displays information about automated clearing house and electronic
fund transfers.

To view the ACH information screen

1. Open the Customer Service screen and load the account you want to work with.

2. Click Pmt Modes tab, then click ACH sub tab.

ORACLE
Financial Services Lending and Leasing

Customer Service » 38 Qo

Search | Customer Service: 20150900014283 | Review Request (Pending: 0)

prcy || Hepojroreclosure || Deficency || Coliateral || Bureau || Gross/Up sell >

ve and add || save and stay ||l Save and Retumn ||| 3 Beturn

> Collections

> Tools
> Setup

The system displays the ACH details depending on the following option selected:

e Recurring - Select ‘Recurring’ to display all the Recurring ACH details.
e One-Time Phone - Select this option to display one time ACH details.
e All - Select ‘All’ to display both recurring and one-time phone ACH details.

If you have selected ‘Recurring’ or ‘One-Time Phone’ option, you can further Add, Edit, or
Copy the details and perform any of the Basic Operations mentioned in Navigation chapter.
On save, the system will automatically post the transaction capturing the current transaction
date along with a comment as 'Direct Record Update' for the particular ACH transactions.

If you have selected ‘Recurring’ option, the following fields are displayed:

In this field:

View this:

Reference #

The unique reference number.

Bank Name

The bank name.

Bank City

Specify the city where the bank exist.
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In this field:

View this:

Bank State Select the state where the bank exist form the drop-down list.

Routing # The routing number.

Account Type | The type of account.

Name On Specify the name of the account.

Account

Account # The account number. If the organizational parameter UIX HIDE RE-
STRICTED DATA is set to Y, this appears as a masked number; for
example, XXXXX1234.

BIC Select the Business Identifier Code from the drop-down list. The list
displays the BIC codes defined in the system.

IBAN Specify the IBAN (International Bank Account Number). IBAN is used
for identifying bank accounts across national borders with a minimal of
risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation based on
modulo 97. On save, system automatically validates the IBAN number
length based on country code, characters, white spaces, and check-
sum. Validation is also done during posting non-monetary transaction
(ACH Maintenance).

You can maintain the IBAN length and other details required as per the
country code in the user defined table (Setup > Administration > Sys-
tem > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is defined by
default with length of IBAN as 18.

Sequence System displays the current Sequence Type of the selected account.

Type Depending on the nature of direct debit, the sequence type can be one
of the following:

- First - First time direct debit

- Recurrent - Subsequent repayments after first direct debit

- Final - Final repayment

- One-off - One time bullet contract repayment

However, during the life cycle of the payment processing, the direct
debit sequence type for an account can change.

Pmt Day The payment day.

Pmt Amt The Payment amount.

Pmt Amt The excess payment.

Excess

Pmt Freq The payment frequency.

Fee Amt The amount charged as fees.

Direct Debit If selected indicates that the fees is debited directly.

Fee
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In this field:

View this:

Start Dt The date the system began using ACH payments for this account
End Dt The ACH end date.
Default If selected indicates that this ACH is the default ACH for the account.
Status The status of the account.

Note

This information can be edited using the Maintenance screen and the non monetary trans-
action ACH MAINTENANCE.

If you have selected ‘One-Time Phone’ or ‘All’ option, the following fields are displayed:

In this field:

View this:

Reference #

The unique reference number.

Bank Name The bank name.

Bank City The bank city.

Bank State List of available states.

Routing # The routing number.

Account Type | The type of account.

Name On The account name.

Account

Account # The account number. If the organizational parameter UIX HIDE RE-
STRICTED DATA is set to Y, this appears as a masked number; for
example, XXXXX1234.

BIC Select the Business Identifier Code from the drop-down list. The list
displays the BIC codes defined in the system.

IBAN Specify the IBAN (International Bank Account Number). IBAN is used

for identifying bank accounts across national borders with a minimal of
risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation based on
modulo 97. On save, system automatically validates the IBAN number
length based on country code, characters, white spaces, and check-
sum. Validation is also done during posting non-monetary transaction
(ACH Maintenance).

You can maintain the IBAN length and other details required as per the
country code in the user defined table (Setup > Administration > Sys-
tem > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT _NL) is defined by
default with length of IBAN as 18.
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In this field:

View this:

Sequence System displays the current Sequence Type of the selected account.
Type - First - First time direct debit
- Recurrent - Subsequent repayments after first direct debit
- Final - Final repayment
- One-off - One time bullet contract repayment
However, during the life cycle of the payment processing, the direct
debit sequence type for an account can change.
Debit Dt The debit date.
Pmt Amt The Payment amount.
Direct Debit If selected indicates that the fees is debited directly.
Fee

Secret Ques-
tion

Select the secret question from the drop down list.

Provided To The person to whom the ACH is concerned.
Whom
Reference Additional reference if any.

Drawer Rela-
tion Type

The withdrawer relation to ACH.

Drawer Name

The name of withdrawer.

Drawer Address of withdrawer,
Address1

Drawer Address of withdrawer,
Address2

Drawer City City of withdrawer,

Drawer State

State of withdrawer,

Drawer Zip Zip of withdrawer,
Status The status of the account.
Note

This information can be edited using the Maintenance screen and the non monetary trans-

action ACH MAINTENANCE.

Copying ACH Details

You can copy and maintain ACH details from Pmt Modes sub tab of Customer Service
screen. Copy option is available only when you have selected the ACH option as either
Recurring or One-Time Phone.

To copy the ACH details
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4.8.3

1. Select a record and click Copy.

2. A confirmation message is displayed as ‘Do you want to Copy ACH Record?’. Click OK
to copy and create a new record.

On confirmation, the system creates a new row with new reference number, Status as ‘Active’,
Default as ‘N’, Start Dt as ‘System Dt + Pre note days’ and all the other details as maintained
in the copied record. When a new record is created using the Copy function, the system will
post a ‘New ACH Transaction’ capturing the current transaction date along with a comment
as 'Direct Record Update'.

Coupon sub tab

The Coupon section displays information regarding coupons associated with the account.
To view the coupon screen
1. Open the Customer Service screen and load the account you want to work with.

2. Click Pmt Modes tab, then click Coupon sub tab.

Ol

RACLE
Financial Services Lending and Leasing

Collections s

Scarch | Customecr Scrvice: 201509000142683 | feviow fequest (Pending: 0)

Account(s): 20150000014283: RODRIGUEZ ROBINSON 5 View || o Aud
View - Format+ | B rrecze £ Detach W 8 © cunenO stow AlO Giou Fullow-up

Bl weow ||« audic

> WP

> Tools

> Setup

View the following:

In this field: View this:

Order If the coupons are ordered for the selected account.

Coupon Start- | The starting number of coupon ordered for the customer.
ing #

Order Date The order date of the coupon.

# of Coupons | The total number of coupons ordered for the customer.

Ordered By The person who ordered the coupons

Post Dated Checks sub tab

The Post Date Check section enables you to view any post dated check information for the
account, if PDC is a method of repayment.

To view the post dated checks details screen
1. Open the Customer Service screen and load the account you want to work with.
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2. Click Pmt Modes tab, then click Post Dated Checks sub tab.

ORACLE
Financial Services Lending and Leasing

P y—— [=)
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Summary || Customer Senvice Account Details || Customer Details || Transaction History || Pmit Modes | Coliateral | Bureau || Cross/Up Sell Activities
ACH  Coupon Post Dated Checks | Paymant Arrangement
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> wep

> Tools
> Setup

View the following:

In this field: | View this:

PDC Type The type of post dated check in use.

Status The status of the post dated check.

Check # The check number of the post dated check.

Check Dt The check date of the post dated check.

Check Amt The check amount of the post dated check.

Bank Name | The bank name of the post dated check.

Account The account type of the post dated check.
Type

Account # The account number of the post dated check.

Comments Additional information as comments, if any.

Payment Arrangement sub tab

The Payment Arrangement section enables you to define and calculate the payment amount
for the account with status Charge-off. An alert message will be displayed in the Customer
Service screen when the user tries to view the payment arrangement for account other than
charged off status.

To view the Payment Arrangement details screen

1. Open the Customer Service screen and load the account you want to work with.
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2. Click Pmt Modes tab, then click Payment Arrangement sub tab.

oORACLE
Financial Services Lending and Leasing

& Welcome, VAVAIDYA

SRR

Start bt &
End 01

] Calcuiate | 53 Activate | {53 Deactivate

End Dx Terma Plon Amt  Outstanding

Flan Amt Paid Amt Satsfied Ind Eroken 1nd

> wrp

> Setup

The Payment Arrangement section is enabled only when the Payment Arrangement Batch job
is posted.

3. Inthe Payment Arrangement section, click View to view the following details:

In this field: Do this:

Frequency Displays the payment frequency.

Start Date Enter the start date from when the customer pays.

Terms Enter the number of payments. Note that if the term is speci-

fied as zero “0”, an error message is displayed.

End Date View the end date of the payment.

Plan Amount View the payment amount which the customer plans to pay.
Outstanding View the outstanding amount.

Amount

4. In the Details section, click View to view the following details:

In this field: | View this:

Date View the start date of the payment plan.

Frequency View the payment frequency.

Plan View the planned payment amount.

Amount

Paid View the paid amount.

Amount

Satisfied Indicates that the customer done the payment arrangements.

Ind

Broken Ind Indicates that the customer did not make the payment arrangement.

Enabled Ind | Indicates that the arrangement is active
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On Clicking Deactivate, the account will be deactivated.

To add a new payment rearrangement plan, previous plan has to be manually deactivated
otherwise the system displays an error message. This condition applies to the payment
arrangement previous plan even when the 'Broken Indicator' is selected.

Only one Payment arrangement plan can exist at a time. If a schedule broken by the customer

make another payment arrangement, the first payment arrangement has to be deactivated
and only then, the other payment can be added.

Customer Service screen’s Bankruptcy tab

The Bankruptcy screen enables you to record the details of a bankruptcy. This information
usually is supplied from the customer or customer’s attorney. You can track each stage of the
bankruptcy process based on its follow-up date and record information using the Details and
Tracking sections.

As there are occasions when a borrower files bankruptcy more than once during tenure of the
Lease, you can record information for multiple bankruptcies. The Add button enables you to
create a new bankruptcy record with different start and end dates. You can also use the
Bankruptcy screen to view previous bankruptcy record using Next and Previous buttons in
Detail section. The Current box in Detail section indicates the current bankruptcy details.

When a Bankruptcy condition is opened on an account, the system defaults a detailed
tracking record with ‘Current’ field enabled and ‘Follow up date’ defaulted to system date. The
‘Disposition’ is defaulted as ‘NEWLY RECEIVED’. The system only adds a new detail tracking
record. No processing will be done with respect to detail tracking record when the bankruptcy
condition is closed.

To enter bankruptcy details for an account

1. Open the Customer Service screen and load the account you want to work with.
2. Click Bankruptcy tab.

3. Inthe Bankruptcy Details section, select the bankruptcy record you want to work with.
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Select Add to refresh the Bankruptcy screen to create a new record.
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4. In the Bankruptcy Details section, enter, view or edit the following information:

Field:

Do this:

Current

Select to indicate this is the current bankruptcy record.

Follow up Dt

Enter the follow-up date for the bankruptcy.

Disposition

Select the bankruptcy disposition.

Type

Select the bankruptcy type.

Customer Select the customer from the drop-down list
Relation The system displays relation of the customer
Comment Enter a comment.

File Received Dt

Select the file received date for the bankruptcy.

Bankruptcy Start
Dt

Select the bankruptcy start date.

Bankruptcy End
Dt

Select the bankruptcy end date.

5. Click Save.

6. Inthe Tracking section, click Load Tracking.

The system loads the bankruptcy tracking parameters.

7. If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute field.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in parameter display.
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4.9.2

49.3

410

4.10.1

8. Complete the Create Tracking section by entering information regarding bankruptcy in
the Value field for each corresponding Parameter, click Save on the Bankruptcy screen.

Call Activities sub tab

Call activity section includes calls from customer, calls you make regarding the account or
changes to the condition of the account. Entries in the Call Activities section are listed in
reverse chronological order of follow-up date.

For details on how to Record a Call Activity, refer Call Activities sub tab section in “Customer
Service screen’s Customer Service tab” section.

Comments sub tab

Oracle Financial Services Lending and Leasing enables you to record comments on the
Customer Service screen using Comments tab. These comments also appear under the
Comments sub tab.

For details on how to Record a Comment, refer Comments sub tab section in “Customer
Service screen’s Customer Service tab” section.

Due Date History sub tab

The Due Date History tab section provides a delinquency history, by payment, by displaying
a history of all due dates, along with when actual payment was made for that due date and
the subsequent balance. If a payment was delinquent, Due Date History section displays the
number of days the customer was delinquent against each due date.

For more details, refer Due Date History sub tab section in “Customer Service screen’s
Transaction History tab” section.

Customer Service screen’s Repo/Foreclosure tab

The Repossession/Foreclosure screen enables you to record information regarding
repossessions/foreclosure in a manner similar to how bankruptcies are recorded on the
Bankruptcy screen. You can track each stage of repossession/foreclosure process based on
the follow-up date and record information using the Details and Tracking section.

Repossession sub tab

On occasion, a lender performs multiple repossessions for the same Lease. The Create New
Repossession button on the Repossession screen enables you to create a new repossession
record for a different collateral and different start and end dates. You can also use the
Repossession screen to view previous repossession information using the Next and Previous
buttons in the Details section. The Current box in Details section indicates the current
repossession record for each asset.

This tab will be available only when the collateral type associated with the Lease account is
a Vehicle.

You can update the current record, but previous records cannot be modified.

When the REPO call activity is posted, system defaults the primary collateral details and
current status will be checked.

When a Repossession condition is opened on an account, the system defaults a detailed
tracking record with ‘Current’ field enabled and ‘Follow up date’ defaulted to system date. The
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‘Disposition’ is defaulted as ‘NEWLY RECEIVED’. The system only adds a new detail tracking
record. No processing will be done with respect to the detail tracking record when the
repossession condition is closed.

To Specify repossession details for an account

1. Open the Customer Service screen and load the account you want to work with.

2. Click the Repol/Foreclosure sub tab, then click Repossession.

3. Inthe Repossession Details section, select the repossession record you want to work
with.
_Or_
Click Add to refresh the Repossession screen to create a new record.
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4. In the Details section, enter view or edit the following information:

In this field: Do this:

Current Select to indicate this is the current repossession record.
Followup Dt Specify the follow-up date for the repossession.
Disposition Select the repossession disposition.

Type Select the repossession type.

Collateral Select the collateral involved in the repossession.
File Received Select the file received date for the repossession.
Dt

Repo Start Dt Select the repossession start date.

Repo End Dt Select the repossession end date.

Comment Specify a comment.

5. In the Tracking section, click Load Tracking.
The system loads the repossession tracking parameters.

4-67 ORACLE



4.10.2

6. If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.
If your system has been configured to use the Sub Attribute field, only attributes in a
particular group appear in the parameter display.

7. Complete the Tracking section by entering information regarding repossession in the
Value field for each corresponding Parameter, then click Save.

Foreclosure sub tab

The Foreclosure screen enables you to record information regarding foreclosure in a manner
similar to how bankruptcies are recorded on the Bankruptcy screen. You can track each stage
of the repossession process based on follow-up date and record information using Details and
Tracking section.

A lender can perform multiple foreclosures for the same Lease. The Create New Foreclosure
button on the Foreclosure screen enable you to create a new foreclosure record for a different
collateral and different start and end dates. You can also use the Foreclosure screens to view
the previous foreclosure information using Previous and Next buttons in Details section. The
Current box in Details section indicates the current foreclosure record for each asset.

This tab will be available only when the Collateral type associated with the Lease account is
home.

You can update the current record, but previous records cannot be modified.

To enter foreclosure details for an account

1. Open the Customer Service screen and load the account you want to work with.
2. Click the Repol/Foreclosure sub tab, then click Foreclosure.

3. Inthe Foreclosure Details section, select the foreclosure record you want to work with.

_0 r'_

4. Inthe Foreclosure Details section, enter view or edit the following information:

In this field: Do this:

Current box Select to indicate this is the current repossession/foreclosure
record.

Followup Dt Select the follow-up date for the repossession/foreclosure.

Disposition Select the foreclosure disposition.

Type Select the foreclosure type.

Collateral Select the foreclosure asset.

File Received Dt Enter the file received date for the foreclosure.
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In this field:

Do this:

Foreclosure Start
Dt

Enter the foreclosure start date.

Foreclosure End
Dt

Enter the foreclosure end date.

Comment

Enter a comment.

5. In the Tracking section, click Load Tracking.

The system loads the foreclosure tracking parameters.

6. If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.
If your system has been configured to use the Sub Attribute field, only attributes in a
particular group appear in the parameter display.

7. Complete the Tracking section by entering information regarding foreclosure in the Value

field for each corresponding Parameter, then click Save.

Analysis sub tab

The Analysis screen enables you to create and analyze possible scenarios for re marketing
and sale of the asset. This enables you to calculate the possible gain or loss in the sale of an
asset. Expenses already incurred on the asset are displayed on Expenses sub screen. You
can change the numbers if you expect more expenses by the time asset is sold. You can have
up to three Repo/Foreclosure and three Sales analyzes on each Analysis screen.

To complete a repossession/foreclosure analysis or sales analysis for an account

1. Open the Customer Service screen and load the account you want to work with.

2. Onthe Customer Service link bar, click the Repo/Foreclosure drop-down link, then click

Analysis

3. Inthe Analysis section, select the analysis record you want to work with and click Load.

_0 r'_
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Click Add to refresh the Foreclosure screen to create a new record.

ORACLE
Financial Services Lending and Leasing

= Close
DashBoard Customer Service [E3f
- Origination Search || Customer Service: 2015090014283 Review Request (Pending: 0) ~
Servicing
Servicing Account(s): 20150900014283: RODRIGUEZ ROBINSON
Customer Service View Fomatv [P Freeze 4 Detach | Wrap M & @ curentO show &l O Group Follow-up
;E(“r"f = thoristio Company Branch Sub Unit Account = Product Days Past Due Curency Pay OF amt Amount
o Uso1. USHQ. UNDEFINED 2015090014783  LEASE VEHICLE 114 USD 15,158.10 4%
Post Date Checks < >

Escrow Transactions
Account Documents
Collateral Managzment
Reports

Producers

Summary | Customer Service || Account Details | Customer Details | Transaction History | Pmt Modes | Bankrupicy | Repo/Foreclosure | Deficiency | Collateral || Bureau | CrossiUp >

Repossession Analysis

Vendors

Bat:;‘ Transactions Analysis dpadd | A Edt  Audit
vances 5
peyiniaits View~ Formatv B Freeze ) Detach Al Wrap @ Selectitoload [v] o Load
Fees Current Ind Level Balance % Analysis Date Asset Current Value Comment
Interfaces N 100.00 02/05/2016
AP Transactions
GL Transactions Analysis
(CASA Reconciliation
peit el || EH saveandadd | [ saveandstay | [ Save and Retum || GaRetum :
* Current Ind Analysis Date Comment Final Analysis  Final Bid
02/05/2016
® ®
*Level *Balance % Nene . :ine
> 100.00 1
Asset Current value Bid3
[~] w0
Analysis
Analysis 1 Analysis 2 Analysis 3
Seles 000 0.00
Bxpense 0,00 0.00
Refunds 000 0.00
Net Proceeds
> Collections Blics” 7505 -
> WEP Net Gain/Loss
> Tools Recovery %
> Setup Analysis By v

4. Inthe Analysis section, select the Current box if you wish to indicate that this is current
analysis worksheet.

5. In the Analysis section, use the Level field to select analysis level you want to use,
ACCOUNT or ASSET.

— Select Account if you want analysis to use value of the entire account.
- Or -
— Select Asset if you want analysis to use the value of a particular asset.

6. In the Analysis section, enter, view, or edit the following information:

In this field: Do this:

Current Ind Current Indicator. Select the check box if analysis is current.

Level Select the Analysis level from the drop down list.

Balance % Specify balance allocation percentage.

Analysis Dt View the analysis date.

Current View the asset current total value.

Value

Asset If you want to perform an analysis for a particular asset, select the asset.
Comment Specify comment associated with the analysis.

7. Specify all the required information in Analysis or Bid section, depending on the type of
incident you are analyzing.

8. Complete the details in Expenses and Refunds sub screens, corresponding to analyze
or bid number on the Analysis screen. The data here is loaded to the analysis and bid
columns as ‘expenses’ and ‘refunds’.
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— To complete the Expenses sub screen:

In this field: Do this:

Expense Type Select the expense type.

Manual Indicates that the expense was entered manually.

Analysis1 Amt | Specify the expense amount for analysis1.

Analysis2 Amt | Specify the expense amount for analysis2.

Analysis3 Amt | Specify the expense amount for analysis3.

Bid1 Amt Specify the expense amount for bid1.

Bid2 Amt Specify the expense amount for bid2.

Bid3 Amt Specify the expense amount for bid3.
— To complete the Refunds sub screen:

In this field: Do this:

Refund Type Select the refund type.

Manual Indicates that the refund was entered manually.

Analysis1 Specify the refund amount for analysis1.

Amt

Analysis2 Specify the refund amount for analysis2.

Amt

Analysis3 Specify the refund amount for analysis3.

Amt

Bid1 Amt Specify the refund amount for bid1.

Bid2 Amt Specify the refund amount for bid2.

Bid3 Amt Specify the refund amount for bid3.

Select the Corresponding Analysis/Bid to Load details Maintained in the Expense and Re-
fund sections.

9. Repeat steps 4 to 8 with information regarding other repossession/foreclosure or sales
analysis.

10. In Status field, select status of the analysis: APPROVED or REJECTED.

11. When you have decided which analysis or which sale bid you want to approve, select your
choice in either the Final Analysis or Final Bid section.

Note

You can approve only one analysis. Based on Analysis approved on ‘Save And Return’
Corresponding Radio button will be enabled in the Final section of Analysis details.

12. Click Save.
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4.10.5

4.10.6

4.11

Call Activities sub tab

Call activity section includes calls from customer, calls you make regarding the account or
changes to the condition of the account. Entries in the Call Activities section are listed in
reverse chronological order of follow-up date.

For details on how to Record a Call Activity, refer Call Activities sub tab section in “Customer
Service screen’s Customer Service tab” section.

Comments sub tab

Oracle Financial Services Lending and Leasing enables you to record comments on the
Customer Service screen using Comments tab. These comments also appear under the
Comments sub tab.

For details on how to Record a Comment, refer Comments sub tab section in “Customer
Service screen’s Customer Service tab” section.

Due Date History sub tab

The Due Date History tab section provides a delinquency history, by payment, by displaying
a history of all due dates, along with when actual payment was made for that due date and
the subsequent balance. If a payment was delinquent, Due Date History section displays the
number of days the customer was delinquent against each due date.

For more details, refer Due Date History sub tab section in “Customer Service screen’s
Transaction History tab” section.

Customer Service screen’s Deficiency tab

The Deficiency screen enables you to record information about deficiency accounts i.e.
accounts that are no longer collectable. You can create and track specific details on status of
the charged-off account for timely follow-up and analysis. You can also track each stage of
the deficiency process based on its follow-up date and record information using the Details
and Tracking sections.

The Add button enables you to create a new deficiency record with different start and end
dates. You can also use the Deficiency Details screen to view deficiency information. The
Current field in Deficiency Details section indicates the current bankruptcy details. To view
the balance of a charged off account, click the Transaction History tab on Customer Service
screen, then click Balances. On the Account Details screen’s Balance Group section, click
Deficiency. For more information on Deficiency Balance, see Balances sub tab section in this
chapter.

When a Deficiency condition is opened on an account, the system defaults a detailed tracking
record with ‘Current’ field enabled and ‘Follow up date’ defaulted to system date. The
‘Disposition’ is defaulted as ‘NEWLY RECEIVED’. The system only adds a new detail tracking
record. No processing will be done with respect to the detail tracking record when the
deficiency condition is closed.

To enter deficiency details for an account

1. Open the Customer Service screen and load the account you want to work with.
2. Click Deficiency tab.

3. Inthe Deficiency Detail section, select the deficiency record you want to work with

_0 r'_
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4. Click Add to refresh the Deficiency screen to create a new record.
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5.

In the Deficiency Detail section, enter, view, or edit the following information:

In this field:

Do this:

Current

Select to indicate this is the current deficiency record.

Followup Dt

Specify the follow-up date for the deficiency.

Disposition

Select the deficiency disposition.

Type

Select the deficiency type.

Comment

Specify a comment.

File Received Dt

Specify the file received date for the deficiency.

Charge Off Dt

Specify the deficiency start date.

Deficiency End
Dt

Specify the deficiency end date.

6. Click Save.
7.

In the Tracking section, click Load Tracking.

The system loads deficiency tracking parameters that track actions taken to collect on the

account.

field.

If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the parameter display.

9. Complete the Tracking section by entering information regarding deficiency in the Value
field for each corresponding Parameter, then click Save.
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Call Activities sub tab

Call activity section includes calls from customer, calls you make regarding the account or
changes to the condition of the account. Entries in the Call Activities section are listed in
reverse chronological order of follow-up date.

For details on how to Record a Call Activity, refer Call Activities sub tab section in “Customer
Service screen’s Customer Service tab” section.

Comments sub tab

Oracle Financial Services Lending and Leasing enables you to record comments on the
Customer Service screen using Comments tab. These comments also appear under the
Comments sub tab.

For details on how to Record a Comment, refer Comments sub tab section in “Customer
Service screen’s Customer Service tab” section.

Due Date History sub tab

The Due Date History tab section provides a delinquency history, by payment, by displaying
a history of all due dates, along with when actual payment was made for that due date and
the subsequent balance. If a payment was delinquent, Due Date History section displays the
number of days the customer was delinquent against each due date.

For more details, refer Due Date History sub tab section in “Customer Service screen’s
Transaction History tab” section.

Customer Service screen’s Collateral tab

The Collateral screen displays information regarding any assets associated with an account.
Collateral can be a vehicle, home, or something else, such as household goods. The
Collateral screen contains the Home and Seller sub tabs. To view the collateral details

1. Open the Customer Service screen and load the account you want to work with.
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2. Click Collateral tab. System displays the following screen:
If the account’s collateral is a vehicle, the Collateral screen opens at Vehicle tab:

Summary  Customer Service  Account Detalls  Customer Detalls  Transaction History  PmtModes  Bankmuptcy  Repo/Foreclosure  Deficiency  Collateral  Bureau  (Cross/Up Sell Activities
Vehlcl% Seller
Vehicle
paid || Jedt | Fuew | Lt
View s Fomity B Feeze [ Detech we @
Primary Description Status Asset Type Lien Status Lien Event Date  Second Lien Holder Comments Lien Release Entity ~ Entity Name Identfication # Year Model Cond
i 0 ACTIVE I UNDEFINED CUSTOMER 0 GOO
N 0 SUBSTITUTED ~ IC NEW CUSTOMER 0 600
N 0 SUBSTITUTED ~ IC LIEN PERFECTED CUSTOMER 0 600
( »
1
Valuation  Tracking
Value Podd || Zeit | Juen | Lot
View v Fomat v E' Freeze ‘{fDeta[h Wiep @ﬂ
Current Source Edition Valuation Dt Supplement Wholesdle Base Usage Retail Amt ~ Addons Amt (+) Usage\/a\uem Total Amt =
No data to display.
{ »
Addons Ben it
View» Format » E} Freeze ﬁDetenh Wiep m
Addong/Atributes Value Amount
No data to display.
{ »
’ H .
— If account’s collateral is a home, the Collateral screen opens at the Home tab:
Summary ~ Customer Service  Account Detalls  Customer Detalls  Transaction History  Pmt Modes  Bankmuptcy ~ RepofForeclosure  Deficiency  Collateral | Bureau  Cross/Up Sell Activities
Homebsd\ew
Home
o pdd /'gd\t S View | o Audit
View v Format v % Freeze HDetarh Wrap m
Primary Description Asset Class Ascet Type Sub Type Occupancy Lien Status Lien Event Date  Second Lien Holder Comments Lien Relezse Entity  Entity Name Identificztion #
[ I
¥ 012 USED HOME HOME SINGLE FAMILY H UNDEFINED 2GAWS52115111.. 7
{ 12
q
Home
BsweandAdd Esweandstay BiaveandRetum @&etum
Type & Description Lien Details Deed Details
Primary ¥ Lien Status v Constuction Permit Dt )
Substtution ¥
Lien Event Date
hst 0 ) Deed Dt [729
* faset Class Second Lien Holder Plece of Issue
* Asget Type Comments Property Boundaries From East
*SubTe Lien Relezse Entity CUSTOMER v North
Occupany Entity Name b South
Cents it/ BNA Cod ]
£nsus Tract / ode P
MEA Code Wl
GEQ Code Widh
Status ACTIVE Length * Country UNITED STATES v
Select Make and Model z Area County Y
*Year 0 Legal Description * Address # 0
i ot " dddsling 1 i
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— If account’s collateral is neither a vehicle nor a home, the Collateral screen opens
at the Other Collateral:

ORACLE 1§ Welom, OFSUUSER ~ presshity 1§ sinat O
% Financial Services Lending and Leasing
Close
 Dashbard Customer Service x ®a
> Origination Seath Customer Service: 0160100010874 | Feven Request (Pending: 0)
Senicing
e Account(s): 20160100010874: BROAD STUART / SMITH EDWIN Elview | & auic
Customer Senice Viewe Pomaiv [ (] 7eme HDetach wa @ B @ cumen: O ShowAll O Group Folowup
FEava Company Brerch Sub Unit Accoun: £ Freduct Days Past Due Cuncy PayOF Art  Amoutt Due Stetus Oldest ue Dt
Transection Atborzation usat sy UNDEFINED 0150100010874 LDAN SECURED AQUSEHDLD 600, 18150 50783 000 ACTIVE 12202016
Post Dte Cheds
Esao Tasadtions
Sunmary | Cusiomes Senice Accourt Detals | CustomerCecalls | Tranactior sty | Prtodss | Baleuptey | RepojPoredosue | Deficency | Collateral | Bureau Crossfup sell Activtes
Aot Coments
Coliter!Hanscenent premy .
Reperts
Prodces
Vencors Collateral Information
tch Transctone | Jut| Evev| S ust
::";“ Views Fomaty B ([[freze Howa v @
e Frivary Substiution  Descrpton AssetClass Asset Tpe SubTe LienSatis lienBertDate  SecordLentolder Coments Lien lezse itty Entybame  Henffition s Regitition s Salus
¥ ¥ UIDEFINED
o Y N 23 CHERCLS VEHIIE UDEFINED CISTONER TBAGRSGIITS . RGN ACTIVE
a Tiactons £
cash Reconcliaton
oy ot i Collateral Information
B saveantaic | [ sseandstay | [ SaveandRetum | GaRetim ‘
Type & Descrition Descrpton Sta )
—_— * conitin i Tt 3
Sustttion ¥ * charge 20000
i Lien Detais
v Address
Lie Satus v
Lien BertDate d * Contry UNTTZDSTATSS
v
Second lien Hlder Couny
Conmerts Address #
Lien lezse ity CUSTONER M AdhessUne 1
Seect Nace end Hodel
Bt ame " Adress e 2
Year ©
P43
Hele Usae Details
Zpkin
Woid
g Giy
enfiction ¢ Bl ;
> Collections Bt 0 sate
ey v
> WP
valuation | Trzcang
> Tools
RS Valia S| Aew i

Clicking on Asset # in the Vehicle sub tab takes you to Collateral Management screen
opening respective collateral. You can modify the details on Collateral management screen
by clicking on ‘Edit’ and saving the record.

The system displays a warning message if the Collateral Management screen is already
open.

4.12.1 Valuation sub tab

With the Valuation sub screen, you can view the collateral or asset valuation for an account.

To view the collateral or asset valuation for an account
1. Open the Customer Service screen and load the account you want to work with.

2. Click Collateral tab and then Valuation.

3. Click the Valuation sub tab to view the following information:

In this field: View this:

Value section

Current Select if this is the current valuation.

Valuation Dt The valuation date of the vehicle.

Source The valuation source.

Edition The valuation edition.

Supplement The valuation supplement.

Wholesale section
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In this field:

View this:

Wholesale Base

The wholesale value.

Usage

The usage. This pertains to Lease and usually is entered as the cur-
rent mileage.

Retail section

Retail Amt

Specify the retail base value.

Addons Amt (+)

The add-ons value.

Usage Value
Amt (+)

The usage value; that is, the monetary effect that current mileage
has on the value of vehicle.

Total Amt (=)

The total value.

Addons section

Addons/Attrib- Select the add-on/attribute.
utes
Value The value of the attribute.
Amount The add-on amount.

Note

Assets can have exactly one current valuation.

Tracking sub tab

With the Tracking sub screen, you can view collateral or asset tracking details to an account,
such as the location of title, liens, and insurance information.

To view the collateral or asset tracking for an account

1. Open the Customer Service screen and load the account you want to work with.

On the Customer Service link bar, click Collateral.

2
3. On the available screen (Vehicle, Home, or Other), click the Tracking sub tab.
4

On the Tracking sub screen, enter, view, or edit the following information:

In this field:

View this:

Tracking Items section

Select

If selected, indicates that this is the current record.

Tracking Item

The tracking type.

Disposition The disposition.
Start Dt The tracking start date.
End Dt The tracking end date.
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In this field: View this:
Followup Dt The next follow-up date.
Comment Comments if any.

Tracking Item D

etails section

Enabled Select to track the information from start date in the Start Dt field.
Parameter The parameter.
Value The tracking parameter value.

4.12.3 Seller sub tab

The Collateral link’s Seller Details screen enables you to view seller details of the collateral of
Lease. You cannot edit or modify details of the seller.

1. In Seller Details section, click View.

2. View the following:

In this field:

View this:

Seller Details

Seller Type The seller type.

Seller Name The seller name.

Nationality The nationality of the seller.

National Id The national Id of the seller.
Authorized Signatory The authorized signatory of the seller.

3. In Seller Address section click View.

4. View the following:

Seller Address

Mailing If selected, indicates that this address is the
mailing address.

Current If selected, indicates that this address is the
current address.

Country The seller’s country name.

Address # The seller’s address.

City The seller’s city name.

State The seller’s state name.

4-78 ORACLE



413

Customer Service screen’s Bureau tab

The Customer Service screen Bureau screen enables you to view credit bureau reports
associated with the account that were pulled during servicing for account. You can also use
the Bureau screen to create and pull additional credit bureau reports and view the results as
a text only file.

To view an existing credit bureau report
1. Open the Customer Service screen and load the account you want to work with.
2. On the Customer Service link bar, click Bureau.

3. Inthe View Report section:
Click Servicing to view credit reports generated with the Customer Service screen.

_Or_
Click Origination to view credit reports generated during Lease origination.

4. In the Bureau Details section, select the report you want to view.

The system displays report as a text file in the Text Report section.
To request a manual credit bureau report
1. Open the Customer Service screen and load the account you want to work with.
2. On the Customer Service link bar, click Bureau.
3. Click Add to open New Request section.
4

Complete the following fields:

In this field: | Do this:

Applicant/ Select the available applicant/customer from

Customer the drop-down list.

Spouse Select the applicant’s spouse from the drop-
down list.

Bureau Select the credit bureau from the drop-down
list.

Report Select the credit bureau report type from the
drop-down list.

5. In the New Request section, click Create Request.

The system displays this information in the Bureau Details section and further information
about customer in Applicant/Customer Detail section.

6. If you want to receive a copy of a previously pulled credit bureau report, enter credit
bureau reorder number in the Credit Bureau Reorder # field on the Bureau Details
section.

7. Click Save.

You can print the report by selecting the report and clicking on Print Report.
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Customer Service screen’s Cross/Up Sell Activities
tab

The Customer Service screen’s Cross/Up Sell Activities tab enables you to view and edit all
the captured marketing trigger based events for respective customers linked primary
accounts.

Oracle Financial Services Lending and Leasing Application has been integrated with a third
party database marketing solutions provider to receive monitoring triggers related to
marketing based call activities. Primarily the active customer details are shared through an
input file and corresponding monitoring triggers data within the processed customer input file
are uploaded back into designated location of OFSLL database through an automated
interface.

The Customer Service screen’s Cross/Up Sell Activities tab displays the first 10 marketing

trigger based call activities with the opportunity details and follow-up requirements. You can
select View All check box to view all the ‘active’ and ‘closed’ call activities.

Edit Cross/Up Sell Activity
To edit a reported Cross/Up Sell Activity

1. Open the Customer Service screen and load the account you want to work with.
2.  On the Customer Service link bar, click Cross/Up Sell Activities.

3. Select the record which you want to update and click Edit.
4

Complete the following fields:

In this field: Do this:

Trigger Dt View the date on which the activity has been recorded.
Product Select the product from drop-down list.

Trigger Action View the trigger action captured.

Trigger Description | View the description of the action.

Result Select the result of the action from the drop-down list.
Reason Select the desired reason for the result selected.
Appn'mnt Select the check box to indicate if a prior appointment is required

for next communication.

Followup Dt Select the agreed follow-up date from the adjoining calendar
icon.

Close If there is no follow-up and the opportunity is closed, you can
select this check box indicating the status of call activity as
closed.

Time Zone Select the time zone of the contact from the drop down list.

Comments Specify additional information, if any.

5. Click Save and Stay or any other save option as explained in Basic Actions section.
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4.15

Create Simple Application

You can use the call activity data and directly initiate the Lease Origination process from
Cross/Up Sell Activities tab.

To create simple application
1. Open the Customer Service screen and load the account you want to work with.
2. On the Customer Service link bar, click Cross/Up Sell Activities.

3. Select the required call activity record and click Create Simple Application.

The system opens Origination > Simple Application Entry screen with Application
section capturing the details of call activity.

You can enter/edit the required details and continue creating credit application data into
Oracle Financial Services Lending and Leasing Application.

For detailed information, refer to Simple Application Entry chapter in Lease Origination User
Manual.

Close Opportunity

You can close an opportunity based on the response received from customer and if there are
no follow-ups required. However, you can close an opportunity and de-link the same from an
account only when all the records are closed.

To close an opportunity
1. Open the Customer Service screen and load the account you want to work with.
2. On the Customer Service link bar, click Cross/Up Sell Activities.

3. Ensure that all the records are marked as closed and click Close Opportunity.

Review Request

The Review Requests page is primarily a work flow tool used to flag an account or an
application for the attention of another Oracle Financial Services Lending and Leasing user
and ask for feedback. It allows the system users to send and receive requests (including e-
mail) commenting on a specific account or application.

In this chapter, you will learn how to compete the following tasks:
e Reviewing a request
e Sending a review request
e Responding to a review request
e E-mailing a Review Request
e Closing a review request

Note the following:

e You can complete the above tasks for an Account Review Request using Review
Request page in the Servicing master tab.

e To complete the above mentioned tasks for an Application Review Request, use
Review Request page available in the Origination master tab.
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Review Requests Tab

The Review Requests page contains the following sections:

e Query Section

e Action Section

e Email Section

e Review request records

e Comments Sections

Query Section

The Query section enables you to filter records according to priority levels i.e.high, normal or
low based on any of the following:

Query _

Options Descriptions

Originator Displays the records of all the active review requests you created.

Receiver Displays the records of all the active review requests you received.

Both Displays all the review requests records you have created as well
as received with the status other than ‘CLOSED’.

View All Displays all the review requests records you sent and received,
both active and closed.

Action Section

The Action section enables you to send, respond or close the review request.

Action Options

Descriptions

Open Applica-
tion/Account

Opens the application details page to review the request. (if you
open it from origination it's application and if from servicing den
account)

Send Request

Sends a review request to another Oracle Financial Services Lend-
ing and Leasing user.

Send Response

Sends a response to a review request from another Oracle Finan-
cial Services Lending and Leasing user.

Close Request

Changes the status of review request to CLOSED and removes its
record from the Review Request page. The status can be viewed
by selecting ‘View All’ in the ‘Query’ section.
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Email Section:

The Email section enables you to send an email to either originator or receiver of the review
request which cannot be responded or replied back from email recipient.

Email Descriptions

Options P

Originator Sends an email of review request information to the person listed in the
Originator column on Review Request page.

Receiver Sends an email of review request to the person listed in the Receiver
column on Review Request page.

Comments Sections

The Comments section enables originator or receiver to specify additional information that
needs to be sent with the request.

Comments iy

Descriptions
From
Originator Displays comments specified by the originator of review request at the
Comment time of creating a request.
Receiver Displays comments specified by the receiver of review request at the
Comment time of reviewing a request.

4.15.1.1 Reviewing a Request

System displays the priority and the number of requests ready for review, if any, for your user
id at My Pending Review Requests By Priority section in the Servicing Dash Board

ORACLE’ . . . & Welcome, PRAKRRAO =  Accessibility o
Financial Services Lending and Leasing
e —— DashBoard s 36 Qlose
DashBoard
DashBoard Origination Setup Admin
Users Productivity
System Monitor My User Queues Product Expiring in Next One Month Critical Batch Job Status
Producer Analysis Description Count Product End Date Batch Job Status
Process Files No data to display. No data to display. No data to display.

> Origination
> Servicing
> Collections
> WEFP

> Tools

»» Setup

My Pending Review Requests By Application:
App # Priority
No data to display

My Pending Review Requests By Priority
Priority Count
Na data to display

< >
F Servicing Producer Vvendor
Number of Queues Hard Assigned
Queue Description Count. A Producers Count By Status Vendors Count By Status
No data to display. Status Count Status Count
ACTIVE 82 ACTIVE 35
Number of Accounts
Queue Description Count Producers Expiring in Next One Month Vendors Expiring in Next One Month
Pl ey & ety Producer End Date Company Name End Date
No data to display. No data to display.

My Pending Review Requests By Accounts
A Priority
No data to display.

My Pending Review Requests By Priority
Priority Count i

& =
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To review requests

1. On the Oracle Financial Services Lending and Leasing application home page, click
Servicing main tab and then click Servicing drop-down link. Click Customer Service

link.

The Customer Service window appears, opened at the Results tab. Under Customer
Service screen, click Review Requests tab.

2. In the Query section, click Receiver.
In the Review Request record, the system displays all open review request you have re-

ceived.

ORACLE’

Financial Services Lending and Leasing

RAKRRAQ ~  Accessibility Q

DashBoard
> Origination
Servicing
Servicing
Customer Service
Securitization
Transaction Authorization
Post Date Checks.
Escrow Transactions
Account Documents
Collateral Management
Reports
Producers
Vendors
Batch Transactions
Advances
Payments
Fees
Interfaces
AP Transactions
GL Transactions
CASA Reconciliation
Conversion Accounts

> Collections
> WEFP

> Tools

> Setup

Customer Service »

Search | Customer Service  Review Request (Pending: 0)

Review Requests

. Action

® originator O Receiver O Both \‘ZI\ o

View = Fomat~ P Freezz i Detach
Priority

Originator
No data to display.
<

Originator
Comment

Wrap

Receiver

Send Request

Receiver
Comment

3 Cose

At || Eview || 2 Audit

Email

% Close Request

Account £ Reason Status
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3.

following screen is displayed.

ORACLE’

Financial Services Lending and Leasing

In the Review Request record, select the record you want to view and click View. The

& Welcome, PRAKRRAQ ~  Accessibility (]

> Collections
> WFP
> Tools

> Setup

S Customer Service [ Close
> Origination Search  Customer Service Review Request (Pending: 0)
Servicing
Servicing Review Requests deadd | Lede | Fvew | o aud
Customer Service Query i i
Securitization
Transaction Authorization £} onginator O Receiver O Both \"i‘}" O 1 Open Account [B Send Request [3% Clos= Request 5 Originator Recsive
Post Date Checks X
FE e e View~ Formats [Ep Freeze it Detach ol Wrap (5]
Account Documents Originator Priority Receiver Account # Reason Status
Collateral Managemant
Reports PRAKRUTI RAG HIGH ARATHI KRISHNA KUMAR REVIEW TRANSACTIONS NEW
D
Producers PRAKRUTI RAG HIGH ABHISHEK LODHA REVIEW PROMOISES WAITING FOR RESPON¢
Vendors <
Batch Transactions
Advances
Payments
F;es Review Requests
Interfaces
P [ sove and Add Save and Stay || [ Save and Return || 3 Retum
GL Transactions ) _
CASA Reconciliation Rl = ccount £ - Status
Conversion Accounts # = Priority | P = Dl
Receiver
Comment
< >

4. For the selected Review Request record, view the following information:

Fields Descriptions

Originator The user id of the request originator.

Priority The request priority: HIGH, NORMAL, or LOW.

Receiver The recipient of the request.

Account # The account number which needs review.

Transaction The transaction selected.

Reason The review reason.

Status The request status.

Date The date and time when the request was created.

Originator Com- The comment by the originator which creating a

ment request.

Receiver Comment | The comment by the receiver after reviewing a
request.

Note

If you click Open Account, system loads the accountin review request and displays the

Account Details page.
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4.15.1.2 Sending a Review Request

The Send Request button enables you to send a review request to another the system user.
However, the Send Request button is enabled only if you have specified the receiver while
creating a review request and have saved it.

To send a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click the
Servicing main tab and then click Servicing drop-down link. Click Review Requests tab.
2. IntheReview Requests page in the Query section, select Originator.
3. Click Add to create a new review request. The following screen is displayed:
ORACLE’ & Welcome, PRAKRRAO ~  Accessibili
Financial Services Lending and Leasing R il =
DashBoard Cutslomer permo [ Close
_» Origination Search  Customer Service  Review Request (Pending: 0)
Servicing
Seriicing Review Requests e add | ZEdt view || < Audi
Customer Service Query Action Email
n Authorization {8 Originator() Receiver () Both \"z"'}; O (2] Open Account [ send Request | | [ send [ Close Request 5 Originator Rex
:f,t;;r;:jkzﬁ View v Formatw  [Ep Freeze () Detach Wrap ®
‘Account Documents Originator Priority Receiver Account & Reason Status
Collateral Management
Reports < >
Producers
Vendors
Batch Transactions
Advances Review Requests
::::em EHsveandadd | B ssveand sty || [ saveand Retum | Ga Retum
L * ot # e e
T pici B = osie 626
Conversion Accounts f J—
< >
> Collections
> WFP
> Tools
> Setup
4. In the Priority field, select the priority of review request: High, Normal, or Low which
helps the recipient in responding to requests. It does not affect the order in which
messages are sent or received.
5. In Receiver field, select the person you want to receive the message.
6. In Account # field, select the account involved with the review request.
The default value NEW appears in the Status field.
7. In Reason field, select the purpose for the review request.
8. In Originator Comment field, specify any additional message you want to send along
with the review request.
9. Click Save And Add/Save And Return.
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The review request is created and Send Request button is enabled in the Action section.

RACLE"
Financial Services Lending and Leasing

Review Requests

o Colloctions
> wee

> Touls

o setus

10. In the Action section, click Send Request.

The system sends your request to the recipient’s, where it appears on My Pending Re-
view Request window in Dash Board with status SENT TO ORIGINATOR.

Responding to a Review Request

When you receive a review request, the system notifies you by creating an entry in My of
Pending Review Requests By Priority section in Dash Board with the number of unseen
messages. In the following example, one review request is waiting on the Review Request

ORACLE ] ) [ 2, Welcome, PRAKRRAD v Accessibilty [=}
Financial Services Lending and Leasing
Close
e DashBoard » (dd
DashBoard
DashBoard Origination Setup Admin
Users Productivity
System Monitor My User Queues Product Expiring in Next One Month Critical Batch Job Status
Producer Analysis Description’ Count. Product End Date Batch Job Status
Process Files No data to display. No data to display. No data to display.

My Pending Review Requests By Applications
App ¥ Priority
No data to display.

My Pending Review Requests By Priority
Priority Count
No data to display.

<€ >
q Servicing Producer Vendor
Number of Queues Hard Assigned
Queus Description Count.  Producers Count By Status Vendors Count By Status
Mo data to display. Status Count Status Count
ACTIVE 82 ACTIVE 35
Number of Accounts
Queue Description Count Producers Expiring in Next One Month 'Vendors Expiring in Next One Month
No data to display. Producer End Date Company Name End Date
No data to display. No data to display.

My Pending Review Requests By Accounts
Bc# Priority
No data to display.

My Pending Review Requests By Priority
> Origination Prio Count ™
> Servicing i >
> Collections
> WFP

> Tools
> Setup

To respond to a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing main tab and then click Servicing drop-down link. Click Customer Service
link. If the Number of Pending Review Requests tab displays a number, click Review
Requests tab. On the Review Request page Query section, select Receiver.

The system displays the unread review requests in Review Request record.
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2. In the Review Request record, select the record you want to view and click View.

ORACLE.
Financial Services Lending and Leasing

Search | cusmmerSanics | Review Request (Pending: @)

Requests
T e mod At || 5 e o St || B Sve i Romumn || 3 Behen

Date 02/C

© Collections
> wer

o Tools

> setup.

3. Click Open Account.
The system loads the account on Customer Service screen and displays Account Details
page.

4. Perform requested task on review request on the account. Click Review Request tab and

selecting request, click Edit. Specify your response in the Receiver Comment field. Click
Save And Return.

Financial Services Lending and Leasing
i Close
e Customer Service 3, [Eife
> Origination Search | Customer Service  Review Request (Pending: 0)
Servicing
Senvicing Review Requests =k add | 7 Edit it
Customer Service Query Action Email
Securitization
Transaction Authorization @® OriginatorD) Receiver O Both \"ij; O (2] Open Account [ send Request [ send Response [ Close Request & Onginator (5 Recaiver
Fost Date Checks =
Escrow Transactions View » Fomate [ Freeze i Detach ol Wrap @
Account Documents Originator Priority Receiver Account # Reason Status
Collateral Managemant PRAKAUTI RAD HIGH ARATHI KRISHNA KUMAR 2015080014267 REVIEW TRANSACTIONS NEW
Reports PRAKRUTI RAQ HIGH ABHISHEK LODHA 20150900014267 REVIEW PROMOISES WAITING FOR RESPON:
Producers < >
Vendors
Batch Transactions:
Advances
::""‘E”:S Review Requests
=
vy [ save and Add Saveand Stay || [ Save and Retum || Ga Retum
AP Transactions
GL Transactions Ongamdor PRAYEUTIRAG Account # 20150900014267 Status NEW
CASA Reconciliation Priocty HIGH Reason REVIEW TRANSACTIONS Datz 02/04
Conversion Accounts B *Receiver ARATHI KRISHNA KUMAR =
Originator Receiver
Comment Comment
< >
> Collections
> WEP
> Tools
> Setup

5. In the Action section, click Send Request.

The system sends your response to the originator, where it appears on Review Request
page with status RETURN TO ORIGINATOR.

The recipient can view sent response by clicking Receiver or View All in Query section.
(The request has a status as RETURN TO ORIGINATOR.)

6. In the Action section, click Close Request

It will remove the message from the Review Request section.
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4.15.1.5

Back on the originator's Review Request page, the message appears when Originator is
selected in Query section. The request has a status as RETURN TO ORIGINATOR.

E-mailing a Review Request

While system updates My Pending Review Requests By Priority section in the DashBoard
to notify you about the new requests, you can also e-mail a review request to both the
originator and a receiver, as applicable. The system will use e-mail address recorded for both
the originator and receive in User Definition section in User page.

To e-mail a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing main tab and then click Servicing drop-down link.

Click Customer Service link.
On the Customer Service link, click Review Requests tab.

Select the request you want to e-mail in the Review Request section.

o > 0D

In Email section, click Originator to send the message to the person listed in Originator
field.

_0 r'_

Click Receiver to send it to the person listed in the Receiver field.
The system emails the details of selected record to e-mail address recorded in user setup.

Closing a Review Request

You can close a review request you created at anytime, regardless of status. However, you
can only close review requests that have your user id in the Originator field. When you close
a review request, the system removes it from Review Request record.

To close a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing main tab and then click Servicing drop-down link.

Click Customer Service link.
On the Customer Service link, click Review Requests tab.

Select the request you want to close in the Review Request section.

o M 0N

In the Action section, click Close Request.
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The system assigns the request as CLOSED and removes it from your Review Request
record. The closed accounts can be reviewed anytime by selecting View All in the Query
section.

orpacte & Fumeem
Financial Services Lending and Leasing

Curstomer service s 3] Close

Search | Custumer Ssivis | Review Request (Pending: 0)

Review Requests < Audi
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5.1

5.2

5.2.1

5. Collections

Introduction

After an application has cycled through the Lease origination process, it becomes an account.
Account maintenance and collections tasks can be performed with Oracle Financial Services
Lending and Leasing’s Collection screen.

The Collection screen enables you to view and manage all customer information in a
centralized location to ensure data integrity and provide better service. Oracle Financial
Services Lending and Leasing provides online real-time information about the applicant(s),
contract, account balances, dues, transactions, call activities, and comments. Oracle
Financial Services Lending and Leasing also supports back-dating of financial transactions till
the account’s opening date.

Activating an Account

An account is automatically activated when you fund the contract using Funding main tab or
convert from a legacy system.

Posting and Reversing Payments

A payment can be posted and reversed on the Payments screen.

Account Mask

After an application completes the Lease origination cycle and is funded or is ported into the
system, it becomes an account and receives an account number. The system assigns
account numbers using the following logic:

YYYYMMNNNNNNNX

where:

YYYYMM = contract date

NNNNNNN = serial number

X = check digit

The system sorts accounts using the NNNNNN portion only. That portion is referred to as the
account ID.

Search Tab

There are two types of search available.

e Account
e Customer

Searching for a Customer or Account

There are a number of different ways to load customer details on the Collections screen.

e Use the Search screen by selecting Customer Centric option(s).
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5.3

5.4

e Use the Quick Search section to search for the customer by Account Number, or
Customer Id, or by specifying the last four digits of Primary SSN (SSN of the primary
applicant).

e Use the Next Account feature to load the customer from a predefined queue.

For details on how to search and load the customer or account details using Search screen,
refer Search Using Customer Details section in Search Function chapter.

Customer Service screen

Most screens on the Customer Service screen contain the Account(s) and Customer(s)
sections as a header. The Account(s) section provides a quick overview of an account by
displaying its company, branch, account number, product, payoff amount and amount due,
status, and oldest due date. The information on Customer Service screen always refers to the
account selected in this section.

The Customer(s) section displays information about customer(s) attached to the account. The
information on Customer Service screen always refers to the customer selected in this
section.

To view account details in Account(s) and Customer(s) sections, open the Collections
screen and load the account you want to work with.

For details on this screen refer Customer Service screen section in Customer Service
chapter.

Customer Service screen’s Summary tab

Open the Collections screen and load the account you want to work with. By default the
Customer Service screen opens the Summary tab.

oRacte

Financial Services Lending and Leasing

(%] Close
" Collections El
 Origination Search  Customer Service, | Review Request (Pending: 0)
> Servicing
Collections Account(s) Elview | & auit
ol View~ Fomat~ [ Freeze fiDetach | ¢l Wrap W a Current () Show All ©) Group Follovi-up
ollections
Collections Company Branch Sub Unit Account # Product Das Past Due Currency Pay OFf Amt Amount Due Status Oldest Due Dt
Bankuptey o data to display.
Repossession
Deficency Summary | Customer Senice | Account Detais | Customer Details | Transaction History| Pt Modes | Bureau | Cross/Up Sel Acivites
Reports
Producers
o Alerts Conditions
Alerts Conditions
Alert Condition Start Ot Followup Dt
Mo data to display. Mo datato display.
4 Account Details Other Information
i
Dues .
Customer Information
Mo data to display. Customer e Relation s Birth Dt Gender
o data to display.
Delq Due Total Due Future Pmt Dt b
LC Due Todays Payoff Oldest Due Dt
NSF Due Future Payoff Amt Paid Excess
Other Due Future Payoff Date Email Disability Privacy Opt Out
" formati Languzge Ship Active Hiltary Duty
Delinquency Information Varita Status Stop Time Zone
Late 30 60 %0 120 150 180 Category Days Correspondence
o data to display.
BP(Life) NSF{ufe) Collector Address Information
BP[Year) NSF{Year) m Permissi |
Type Cument (" ailng. Address Phone
Activities Mo datato display.
Active Dt App ¥ Last Pt Amt
5 WFP Last Activity Dt Paid Off Dt Charge Off Dt Employment Information
Due Day ffective Dt il y permissi
» T Current TS Eploy Address Ph
Tl Last Pt Dt Curtent Pt Customer Score ko] I [hg Call s i
> Setup Customer Grade Last Bill Amt Behaviour Score o data to display. -
=
Copyright © 1998,2016, Oracle and/or its affliates. All ights reserved. ‘About
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5.5

5.5.0.1

5.6

5.6.1

For details on this screen refer Customer Service screen’s Summary tab section in Customer
Service chapter.

Customer Service screen’s Customer Service tab

Open the Collection screen and load the account you want to work with. Click the Customer
Service tab to view the sections under it.

Recording a Call Activity

To record a call activity
1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Service sub tab and then click Call Activities tab under it. Click Add.
The system displays the following screen.

"ORACLE"
Financial I Services Lending and Leasin g

xxxxxxxxx

nnnnn

For details on this screen refer Customer Service screen’s Customer Service tab section in
Customer Service chapter.

Customer Service screen’s Account Details tab

Open the Collections screen and load the account you want to work with. Click the Account
Details tab to view the sections under it.

Account Details sub tab

Oracle Financial Services Lending and Leasing enables you to view account details using
Account Details sub tab.
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5.7

In the Account Information section click View.

ORACLE
Financial Services Lending and Leasing

e Collections x ez
> Origination Search | Customer Service: 2015090014283 | Review Request (Pending: 0)
> Servicing
T Account(s): 20150900014283: RODRIGUEZ ROBINSON Elyew | oAt
View v Format~ [ freeze fffiDetach | ol wrap W@ & © Current Show Al Group Follow-up
Company Branch  SubUnit  Acc Dav= RSt cumrency  Pay OFf Amt Amount Due Status Oldest Due Dt
usor  UsiQ  UNDEFL. 20 114 UsD 15,158.10 4,295.60 ACTIVE:DELQ  10/05/2015
Summary y || Customer Account Details | Customer Details | Transaction History || PmtModes || Collateral | Burcau Cross/Up Sel Activities
Account Details | Statements || Rate Schedule < | Contract Informaton
Account Information Elven || < Audt
Vew~ Format~ B Freeze  ffiDetach wrap
#ofExtensons = ofExtensions * of Extension Term = of Extension Term # of Due Day Zofbuebay | o e ey o e
Crear) wife) (vear) i) changes(Year) changes(uife) L5t Extn Dt D= Day ChangenE Total T
o o o o o o 15
Pl i
<

Account Information

Extn and Due Dates Additional Details
) 0 Total Term 15

Maturity Dt 11/05/2016

> wre
> Tools
> Setup Ly

For details on this screen refer Customer Service screen’s Account Details tab section in
Customer Service chapter.

Customer Service screen’s Customer Details tab

Open the Customer Service screen and load the account you want to work with. Click the
Customer tab to view the sections under it.

Information gathered on the application entry process regarding the customer and customer’s
address, employment data, and phone numbers appears on the Customer Details screen.
Using the Customer Service screen’s Customer Details tab, you can update or add to a
customer’s address, employment information, or phone listing. All the information about the
customer can be changed using Maintenance screen.

To view or edit customer information
1. Open the Customer Service screen and load the account you want to work with.
2. Click Customer Details sub tab.

ORACLE
Financial Services Lending and Leasing

> DashBoard it ] Bl e
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Collections Company Branch  Sublnit  Account % Product D2VE P2t Gurrency  Pay OFF Amt Amount Due Status Oldest Due Bt
Barkruptey No data to display.
Repossession 9 - i
Deficency
Reports
ProdicS Summary | Customer Service || Account Detals | Customer Details | Transaction History || PmtModes || Bureau || Cross/Up Sel Actiities
Vendors
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Customer Information 3
2 Edit = vie: o Audit
vew s Fomatv | B | [llFee= fMoelcn | Jdwap | @
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“ Ne data to dsplay.
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Customer Information
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Customer =
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Name Expiry Dt
Birth Dt Visa # FATCA
Marital Status Nationaiity .
Enabled National ID P tiplce
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ilitary Service
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5.8

5.9

5.9.1

For details on this screen refer Customer Service screen’s Customer Details tab section in
Customer Service chapter.

Customer Service screen’s Transaction History tab

Open the Customer Service screen and load the account you want to work with. Click the
Transaction History tab to view the sections under it.

For details on this screen refer Customer Service screen’s Transaction History tab section in
Customer Service chapter.

Customer Service screen’s Pmt Modes tab

Open the Customer Service screen and load the account you want to work with. Click the
Pmt Modes sub tab to view the sections under it.

ACH sub tab

If used, the ACH section displays information about automated clearing house and electronic
fund transfers.

To view the ACH information screen
1. Open the Customer Service screen and load the account you want to work with.
2. Click Pmt Modes tab, then click ACH sub tab.

ORACLE"
Financial Services Lending and Leasing

Close
e Collections £

> Origination Search | Customer Service: 20150900014267 | Review Request (Fending: o)

> Servicing

Account(s): 20150900014267: SIGG MARK [El view || o Audit
View v Format~ | B Freez= i Detach = W L&, @ Corrent© Show Al © Gronp Fallow-n
Company Branch  SubUrit  Account & Product &
usol  USHQ 20150300014267 LOAN VEHICLE (FR)

ncy  Pay OFf Amt. Amount Due Status Oldest Due Dt
usD 19,397.24 5,209.00 ACTIVE:DELQ  10/01/2015

Summary | Custamer Sarvies | AccountDatais | Customer Datads | Transschion History | PmtModes | Collstersl | Burssu | Cross/Up Sel Actvities

AcH | Coupon || PostDated Checks || Payment Arrangement

ACH Information

e On Account

> WEP
> Tools
> Setup

For details on this screen refer Customer Service screen’s Pmt Modes tab section in
Customer Service chapter.
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5.10

5.1

Customer Service screen’s Collateral tab

The Collateral screen displays information regarding any assets associated with an account.
Collateral can be a vehicle, home, or something else, such as household goods. The Collat-
eral screen contains the Home and Seller sub tabs. To view the collateral details

1. Open the Customer Service screen and load the account you want to work with.
2. Click Collateral tab. The system displays the following screen:

ORACLE'
Financial Services Lending and Leasing

e Close
> DashBoard o o4 ®
> Origination Search  Customer Service: 20150900014283  Review Request (Pending: 0 -
> Servidng
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Colections Company Branch  Sublnit Account # Product Bays pDajé Currency  Pay OFf Amt. Amount Due Status Oldest Due Dt
z‘:’;::;':;m USOl  USHQ  UNDEFL. 2015030014283 LEASE VEHICLE 114 USD 15,158.10 4,296.60 ACTIVEDELQ  10/05/2015
« 0 v
Deficency
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Vendors
Vehicle = seler
Vehicle
e add | A Edit | [ e < Audt
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Tupe &Description [ Description 2015 AUDI A4 Exrel2
Total 24
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Substitution _ ;
ewtd THD Lien Details i
* Asset Class | NEW VEHICLE [+l s
Lien Status UNDEFINED [= ooy e =
* AssetType VEHICLE [l Lien Event Dat B
DR County NORFOLK [=]
*SubType | AR [ Second ten Holder
Address # 480 NEPONSET ST
*Registration # UNDEFINED e
Status ACTIVE Address Line 1
Lien Release Entity . o
Select Make and Model = Bl esine: Tmenesr
> WFP P Entity Name Zp 02019 -
btk Make ALDI —_—e ZpExn
> Setup Model A4 City BELLINGHAM 15

For details on this screen refer Customer Service screen’s Collateral tab section in Customer
Service chapter.

Customer Service screen’s Bureau tab

The Customer Service screen Bureau screen enables you to view credit bureau reports
associated with account that were pulled during Lease servicing for the account. You can also
use the Bureau screen to create and pull additional credit bureau reports and view the results
as a text only file.

To view an existing credit bureau report

1. Open the Customer Service screen and load the account you want to work with.
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5.12

5.12.1

2. On the Customer Service link bar, click Bureau.

ORACLE’
Financial Services Lending and Leasing
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3. For details on this screen refer Customer Service screen’s Collateral tab section in
Customer Service chapter.

Review Request

The Review Requests page is primarily a work flow tool used to flag an account or an
application for the attention of another Oracle Financial Services Lending and Leasing user
and ask for feedback. It allows the system users to send and receive requests (including e-
mail) commenting on a specific account or application.

In this chapter, you will learn how to compete the following tasks:

e Reviewing a request

e Sending a review request

e Responding to a review request
e E-mailing a Review Request

e Closing a review request

Note the following:

e You can complete the above tasks for an Account Review Request using Review
Request page in the Servicing master tab.

e To complete the above mentioned tasks for an Application Review Request, use
Review Request page available in the Origination master tab.

Review Requests Tab

The Review Requests page contains the following sections:

e Query Section
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e Action Section

e Email Section

e Review request records
e Comments Sections

Query Section

The Query section enables you to filter records according to priority levels i.e.high, normal or
low based on any of the following:

Query L

Options Descriptions

Originator Displays the records of all the active review requests you created.

Receiver Displays the records of all the active review requests you received.

Both Displays all the review requests records you have created as well
as received with the status other than ‘CLOSED’.

View All Displays all the review requests records you sent and received,
both active and closed.

Action Section

The Action section enables you to send, respond or close the review request.

Action Options Descriptions

Open Applica- Opens the application details page to review the request. (if you

tion/Account open it from origination it’s application and if from servicing den
account)

Send Request Sends a review request to another Oracle Financial Services Lend-

ing and Leasing user.

Send Response | Sends a response to a review request from another Oracle Finan-
cial Services Lending and Leasing user.

Close Request Changes the status of review request to CLOSED and removes its
record from the Review Request page. The status can be viewed
by selecting ‘View All’ in the ‘Query’ section.

Email Section:

The Email section enables you to send an email to either originator or receiver of the review
request which cannot be responded or replied back from email recipient.

Email

Options Descriptions

Originator Sends an email of review request information to the person listed in the
Originator column on Review Request page.
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Email

Options Descriptions

Receiver

Sends an email of review request to the person listed in the Receiver
column on Review Request page.

Comments Sections

The Comments section enables originator or receiver to specify additional information that

needs to be sent with the request.

Comments iy

Descriptions
From
Originator Displays comments specified by the originator of review request at the
Comment time of creating a request.
Receiver Displays comments specified by the receiver of review request at the
Comment time of reviewing a request.

5.12.1.1 Reviewing a Request

System displays the priority and the number of requests ready for review, if any, for your user
id at My Pending Review Requests By Priority section in the Servicing Dash Board

& Welcome, PRAKRRAQ =  Accessibility =

ORACLE’
Financial Services Lending and Leasing
DachBoard DashBoard 5
DashBoard
DashBoard Origination Setup
Users Productivity
System Monitor My User Queues Product Expiring in Next One Month
Producer Analysis Description Product End Date
Process Files No data to display. No data o display.
My Pending Review Requests By Applications
App #
No data to display.
My Pending Review Requests By Priority
Priority
No data to display.
< >
R Servicing Producer
Number of Queues Hard Assigned
Quaue Description ” Producers Count By Status
N data to display. Status Count.
ACTIVE 82
Number of Accounts
Queus Description Producers Expiring in Next One Month
No data to display Producer End Date
No data to display.
My Pending Review Requests By Accounts
A
No data to display.
My Pending Review Requests By Priority
> Origination Priority M
> Servicing * il >
> Collections
> WFP
> Tools
> Setup

36 lose

Admin

Critical Batch Job Status
Batch Job Status
No data to display.

vendor

Vendors Count By Status
Status Count
ACTIVE 35

Vendors Expiring in Next One Month
Company Name End Date
No data to display.

To review requests

1. On the Oracle Financial Services Lending and Leasing application home page, click
Servicing main tab and then click Servicing drop-down link. Click Customer Service

link.

The Customer Service window appears, opened at the Results tab. Under Customer
Service screen, click Review Requests tab.
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2. In the Query section, click Receiver.

In the Review Request record, the system displays all open review request you have re-

ceived.

ORACLE’

Financial Services Lending and Leasing

DashBoard
> Origination
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Transaction Authorization
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Review Requests
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View w Format v
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<
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Action
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Priority Receiver Account #

Receiver
Comment

& it

Email

[ig% Close Request

Reason

[ Close
Eview | o Audit
(59 Reeiver
Status
2>

3. Inthe Review Request record, select the record you want to view and click View. The
following screen is displayed.

ORACLE’
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DashBoard
> Origination
Servicing
Servicing
Customer Service
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Account Documents
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[ Close Request
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>
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4. For the selected Review Request record, view the following information:

Fields Descriptions

Originator The user id of the request originator.

Priority The request priority: HIGH, NORMAL, or LOW.

Receiver The recipient of the request.

Account # The account number which needs review.

Transaction The transaction selected.

Reason The review reason.

Status The request status.

Date The date and time when the request was created.

Originator Com- The comment by the originator which creating a

ment request.

Receiver Comment | The comment by the receiver after reviewing a
request.

Note

If you click Open Account, system loads the accountin review request and displays the
Account Details page.

5.12.1.2 Sending a Review Request

The Send Request button enables you to send a review request to another the system user.
However, the Send Request button is enabled only if you have specified the receiver while
creating a review request and have saved it.

To send a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click the
Servicing main tab and then click Servicing drop-down link. Click Review Requests tab.

2. In theReview Requests page in the Query section, select Originator.
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3. Click Add to create a new review request. The following screen is displayed:

ORACLE"
Financial Services Lending and Leasing

e Customer Service 38 Clos=
’» Origination Search | Customer Service  Review Request (Pending: 0)
Servicing
Senicing Review Requests g pdd | FEdit | [H view | o Aui
Customer Service Query g sy
Securitization
Transaction Authorization {8 originatorO) Receiver O Both v‘ﬂ [m} [ Qpen Account [ SendRequest | | [ Send Respons= | | [ Close Request 5 Originator 7 Rex
Post Date Checks 3
Escrow Transactions View w Format = | (5} freeze  Ef! Detach ol Wrap W
Account Documents Originator Priarity Receiver Account # Reason Status
Collateral Management
Reports < >
Producers
Vendors
Batch Transactions
Advances Review Requests
Payments
o [ saveandadd | [ saveand Stay | [ Saveand Retum | G Retum
Interfaces B
AP Transactions Originator * Account # - Status
Gl 35 & T Date 02/
6L Transactions Priority 12 *Reason ) )
CASA Reconiliation x
Recesiver &d
Conversion Accounts o
Griginator Receiver
Commant Comment
< >
> Collections
> WP
> Tools
> Setup

4. In the Priority field, select the priority of review request: High, Normal, or Low which
helps the recipient in responding to requests. It does not affect the order in which
messages are sent or received.

5. In Receiver field, select the person you want to receive the message.

6. In Account # field, select the account involved with the review request.
The default value NEW appears in the Status field.

7. In Reason field, select the purpose for the review request.

8. In Originator Comment field, specify any additional message you want to send along
with the review request.

9. Click Save And Add/Save And Return.

The review request is created and Send Request button is enabled in the Action section.

RACLE"
Financial Services Lending and Leasing

Review Requests

(= el = et

o Colloctions
> wee

= Tools
= Setup

10. In the Action section, click Send Request.

The system sends your request to the recipient’s, where it appears on My Pending Re-
view Request window in Dash Board with status SENT TO ORIGINATOR.
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5.12.1.3 Responding to a Review Request

When you receive a review request, the system notifies you by creating an entry in My of
Pending Review Requests By Priority section in Dash Board with the number of unseen
messages. In the following example, one review request is waiting on the Review Request

page.

ORACLE’
Financial Services Lending and Leasing

PRAKRRAD + Accesilty =)

DashBoard DashBoard
DashBoard
DashBoard Origination

Users Productivity
System Monitor
Producer Analysis
Process Files

My User Queues
Description
No data to display.

Count

App = Priority
No data to display.

My Pending Review Requests By Priority
Priority
No data to display.

Count

Servicing
Number of Queues Hard Assigned

Queue Description Count
No data to display
Number of Accounts

Quaue Description Count

No data to display.

My Pending Review Requests By Accounts
Bcc# Priority
No data to display.

»» Origination Priority Count

> Servicing i >
> Collections

> WFP

> Tools

> Setup

< >

Setup

Product Expiring in Next One Month
Product End Date
No data to display.

My Pending Review Requests By Applications

Producer

A Producers Count By Status
Status
ACTIVE

Count
82

Producers Expiring in Next One Month
Producer End Date
No data to display.

My Pending Review Requests By Priority
v

3¢ Close

Admin

Critical Batch Job Status

Batch Job Status
No data to display.
Vendor
'Venders Count By Status
Status Gount
ACTIVE 35

‘Vendors Expiring in Next One Month
Company Name End Date
No data to display.

To respond to a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing main tab and then click Servicing drop-down link. Click Customer Service
link. If the Number of Pending Review Requests tab displays a number, click Review
Requests tab. On the Review Request page Query section, select Receiver.

The system displays the unread review requests in Review Request record.

2.

oORACLE
Financial Services Lending and Leasing

In the Review Request record, select the record you want to view and click View.

PRAKRUTI RAO
<

Review Requests

> Tools

> sewup

BB Seve cnd Sty

Click Open Account.

The system loads the account on Customer Service screen and displays Account Details

page.
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4. Perform requested task on review request on the account. Click Review Request tab and
selecting request, click Edit. Specify your response in the Receiver Comment field. Click
Save And Return.

ORACLE’ P ————
Financial Services Lending and Leasing e il =
DashBoard Corstonetr Sorvice 36 Close
> Origination Search  Customer Service  Review Request (Pending: 0)
Servicing
Servicing Review Requests ok add | Edit | View = < Aud
S\nf-nw:«eriamca Query Action Email
Transacton Authorization ® onginater Q) Recenver O goth "5 [ () gpen Account [ send Request Send Respons= | | [k Clase Request 5 Oniginator 5 Receiver
Post Date Checks
s View v Formatv (5 Fresze i Detach Wrap (5]
Account Documents Originator Priority Receiver Account # Reason Status
Collateral Management PRAKRUTI RAC HIGH ARATHI KRISHNA KUMAR 20150900014267 REVIEW TRANSACTIONS NEW
Reports PRAKRUTI RAO HIGH ABHISHEK LODHA )150900 REVIEW PROMOISES 'WAITING FOR RESPON:
i ¢
Batch Transactions
Advances
Payments Review Requests
m::}:; [ save end add | [ Save and Stay || [ save and Retum || (3 Retum
casA Reconciliation Priority HIGH Reason REVIEW TRANSACTIONS Dela: 02/,
Conversion Accounts o * Receiver ARATHI KRISHNA KUMAR bd
< >
> Collections
> WFP
> Tools
* Setup
5. Inthe Action section, click Send Request.
The system sends your response to the originator, where it appears on Review Request
page with status RETURN TO ORIGINATOR.
The recipient can view sent response by clicking Receiver or View All in Query section.
(The request has a status as RETURN TO ORIGINATOR.)

6. Inthe Action section, click Close Request

It will remove the message from the Review Request section.

Back on the originator’'s Review Request page, the message appears when Originator is
selected in Query section. The request has a status as RETURN TO ORIGINATOR.

E-mailing a Review Request

While system updates My Pending Review Requests By Priority section in the DashBoard
to notify you about the new requests, you can also e-mail a review request to both the
originator and a receiver, as applicable. The system will use e-mail address recorded for both
the originator and receive in User Definition section in User page.

To e-mail a review request

1.

o > 0D

On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing main tab and then click Servicing drop-down link.

Click Customer Service link.
On the Customer Service link, click Review Requests tab.
Select the request you want to e-mail in the Review Request section.

In Email section, click Originator to send the message to the person listed in Originator
field.
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_or_
Click Receiver to send it to the person listed in the Receiver field.

The system emails the details of selected record to e-mail address recorded in user setup.

Closing a Review Request

You can close a review request you created at anytime, regardless of status. However, you
can only close review requests that have your user id in the Originator field. When you close
a review request, the system removes it from Review Request record.

To close a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing main tab and then click Servicing drop-down link.

2. Click Customer Service link.

3. On the Customer Service link, click Review Requests tab.

4. Select the request you want to close in the Review Request section.

5. In the Action section, click Close Request.

The system assigns the request as CLOSED and removes it from your Review Request

record. The closed accounts can be reviewed anytime by selecting View All in the Query
section.

orAcLe: ST e oo,

Financial Services Lending and Leasing

Curstomer service s 3] Close

" callections

> Tools
> Sctup
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6.1

6.2

6.2.1

6. Bankruptcy

Introduction

After an application has cycled through the Lease origination process, it becomes an account.
Account maintenance and collections tasks can be performed with Oracle Financial Services
Lending and Leasing’s Bankruptcy screen.

The Bankruptcy screen enables you to view and manage all customer information in a
centralized location to ensure data integrity and provide better service. Oracle Financial
Services Lending and Leasing provides online real-time information about the applicant(s),
contract, account balances, dues, transactions, call activities, and comments. Oracle
Financial Services Lending and Leasing also supports back-dating of financial transactions till
the account’s opening date.

Activating an Account

An account is automatically activated when you fund the contract using the Funding main tab
or convert from a legacy system.

Posting and Reversing Payments

A payment can be posted and reversed on the Payments screen.

Account Mask

After an application completes the Lease origination cycle and is funded or is ported into the
system, it becomes an account and receives an account number. The system assigns
account numbers using the following logic:

YYYYMMNNNNNNNX

where:

YYYYMM = contract date

NNNNNNN = serial number

X = check digit

The system sorts accounts using the NNNNNN portion only. That portion is referred to as the
account ID.

Search Tab

There are two types of search available.

e Account
e Customer

Searching for a Customer or Account

There are a number of different ways to load the customer details on the Bankruptcy screen.

e Use the Search screen by selecting Customer Centric option(s).
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e Use the Quick Search section to search for the customer by Account Number, or
Customer Id, or by specifying the last four digits of Primary SSN (SSN of the primary
applicant).

e Use the Next Account feature to load the customer from a predefined queue.

For details on how to search and load the customer or account details using Search screen,
refer Search Using Customer Details section in Search Function chapter.

Customer Service screen

Most screens on the Customer Service screen contain the Account(s) and Customer(s)
sections as a header. The Account(s) section provides a quick overview of an account by
displaying its company, branch, account number, product, payoff amount and amount due,
status, and oldest due date. The information on Customer Service screen always refers to the
account selected in this section.

The Customer(s) section displays information about customer(s) attached to the account. The
information on Customer Service screen always refers to the customer selected in this
section.

To view account details in the Account(s) and Customer(s) sections, open Bankruptcy
screen and load the account you want to work with.

On the Customer Service screen’s Account(s) section, you can view the information based
on your selection.

For details on this screen refer Customer Service screen section in Customer Service
chapter.
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6.5

6.5.1

6.5.1.1

Customer Service screen’s Summary tab

Open the Bankruptcy screen and load the account you want to work with. By default the
Customer Service screen opens the Summary tab.

oRActe

Financial Services Lending and Leasing

B Close
e Collections 5 E]
* Origination Search  Customer Service  Review Request (Pending: 0)
> Senvicing
Colletions Account(s) Elview | Fauit
o View Fomatv [ Freeze EliDetch W G & current () Show All ©) Group Follow-up
ollections :
Callections Company Branch Sub Unit Account 2 Product Days Past Due Currency Pay Off Amt Amout Due Status Oldest Due Dt
Bankuptey Mo data to display
Repossession
Deficiency Summary | Customer Servce | Account Details | Customer Detalls | Transaction History | Pt Modes | Burea | Cross/Up Sell Actvities
Reports
Producers
i Alerts Conditions
Vendors
Alerts Conditions
Alert Condition Start Ot Followup Dt
Mo data to display. Mo data to display.
“ Account Details Other Information
‘
Dues .
Customer Information
Mo data to display. Customer ;. Relation ssi Birth Dt Gender
140 data to display.
Delg Due Total Due Future Pt Dt 5
LCDue Todays Payoff Oldest Due Dt
NS Due Future Fayoff Amt Paid Excess
Other Due Future Payoff Date Emai Disabilty Fivacy Opt Out
" formati Language Skin Active Miltary Duty
Delinquency Information Wartal tatus Stop Time Zone
e 30 6 £l W 150 180 Categoy Das Correspondence
Mo data to display
BR(Life) NsF(Life) Collector Address Information
BR(Year) NsF(Year) . Permissi |
Type Current {11 Wailing Address Phone
Activities 1o data to display.
Active Dt App # Last Pt At
> WFP Last Activity Dt Paid Off Dt Charge Off Dt Employment Information
G Due Day Effective Dt wiltary Duty ey
b Toske Last Pt Dt Current Pt Customer score e e R = o
> Setup Customer Grade Last Bill Amt Behaviour Score Hio data to display. -
—
Copyright © 199, 2016, Oracle andjor it affiates. Al rights reserved. Abou

For details on this screen refer Customer Service screen’s Summary tab section in Customer
Service chapter.

Customer Service screen’s Customer Service tab

Open the Bankruptcy screen and load the account you want to work with. Click the
Customer Service tab to view the sections under it.

Call Activities sub tab

With Call Activities section, the system enables you to record the details of all actions you
performed regarding this account. This includes calls from the customer, calls you make
regarding the account, or changes to condition of the account. Entries in the Call Activities
section are listed in reverse chronological order of follow-up date and are user defined.

Each action and result has a code and description. The code for call action and call result is
what appears on the Call Activity sub screen.

Recording a Call Activity

To record a call activity

1. Open the Bankruptcy screen and load the account you want to work with.
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6.6.1

6.7

2. Click Customer Service sub tab and then click Call Activities tab under it. Click Add.

The system displays the following screen.
"ORACH

Le:
Financial Services Lending and Leasing

& Welcome, DEMOSUPR +  Accessbilly 4G Sign Qut O

Eaos=

Glview | Pt

mount Due Status Ocest bus ox
0.00 ACTIVE 0272072016

B saveand add [ & Save and stay

Promise Anit Condition Appn'mt Followup DU Time Zone
0.00 - @

Collections

Tools
setup

For details on this screen refer Customer Service screen’s Customer Service tab section in
Customer Service chapter.

Customer Service screen’s Account Details tab

Open the Bankruptcy screen and load the account you want to work with. Click the Account
Details tab to view the sections under it.

Account Details sub tab

Oracle Financial Services Lending and Leasing enables you to view account details using
Account Details sub tab.

In the Account Information section click View.

ORACLE"
Financial Services Lending and Leasing

= P Collections x (3] Glos=
> Origination Search | Customer Service: 20150900014283 | Review Request (Pending: 0)
Account(s): 20150900014283: RODRIGUEZ ROBINSON Elven | Audt
View~ Format~ b Freeze BfiDetach | ol Wrap @ & © curent© Show Al Group Follow-up
Company Branch  SubUnit  Account = Product Davs et currency  Pay OFf Amt Amount Due Status Oldest Due Dt
USOL  USHQ  UNDEFL. 2015000014283 LEASE VEHICLE 114 UsD 15,158.10 4,296.60 ACTIVE:DELQ  10/05/2015
Producers Summary || Customer Service || Account Details | Customer Details | Transaction Hstory | PmtModes | Coliateral | Burcau || CrossjUp Sell Acthities
Vendors

Account Details | Statements | Rate Schedule || Insurances || Contract Information

Account Information Elvew || <2 Ausit
View - Format~ [ Freeze §#iDetach Virap @
#ofExtensions  * of Extensions = of Extension Term # of Extension Term # of Due Day * of Due Day
it e oy o5 ey Zof Due B2 Last Extn OF Due Day Change Dt Total Term
o o o o [ 15

Account Information

Additional Details
# of Due Day chang ) o Total Term 15
= of Due

Maturity Dt 11/05/2016

> WEP

> Tools
> Setup I}

3. For details on this screen refer Customer Service screen’s Account Details tab section in
Customer Service chapter.

Customer Service screen’s Customer Details tab

Open the Bankruptcy screen and load the account you want to work with. Click the
Customer tab to view the sections under it.
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6.9

Information gathered on the application entry process regarding the customer and customer’s
address, employment data, and phone numbers appears on the Customer Details screen.
Using the Customer Service screen’s Customer Details tab, you can update or add to a
customer’s address, employment information, or phone listing. All the information about the
customer can be changed using Maintenance screen.

To view or edit customer information
1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Details sub tab.

ORACLE
Financial Services Lending and Leasing

ollection: Close
> DashBoard L 24 C
> Origination Search = Customer Service | Review Request (Pending: 0) 2
> Servicing
| Elview || < Audt
e Account(s) _ By 2 Aux
iRietine view v Format~ [y Freeze Efivetmch ol wiap W & O curent® Show Al D Group Folon-up
Collections Company Branch  SubUnit  Account & Product DevsPeet Currency  Pay OFF amt Amount Due Status Oldest Due Dt
Bankruptcy No data to display.
Repossession % — 5
Deficency
Reports
Producers Summary | Customer Service | AccountDetals | Customer Details | Transaction History || Pt Modes | Bureau | Cross/Up Sell Actiities
vendors
Customer  Business
Customer Information E
& Edit =] Vie: < Audit
View  Format~ | By Freere igfiDetach | olwrap | @
Customer # Relation Ecoa niame ssn Birth Dt marital Status Enabled Lanc
“ Mo data to diplay.
T 4
< 7
Customer Information
[ saveand stay || [ save andReturn | CaRetun
Customer
Identification Details KvC
Customer #
Relation Passpart £ Reference =
Ecoa Tssue Dt Status
Name Expiry Dt
Birth Dt visa = e
Marital Status Matonzity: Birth Pk
Enabled __ National ID ikt
- Birth Country
BT Y
it S Permanent US Resident Status
M M License State
= Mother's Maiden Name P G RS
Class Type ey 5
ilitary Service
> Tools Email Power of Attorney
Stop Correspondence ;
T op Correspondence [ Holder Name L
st pl Arcemer

3. For details on this screen refer Customer Service screen’s Customer Details tab section
in Customer Service chapter.

Customer Service screen’s Transaction History tab

Open the Bankruptcy screen and load the account you want to work with. Click the
Transaction History tab to view the sections under it.

For details on this screen refer Customer Service screen’s Transaction History tab section in
Customer Service chapter.

Customer Service screen’s Pmt Modes tab

Open the Bankruptcy screen and load the account you want to work with. Click the Pmt
Modes sub tab to view the sections under it.
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ACH sub tab

If used, the ACH section displays information about automated clearing house and electronic
fund transfers.

To view the ACH information screen

1. Open the Customer Service screen and load the account you want to work with.

Click Pmt Modes tab, then click ACH sub tab.

ORACLE"
Financial Services Lending and Leasing

ACH Information

> wep
> Tools
> Setup

For details on Pmt Modes tab refer Customer Service screen’s Pmt Modes tab section in
Customer Service chapter.

Customer Service screen’s Bankruptcy tab

The Bankruptcy screen enables you to record the details of a bankruptcy. This information
usually is supplied from the customer or customer’s attorney. You can track each stage of the
bankruptcy process based on its follow-up date and record information using the Details and
Tracking sections.

As there are occasions when a borrower files bankruptcy more than once during the tenure
of the Lease, you can record information for multiple bankruptcies. The Add button enables
you to create a new bankruptcy record with different start and end dates. You can also use
the Bankruptcy screen to view the previous bankruptcy record using Next and Previous
buttons in the Detail section. The Current box in Detail section indicates the current
bankruptcy details.

To enter bankruptcy details for an account
1. Open the Customer Service screen and load the account you want to work with.
2. Click Bankruptcy tab.

3. Inthe Bankruptcy Details section, select the bankruptcy record you want to work with.
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Select Add to refresh the Bankruptcy screen to create a new record.

ORACLE’
Financial Services Lending and Leasing

Bankru (38 Close:
> DashBoard akniptors
> Origination Search | Customer Service: 20150900014267 | Review Request (Pending: 0)
> Servicing
N Cabmrie Account(s): 20150900014267: SIGG MARK Elven || o udt
o View» Formatw [ Freeze ffiDetach | o wrap W & ) Current® show All © Group Follow-up
Colections Company Branch Sub Unit Account # Product Days Past Due Currency Pay OFf Amt. Amount Due §
Bankruptcy so1 UsHQ 0150800014267  LOAN VEHICLE (FR) 19,357.24 5,208.00 ¢
Repossession g ] G
Defigency
Reports Sy [Catre evee | e e | [Grena oo | [T tieey | [Fmtees| | Bankruptcy | | Colataat (e e [[romiie st Ao
Producers
Vendors
Bankruptcy Details deadd | AEdt | Evien || o Audit
Vew v Fomat [ Freee GfDetach wep @
Current Folowup Dt Disposition Type Customer Relation Comment File Received Dt Bankruptcy Start Dt Bankruptcy £
No data to display
= 2 0 E
Bankruptcy Details
‘ [ save and tay || [ Save andRetun | CaReturn g
Current _ Relation
Folowup Dt Comment
Disposition
Tie File Received Dt
Hstomer Bankruptcy Start D
Bankruptcy End Dt
Tracking ] vies <7 Auc
View ~ Format ~ | B Freeze §fiDelach | olwen | @R
Sub Parameter Parameter Value
Mo data to display.
Call Activities | Comments | Due Date History
> WFP
> Tools
> Setup

For details on this screen refer Customer Service screen’s Bankruptcy tab section in

Customer Service chapter.

Customer Service screen’s Collateral tab

The Collateral screen displays information regarding any assets associated with an account.
Collateral can be a vehicle, home, or something else, such as household goods. The Collat-
eral screen contains the Home and Seller sub tabs. To view the collateral details

1. Open the Customer Service screen and load the account you want to work with.
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e Click Collateral tab. The system displays the following screen:

ORACLE’

Financial Services Lending and Leasing

- DashBoard
> Origination
» Servicing
Collections

Collections
Collections
Bankruptcy
Repossession
Deficency
Reports
Producers
vendors

> WFP
» Tools
> Setup

Collections

Search  Customer Service: 20150900014283  Review Request (Pending: 0

Account(s): 20150900014283: RODRIGUEZ ROBINSON

View v Format~ [

Company Branch
UsoL  UsHQ
«

Summary || Customer Service | AccountDetails || Customer Details

Vehide  Seller

Freeze £ Detach
Subunit  Account #
UNDEFIL... 20150900014283 LEASE VEHICLE

Wrap W & @ curent® Show Al Group Follow-up
Product DEY;PDE:;Currer\cy Pay Off Amt

114 USD 15,158.10

m

Transaction History | Pmt Modes

Vehicle
View v Formatw  [Ep Freeze EffiDetach | ol Wirap ()]
Primary Description Status Asset Type Lien Status
¥ 2015 AUDI A4 ACTIVE VEHICLE UNDEFINED
g < T
Vehicle
Type & Description % Description 2015 AUDI A4

Primary ¥
Substiution
hsset % 14012
* Asset Class NEW VEHICLE
* Asset Type VEHICLE
*SubType CAR
*Registration # |UNDEFINED
Status ACTIVE
Select Make and Mode!
*Year 2015
Make ALDI
Model A4

Condition GOOD CONDITIONED

Lien Details
= Lien Status UNDEFINED
= Lien Event Date iy
= Second Lien Holder

Comments
Lien Release Entity

Entity Name

Usage Details

Collateral

Amount Due Status

Lien Event Date

[36] Close:
[Svew || o audt
Oldest Due Dt
4,206.60 ACTIVEDELQ  10/05/2015
. V _
Bureau || Cross/Up Sell Activities
L
op add | Edit =] vier < Audit
Second Lien Holder  Comments Lien Refease Entity  Enf
v
1

[+

=

[

[ saveandstay || [ save andRetum

GaRewm
Extra 2

Total 24

Charge 200,00

Address

* Country  UNITED STATES

[

County NORFOLK
Address # 480 NEPONSET 5T
Address Line 1

Address Line 2 TURNPIKE ST

Zip 02019 v

ZipExtn
City BELLINGHAM

If the account’s collateral is a vehicle, Collateral screen opens at the Vehicle tab:

If the account’s collateral is a home, Collateral screen opens at the Home tab.

If the account’s collateral is neither a vehicle nor a home, Collateral screen opens

at the Other Collateral.

For details on this screen refer Customer Service screen’s Collateral tab section in Customer
Service chapter.

Customer Service screen’s Bureau tab

The Customer Service screen Bureau screen enables you to view credit bureau reports

associated with account that were pulled during servicing for the account. You can also use
the Bureau screen to create and pull additional credit bureau reports and view the results as
a text only file.

To view an existing credit bureau report

1. Open the Customer Service screen and load the account you want to work with.
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2. On the Customer Service link bar, click Bureau.

ORACLE’
Financial Services Lending and Leasing

Collecti (W glose
> DashBoard EERTTS
> Origination Search  Customer Service: 20150900014267  Review Request (Pending: 0}
> Servicing
Collections Account(s): 20150900014267: SIGG MARK (S view || o audit
View v Format v Freeze Detach Virap 5, © Current® Show All ©) Group Follow-up
Collections & o < @ &
Collections Company Branch  SubUnit  Account # Product B pDausé Currency  Pay Off Amt Amount Due Status Oldest Due Dt
:’;i“;gm usor  UsHQ 2015090014267 LOAN VEHICLE (FR) 118 UsD 18,397.24 5,209.00 ACTVEDELQ  10/01/2015
« I v
Deficency
Reports
Producers Summary || Customer Service || AccountDetais || Customer Details | Transaction History  PmtModes  Colatersl  Bureaw | CrossjUp Sel Activities
Vendors
Bureau Details dpadd | AEdt | 5 vew || o Audt
IMPORTANT: Actess to credit reparting agency systems i for authorized users and only for permissible purposes, Unauthorized access is prohibited under the Fair Credit Reporting Act and is punishable by
$2500 fine andfor 1 year in Federal prison per occurrence
View v Format~  [5 Freeze  giDetach ol Wrap B [0 submitRequest  ViewReport @ Servidng ©) Crigination
Type Bureau = Status Dt Report S;‘jﬁ:‘f“
No dats to dsplay.
< m ] »
g [
4
Applicant/Customer Detail
View v Formatv (B Freeze  ffiDetach all Wrap 5]
Type First Name I Last Name: Status Birth Dt SN Suffix Address Type Country
No data to dsplay.
[y — m »
Bureau Report
View Repart @) Text(®) POF
View v Format~ [ Freeze pfiDetach | ol Wrap B B PrintReport
Text
No data to dsplay.
> WEP
 Tools
> Setup

For details on this screen refer Customer Service screen’s Collateral tab section in Customer
Service chapter.

Review Request

The Review Requests page is primarily a work flow tool used to flag an account or an
application for the attention of another Oracle Financial Services Lending and Leasing user
and ask for feedback. It allows the system users to send and receive requests (including e-
mail) commenting on a specific account or application.

In this chapter, you will learn how to compete the following tasks:

e Reviewing a request
e Sending a review request

e Responding to a review request
e E-mailing a Review Request
e Closing a review request

Note the following:

e You can complete the above tasks for an Account Review Request using Review
Request page in the Servicing master tab.

e To complete the above mentioned tasks for an Application Review Request, use
Review Request page available in the Origination master tab.

Review Requests Tab

The Review Requests page contains the following sections:
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e Query Section

e Action Section

e Email Section

e Review request records

e Comments

Query Section

Sections

The Query section enables you to filter records according to priority levels i.e.high, normal or
low based on any of the following:

Query o

Options Descriptions

Originator Displays the records of all the active review requests you created.

Receiver Displays the records of all the active review requests you received.

Both Displays all the review requests records you have created as well
as received with the status other than ‘CLOSED’.

View All Displays all the review requests records you sent and received,
both active and closed.

Action Section

The Action section enables you to send, respond or close the review request.

Action Options

Descriptions

Open Applica-
tion/Account

Opens the application details page to review the request. (if you
open it from origination it's application and if from servicing den
account)

Send Request

ing and Leasing user.

Send Response

Sends a response to a review request from another Oracle Finan-
cial Services Lending and Leasing user.

Close Request

Changes the status of review request to CLOSED and removes its
record from the Review Request page. The status can be viewed
by selecting ‘View All’ in the ‘Query’ section.

Email Section:

Sends a review request to another Oracle Financial Services Lend-

The Email section enables you to send an email to either originator or receiver of the review

request which cannot be responded or replied back from email recipient.

Email Descriptions

Options P

Originator Sends an email of review request information to the person listed in the
Originator column on Review Request page.
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Email

Options Descriptions

Receiver

Sends an email of review request to the person listed in the Receiver
column on Review Request page.

Comments Sections

The Comments section enables originator or receiver to specify additional information that

needs to be sent with the request.

Comments iy

Descriptions
From
Originator Displays comments specified by the originator of review request at the
Comment time of creating a request.
Receiver Displays comments specified by the receiver of review request at the
Comment time of reviewing a request.

6.13.1.1 Reviewing a Request

System displays the priority and the number of requests ready for review, if any, for your user
id at My Pending Review Requests By Priority section in the Servicing Dash Board

& Welcome, PRAKRRAQ =  Accessibility =

window.
ORACLE"
Financial Services Lending and Leasing
DashBoard DashBoard
DashBoard
DashBoard Origination

Users Productivity

System Monitor My User Queues

Froducer Analysis Description
Process Files No data to display.

App #
No data to display.

Priority
No data to display.

<
Servicing

Queue Description
No data to display.

Number of Accounts
Queue Description
No data to display

Acc ¥
No data to display.

> Origination Priority
> Servicing E]

> Collections

> WEP

> Tools

> Setup

Number of Queues Hard Assigned

My Pending Review Requests By Applications

My Pending Review Requests By Priority

Setup
Product Expiring in Next One Month

Product End Date
No data to display.

Producer

” Producers Count By Status

My Pending Review Requests By Accounts

My Pending Review Requests By Priority
v

>

Status Count
ACTIVE 82

Producers Expiring in Next One Month
Producer End Date:
No data to display.

36 lose

Admin

Critical Batch Job Status
Batch Job Status
No data to display.

vendor

Vendors Count By Status
Status Count
ACTIVE 35

Vendors Expiring in Next One Month
Company Name End Date
No data to display.

To review requests

1. On the Oracle Financial Services Lending and Leasing application home page, click
Servicing main tab and then click Servicing drop-down link. Click Customer Service

link.

The Customer Service window appears, opened at the Results tab. Under Customer
Service screen, click Review Requests tab.
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2. In the Query section, click Receiver.

In the Review Request record, the system displays all open review request you have re-

ceived.

ORACLE’

Financial Services Lending and Leasing

DashBoard
> Origination
Servicing
Servicing
Customer Service
Securitization
Transaction Authorization
Post Date Checks.
Escrow Transactions
Account Documents
Collateral Management
Reports
Producers
Vendors
Batch Transactions
Advances
Payments
Fees
Interfaces
AP Transactions
GL Transactions
CASA Reconciliation
Conversion Accounts

> Collections
> WEFP
> Tools
> Setup

Customer Service »

Search | Customer Servi

Review Requests
Query

@ originatorO) Receiver O soth

View w Format v

Originator
No data to display.
<

Originator
Comment

ez Review Request (Pending: 0)

Action
el |} Open Account [ Send Response
B Freeze ! Detach o Wrap W
Priority Receiver Account #

Receiver
Comment

& it

Email

[ig% Close Request

Reason

[ Close
Eview | o Audit
(59 Reeiver
Status
2>

3. Inthe Review Request record, select the record you want to view and click View. The
following screen is displayed.

ORACLE’

Financial Services Lending and Leasing

DashBoard
> Origination
Servicing
Servicing
Customer Service
Securitization
Transaction Authorization
Post Date Checks
Escrow Transactions
Account Documents
Collateral Management
Reports
Producers
Vendors
Batch Transactions
Advances
Payments
Fees
Interfaces
AP Transactions
GL Transactions
(CASA Recenciliation
‘Conversion Accounts

> Collections
> WEP
> Tools
> Setup

Customer Service

Search | Customer Service

Review Requests
Query

riginatar () Receiver
View~ Formaty [P
Oniginator

PRAKRUTI RAC
PRAKRUTI RAQ
(2

Review Requests

Originator
= Priority
* Recaiver

Originator
Comment

Review Request (Pending: 0)

Action
Deah Ve O (21 Open Account [ Send Request | | [T Send Response
Freeze i Detach ol Wrap o]
Pricrity Receiver Account =
HIGH ARATHI KFISHNA KUMAR 20150900014267
HIGH ABHISHEK LODHA 20150900014267
[ save and add

* Account #
= *Reasan
Receiver
‘Comment

o pdd | 7 Edit

Email

[ Close Request

Reason

REVIEW TRANSACTIONS
REVIEW PROMOISES

& save and stay

£

I save and Retum

[ Close

= view || < Audit

Status

NEW
WAITING FOR RESPON:
>

<A Betum

Status
Date 02/(
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4. For the selected Review Request record, view the following information:

Fields Descriptions

Originator The user id of the request originator.

Priority The request priority: HIGH, NORMAL, or LOW.

Receiver The recipient of the request.

Account # The account number which needs review.

Transaction The transaction selected.

Reason The review reason.

Status The request status.

Date The date and time when the request was created.

Originator Com- The comment by the originator which creating a

ment request.

Receiver Comment | The comment by the receiver after reviewing a
request.

Note

If you click Open Account, system loads the accountin review request and displays the
Account Details page.

6.13.1.2 Sending a Review Request

The Send Request button enables you to send a review request to another the system user.
However, the Send Request button is enabled only if you have specified the receiver while
creating a review request and have saved it.

To send a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click the
Servicing main tab and then click Servicing drop-down link. Click Review Requests tab.

2. In theReview Requests page in the Query section, select Originator.
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3. Click Add to create a new review request. The following screen is displayed:

ORACLE"
Financial Services Lending and Leasing

e Customer Service 38 Clos=
’» Origination Search | Customer Service  Review Request (Pending: 0)
Servicing
Senicing Review Requests g pdd | FEdit | [H view | o Aui
Customer Service Query g sy
Securitization
Transaction Authorization {8 originatorO) Receiver O Both v‘ﬂ [m} [ Qpen Account [ SendRequest | | [ Send Respons= | | [ Close Request 5 Originator 7 Rex
Post Date Checks 3
Escrow Transactions View w Format = | (5} freeze  Ef! Detach ol Wrap W
Account Documents Originator Priarity Receiver Account # Reason Status
Collateral Management
Reports < >
Producers
Vendors
Batch Transactions
Advances Review Requests
Payments
o [ saveandadd | [ saveand Stay | [ Saveand Retum | G Retum
Interfaces B
AP Transactions Originator * Account # - Status
Gl 35 & T Date 02/
6L Transactions Priority 12 *Reason ) )
CASA Reconiliation x
Recesiver &d
Conversion Accounts o
Griginator Receiver
Commant Comment
< >
> Collections
> WP
> Tools
> Setup

4. In the Priority field, select the priority of review request: High, Normal, or Low which
helps the recipient in responding to requests. It does not affect the order in which
messages are sent or received.

5. In Receiver field, select the person you want to receive the message.

6. In Account # field, select the account involved with the review request.
The default value NEW appears in the Status field.

7. In Reason field, select the purpose for the review request.

8. In Originator Comment field, specify any additional message you want to send along
with the review request.

9. Click Save And Add/Save And Return.

The review request is created and Send Request button is enabled in the Action section.

RACLE"
Financial Services Lending and Leasing

Review Requests

(= el = et

o Colloctions
> wee

= Tools
= Setup

10. In the Action section, click Send Request.

The system sends your request to the recipient’s, where it appears on My Pending Re-
view Request window in Dash Board with status SENT TO ORIGINATOR.
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6.13.1.3 Responding to a Review Request

When you receive a review request, the system notifies you by creating an entry in My of
Pending Review Requests By Priority section in Dash Board with the number of unseen
messages. In the following example, one review request is waiting on the Review Request

page.

ORACLE’
Financial Services Lending and Leasing

PRAKRRAD + Accesilty =)

DashBoard DashBoard
DashBoard
DashBoard Origination

Users Productivity
System Monitor
Producer Analysis
Process Files

My User Queues
Description
No data to display.

Count

App = Priority
No data to display.

My Pending Review Requests By Priority
Priority
No data to display.

Count

Servicing
Number of Queues Hard Assigned

Queue Description Count
No data to display
Number of Accounts

Quaue Description Count

No data to display.

My Pending Review Requests By Accounts
Bcc# Priority
No data to display.

»» Origination Priority Count

> Servicing i >
> Collections

> WFP

> Tools

> Setup

< >

Setup

Product Expiring in Next One Month
Product End Date
No data to display.

My Pending Review Requests By Applications

Producer

A Producers Count By Status
Status
ACTIVE

Count
82

Producers Expiring in Next One Month
Producer End Date
No data to display.

My Pending Review Requests By Priority
v

3¢ Close

Admin

Critical Batch Job Status

Batch Job Status
No data to display.
Vendor
'Venders Count By Status
Status Gount
ACTIVE 35

‘Vendors Expiring in Next One Month
Company Name End Date
No data to display.

To respond to a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing main tab and then click Servicing drop-down link. Click Customer Service
link. If the Number of Pending Review Requests tab displays a number, click Review
Requests tab. On the Review Request page Query section, select Receiver.

The system displays the unread review requests in Review Request record.

2.

oORACLE
Financial Services Lending and Leasing

In the Review Request record, select the record you want to view and click View.

PRAKRUTI RAO
<

Review Requests

> Tools

> sewup

BB Seve cnd Sty

Click Open Account.

The system loads the account on Customer Service screen and displays Account Details

page.
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6.13.1.4

4. Perform requested task on review request on the account. Click Review Request tab and
selecting request, click Edit. Specify your response in the Receiver Comment field. Click
Save And Return.

ORACLE’ P ————
Financial Services Lending and Leasing e il =
DashBoard Corstonetr Sorvice 36 Close
> Origination Search  Customer Service  Review Request (Pending: 0)
Servicing
Servicing Review Requests ok add | Edit | View = < Aud
S\nf-nw:«eriamca Query Action Email
Transacton Authorization ® onginater Q) Recenver O goth "5 [ () gpen Account [ send Request Send Respons= | | [k Clase Request 5 Oniginator 5 Receiver
Post Date Checks
s View v Formatv (5 Fresze i Detach Wrap (5]
Account Documents Originator Priority Receiver Account # Reason Status
Collateral Management PRAKRUTI RAC HIGH ARATHI KRISHNA KUMAR 20150900014267 REVIEW TRANSACTIONS NEW
Reports PRAKRUTI RAO HIGH ABHISHEK LODHA )150900 REVIEW PROMOISES 'WAITING FOR RESPON:
i ¢
Batch Transactions
Advances
Payments Review Requests
m::}:; [ save end add | [ Save and Stay || [ save and Retum || (3 Retum
casA Reconciliation Priority HIGH Reason REVIEW TRANSACTIONS Dela: 02/,
Conversion Accounts o * Receiver ARATHI KRISHNA KUMAR bd
< >
> Collections
> WFP
> Tools
* Setup
5. Inthe Action section, click Send Request.
The system sends your response to the originator, where it appears on Review Request
page with status RETURN TO ORIGINATOR.
The recipient can view sent response by clicking Receiver or View All in Query section.
(The request has a status as RETURN TO ORIGINATOR.)

6. Inthe Action section, click Close Request

It will remove the message from the Review Request section.

Back on the originator’'s Review Request page, the message appears when Originator is
selected in Query section. The request has a status as RETURN TO ORIGINATOR.

E-mailing a Review Request

While system updates My Pending Review Requests By Priority section in the DashBoard
to notify you about the new requests, you can also e-mail a review request to both the
originator and a receiver, as applicable. The system will use e-mail address recorded for both
the originator and receive in User Definition section in User page.

To e-mail a review request

1.

o > 0D

On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing main tab and then click Servicing drop-down link.

Click Customer Service link.
On the Customer Service link, click Review Requests tab.
Select the request you want to e-mail in the Review Request section.

In Email section, click Originator to send the message to the person listed in Originator
field.
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6.13.1.5

_or_
Click Receiver to send it to the person listed in the Receiver field.

The system emails the details of selected record to e-mail address recorded in user setup.

Closing a Review Request

You can close a review request you created at anytime, regardless of status. However, you
can only close review requests that have your user id in the Originator field. When you close
a review request, the system removes it from Review Request record.

To close a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing main tab and then click Servicing drop-down link.

2. Click Customer Service link.

3. On the Customer Service link, click Review Requests tab.

4. Select the request you want to close in the Review Request section.

5. In the Action section, click Close Request.

The system assigns the request as CLOSED and removes it from your Review Request

record. The closed accounts can be reviewed anytime by selecting View All in the Query
section.

orAcLe: ST e oo,

Financial Services Lending and Leasing

Curstomer service s 3] Close

" callections

> Tools
> Sctup
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7.1

7.2

7.21

7. Repossession

Introduction

After an application has cycled through the Lease origination process, it becomes an account.
Account maintenance and collections tasks can be performed with Oracle Financial Services
Lending and Leasing’s Repossession screen.

The Repossession screen enables you to view and manage all customer information in a
centralized location to ensure data integrity and provide better service. Oracle Financial
Services Lending and Leasing provides online real-time information about the applicant(s),
contract, account balances, dues, transactions, call activities, and comments. Oracle
Financial Services Lending and Leasing also supports back-dating of financial transactions till
the account’s opening date.

Activating an Account

An account is automatically activated when you fund the contract using the Funding main tab
or convert from a legacy system.

Posting and Reversing Payments

A payment can be posted and reversed on the Payments screen.

Account Mask

After an application completes the Lease origination cycle and is funded or is ported into the
system, it becomes an account and receives an account number. The system assigns
account numbers using the following logic:

YYYYMMNNNNNNNX

where:

YYYYMM = contract date

NNNNNNN = serial number

X = check digit

The system sorts accounts using the NNNNNN portion only. That portion is referred to as the
account ID.

Search Tab

There are two types of search available.

e Account
e Customer

Searching for a Customer or Account

There are a number of different ways to load the customer details on Repossession screen.

e Use the Search screen by selecting Customer Centric option(s).
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7.3

e Use the Quick Search section to search for the customer by Account Number, or
Customer Id, or by specifying the last four digits of Primary SSN (SSN of the primary
applicant).

e Use the Next Account feature to load the customer from a predefined queue.

For details on how to search and load the customer or account details using Search screen,
refer Search Using Customer Details section in Search Function chapter.

Customer Service screen

Most screens on the Customer Service screen contain the Account(s) and Customer(s)
sections as a header. The Account(s) section provides a quick overview of an account by
displaying its company, branch, account number, product, payoff amount and amount due,
status, and oldest due date. The information on Customer Service screen always refers to the
account selected in this section.

The Customer(s) section displays information about customer(s) attached to the account. The
information on Customer Service screen always refers to the customer selected in this
section.

To view account details in the Account(s) and Customer(s) sections, open Repossession
screen and load the account you want to work with.

On the Customer Service screen’s Account(s) section, you can view the information based
on your selection.

For details on this screen refer Customer Service screen section in Customer Service
chapter.
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7.5

7.5.1

7.51.1

Customer Service screen’s Summary tab

Open the Repossession screen and load the account you want to work with. By default the
Customer Service screen opens the Summary tab.

oRace
Financial Services Lending and Leasing

B Close
e Collections 5 E]
* Origination Search  Customer Service  Review Request (Pending: 0)
> Senvicing
Colletions Account(s) Elview | Fauit
o View Fomatv [ Freeze EliDetch W G & current () Show All ©) Group Follow-up
ollections :
Callections Company Branch Sub Unit Account 2 Product Days Past Due Currency Pay Off Amt Amout Due Status Oldest Due Dt
Bankuptey Mo data to display
Repossession
Deficiency Summary | Customer Servce | Account Details | Customer Detalls | Transaction History | Pt Modes | Burea | Cross/Up Sell Actvities
Reports
Producers
i Alerts Conditions
Vendors
Alerts Conditions
Alert Condition Start Ot Followup Dt
Mo data to display. Mo data to display.
“ Account Details Other Information
‘
Dues .
Customer Information
Mo data to display. Customer ;. Relation ssi Birth Dt Gender
140 data to display.
Delg Due Total Due Future Pt Dt 5
LCDue Todays Payoff Oldest Due Dt
NS Due Future Fayoff Amt Paid Excess
Other Due Future Payoff Date Emai Disabilty Fivacy Opt Out
" formati Language Skin Active Miltary Duty
Delinquency Information Wartal tatus Stop Time Zone
e 30 6 £l W 150 180 Categoy Das Correspondence
Mo data to display
BR(Life) NsF(Life) Collector Address Information
BR(Year) NsF(Year) . Permissi |
Type Current {11 Wailing Address Phone
Activities 1o data to display.
Active Dt App # Last Pt At
> WFP Last Activity Dt Paid Off Dt Charge Off Dt Employment Information
G Due Day Effective Dt wiltary Duty ey
b Toske Last Pt Dt Current Pt Customer score e e R = o
> Setup Customer Grade Last Bill Amt Behaviour Score Hio data to display. -
—
Copyright © 199, 2016, Oracle andjor it affiates. Al rights reserved. Abou

For details on this screen refer Customer Service screen’s Summary tab section in Customer
Service chapter.

Customer Service screen’s Customer Service tab

Open the Repossession screen and load the account you want to work with. Click the
Customer Service tab to view the sections under it.

Call Activities sub tab

With the Call Activities section, system enables you to record the details of all actions you
performed regarding this account. This includes calls from the customer, calls you make
regarding the account, or changes to condition of the account. Entries in the Call Activities
section are listed in reverse chronological order of follow-up date and are user-defined.

Each action and result has a code and description. The code for the call action and call result
is what appears on Call Activity sub screen.

Recording a Call Activity

To record a call activity

1. Open the Repossession screen and load the account you want to work with.
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7.6.1

7.7

2. Click Customer Service sub tab and then click Call Activities tab under it. Click Add.

The system displays the following screen.
"ORACH

Le:
Financial Services Lending and Leasing

& Welcome, DEMOSUPR +  Accessbilly 4G Sign Qut O

Eaos=

Glview | Pt
Olcest e 0
oa/20/2016

B saveand add [ & Save and stay

Appn'mt Followup DU Time Zone

Collections

Tools
setup

For details on this screen refer Customer Service screen’s Customer Service tab section in
Customer Service chapter.

Customer Service screen’s Account Details tab

Open the Repossession screen and load the account you want to work with. Click the
Account Details tab to view the sections under it.

Account Details sub tab

Oracle Financial Services Lending and Leasing enables you to view account details using
Account Details sub tab.

In the Account Information section click View.

ORACLE"
Financial Services Lending and Leasing

= P Collections x (3] Glos=
> Origination Search | Customer Service: 20150900014283 | Review Request (Pending: 0)
Account(s): 20150900014283: RODRIGUEZ ROBINSON Elven | Audt
View~ Format~ b Freeze  EfiDetach 0 Weap @ & © curent© Show Al Group Follow-up
Company Branch  SubUnit  Account = Product Davs et currency  Pay OFf Amt Amount Due Status Oldest Due Dt
USOL  USHQ  UNDEFL. 2015000014283 LEASE VEHICLE 114 UsD 15,158.10 4,296.60 ACTIVE:DELQ  10/05/2015
Producers Summary || Customer Service || Account Details | Customer Details | Transaction Hstory | PmtModes | Coliateral | Burcau || CrossjUp Sell Acthities
Vendors
Account Details | Statements || Rate Schedule || Insurances || Contract Information
Account Information Elvew || <2 Ausit
ew's Fomats | B Freeze ffiDetach wiep @
#ofExtensions  * of Extensions = of Extension Term # of Extension Term # of Due Day ZofDueDay | o ey e e
(rear) ife) (vear) wife) changes(rear) changes(uife) L5t xtn Dt Due Day Change Dt Total T
o o o o [ [ 15
5
“
Account Information
Gagetun

Additional Details
# of Due Day chang ) o Total Term 15
= of Due

Maturity Dt 11/05/2016

> WEP
> Tools
> Setup

For details on this screen refer Customer Service screen’s Account Details tab section in
Customer Service chapter.

Customer Service screen’s Customer Details tab

Open the Repossession screen and load the account you want to work with. Click the
Customer tab to view the sections under it.
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7.9

Information gathered on the application entry process regarding the customer and customer’s
address, employment data, and phone numbers appears on Customer Details screen. Using
the Customer Service screen’s Customer Details tab, you can update or add to a customer’s
address, employment information, or phone listing.All the information about the customer can
be changed using Maintenance screen.

To view or edit customer information
1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Details sub tab.

ORACLE
Financial Services Lending and Leasing

ollection: Close
> DashBoard L 24 C
> Origination Search = Customer Service | Review Request (Pending: 0) 2
> Servicing
| Elview || < Audt
e Account(s) _ By 2 Aux
iRietine view v Format~ [y Fresze i Detach W & O curent® Show Al D Group Folon-up
Collections Company Branch  SubUnit  Account & Product DevsPeet Currency  Pay OFF amt Amount Due Status Oldest Due Dt
Bankruptcy No data to display.
Repossession % — 5
Deficency
Reports
Producers Summary | Customer Service | AccountDetals | Customer Details | Transaction History || Pt Modes | Bureau | Cross/Up Sell Actiities
vendors
Customer  Business
Customer Information E
& Edit =] Vie: < Audit
View  Format~ | By Freere igfiDetach | olwrap | @
Customer # Relation Ecoa niame ssn Birth Dt marital Status Enabled Lanc
“ Mo data to diplay.
T 4
< 7
Customer Information
[ saveand stay || [ save andReturn | CaRetun
Customer
Identification Details KvC
Customer #
Relation Passpart £ Reference =
Ecoa Tssue Dt Status
Name Expiry Dt
Birth Dt visa = e
Marital Status Matonzity: Birth Pk
Enabled __ National ID ikt
- Birth Country
BT Y
it S Permanent US Resident Status
M M License State
= Mother's Maiden Name P G RS
Class Type ey 5
ilitary Service
> Tools Email Power of Attorney
Stop Correspondence ;
T op Correspondence [ Holder Name L
st pl Arcemer

For details on this screen refer Customer Service screen’s Customer Details tab section in
Customer Service chapter.

Customer Service screen’s Transaction History tab

Open the Repossession screen and load the account you want to work with. Click the
Transaction History tab to view the sections under it.

For details on this screen refer Customer Service screen’s Transaction History tab section in
Customer Service chapter.

Customer Service screen’s Pmt Modes tab

Open the Repossession screen and load the account you want to work with. Click the Pmt
Modes sub tab to view the sections under it.
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7.9.1

7.10

7.10.1

ACH sub tab

If used, the ACH section displays information about automated clearing house and electronic
fund transfers.

To view the ACH information screen

1. Open the Customer Service screen and load the account you want to work with.

Click Pmt Modes tab, then click ACH sub tab.

ORACLE"
Financial Services Lending and Leasing

= Close
T Collections 1)

> Origination Search | Customer Service: 2015090001267 | Review Request (Pending: 0)
Account(s): 20150900014267: SIGG MARK Eluew || o2 audt
View v Format~ P Freeze  EiDetach wirap W B © Curenl© Shuw Al Group Follow-up
o:

Company Branch  SubUnit Account # Product. Amount Due Status Oldest Due Dt

usoi  UsHQ 20150900014267 LOAN VEHICLE (FR) 5,200,00 ACTIVEIDELQ  10/01/2015

summary || Custor Account Leta

Cross/Up sell actines

Ach || Coupon || PostDated Chedks | I

ACH Information
View - Format~ 5 Fresas [fiDetach rop ® O Reaiming @ Gne-Time Phone ©) A

Reference # Bank Name Bank City. Bank state Routing * Account Type Name On Account  Account % s1C BAN
“ No data to display.

ACH Information

> wep

> Tools

> Setup

For details on this screen refer Customer Service screen’s Pmt Modes tab section in
Customer Service chapter.

Customer Service screen’s Repo/Foreclosure tab

The Repossession/Foreclosure screen enables you to record information regarding
repossessions/foreclosure in a manner similar to how bankruptcies are recorded on the
Bankruptcy screen. You can track each stage of the repossession/foreclosure process based
on the follow-up date and record information using Details and Tracking section.

Repossession sub tab

On occasion, a lender performs multiple repossessions for the same Lease. The Create New
Repossession button on the Repossession screen enables you to create a new repossession
record for a different collateral and different start and end dates. You can also use the
Repossession screen to view previous repossession information using the Next and Previous
buttons in Details section. The Current box in Details section indicates the current
repossession record for each asset.

This tab will be available only when the collateral type associated with the Lease account is
a Vehicle.

You can update the current record, but previous records cannot be modified.

To Specify repossession details for an account
1. Open the Repossession screen and load the account you want to work with.
2. Click the RepolForeclosure sub tab, then click Repossession.

3. Inthe Repossession Details section, select the repossession record you want to work
with.
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Click Add to refresh the Repossession screen to create a new record.

oRacLe
Financial Services Lending and Leasing

Close
e Repossession x Mo
> origination Search| G 3 ¢ Request (Pending: 0)
> Senvicing
Gilletions Account(s): 20160100013159: LT17 L117 Qwey o Audit
pr View~ Format+ frewe RiDetach  wep | G & © curent O showll O Group Followup
ollections
Collecions Company Branch Sub Unit Account & Product Doys Past Due Currency Pay O Amt Amount Due Status Oldest Due Dt
Bankruptey uso1 usHg 2016010013159 LOAN VEHICLE(FR) 19 UsD 36,0049 000 02/01/2016
Repossession
Deficiency Summary | Customer Service | Account Details | Customer Detals | Transactio History | Pmt Modes ~ Repo/Foreclosure | Collsteral | Bureau | Cross/Up Sell Ativites
Reports
Producers Repossession  Analyss
Vendors
Repossession Details dpadd | JEdt | [ view | & Audt
Views Format~ B Freeze 5 Detach wap @
Current Followup Dt Type Collateral Dispesition File Received Dt Repa Dt Repo End Dt Comment
AT T2 DTOYOTA COROLA
Y 02ufnts  DEFAULT CUSTOMER REDEEWED VEHICLE 00306 0316 0229016
Repossession Details
0 B saveandadd | B saveand stay | [ Save and Retun | G Retum
‘
*Current * Collseral 0 TOYOTA COROLA 2 Repo Dt fy
*FalloupDt 123174000 B Dispsition v Repo End Dt )
Type M File Received Dt Y Camment
Y
Tracking Z it | [Elview | o auit
Views Formatv [ Freese ffiDetach ¢l Wrap M Load Tracking
SubParameter  Parameter Value
Mo datato cisplay
Call Activities | Comments | Due Date Fistory
Call Activities dadd | A rit | 2] view | o Auit
Viewv Fomatv [ Freeze ] Detach rap ]
Adion Result Contact Reason Cancel Promise Dt Promise Amt Condition Appointr Followup Dt Time Zone Adi Followup Ot
> WFP o oRe ATIORNEY N 0.00 HONE N 0030t 02/02/2016 12:30:00
> Tools Y
> Setup "
Copyright © 19982016, Oracle andjor it afilates. Al ights reserved ‘bt

For details on this screen refer Customer Service screen’s Repo/Foreclosure tab section in
Customer Service chapter.

7.11 Customer Service screen’s Collateral tab

The Collateral screen displays information regarding any assets associated with an account.
Collateral can be a vehicle, home, or something else, such as household goods. The Collat-
eral screen contains the Home and Seller sub tabs. To view the collateral details

1. Open the Repossession screen and load the account you want to work with.

-7 ORACLE



7.12

ORACLE’

Click Collateral tab. The system displays the following screen:

Financial Services Lending and Leasing

- DashBoard
> Origination
» Servicing
Collections

Collections
Collections
Bankruptcy
Repossession
Deficency
Reports
Producers
vendors

> WFP
» Tools
> Setup

Collections

Search  Customer Service: 20150900014283  Review Request (Pending: 0

Account(s): 20150900014283: RODRIGUEZ ROBINSON

View v Format~ [

Company Branch
UsoL  UsHQ
«

Summary || Customer Service | AccountDetails || Customer Details

Vehide  Seller

Freeze £ Detach
Subunit  Account #
UNDEFIL... 20150900014283 LEASE VEHICLE

Wrap W & @ curent® Show Al Group Follow-up
Product DEY;PDE:;Currer\cy Pay Off Amt

114 USD 15,158.10

m

Transaction History | Pmt Modes

Vehicle
View v Formatw  [Ep Freeze EffiDetach | ol Wirap ()]
Primary Description Status Asset Type Lien Status
¥ 2015 AUDI A4 ACTIVE VEHICLE UNDEFINED
g < T
Vehicle
Type & Description % Description 2015 AUDI A4

Primary ¥
Substiution
hsset % 14012
* Asset Class NEW VEHICLE
* Asset Type VEHICLE
*SubType CAR
*Registration # |UNDEFINED
Status ACTIVE
Select Make and Mode!
*Year 2015
Make ALDI
Model A4

Condition GOOD CONDITIONED

Lien Details
= Lien Status UNDEFINED
= Lien Event Date iy
= Second Lien Holder

Comments
Lien Release Entity

Entity Name

Usage Details

Collateral

Amount Due Status

Lien Event Date

[36] Close:
[Svew || o audt
Oldest Due Dt
4,206.60 ACTIVEDELQ  10/05/2015
. V _
Bureau || Cross/Up Sell Activities
L
op add | Edit =] vier < Audit
Second Lien Holder  Comments Lien Refease Entity  Enf
v
1

[+

=

[

[ saveandstay || [ save andRetum

GaRewm
Extra 2

Total 24

Charge 200,00

Address

* Country  UNITED STATES

[

County NORFOLK
Address # 480 NEPONSET 5T
Address Line 1

Address Line 2 TURNPIKE ST

Zip 02019 v

ZipExtn
City BELLINGHAM

If the account’s collateral is a vehicle, the Collateral screen opens at the Vehicle

tab:

If the account’s collateral is a home, the Collateral screen opens at the Home tab.

If the account’s collateral is neither a vehicle nor a home, the Collateral screen
opens at the Other Collateral.

For details on this screen refer Customer Service screen’s Collateral tab section in Customer
Service chapter.

Customer Service screen’s Bureau tab

The Customer Service screen Bureau screen enables you to view credit bureau reports

associated with the account that were pulled during Lease servicing for the account. You can
also use the Bureau screen to create and pull additional credit bureau reports and view the
results as a text only file.

To view an existing credit bureau report

1. Open the Customer Service screen and load the account you want to work with.
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2. On the Customer Service link bar, click Bureau.

ORACLE’
Financial Services Lending and Leasing

Collecti (W glose
> DashBoard EERTTS
> Origination Search  Customer Service: 20150900014267  Review Request (Pending: 0}
> Servicing
Collections Account(s): 20150900014267: SIGG MARK (S view || o audit
View v Format v Freeze Detach Virap 5, © Current® Show All ©) Group Follow-up
Collections & o < @ &
Collections Company Branch  SubUnit  Account # Product B pDausé Currency  Pay Off Amt Amount Due Status Oldest Due Dt
:’;i“;gm usor  UsHQ 2015090014267 LOAN VEHICLE (FR) 118 UsD 18,397.24 5,209.00 ACTVEDELQ  10/01/2015
« I v
Deficency
Reports
Producers Summary || Customer Service || AccountDetais || Customer Details | Transaction History  PmtModes  Colatersl  Bureaw | CrossjUp Sel Activities
Vendors
Bureau Details dpadd | AEdt | 5 vew || o Audt
IMPORTANT: Actess to credit reparting agency systems i for authorized users and only for permissible purposes, Unauthorized access is prohibited under the Fair Credit Reporting Act and is punishable by
$2500 fine andfor 1 year in Federal prison per occurrence
View v Format~  [5 Freeze  giDetach ol Wrap B [0 submitRequest  ViewReport @ Servidng ©) Crigination
Type Bureau = Status Dt Report S;‘jﬁ:‘f“
No dats to dsplay.
< m ] »
g [
4
Applicant/Customer Detail
View v Formatv (B Freeze  ffiDetach all Wrap 5]
Type First Name I Last Name: Status Birth Dt SN Suffix Address Type Country
No data to dsplay.
[y — m »
Bureau Report
View Repart @) Text(®) POF
View v Format~ [ Freeze pfiDetach | ol Wrap B B PrintReport
Text
No data to dsplay.
> WEP
 Tools
> Setup

For details on this screen refer Customer Service screen’s Collateral tab section in Customer
Service chapter.

Review Request

The Review Requests page is primarily a work flow tool used to flag an account or an
application for the attention of another Oracle Financial Services Lending and Leasing user
and ask for feedback. It allows the system users to send and receive requests (including e-
mail) commenting on a specific account or application.

In this chapter, you will learn how to compete the following tasks:

e Reviewing a request

e Sending a review request

e Responding to a review request
e E-mailing a Review Request

e Closing a review request

Note the following:

e You can complete the above tasks for an Account Review Request using Review
Request page in the Servicing master tab.

e To complete the above mentioned tasks for an Application Review Request, use
Review Request page available in the Origination master tab.

Review Requests Tab

The Review Requests page contains the following sections:
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e Query Section

e Action Section

e Email Section

e Review request records

e Comments

Query Section

Sections

The Query section enables you to filter records according to priority levels i.e.high, normal or
low based on any of the following:

Query o

Options Descriptions

Originator Displays the records of all the active review requests you created.

Receiver Displays the records of all the active review requests you received.

Both Displays all the review requests records you have created as well
as received with the status other than ‘CLOSED’.

View All Displays all the review requests records you sent and received,
both active and closed.

Action Section

The Action section enables you to send, respond or close the review request.

Action Options

Descriptions

Open Applica-
tion/Account

Opens the application details page to review the request. (if you
open it from origination it's application and if from servicing den
account)

Send Request

ing and Leasing user.

Send Response

Sends a response to a review request from another Oracle Finan-
cial Services Lending and Leasing user.

Close Request

Changes the status of review request to CLOSED and removes its
record from the Review Request page. The status can be viewed
by selecting ‘View All’ in the ‘Query’ section.

Email Section:

Sends a review request to another Oracle Financial Services Lend-

The Email section enables you to send an email to either originator or receiver of the review

request which cannot be responded or replied back from email recipient.

Email Descriptions

Options P

Originator Sends an email of review request information to the person listed in the
Originator column on Review Request page.

ORACLE



Email

Options Descriptions

Receiver

Sends an email of review request to the person listed in the Receiver
column on Review Request page.

Comments Sections

The Comments section enables originator or receiver to specify additional information that

needs to be sent with the request.

Comments iy

Descriptions
From
Originator Displays comments specified by the originator of review request at the
Comment time of creating a request.
Receiver Displays comments specified by the receiver of review request at the
Comment time of reviewing a request.

7.13.1.1 Reviewing a Request

System displays the priority and the number of requests ready for review, if any, for your user
id at My Pending Review Requests By Priority section in the Servicing Dash Board

& Welcome, PRAKRRAQ =  Accessibility =

window.
ORACLE"
Financial Services Lending and Leasing
DashBoard DashBoard
DashBoard
DashBoard Origination

Users Productivity

System Monitor My User Queues

Froducer Analysis Description
Process Files No data to display.

App #
No data to display.

Priority
No data to display.

<
Servicing

Queue Description
No data to display.

Number of Accounts
Queue Description
No data to display

Acc ¥
No data to display.

> Origination Priority
> Servicing E]

> Collections

> WEP

> Tools

> Setup

Number of Queues Hard Assigned

My Pending Review Requests By Applications

My Pending Review Requests By Priority

Setup
Product Expiring in Next One Month

Product End Date
No data to display.

Producer

” Producers Count By Status

My Pending Review Requests By Accounts

My Pending Review Requests By Priority
v

>

Status Count
ACTIVE 82

Producers Expiring in Next One Month
Producer End Date:
No data to display.

36 lose

Admin

Critical Batch Job Status
Batch Job Status
No data to display.

vendor

Vendors Count By Status
Status Count
ACTIVE 35

Vendors Expiring in Next One Month
Company Name End Date
No data to display.

To review requests

1. On the Oracle Financial Services Lending and Leasing application home page, click
Servicing main tab and then click Servicing drop-down link. Click Customer Service

link.

The Customer Service window appears, opened at the Results tab. Under Customer
Service screen, click Review Requests tab.
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2. In the Query section, click Receiver.

In the Review Request record, the system displays all open review request you have re-

ceived.

ORACLE’

Financial Services Lending and Leasing

DashBoard
> Origination
Servicing
Servicing
Customer Service
Securitization
Transaction Authorization
Post Date Checks.
Escrow Transactions
Account Documents
Collateral Management
Reports
Producers
Vendors
Batch Transactions
Advances
Payments
Fees
Interfaces
AP Transactions
GL Transactions
CASA Reconciliation
Conversion Accounts

> Collections
> WEFP
> Tools
> Setup

Customer Service »

Search | Customer Servi

Review Requests
Query

@ originatorO) Receiver O soth

View w Format v

Originator
No data to display.
<

Originator
Comment

ez Review Request (Pending: 0)

Action
el |} Open Account [ Send Response
B Freeze ! Detach o Wrap W
Priority Receiver Account #

Receiver
Comment

& it

Email

[ig% Close Request

Reason

[ Close
Eview | o Audit
(59 Reeiver
Status
2>

3. Inthe Review Request record, select the record you want to view and click View. The
following screen is displayed.

ORACLE’

Financial Services Lending and Leasing

DashBoard
> Origination
Servicing
Servicing
Customer Service
Securitization
Transaction Authorization
Post Date Checks
Escrow Transactions
Account Documents
Collateral Management
Reports
Producers
Vendors
Batch Transactions
Advances
Payments
Fees
Interfaces
AP Transactions
GL Transactions
(CASA Recenciliation
‘Conversion Accounts

> Collections
> WEP
> Tools
> Setup

Customer Service

Search | Customer Service

Review Requests
Query

riginatar () Receiver
View~ Formaty [P
Oniginator

PRAKRUTI RAC
PRAKRUTI RAQ
(2

Review Requests

Originator
= Priority
* Recaiver

Originator
Comment

Review Request (Pending: 0)

Action
Deah Ve O (21 Open Account [ Send Request | | [T Send Response
Freeze i Detach ol Wrap o]
Pricrity Receiver Account =
HIGH ARATHI KFISHNA KUMAR 20150900014267
HIGH ABHISHEK LODHA 20150900014267
[ save and add

* Account #
= *Reasan
Receiver
‘Comment

o pdd | 7 Edit

Email

[ Close Request

Reason

REVIEW TRANSACTIONS
REVIEW PROMOISES

& save and stay

£

I save and Retum

[ Close

= view || < Audit

Status

NEW
WAITING FOR RESPON:
>

<A Betum

Status
Date 02/(
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4. For the selected Review Request record, view the following information:

Fields Descriptions

Originator The user id of the request originator.

Priority The request priority: HIGH, NORMAL, or LOW.

Receiver The recipient of the request.

Account # The account number which needs review.

Transaction The transaction selected.

Reason The review reason.

Status The request status.

Date The date and time when the request was created.

Originator Com- The comment by the originator which creating a

ment request.

Receiver Comment | The comment by the receiver after reviewing a
request.

Note

If you click Open Account, system loads the accountin review request and displays the
Account Details page.

7.13.1.2 Sending a Review Request

The Send Request button enables you to send a review request to another the system user.
However, the Send Request button is enabled only if you have specified the receiver while
creating a review request and have saved it.

To send a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click the
Servicing main tab and then click Servicing drop-down link. Click Review Requests tab.

2. In theReview Requests page in the Query section, select Originator.
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3. Click Add to create a new review request. The following screen is displayed:

ORACLE"
Financial Services Lending and Leasing

e Customer Service 38 Clos=
’» Origination Search | Customer Service  Review Request (Pending: 0)
Servicing
Senicing Review Requests g pdd | FEdit | [H view | o Aui
Customer Service Query g sy
Securitization
Transaction Authorization {8 originatorO) Receiver O Both v‘ﬂ [m} [ Qpen Account [ SendRequest | | [ Send Respons= | | [ Close Request 5 Originator 7 Rex
Post Date Checks 3
Escrow Transactions View w Format = | (5} freeze  Ef! Detach ol Wrap W
Account Documents Originator Priarity Receiver Account # Reason Status
Collateral Management
Reports < >
Producers
Vendors
Batch Transactions
Advances Review Requests
Payments
o [ saveandadd | [ saveand Stay | [ Saveand Retum | G Retum
Interfaces B
AP Transactions Originator * Account # - Status
Gl 35 & T Date 02/
6L Transactions Priority 12 *Reason ) )
CASA Reconiliation x
Recesiver &d
Conversion Accounts o
Griginator Receiver
Commant Comment
< >
> Collections
> WP
> Tools
> Setup

4. In the Priority field, select the priority of review request: High, Normal, or Low which
helps the recipient in responding to requests. It does not affect the order in which
messages are sent or received.

5. In Receiver field, select the person you want to receive the message.

6. In Account # field, select the account involved with the review request.
The default value NEW appears in the Status field.

7. In Reason field, select the purpose for the review request.

8. In Originator Comment field, specify any additional message you want to send along
with the review request.

9. Click Save And Add/Save And Return.

The review request is created and Send Request button is enabled in the Action section.

RACLE"
Financial Services Lending and Leasing

Review Requests

(= el = et

o Colloctions
> wee

= Tools
= Setup

10. In the Action section, click Send Request.

The system sends your request to the recipient’s, where it appears on My Pending Re-
view Request window in Dash Board with status SENT TO ORIGINATOR.
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7.13.1.3 Responding to a Review Request

When you receive a review request, the system notifies you by creating an entry in My of
Pending Review Requests By Priority section in Dash Board with the number of unseen
messages. In the following example, one review request is waiting on the Review Request

page.

ORACLE’
Financial Services Lending and Leasing

PRAKRRAD + Accesilty =)

DashBoard DashBoard
DashBoard
DashBoard Origination

Users Productivity
System Monitor
Producer Analysis
Process Files

My User Queues
Description
No data to display.

Count

App = Priority
No data to display.

My Pending Review Requests By Priority
Priority
No data to display.

Count

Servicing
Number of Queues Hard Assigned

Queue Description Count
No data to display
Number of Accounts

Quaue Description Count

No data to display.

My Pending Review Requests By Accounts
Bcc# Priority
No data to display.

»» Origination Priority Count

> Servicing i >
> Collections

> WFP

> Tools

> Setup

< >

Setup

Product Expiring in Next One Month
Product End Date
No data to display.

My Pending Review Requests By Applications

Producer

A Producers Count By Status
Status
ACTIVE

Count
82

Producers Expiring in Next One Month
Producer End Date
No data to display.

My Pending Review Requests By Priority
v

3¢ Close

Admin

Critical Batch Job Status

Batch Job Status
No data to display.
Vendor
'Venders Count By Status
Status Gount
ACTIVE 35

‘Vendors Expiring in Next One Month
Company Name End Date
No data to display.

To respond to a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing main tab and then click Servicing drop-down link. Click Customer Service
link. If the Number of Pending Review Requests tab displays a number, click Review
Requests tab. On the Review Request page Query section, select Receiver.

The system displays the unread review requests in Review Request record.

2.

oORACLE
Financial Services Lending and Leasing

In the Review Request record, select the record you want to view and click View.

PRAKRUTI RAO
<

Review Requests

> Tools

> sewup

BB Seve cnd Sty

Click Open Account.

The system loads the account on Customer Service screen and displays Account Details

page.
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7.13.1.4

4. Perform requested task on review request on the account. Click Review Request tab and
selecting request, click Edit. Specify your response in the Receiver Comment field. Click
Save And Return.

ORACLE’ P ————
Financial Services Lending and Leasing e il =
DashBoard Corstonetr Sorvice 36 Close
> Origination Search  Customer Service  Review Request (Pending: 0)
Servicing
Servicing Review Requests ok add | Edit | View = < Aud
S\nf-nw:«eriamca Query Action Email
Transacton Authorization ® onginater Q) Recenver O goth "5 [ () gpen Account [ send Request Send Respons= | | [k Clase Request 5 Oniginator 5 Receiver
Post Date Checks
s View v Formatv (5 Fresze i Detach Wrap (5]
Account Documents Originator Priority Receiver Account # Reason Status
Collateral Management PRAKRUTI RAC HIGH ARATHI KRISHNA KUMAR 20150900014267 REVIEW TRANSACTIONS NEW
Reports PRAKRUTI RAO HIGH ABHISHEK LODHA )150900 REVIEW PROMOISES 'WAITING FOR RESPON:
i ¢
Batch Transactions
Advances
Payments Review Requests
m::}:; [ save end add | [ Save and Stay || [ save and Retum || (3 Retum
casA Reconciliation Priority HIGH Reason REVIEW TRANSACTIONS Dela: 02/,
Conversion Accounts o * Receiver ARATHI KRISHNA KUMAR bd
< >
> Collections
> WFP
> Tools
* Setup
5. Inthe Action section, click Send Request.
The system sends your response to the originator, where it appears on Review Request
page with status RETURN TO ORIGINATOR.
The recipient can view sent response by clicking Receiver or View All in Query section.
(The request has a status as RETURN TO ORIGINATOR.)

6. Inthe Action section, click Close Request

It will remove the message from the Review Request section.

Back on the originator’'s Review Request page, the message appears when Originator is
selected in Query section. The request has a status as RETURN TO ORIGINATOR.

E-mailing a Review Request

While system updates My Pending Review Requests By Priority section in the DashBoard
to notify you about the new requests, you can also e-mail a review request to both the
originator and a receiver, as applicable. The system will use e-mail address recorded for both
the originator and receive in User Definition section in User page.

To e-mail a review request

1.

o > 0D

On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing main tab and then click Servicing drop-down link.

Click Customer Service link.
On the Customer Service link, click Review Requests tab.
Select the request you want to e-mail in the Review Request section.

In Email section, click Originator to send the message to the person listed in Originator
field.
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7.13.1.5

_or_
Click Receiver to send it to the person listed in the Receiver field.

The system emails the details of selected record to e-mail address recorded in user setup.

Closing a Review Request

You can close a review request you created at anytime, regardless of status. However, you
can only close review requests that have your user id in the Originator field. When you close
a review request, the system removes it from Review Request record.

To close a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing main tab and then click Servicing drop-down link.

2. Click Customer Service link.

3. On the Customer Service link, click Review Requests tab.

4. Select the request you want to close in the Review Request section.

5. In the Action section, click Close Request.

The system assigns the request as CLOSED and removes it from your Review Request

record. The closed accounts can be reviewed anytime by selecting View All in the Query
section.

orAcLe: ST e oo,

Financial Services Lending and Leasing

Curstomer service s 3] Close

" callections

> Tools
> Sctup
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8.1

8.2

8.21

8. Deficiency

Introduction

After an application has cycled through the Lease origination process, it becomes an account.
Account maintenance and collections tasks can be performed with Oracle Financial Services
Lending and Leasing’s Deficiency screen.

The Deficiency screen enables you to view and manage all customer information in a
centralized location to ensure data integrity and provide better service. Oracle Financial
Services Lending and Leasing provides online real-time information about the applicant(s),
contract, account balances, dues, transactions, call activities, and comments. Oracle
Financial Services Lending and Leasing also supports back-dating of financial transactions till
the account’s opening date.

Activating an Account

An account is automatically activated when you fund the contract using the Funding main tab
or convert from a legacy system.

Posting and Reversing Payments

A payment can be posted and reversed on the Payments screen.

Account Mask

After an application completes the Lease origination cycle and is funded or is ported into the
system, it becomes an account and receives an account number. The system assigns
account numbers using the following logic:

YYYYMMNNNNNNNX

where:

YYYYMM = contract date

NNNNNNN = serial number

X = check digit

The system sorts accounts using the NNNNNN portion only. That portion is referred to as the
account ID.

Search Tab

There are two types of search available.

e Account
e Customer

Searching for a Customer or Account

There are a number of different ways to load the customer details on Deficiency screen.

e Use the Search screen by selecting Customer Centric option(s).
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8.3

e Use the Quick Search section to search for the customer by Account Number, or
Customer Id, or by specifying the last four digits of Primary SSN (SSN of the primary
applicant).

e Use the Next Account feature to load the customer from a predefined queue.

For details on how to search and load the customer or account details using Search screen,
refer Search Using Customer Details section in Search Function chapter.

Customer Service screen

Most screens on the Customer Service screen contain the Account(s) and Customer(s)
sections as a header. The Account(s) section provides a quick overview of an account by
displaying its company, branch, account number, product, payoff amount and amount due,
status, and oldest due date. The information on Customer Service screen always refers to the
account selected in this section.

The Customer(s) section displays information about the customer(s) attached to the account.
The information on Customer Service screen always refers to the customer selected in this
section.

To view account details in the Account(s) and Customer(s) sections, open the Deficiency
screen and load the account you want to work with.

On the Customer Service screen’s Account(s) section, you can view the information based
on your selection.

For details on this screen refer Customer Service screen section in Customer Service
chapter
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8.4

8.5

8.5.1

8.5.1.1

Customer Service screen’s Summary tab

Open the Deficiency screen and load the account you want to work with. By default the
Customer Service screen opens the Summary tab.

oRace
Financial Services Lending and Leasing

B Close
e Collections 5 E]
* Origination Search  Customer Service  Review Request (Pending: 0)
> Senvicing
Colletions Account(s) Elview | Fauit
o View Fomatv [ Freeze EliDetch W G & current () Show All ©) Group Follow-up
ollections :
Callections Company Branch Sub Unit Account 2 Product Days Past Due Currency Pay Off Amt Amout Due Status Oldest Due Dt
Bankuptey Mo data to display
Repossession
Deficiency Summary | Customer Servce | Account Details | Customer Detalls | Transaction History | Pt Modes | Burea | Cross/Up Sell Actvities
Reports
Producers
i Alerts Conditions
Vendors
Alerts Conditions
Alert Condition Start Ot Followup Dt
Mo data to display. Mo data to display.
“ Account Details Other Information
‘
Dues .
Customer Information
Mo data to display. Customer ;. Relation ssi Birth Dt Gender
140 data to display.
Delg Due Total Due Future Pt Dt 5
LCDue Todays Payoff Oldest Due Dt
NS Due Future Fayoff Amt Paid Excess
Other Due Future Payoff Date Emai Disabilty Fivacy Opt Out
" formati Language Skin Active Miltary Duty
Delinquency Information Wartal tatus Stop Time Zone
e 30 6 £l W 150 180 Categoy Das Correspondence
Mo data to display
BR(Life) NsF(Life) Collector Address Information
BR(Year) NsF(Year) . Permissi |
Type Current {11 Wailing Address Phone
Activities 1o data to display.
Active Dt App # Last Pt At
> WFP Last Activity Dt Paid Off Dt Charge Off Dt Employment Information
G Due Day Effective Dt wiltary Duty ey
b Toske Last Pt Dt Current Pt Customer score e e R = o
> Setup Customer Grade Last Bill Amt Behaviour Score Hio data to display. -
—
Copyright © 199, 2016, Oracle andjor it affiates. Al rights reserved. Abou

For details on this screen refer Customer Service screen’s Summary tab section in Customer
Service chapter

Customer Service screen’s Customer Service tab

Open the Deficiency screen and load the account you want to work with. Click the Customer
Service tab to view the sections under it.

Call Activities sub tab

With the Call Activities section, the system enables you to record details of all actions you
performed regarding this account. This includes calls from the customer, calls you make
regarding account, or changes to condition of the account. Entries in the Call Activities
section are listed in reverse chronological order of follow-up date and are user-defined.

Each action and result has a code and description. The code for the call action and call result
is what appears on Call Activity sub screen.

Recording a Call Activity

To record a call activity

1. Open the Deficiency screen and load the account you want to work with.
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8.6

8.6.1

8.7

2. Click Customer Service sub tab and then click Call Activities tab under it. Click Add.

The system displays the following screen.
"ORACH

Le:
Financial Services Lending and Leasing

& Welcome, DEMOSUPR +  Accessbilly 4G Sign Qut O

Eaos=

Glview | Pt

mount Due Status Ocest bus ox
0.00 ACTIVE 0272072016

B saveand add [ & Save and stay

Promise Anit Condition Appn'mt Followup DU Time Zone
0.00 - @

Collections

Tools
setup

For details on this screen refer Customer Service screen’s Customer Service tab section in
Customer Service chapter

Customer Service screen’s Account Details tab

Open the Deficiency screen and load the account you want to work with. Click the Account
Details tab to view the sections under it.

Account Details sub tab

Oracle Financial Services Lending and Leasing enables you to view account details using
Account Details sub tab.

In the Account Information section click View.

ORACLE"
Financial Services Lending and Leasing

= P Collections x (3] Glos=
> Origination Search | Customer Service: 20150900014283 | Review Request (Pending: 0)
Account(s): 20150900014283: RODRIGUEZ ROBINSON Elven | Audt
View~ Format~ b Freeze BfiDetach | ol Wrap @ & © curent© Show Al Group Follow-up
Company Branch  SubUnit  Account = Product Davs et currency  Pay OFf Amt Amount Due Status Oldest Due Dt
USOL  USHQ  UNDEFL. 2015000014283 LEASE VEHICLE 114 UsD 15,158.10 4,296.60 ACTIVE:DELQ  10/05/2015
Producers Summary || Customer Service || Account Details | Customer Details | Transaction Hstory | PmtModes | Coliateral | Burcau || CrossjUp Sell Acthities
Vendors

Account Details | Statements | Rate Schedule || Insurances || Contract Information

Account Information Elvew || <2 Ausit
View - Format~ [ Freeze §#iDetach Virap @
#ofExtensions  * of Extensions = of Extension Term # of Extension Term # of Due Day * of Due Day
it e oy o5 ey Zof Due B2 Last Extn OF Due Day Change Dt Total Term
o o o o [ 15

Account Information

Additional Details
# of Due Day chang ) o Total Term 15
= of Due

Maturity Dt 11/05/2016

> WEP

> Tools
> Setup I}

For details on this screen refer Customer Service screen’s Account Details tab section in
Customer Service chapter

Customer Service screen’s Customer Details tab

Open the Deficiency screen and load the account you want to work with. Click the Customer
tab to view the sections under it.
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8.8

8.9

Information gathered on the application entry process regarding the customer and customer’s
address, employment data, and phone numbers appears on Customer Details screen. Using
the Customer Service screen’s Customer Details tab, you can update or add to a customer’s
address, employment information, or phone listing. All the information about the customer can
be changed using Maintenance screen.

To view or edit customer information
1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Details sub tab.

ORACLE
Financial Services Lending and Leasing

ollection: Close
> DashBoard L 24 C
> Origination Search = Customer Service | Review Request (Pending: 0) 2
> Servicing
| Elview || < Audt
e Account(s) _ By 2 Aux
iRietine view v Format~ [y Fresze i Detach W & O curent® Show Al D Group Folon-up
Collections Company Branch  SubUnit  Account & Product DevsPeet Currency  Pay OFF amt Amount Due Status Oldest Due Dt
Bankruptcy No data to display.
Repossession % — 5
Deficency
Reports
Producers Summary | Customer Service | AccountDetals | Customer Details | Transaction History || Pt Modes | Bureau | Cross/Up Sell Actiities
vendors
Customer  Business
Customer Information E
& Edit =] Vie: < Audit
View  Format~ | By Freere igfiDetach | olwrap | @
Customer # Relation Ecoa niame ssn Birth Dt marital Status Enabled Lanc
“ Mo data to diplay.
T 4
< 7
Customer Information
[ saveand stay || [ save andReturn | CaRetun
Customer
Identification Details KvC
Customer #
Relation Passpart £ Reference =
Ecoa Tssue Dt Status
Name Expiry Dt
Birth Dt visa = e
Marital Status Matonzity: Birth Pk
Enabled __ National ID ikt
- Birth Country
BT Y
it S Permanent US Resident Status
M M License State
= Mother's Maiden Name P G RS
Class Type ey 5
ilitary Service
> Tools Email Power of Attorney
Stop Correspondence ;
T op Correspondence [ Holder Name L
st pl Arcemer

For details on this screen refer Customer Service screen’s Customer Details tab section in
Customer Service chapter.

Customer Service screen’s Transaction History tab

Open the Deficiency screen and load the account you want to work with. Click the
Transaction History tab to view the sections under it.

For details on this screen refer Customer Service screen’s Transaction History tab section in
Customer Service chapter.

Customer Service screen’s Pmt Modes tab

Open the Deficiency screen and load the account you want to work with. Click the Pmt
Modes sub tab to view the sections under it.
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8.9.1 ACH sub tab

If used, the ACH section displays information about automated clearing house and electronic
fund transfers.

To view the ACH information screen
1. Open the Customer Service screen and load the account you want to work with.

Click Pmt Modes tab, then click ACH sub tab.

ORACLE"
Financial Services Lending and Leasing

= Close
T Collections 1)

> Origination Search | Customer Service: 2015090001267 | Review Request (Pending: 0)

Account(s): 20150900014267: SIGG MARK [Elten || 2 rudt
View v Format~ B Freeze  Efi Detoch wrap W G © Cunent© Shuw AlO Group Fullow-u
o

Company Branch  SubUnit Account # Product. e Amount Due Status Oldest Due Dt

usoi  UsHQ 20150900014267 LOAN VEHICLE (FR) 5,200,00 ACTIVEIDELQ  10/01/2015

summary || Custor Account Leta

Cross/Up sell actines

Ach || Coupon || PostDated Chedks | I

ACH Information
View - Format~ 5 Fresas [fiDetach rop ® O Reaiming @ Gne-Time Phone ©) A

Reference # Bank Name Bank City. Bank state Routing * Account Type Name On Account  Account % s1C BAN
“ No data to display.

ACH Information

> wep

> Tools
> Setup

For details on this screen refer Customer Service screen’s Pmt Modes tab section in
Customer Service chapter.

8.10 Customer Service screen’s Deficiency tab

The Deficiency screen enables you to record information about deficiency accounts i.e.
accounts that are no longer collectable. You can create and track specific details on the status
of the charged-off account for timely follow-up and analysis. You can also track each stage of
the deficiency process based on its follow-up date and record information using the Details
and Tracking sections.

The Add button enables you to create a new deficiency record with different start and end
dates. You can also use the Deficiency Details screen to view the deficiency information.
The Current field in the Deficiency Details section indicates the current bankruptcy details.

Note

To view the balance of a charged off account, click the Transaction History tab on Custom-
er Service screen, then click Balances. On the Account Details screen’s Balance Group
section, click Deficiency. For more information on Deficiency Balance, see Balances sub
tab section in this chapter.

To enter deficiency details for an account
1. Open the Customer Service screen and load the account you want to work with.
2. Click Deficiency tab.

3. Inthe Deficiency Detail section, select the deficiency record you want to work with
_Or_
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Click Add to refresh the Deficiency screen to create a new record.
CRACLE. iesianihganiiensiig

> DashBoard Deficiency x [3 Close
= Onwinaron Search | Customer Service | Review Request (Pending: 0)
> servicing )
Collections Account(s) B
e ions View v Fomatv B Frecze Hivench | dwar | @ & Current (3 show All () Group Followe-up
Collctio Company Branch Sub Unit Account = Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt

No data to display.

Summary | Customer Service | Account Details || Customer Details | Transaction History | Pmt Modes  Deficiency | Bureau || Cross/Up Sell Activities

S Deficiency Details b add || Lt || 5 vew |  avit
Viewv Formatv [ Freeze i Detach Wrap )
Curent Followup Dt Dispositon e Comment File Received Dt Charge OFF Dt Deficency End Dt
¥ 1273174000

Deficiency Details

B ssve sndacd || B seve snd stey | [ Ssve andRetum || Caetun

“ Curtent @) Camment
‘ “Falovupx 235000 B )
; q
* Diposition’ NEHLY RECEIVED .
P File Received Dt )
Tipe 2 Charge OFf 0t
Deficiency End Dt )
Tracking Z i | Elview | auit
Views Format~ | B | [ Freese Ffioetach | cdviop | @) o LosdTracking
Sub Parameter Parameter Value
o data o dpla
Call Activties | Comments | Due Date History
> wep
> Tools
> Setup
COPIONT © 1955,2016, Orace and/or = Shates, Al Hghtsreserved ) “About

For details on this screen refer Customer Service screen’s Deficiency tab section in
Customer Service chapter.

8.11 Customer Service screen’s Collateral tab

The Collateral screen displays information regarding any assets associated with an account.
Collateral can be a vehicle, home, or something else, such as household goods. The Collat-
eral screen contains the Home and Seller sub tabs. To view the collateral details

1. Open the Repossession screen and load the account you want to work with.

e Click Collateral tab. The system displays the following screen:

ORACLE'
Financial Services Lending and Leasing

 DashBoard fociimasy [ e
> Origination Search  Customer Service: 20150900014283  Review Request (Fending: 0] .
> Servicing
oot Account(s): 20150900014283: RODRIGUEZ ROBINSON S view || < audit
View v Format = Fresze 5 Detach ] virzp B, @ currenti® Show All ©) Group Follow-uy
Collections & e i @ a S i
Colections Company Branch  Sublnit Account # Product Bays PDE:; Currency  Pay OFf Amt. Amount Due Status Oldest Due Dt
2'222“;2% USDL  USHQ  UNDEFL. 2015030014283 LEASE VEHICLE 114 UsD 15,158.10 4,296.60 ACTIVEDELQ  10/05/2015
7] 0 ] b
Deficency
Reports
Producers Summary | Customer Service | AccountDetails || Customer Detals | Transaction History || PmtModes Collateral | Bureau | Cross/Up Sell Activifies
Vendors
Vehicle  Seler
Vehicle
qeadd | A Edit | [ Ve o Audit
View = Format~  [Ep Fresze EfiDetach ol Virap ®
Primary Desaription Status Asset Type Lien Status LienEventDate  Second Lien Holder  Comments Lien Release Entity  Enf
v 2015 AUDI A4 ACTIVE VEHICLE UNDEFINED
g | —— 8 §
Vehicle
Save andStay || [ Save andRetum || CaRetum
Type & Description % Desaription 2015 AUDT A4 Extra 2 4
Total 24
Condition GOOD CONDITIONED
Primary ¥ & Charge 200,00
Substitution . :
Assets 14012 e Address
* Asset Class NEW VEHICLE [
Lien Status  UNDEFINED [+ * Country | UNETED STATES =
* AssetType VEHICLE = Lien Event Dat Y
i} A County NORFOLK =
e o B Second tien Hoder
Address = 480 NEPONSET ST
*Registration ¥ UNDEFINED o
Adgess Line 1
Status ACTIVE F—— =
Seleck ke ard Model %) Glbgsel Address Line 2 TURNPIKE ST
LEWE *Year 2015 b i Zp 02013 =
ooty Make ALDI Usage Details Zip Extn
» Setup Model Ad City BELLINGHAM 15
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8.12

8.13

— If the account’s collateral is a vehicle, the Collateral screen opens at Vehicle tab:
— If the account’s collateral is a home, the Collateral screen opens at Home tab.

— If the account’s collateral is neither a vehicle nor a home, the Collateral screen
opens at Other Collateral.

For details on this screen refer Customer Service screen’s Collateral tab section in Customer
Service chapter.

Customer Service screen’s Bureau tab

The Customer Service screen Bureau screen enables you to view credit bureau reports
associated with the account that were pulled during Lease servicing for the account. You can
also use the Bureau screen to create and pull additional credit bureau reports and view the
results as a text only file.

To view an existing credit bureau report
1. Open the Customer Service screen and load the account you want to work with.

2. On the Customer Service link bar, click Bureau.

Financial Services Lending and Leasing
i Close
D Collections ]
B e patata Search  Customer Service: 20150900014267 | Review Request (Pending: 0)
> Servicing
Collections Account(s): 20150900014267: SIGG MARK [Elen || o audit
W~ - Freeze Virap E, @ curent ) show All ©) Group Follow-u
Cileckine View v Format~ [ Hfipetach | o W & p p
Collections Company Branch  SubUnit  Account # Product £ais ;aus; Currency  Pay Off Amt Amount Due Status Oldest Due Dt
Barkrupte
RZ';OS“;SS“'W usor  UsHQ 20150300014267 LOAN VEHICLE (FR) 118 UsD 19,3724 520900 ACTVEDELQ  10/01/2015
« 1 v
Deficency
Reports
Producers Summary || Customer Service || Account Detaifs || Customer Detals || Transaction History | PmtModes || Collateral | Burean | CrossUp Sell Activities
Vendors
Bureau Details dpadd | AEdt | [Eview | o Audit
IMPORTANT: Access to credit reparting agency systems is for authorized users and only for permissible purposes, Unauthorized access s prohibited under the Fair Credit Reporting Act and is purishable by a
$2500 fine andjor 1 year in Federal prison per ocaurrence
View » Formatw  [E Freeze  gfiDetach Wrap (5] Submit Request  View Report @ Servidng () Crigination
Type Bureau # Status ot Repart s cas
No data to display.
PiE D v
g [
4
Applicant/ Customer Detail
View v Format~ [ Fresze pfiDetoch | o Wirap o]
Type First Name I Last Name Status Birth Dt =) Suffix Address Type Country
No data to display.
[ = m *
Bureau Report
View Report @ Text(®) POF
View » Formatw [ Freeze i Detach ol Wrap & B PrintReport
Text
No data to dsplay.
> WFP
> Tools
> Setup

For details on this screen refer Customer Service screen’s Collateral tab section in Customer
Service chapter

Review Request

The Review Requests page is primarily a work flow tool used to flag an account or an
application for the attention of another Oracle Financial Services Lending and Leasing user
and ask for feedback. It allows the system users to send and receive requests (including e-
mail) commenting on a specific account or application.
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8.13.1

In this chapter, you will learn how to compete the following tasks:

e Reviewing a request
e Sending a review request

Responding to a review request

E-mailing a Review Request

Closing a review request

Note the following:

e You can complete the above tasks for an Account Review Request using Review
Request page in the Servicing master tab.

e To complete the above mentioned tasks for an Application Review Request, use
Review Request page available in the Origination master tab.

Review Requests Tab

The Review Requests page contains the following sections:
e Query Section
e Action Section
e Email Section
e Review request records
e Comments Sections

Query Section

The Query section enables you to filter records according to priority levels i.e.high, normal or
low based on any of the following:

Query .

Options Descriptions

Originator Displays the records of all the active review requests you created.

Receiver Displays the records of all the active review requests you received.

Both Displays all the review requests records you have created as well
as received with the status other than ‘CLOSED’.

View All Displays all the review requests records you sent and received,
both active and closed.

Action Section

The Action section enables you to send, respond or close the review request.

Action Options Descriptions

Open Applica- Opens the application details page to review the request. (if you

tion/Account open it from origination it's application and if from servicing den
account)

Send Request Sends a review request to another Oracle Financial Services Lend-

ing and Leasing user.
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Action Options Descriptions

Send Response | Sends a response to a review request from another Oracle Finan-
cial Services Lending and Leasing user.

Close Request Changes the status of review request to CLOSED and removes its
record from the Review Request page. The status can be viewed
by selecting ‘View All’ in the ‘Query’ section.

Email Section:

The Email section enables you to send an email to either originator or receiver of the review
request which cannot be responded or replied back from email recipient.

Email Descriptions

Options P

Originator Sends an email of review request information to the person listed in the
Originator column on Review Request page.

Receiver Sends an email of review request to the person listed in the Receiver
column on Review Request page.

Comments Sections

The Comments section enables originator or receiver to specify additional information that
needs to be sent with the request.

Comments e

Descriptions
From
Originator Displays comments specified by the originator of review request at the
Comment time of creating a request.
Receiver Displays comments specified by the receiver of review request at the
Comment time of reviewing a request.
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8.13.1.1 Reviewing a Request

System displays the priority and the number of requests ready for review, if any, for your user
id at My Pending Review Requests By Priority section in the Servicing Dash Board

window.

ORACLE’

Financial Services Lending and Leasing

& Welcome, PRAKRRAD +

DashBoard
DashBoard
DashBoard
Users Productivity
System Monitor
Producer Analysis
Process Files

> Origination
> Servicing
> Collections
> WFP

> Tools
 Setup

DashBoard

Origination Setup

My User Queues
Description Count Product End Date:
N data to display. No data to display.

Product Expiring in Next One Month

My Pending Review Requests By Applications
App = Pririty
No data to display.

My Pending Review Requests By Priority
Priority Count
No data to display.

< >
Servicing Producer
Number of Queues Hard Assigned
Queus Description Count ” Producers Count By Status

No data to display. Status Count
ACTIVE 62

Number of Accounts
Quaue Description Count Producers Expiring in Next One Month
No data o display. producer End Date
No data to display.
My Pending Review Requests By Accounts
Acc# Priority
No data to display.

My Pending Review Requests By Priority
Priority Count. N

< >

Admin

Critical Batch Job Status
Batch Job Status
No data to display.

Vendor

Vendors Count By Status
Status Gount
ACTIVE 35

Vendors Expiring in Next One Month
Company Name End Date
No data to display.

To review requests

1. On the Oracle Financial Services Lending and Leasing application home page, click
Servicing main tab and then click Servicing drop-down link. Click Customer Service

link.

The Customer Service window appears, opened at the Results tab. Under Customer
Service screen, click Review Requests tab.

2. In the Query section, click Receiver.
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In the Review Request record, the system displays all open review request you have re-

ceived.

ORACLE’

Financial Services Lending and Leasing

DashBoard
 Origination
Servicing
Servicing
Customer Service
Securitization
Transaction Authorization
Post Date Checks
Escrow Transactions
Account Documents
Collateral Management
Reports
Producers
Vendors
Batch Transactions
Advances
Payments
Fees
Interfaces
AP Transactions
GL Transactions
CASA Reconciliztion
Conversion Accounts

» Collections
> WFP
> Tools

> Setup

Customer Service

Search | Customer Service

Review Requests
Query

@ Originator ) Receiver O Both

View w  Formatv

Originator
No data to display.
<

Originator
Comment

Review Request (Pending: 0)

Freeze

& Detach
Priority

Receiver

Receiver
Comment

Account #

Z i

Email

Bl yiew

[ Close Request

Reasan

Status

3.

following screen is displayed.

ORACLE’

Financial Services Lending and Leasing

In the Review Request record, select the record you want to view and click View. The

DashBoard
> Origination
Servicing
Servicing
Customer Service
Securitization
Transaction Authorization
Post Date Chacks
Escrow Transactions
Account Documents
Collateral Management
Reports
Producers
Vendors
Batch Transactions
Advances
Payments
Fees
Interfaces
AP Transactions
GL Transactions
CASA Reconciliation
Conversion Accounts 1

> Collections
> WFP
> Tools

> Setup

Customer Service x

Search  Customer Sarvice

Review Requests
Query

Review Request (Pending: 0)

Action
- - View = =
oniginator O Rexceiver O ot~ V=4 [ (21 Gpen Account B Send Request
View~ Formaty [P Freere i Detach J Wrap o0}
Originator Pricrity Recaiver
PRAKRUTI RAG HIGH ARATHI KRISHNA KUMAR
PRAKRUTI RAG HIGH ABHISHEK LODHA
Review Requests
Originator * Account #
* Priority hd
i = * Reason
* Receiver 54
Originatar Receiver
Evinoiest Comment
<

% Send Res

Account #

20150800014267
20150800014267

[ seve and add

[ Qose
gepdd | Lede | F 7 Audit
Email
5% Clos= Request 5 Originator
Reason Status
REVIEW TRANSACTIONS NEW

REVIEW PROMOISES WAITING FOR RESPON:
>

E sove and sty || [ save and Return || G2 Retumn
- Status
Date 02/C
[¥]
>

4. For the selected Review Request record, view the following information:

Fields

Descriptions

Originator

The user id of the request originator.
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Fields

Descriptions

Priority The request priority: HIGH, NORMAL, or LOW.
Receiver The recipient of the request.
Account # The account number which needs review.

Transaction

The transaction selected.

Reason The review reason.
Status The request status.
Date The date and time when the request was created.

Originator Com-
ment

The comment by the originator which creating a
request.

Receiver Comment

The comment by the receiver after reviewing a
request.

Note

If you click Open Account, system loads the accountin review request and displays the
Account Details page.

8.13.1.2 Sending a Review Request

The Send Request button enables you to send a review request to another the system user.
However, the Send Request button is enabled only if you have specified the receiver while
creating a review request and have saved it.

To send a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click the
Servicing main tab and then click Servicing drop-down link. Click Review Requests tab.

2. IntheReview Requests page in the Query section, select Originator.
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3. Click Add to create a new review request. The following screen is displayed:

ORACLE"
Financial Services Lending and Leasing

e Customer Service 38 Clos=
’» Origination Search | Customer Service  Review Request (Pending: 0)
Servicing
Senicing Review Requests g pdd | FEdit | [H view | o Aui
Customer Service Query g sy
Securitization
Transaction Authorization {8 originatorO) Receiver O Both v‘ﬂ [m} [ Qpen Account [ SendRequest | | [ Send Respons= | | [ Close Request 5 Originator 7 Rex
Post Date Checks 3
Escrow Transactions View w Format = | (5} freeze  Ef! Detach ol Wrap W
Account Documents Originator Priarity Receiver Account # Reason Status
Collateral Management
Reports < >
Producers
Vendors
Batch Transactions
Advances Review Requests
Payments
o [ saveandadd | [ saveand Stay | [ Saveand Retum | G Retum
Interfaces B
AP Transactions Originator * Account # - Status
Gl 35 & T Date 02/
6L Transactions Priority 12 *Reason ) )
CASA Reconiliation x
Recesiver &d
Conversion Accounts o
Griginator Receiver
Commant Comment
< >
> Collections
> WP
> Tools
> Setup

4. In the Priority field, select the priority of review request: High, Normal, or Low which
helps the recipient in responding to requests. It does not affect the order in which
messages are sent or received.

5. In Receiver field, select the person you want to receive the message.

6. In Account # field, select the account involved with the review request.
The default value NEW appears in the Status field.

7. In Reason field, select the purpose for the review request.

8. In Originator Comment field, specify any additional message you want to send along
with the review request.

9. Click Save And Add/Save And Return.

The review request is created and Send Request button is enabled in the Action section.

RACLE"
Financial Services Lending and Leasing

Review Requests

(= el = et

o Colloctions
> wee

= Tools
= Setup

10. In the Action section, click Send Request.

The system sends your request to the recipient’s, where it appears on My Pending Re-
view Request window in Dash Board with status SENT TO ORIGINATOR.
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8.13.1.3 Responding to a Review Request

When you receive a review request, the system notifies you by creating an entry in My of
Pending Review Requests By Priority section in Dash Board with the number of unseen
messages. In the following example, one review request is waiting on the Review Request

page.

ORACLE’
Financial Services Lending and Leasing

PRAKRRAD + Accesilty =)

DashBoard DashBoard
DashBoard
DashBoard Origination

Users Productivity
System Monitor
Producer Analysis
Process Files

My User Queues
Description
No data to display.

Count

App = Priority
No data to display.

My Pending Review Requests By Priority
Priority
No data to display.

Count

Servicing
Number of Queues Hard Assigned

Queue Description Count
No data to display
Number of Accounts

Quaue Description Count

No data to display.

My Pending Review Requests By Accounts
Bcc# Priority
No data to display.

»» Origination Priority Count

> Servicing i >
> Collections

> WFP

> Tools

> Setup

< >

Setup

Product Expiring in Next One Month
Product End Date
No data to display.

My Pending Review Requests By Applications

Producer

A Producers Count By Status
Status
ACTIVE

Count
82

Producers Expiring in Next One Month
Producer End Date
No data to display.

My Pending Review Requests By Priority
v

3¢ Close

Admin

Critical Batch Job Status

Batch Job Status
No data to display.
Vendor
'Venders Count By Status
Status Gount
ACTIVE 35

‘Vendors Expiring in Next One Month
Company Name End Date
No data to display.

To respond to a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing main tab and then click Servicing drop-down link. Click Customer Service
link. If the Number of Pending Review Requests tab displays a number, click Review
Requests tab. On the Review Request page Query section, select Receiver.

The system displays the unread review requests in Review Request record.

2.

oORACLE
Financial Services Lending and Leasing

In the Review Request record, select the record you want to view and click View.

PRAKRUTI RAO
<

Review Requests

> Tools

> sewup

BB Seve cnd Sty

Click Open Account.

The system loads the account on Customer Service screen and displays Account Details

page.
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8.13.14

4. Perform requested task on review request on the account. Click Review Request tab and
selecting request, click Edit. Specify your response in the Receiver Comment field. Click
Save And Return.

ORACLE’ P ————
Financial Services Lending and Leasing e il =
DashBoard Corstonetr Sorvice 36 Close
> Origination Search  Customer Service  Review Request (Pending: 0)
Servicing
Servicing Review Requests ok add | Edit | View = < Aud
S\nf-nw:«eriamca Query Action Email
Transacton Authorization ® onginater Q) Recenver O goth "5 [ () gpen Account [ send Request Send Respons= | | [k Clase Request 5 Oniginator 5 Receiver
Post Date Checks
s View v Formatv (5 Fresze i Detach Wrap (5]
Account Documents Originator Priority Receiver Account # Reason Status
Collateral Management PRAKRUTI RAC HIGH ARATHI KRISHNA KUMAR 20150900014267 REVIEW TRANSACTIONS NEW
Reports PRAKRUTI RAO HIGH ABHISHEK LODHA )150900 REVIEW PROMOISES 'WAITING FOR RESPON:
i ¢
Batch Transactions
Advances
Payments Review Requests
m::}:; [ save end add | [ Save and Stay || [ save and Retum || (3 Retum
casA Reconciliation Priority HIGH Reason REVIEW TRANSACTIONS Dela: 02/,
Conversion Accounts o * Receiver ARATHI KRISHNA KUMAR bd
< >
> Collections
> WFP
> Tools
* Setup
5. Inthe Action section, click Send Request.
The system sends your response to the originator, where it appears on Review Request
page with status RETURN TO ORIGINATOR.
The recipient can view sent response by clicking Receiver or View All in Query section.
(The request has a status as RETURN TO ORIGINATOR.)

6. Inthe Action section, click Close Request

It will remove the message from the Review Request section.

Back on the originator’'s Review Request page, the message appears when Originator is
selected in Query section. The request has a status as RETURN TO ORIGINATOR.

E-mailing a Review Request

While system updates My Pending Review Requests By Priority section in the DashBoard
to notify you about the new requests, you can also e-mail a review request to both the
originator and a receiver, as applicable. The system will use e-mail address recorded for both
the originator and receive in User Definition section in User page.

To e-mail a review request

1.

o > 0D

On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing main tab and then click Servicing drop-down link.

Click Customer Service link.
On the Customer Service link, click Review Requests tab.
Select the request you want to e-mail in the Review Request section.

In Email section, click Originator to send the message to the person listed in Originator
field.
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8.13.1.5

_or_
Click Receiver to send it to the person listed in the Receiver field.

The system emails the details of selected record to e-mail address recorded in user setup.

Closing a Review Request

You can close a review request you created at anytime, regardless of status. However, you
can only close review requests that have your user id in the Originator field. When you close
a review request, the system removes it from Review Request record.

To close a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing main tab and then click Servicing drop-down link.

2. Click Customer Service link.

3. On the Customer Service link, click Review Requests tab.

4. Select the request you want to close in the Review Request section.

5. In the Action section, click Close Request.

The system assigns the request as CLOSED and removes it from your Review Request

record. The closed accounts can be reviewed anytime by selecting View All in the Query
section.

orAcLe: ST e oo,

Financial Services Lending and Leasing

Curstomer service s 3] Close

" callections

> Tools
> Sctup
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9.1

9. Tools

Depending on the type of product you are working with during origination, the Tools screens
enable you to calculate Lease and Vehicle value details.

Tools in the main menu are standalone and information calculated using them can only be
viewed.

Lease Calculator

The lease calculator works in one of four modes, depending on which of the following options
you select in the Lease Calculator section:

e Calculate Payment

e Calculate Rate

e Calculate Residual Percent

e Calculate Gross Capitalized Cost.

The Calculate Payment mode calculates the base monthly payment using the information
provided: the gross capitalized cost, capitalized cost reduction, residual percentage, rate, and
lease term.

The Calculate Rate mode calculates the rate and the rent factor using the gross capitalized
cost, capitalized cost reduction, residual percent, lease term, and base monthly payment.

The Residual Percent mode calculates the residual percent using the gross capitalized cost,
capitalized cost reduction, rate, lease term, and base monthly payment.

The Gross Capitalized Cost mode calculates the gross capitalized cost using the capitalized
cost reduction, residual percent, rate, lease term, and base monthly payment.

Note

If you want to clear (or “refresh”) the lease calculator at any time, click Initialize in the
Lease Calculator section.
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To calculate a lease payment

1.

Calculator.

ORACLE’
Financial Services Lending and Leasing

On the Oracle Lending and Leasing home screen, click Tools— Tools — Lease

PR — k=)

Lease Calculator x

DashBoard

Origination Lease Calculator
> Servicing
> Collections Parameters

* Contract Dt 02/01/2016
*First Pmt Dt | 03/01/2016
Maturity Dt 02/01/2016

Gross Capitalized Cost 0.00

Lease Calculator
Vehicle Evaluator

Capitalized Cost Reduction 0.00

> Setup

® Calculate Payment () Calculate Rate/Rent Factor () Calculate Residual Percent ) Calculate Gross Capitsiized Cost {8 Initialize || [F] Calculate B, Print Quote
Adjusted Capitalized Cost 0.00 Rent Factor 0.000000
[?G Residual Value(-) 0.00 Total of Base Monthly Pmts (=) 0.00
(£ Residual % 0.0000 *Term 0
Depreciation Value (=) 0.00 Base Monthly Payment (=) 0.00

3¢ dlose

Rent Charge (+) 0.00
*Rate 0.0000

2. Inthe Lease Calculator section, click Calculate Payment, then click Initialize.
3. Inthe Lease Details section, complete the following fields:
Field: Do this:

Contract Dt

Enter the contract date.

First Pmt Dt

Enter the first payment date.

Maturity Dt

View the maturity date.

Gross Capitalized Cost

Enter the gross capitalized cost.

Capitalized Cost Reduction

Enter the capitalized cost reduction.

Adjusted Capitalized Cost

View the adjusted cap cost.

Residual Value (-)

View the residual value.

Residual%

Enter the residual percentage.

Rent Charge (+)

View the rent.

Rate

Enter the rate.

Rent Factor

View the rent factor.

Total of Base Monthly Pmts (=)

View the total of payments.

Term

Enter the term.

Base Monthly Payment

View the base monthly payment.
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9.1.1

9.1.2

4. In the Lease Calculator section, click Calculate.
The system calculates the Base Monthly Payment (=) field on the Lease Details section.
To calculate a rate

1. Inthe Lease Calculator section, click Calculate Rate, then click Initialize. You can refer
to the above section for updating information in the required fields.

2. In the Lease Calculator section, click Calculate.
The system calculates the Rate field on the Lease Details section.
To calculate a residual percent

1. Inthe Lease Calculator section, click Calculate Residual Percent, then click Initialize.
You can refer to the above section for updating information in the required fields.

2. In the Lease Calculator section, click Calculate.
The system calculates the Residual% field on the Lease Details section.
To calculate a gross capitalized cost

1. Inthe Lease Calculator section, click Calculate Gross Capitalized Cost, then click
Initialize. You can refer to the above section for updating information in the required
fields.

2. In the Lease Calculator section, click Calculate.
The system calculates the Gross Capitalized Cost field on the Lease Details section.

Printing a Quote

You can generate a summarised report using the calculated lease details in the format of
quote with lease details and charges.

In the Lease Calculator screen, click Print Quote. The system generates a PDF document to
the default downloads repository consisting of the following information in the respective
headers:

Lease Details

The Lease Details section consists of Contract Start Date, Contract End Date, First Payment
Date, Total Lease Term, and Rate.

Payment/Finance Charge
The Payment/Finance Charge section consists of gross capitalized cost, adjusted capitalized

cost, percentage of residual value, rent factor, base monthly payment, and total of base
monthly payments including rental charges.

Copy Calculation to Contract or Decision tab

Depending on the screen from where you have accessed the tools sub tab, you can copy the
calculated values to either Contract or Decision tab. If you are in Underwriting stage, you can
copy the values to decision tab. Similarly during Funding stage, you can copy the values to
contract tab.

1. Click Initialize and reset the calculator.
2. Click Import values. System displays basic values entered in previous tabs.

3. Select one of the following option “Calculate Payment/Calculate Rate/Calculate Residual
Percent/Calculate Gross Capitalized Cost” and click Calculate. System displays
calculated values based on selection.
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9.2

Click Copy to Contract/Decision. The calculated details are copied to the respective fields in
Contract/Decision tab.

Vehicle Evaluator

The Vehicle Evaluator screen allows you to calculate the value of a vehicle. You can use the
Vehicle Evaluator screen to calculate the value of either a vehicle you are entering as the new
collateral or vehicle currently listed as the application’s collateral.

The Vehicle Evaluator screen can be cleared or refreshed at any time by clicking Clear.

To calculate a vehicle value

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Tools— Tools
—> Vehicle Evaluator

oORACLE"
Financial Services Lending and Leasing

kUl

‘‘‘‘‘

»»»»»

msrp

> Setup < >

2. Inthe Vehicle Evaluator section, use Asset field to select the vehicle you want to
appraise. This can be either NEW COLLATERAL or a vehicle entered on the Collateral
link.

3. Inthe Vehicle Evaluator section, click Initialize. The system completes Valuation
Source, Period and Region fields.

4. If needed, you can change the default contents of the fields in Vehicle Evaluator.

If you selected a vehicle from the Collateral link in step 3, information from the Vehicle
section appears in Vehicle section in Vehicle Evaluator screen.

6. If you selected NEW COLLATERAL in step 3, complete the Identification #
-or-
Complete the fields in the Vehicle section.

7. Inthe Vehicle Evaluator section, click Evaluate.

— If you have specified the vehicle identification number, system searches for the
value of that vehicle with that identification number, then completes Vehicle
Evaluator screen with information about that exact match.

— If you completed the Vehicle section, system searches for the value of a vehicle
matching that description.

— In either case, the system displays following information about the vehicle:
— In the Vehicle section, view the returned information:
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Field: View this:

Year The asset year.

Make The asset make.

Model The asset model.

Body The asset body style.

Usage The asset usage or current mileage.
Weight The asset weight.

In the Valuation (Total Value) block, view the returned information:

Field: View this:

MSRP Manufacturer’s suggested retail price value of the asset.
Total Total value of the asset.

Usage Adjusted usage value of the asset.

In the Base and Attribute Value section, view the returned information:

Field: View this:

Base Retail Total retail value of the asset.

Base Loan Base loan value of the asset.

Base Trade Base trade value of the asset.

Retail Retail value of the asset attributes.
Loan Loan value of the asset attributes.
Trade Base trade value of the asset attributes.

9.2.1 Attributes Tab

In the Attributes section, view the following information:

Field: View this:

Attribute Asset attribute.

Retail Attribute retail value.

Loan Attribute loan value.

Trade Attribute trade value.

Standard Standard indicator. If selected, indicates that the attribute is a standard.
Package If selected, indicates that the attribute is inclusive.

Incl
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Field: View this:

Selected If selected, indicates that the attribute is selected.

If you want to re-calculate the values using other data in Total Value and Base and Attribute
Value section, do the following:

e Make the required changes to the desired parameters fields in Vehicle Evaluator and
Vehicle sections.

e Inthe Vehicle Evaluator section, click Recalculate.
The system updates the values in Total Value and Base and Attribute Value sections.

If you choose, use Attributes section to select or clear the Selected box for attributes of the
vehicle. This automatically updates the values in Total Value and Base and Attribute Value
sections. (Note: Attribute amounts within brackets reduce the amount in Totals field in the
Total Value section.)

To copy the calculated value to the Collateral link

You can copy the calculated value to Collateral link only if you have accessed the tools tab
either from Underwriting or Funding Tab. Accessing Tools from the main menu does not
support this option.

1. Complete the following steps in the section To calculate a vehicle value.

2. In the Vehicle Evaluator screen, click Copy to Asset.

The system uses calculations on the Vehicle Evaluator screen to complete Valuation sub
screen on Collateral link. Any pre-existing collateral is no longer the primary collateral.
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10. Oracle Financial Services Lending and Leasing

10.1

Reports

During day, or at end of the day, you may want to retrieve any information from several
operations that were performed during the day in your financial institution. You can generate
this information in the form of reports in Oracle Financial Services Lending and Leasing. You
can specify the values in the Report Parameters section and generate a report using that

information.
Navigation to Reports

On the Oracle Financial Services Lending and Leasing home page, click
Collections— Collections— Reports.

. PRAKRRAO - Accessibitty NN —

ORACLE"
Financial Services Lending and Leasing
==
S Detacn - @
e
ND E COLLECTION! ~
=
=
uznoe M
e
=
S
o)
=
S
This collection report lists bankruptcy accounts.
Parameters:
e Company/Branch
e Report Format
Example of the Bankruptcy Log report
Report - t ORACLE
Financial Services Lending and Leasing
Da
Company : US01
Branch - USHQ
ALL AMOUNT ARE IN USD
Pool Id Type Disposition Account # customer Balance Bankruptcy File Rcvd Follow-up
Date Date Dat
UNDEFIN NEWLY 201512000 ANAND AJITHA 51034 65 02/04/2016
ED RECEIVED 11375
Pool Total : 51,034.65
Branch Total : 51,034 65
Company Total: 51,03465
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10.2 Collector Activity (Detailed) Loqg

This collection report lists collector activity details.

Parameters:
e Company/Branch

e From MM/DD/YYYY
e To MM/DD/YYYY

Example of the Collector Activity (Detailed) Log report

KLEQ

ALL AMOUNT ARE IN USD

ORACLE'

Financial Services Lending and Leasing

Date Collactor Account § Fame call Type Action

Result Type

Follow-up Dt

Promise Dt

Promise Amt ©

SHASHANE SPARROW JACK / MARYY PR 12/20/2015 1,000.00 N
12/17/2015 ESRIVASTAVA 2/17
collector Activity A collector Total: 1,000.00 |
count :
HARSHAL SPARROW JACK / MARYY PP 1,000.00 N
TEMZIRE /17
SPARROW JACK / MARYY PP 1,000.00 N
2/28
collector Activity 2 collector Total: 2,000.00
count :
NTAR 2012020001083 LEWIS JERRY / JEAN a ™ ™ 2,000.00 W
12/23/2015 EHAIRNAR 24/30
Accounts 1 Collector Activity [ 1 2,000.00 |
Worked: count :
pat Date Activity 2,000.00
VENKATESHWAR ca 22/ o000 §
12/18/2015 ULU ROUTHU
ector Activity ol 0.00
count :
Date Count: . Date Activity 0.00
= Count :

h activity

Grand Count

10.3 Collector Activity Loq

This collection report lists collector.

Parameters:
e Company/Branch

e From MM/DD/YYYY
e To MM/DD/YYYY

e Account Number

e Department

e User Name

e Report Format

10-2
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10.4

10.5

Example of the Collector Activity Log report

Report ORACLE
Financial Services Lending and Leasing
Dat
From Date: DL/D1/1800 To Date: D1/01/2048
Company: NLO2
Branch: NLHQ
DepartmentODD-01 ORIGINATION
Date Collector Name Account Call Type Action Result Type Count Comments
Type
01/19/2018 SERVICE OFSLL 20120400010114 [ cc HU 5 ACC_STATEMENT LETTER GENERATED. ([CORRESPONDENCE:
NLNCE_STM_LTR_VR JOB REQUEST ID: 10078)
SERVICE OFSLL 2012040001014 I cc HU 1 COULECTIONT LETTER GEMERATED. (CORRESPONDENCE
CNLNCE_COL_LTR1_VR JOB REQUEST ID- 10121}
SERVICE OFSLL 20120400010114 [ c HU 1 COULECTIONZ LETTER GENERATED. (CORRESPONDENCE
CNLNCE_COL_LTR2 VR JOB REQUEST ID: 10128)
SERVICE OFSLL 20120400010114 I < HU 1 COLLECTION3 LETTER GENERATED. (CORRESPONDENCE.
CNLNCE_COL,_LTR3_VR JOB REQUEST ID: 10135)
SERVICE OFSLL 2012040001014 [ cc HU 1 WELCOME LETTER GENERATED. (CORRESPONDENCE:
CNLNCE_WEL_LTR_VR JOS REQUEST ID: 8141)
SHASHANK 2012040001014 I cc HU 1 CUSTOMER CALLED-HUNG UP, CONTAGTED: BROTHER-IN-LAW,
SRIVASTAVA NEXT FOLLOWUP DATE: 01/22/2016
Date Total 10
1211772 HARSHAL TEMGIRE  20120200010081 cc PR g CUSTOMER CALLED-PROMISE TO PAY. CONTAGTED: ATTORNEY,
PROMISES: 51 uouonma:?osﬁnm 1211772015, NEXT
DATE:
HARSHAL TEMGIRE  20120200010081 cc PP 3 CUSTOMER CA.LLED PROM\JE TO PAf ..QNTACTEO ATTORNEY,
PROMISES: $1.000.00 TO BE POSTED BY: 12242015, NEXT
FOLLOWUP DATE: 1227/2015
KIR&N GOUDU 20121000010174 AT PH 1 ARSI AL TH e RS PAYMERT I (AR STORE ]
CONTACTED: ANSWERING MAC PROMISES:
TO BE POSTED BY: 12/17/2015, NEXT FOLLOWUP DATE: e
KIRAN GOUDU 20121000010174 AT PH 1 ‘CUSTOMER CALLED-PAYMENT IN HAND (STORE), CONTACTED:
ANSWERING MACHINE, PROMISES: $1.000.00 TO BE POSTED
BY: 12/17/2015, NEXT FOLLOWUR DATE: 12/20/2015
KIRAN GOUDU 20121000010174 aT PH ) CUSTOMER CALLED-PAYMENT IN HAND (STORE). CONTACTED:
ANSWERING MACHINE, PROMISES: $1,000.00 TO BE POSTED
BY: 1212412015, NEXT FOLLOWUP DATE: 12i27/2015
KIRAN GOUDU 20121000010174 cc PH 2 ATTORNEY/GENERAL TELEPHONED-PAYMENT IN HAND (STORE),
CONTACTED: ANSWERING MACHINE, PROMISES: $4.324.00
TO BE POSTED BY: 12/17/2015. NEXT FOLLOWUP DATE: 122072015
KIRAN GOUDU 20121000010174 cc PH 2 ‘CUSTOMER CALLED-PAYMENT IN HAND (STORE} CONTACTED:
ANSWERING MACHINE, PROMISES: $1,000.00 TO BE POSTED
BY: 121712015, NEXT FOLLOWUP aATE 120202015
KIRAN GOUDU 20121000010174 oc PH 2 Cb"TDM:R CALLED-PAYMENT IN HAND (STORE), CONTACTED:
1,000.00 TO BE POSTED
BY: 1212412018, NEXT FOU.OWLF DATE: 1202772015
KIRAN GOUDU 20120200010081 =] PP El COLLATERAL INFORMATION UPDATED - COLLATERAL TYPE: HOME.
Date Total: 42
120302015 NAGAVENKATA 20120200010231 [ AT PH 4 A‘I'TORNE“-GENERALTEI_FHONED—PAYM&N’T IN HAND cs‘roﬁa
VINNAKOT CONTACTED: ANSWERING MACHINE, ISES:
TO BE POSTED BY: 12/30/2015, MEXT FOUL BniE DATE: 13502018
SERVIGE OFSLL 20120200010231 [ AT PH 52 ACC_STATEMENT LETTER GENERATED. (CORRESPONDENGE:
CNLSCE_STM _LTR JOB REQUEST ID: 10105}
VARSHA VAIDYA 20120200010231 [ AT PH 2 PAYOFF QUOTE PROVIDED TO FOR AMOUNT USD 8,500.00 VALID
UPTO 123172015
Date Total: 58
Department Total 148

Branch Total: 145
r 33T

Collector Productivity by Queue

This collection report lists collector productivity sorted by queue.

Parameters:
e Company/Branch
e From MM/DD/YYYY
e To MM/DD/YYYY

Example of the Collector Productivity by Queue report

C)I?AC L

Fing I Services Lending

Deficiency Log

This collection report lists deficiencies.
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Parameters:
e Company/Branch
e Report Format

Example of the Deficiency Log report

2s Lending and Leasing

Account # Customer/Product Follow-Up Charge-Off File Rcvd Date Balance
Date ate
UNDEFIN 201202000 02/16/2012 02/16/2013 0371072 5011.65
ED a1
201202000 02/16/2012 02/16/2012 0371072012 5011.65
10108 un
201201000 ANDERSON NEQ / ANNA/LOAN-  12/22/2015 12/24/2015 02/10/2012 BO23.77
12/24/2015 12/24/2015 0271072012 BO23.77
12/24/2015 12/24/2015 0271072012 BO23.77
12/24/2015 12/24/2015 0271072012 BO23.77
12/24/2015 12/24/2015 03/10/2012 7083 58
JOSEPHINE/LOAN - UN
POTTER HARRY / RUDY/LOAN- 12/247/2015 0371072012 EECERS
un

72272015 0371072 EECER)
12/24/2015 0371072 EECERE)
1272472015 0371072012 J983.58

1272472015 0371072012

12/24/2015 0a/10/2012

1272472015 Da/1072012

1272472015 0471072012

DPoocl ID Type

Follow-Up Charge-Off File Rcovd Date Balance
Date

12/24/2015 1272472015

12/28/2015 1272472015

SCHWARZ ALLAN [ 12/24/2015 1272472015 15798.02
TRACY/LOAN-VE

201204000 TETSUYR KO3 7 12/24/2015 1272472015 13993 .07
1839 AKTRA/LOAN-SG

17 220,576.90

EF 230,576.00

Company e 33 290, 659.00

10.6 Delinquency Analysis by Credit and Grade

This collection report lists delinquency analysis sorted by credit grade.

Parameters:
e Company/Branch

e Producer

Example of the Delinquency Analysis by Credit and Grade report

10.7 Delinquency Analysis by Producer

This collection report list delinquency analysis sorted by producer.

Parameters:
e Company/Branch
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e Product
e Producer
e Report Format

Example of the Delinquency Analysis by Producer report

Report: Delinquency Analysis By Producer
/11/2013 16:00 PM

Date: 10,

ORACLE
Financial Services Lending and Leasing

AL ALL
Py Ssrsent of Fmsunt
50 EX o e Toral
o ~oo as. 11 .ma "
AT T
Amoun parcent of Amcun:
50 £ eaT 50 ToERT

10.8 Delinquency Analysis by State

This collection report lists delinquency analysis sorted by credit state.

Parameters:
e Company/Branch

e Product
e State
e Report Format

Example of the Delinquency Analysis by State report

Re by Sta ORACLE
Da Financial Services Lending and Leasing
Company- xroz t: ALL State: ALL
Branch: x
ALL TS0
¥ of Accounts Amount Percent ol Amount
Balance 30 B0 00: Total 30 50 I 30 50 0+ Total
=, 84584 g a 1 1 500 500 5, 831.78 T 000 59651 55 691
1 0.0 .00 0.000 99.691
2 .00 o0 0,000
E .00 60 0000
3 500 oo 5000
2 0.00 .00 oo 99.44!
c 2 12 2 o.co e 12 ok el 99.ao0 39400
1 a 3 12 0.00 1 oo 99.40 9. 400
and Tota
5,849.84 o o 1 1 o.00 00 s 9969
Branch: wrz1
ALL AMOUNT ARE IN USD
# of Accounts
Talance 30 60 90+ Total 30 [0
25,228.03 o ) 3 3 o.ca .00
22,866.90 o g z = .00 00
48,094,953 o o s s o.00 00
48,098 o ,804.8 o.o00 95.238 2
Tand Tora
o.co .00 L0 24 95.240
Product: ALL State: ALL

10.9 Delinquency Log

This collection report lists delinquencies.
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Parameters:
e Company/Branch

e Report Format

Example of the Delinquency Log report

10.10 Non Monetary Txns Logq

This collection report lists non monetary transactions.

Parameters:
e Company/Branch

e Account Number
e From MM/DD/YYYY
e To MM/DD/YYYY
e Report Format
Example of the Non Monetary Txns Log report

o u T =

omacL e

10.11 Collection Queue Wise Promises Report

The collection report lists queue wise promise reports.
Parameters:

e Company/Branch

e From MM/DD/YYYY

e To MM/DD/YYYY

e Report Format

e Queue Name
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Example of the Collection Queue Wise Promise report

Queue Promises Log ORACLE
Financial Services Lending ar

10.12 Payment Promise Loq

The collection report lists payment promises.

Parameters:
e Company/Branch

e Collector

e From MM/DD/YYYY
e To MM/DD/YYYY

e Report Format

Example of the Payment Promise Log report

10.13 Repossession/Foreclosure Log

This collection report lists bankruptcy accounts.

Parameters:
e Company/Branch

e Report Format

10-7
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Example of the Repossession/Foreclosure Log report

Report : Repossession/Foreclosure Log ORACLE
Date: 3/14/2016 18:29 PM Financial Services Lending and Leasing

ALL AMOUNT ARE IN USD

Type Disposition Account # Customer/Asset Balance Repo Forc File Recvd Follow-up Date
Date Date
NEWLY 20150600010169 UNIT1 SUB 51,373.78 03/04/2016
RECETIVED 0 TOYOTA CAMRY
NEWLY 20150600010169 UNIT1 SUB 51,373 .78 03/04/2016
RECEIVED
Type Count: 2 Type Total: 102,747.56
Branch Count: 2 Branch Total: 102,747.56
Company Count: 2 Company Total: 102,747.56
Grand Count: 2 Grand Total: 102,747.56

10.14 Accounts and Listing - Lease

This report lists the accounts log.
Parameters:

e Company/Branch
e Account Status
e Report Format

Example for Accounts and Listing report
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11. Producer

Oracle Financial Services Lending and Leasing is capable to create and service direct as well
as indirect Lease. Indirect Lease are generated through Producer Entities like Dealerships
and Agents. It is essential to create and maintain such entities to enable incentive tracking
and business development achieved through each entity.

Applications are sent to financial institutions indirectly through producer entities like dealers
or agents on behalf of a customer. Specifying Producer details is mandatory while creating a
application since the system associates a credit application with the producer entity which
sent it, on the Application Entry, Underwriting, and Funding screens. When the credit
application is approved and funded, the system associates the account with the producer
entity.

The following three different status are defined for Producer Entities in OFSLL:

e Active: Only if Producer Status is Active, the application sourced through that Producer
Entity can be funded.

e Inactive: If the Producer Status is Inactive, the application sourced through that
Producer Entity cannot be funded.

e Temporary: If the Producer Status is Temporary, the application sourced through that
Producer Entity can only be reviewed. However it cannot be funded.

The producers are paid for their participation, either:

e Up front during funding
-or-
e Up front on a monthly basis
-or-
e When the interest is earned
-or-
e When the payment is received from customer based on the set up compensation plans.
The Producer Setup screen contains pages that enable you to maintain and administer

producer compensation, compensation payments, charge back plans, and chargeback
parameters.

While setting up Producer entities it is also essential to setup the Producer Cycles under
'Setup' in main menu. For more details, refer to Configuring Lending and Leasing guides.
While working with the Producer Setup screen, you will primarily use the following sub tabs:
1. Payment Details

Tracking Attributes

Contracts

Comments

o M w0 DN

Summary

The Producers screen, completed during setup, can be used to view and maintain producer
details.
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11.1

Producer Details

The Producer details screen allows you to record or edit basic information about the producer.
You can set up dealers or producers for a company and branch. You can also set up a default
underwriter and a default collector for a producer. The system uses this information in the
origination work flow to select a queue.

The producer number, name, contact information, company and branch to which the producer
is associated with, federal tax number, status, and license information can be stored in this
screen.

Navigating to Producer

1. On the Oracle Financial Services Lending and Leasing home screen, click
Collection— Collections— Producers.

2. The system displays the Producers setup screen.

ORACLE - s & Welcome, PRAKRRAQ +
Financial Services Lending and Leasing
Close
DashBoard e =
> Origination Producer Details oF Add | 7 Edit S| View || <7 Audit
= View ~ Format~ P Freeze  ff Detach Wrap W o
Servicig Producer # Old Producer #  Name Company Branch Start Dt End Dt Status Enzbled
- . UNDEFINED: 02/03/2016 12/31/9993 Y
Customer Servic
r:;:":‘;"“e AK-00001 HELL HELL uso1 UsRL 12/22/2015 12/31/1999 ACTIVE Y "
S CA-00001 €A-00001 DEMO [i= usHa 11/06/2012 12/31/9999 ACTVE ¥
s D‘[ clr:' e 5 CA-D0D02 CA-D000Z RANDYS AUTO SA__ USD1 USHQ 01/01/1800 12/31/4000 ACTIVE "
. o ‘1 R CA-00003 CA-00003 ACE HEADQUART.. USO1 UsHQ 01/01/1800 12/31/4000 ACTIVE ¥
S CA-00004 CA-00004 VOLKSWAGEN OF.. USO1 UsHQ 01/01/1500 12/31/4000 ACTIVE ¥
4 ‘;"" Ik ‘D_“‘"” 1% . CA-DDD0S CA-D000S AUTO JUNGLE Us01 UsHQ 01/01/1800 12/31/4000 ACTIVE ¥
Lobeie sl Morogeanchl CA-00006 CA-00006 SIMI VALLEY CHR . USO1 UsHQ 01/01/1800 12/31/4000 ACTIVE ¥
Reparts cA-00007 PHANINDRA uso1 UsHa 12/12/2010 12/31/9999 ACTIVE Y v
Producers CA-D0008 FHANINDRA PHANINDRA1 Uso1 USHQ 13/19/2012 12/31/9998 ACTIVE Y
Vendors < >
Batch Transactions i
Advances -
Mu— Producer Details
Fees [ saveendadd | Hseveandsmy | [ ssveandRetum | 3 Retum
Interfaces
AR sions * Producar #  UNDEFINED Max Float 99,999
GL Transactions ————— * Country =]
CASA Reconciliation - A
Conversion Accounts i *Name T
R — [w] Address Line 1
- [g] Addressine2
ozj032006 B -x & .
123j9000 (B ip Bn fon Type STATEMENT V]
*Contact - " Collection mMONTHLY [v]
i Frequency
Stats v
*Group 53] o= 2l = Refund | NoNE &
e ~ *phone 1 (000)-000-0000 Disbursement Method
Bin1 *Region v
Type v g [~
= Phone 2 *Terito v
Status v] 2 L
= Bain2
* Sales Agent v Li Detail
* Fax Prefix [v] E—
* Undenwriter [~
*Fax 1 (000)-000-0000 — B
. =
Funder = Fax Prefic? [+] *Valid To B
> Collections * Collctor [+ Fax2
e =Fed Tax # UNDEFINED .
> Tools Address Details toetomre |0
Amaunt N
P Payment Details | Compensation | Subvention || Transactions | Holdback/Loss Reserve || Tracking Attributes || Statements | Contacts || Comments | Summary || Title Staty >~

To set up the Producer

1. In the Producer section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Producer # Based on the system setup, either:
Specify the producer number

-or-

The system generates producer number.

Producer will be activated on the next system date (current system
date + 1) and not on the start date.
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Field:

Do this:

Old Producer #

Specify the old producer number.

Name Specify the producer name.

Company Select the company from the drop-down list.

Branch Select the branch from the drop-down list.

Start Dt Select the producer start date by clicking on the adjoining Calendar
icon.

End Dt Select the producer end date by clicking on the adjoining Calendar
icon.

Contact Specify the producer contact.

Group Select the producer contact group from the drop-down list.

Grade Select the producer grade as per business processes from the drop-
down list. The list consist of values which are used only for
categorizing at the producer level and can be changed periodically
as per business requirement.

Type* Select the producer type from the drop-down list. The Group and
Type fields help in setting up the pricing schemes on Pricing screen.

Status Select the appropriate status from the drop-down list. The contents
of this field can be linked to edits in Lease origination cycle so that
only applications from Producers whose status is 'Active' can be
funded.

Sales Agent Select the sales agent associated with this producer from the drop-

down list.

Underwriter

Select the default underwriter assigned to this producer from the
drop-down list. Only users with a responsibility for an
UNDERWRITER can be designated as underwriters for producers.

Funder

Select the users with responsibility as Funding Specialist, from the
drop-down list.

Collector

Select the default collector or agent assigned to this producer from
the drop-down list. (This will appear in the Collector field in
Delinquency Information section of Account Details screen on
the Customer Service screen).

Fed Tax #

Specify the federal tax identification number. If the organizational
parameter UIX HIDE RESTRICTED_ DATA is set to Y, this appears
as a masked number; for example, XXXXX1234.

Address section

Country

Select the country code from the drop-down list.

Address Line 1

Specify address line 1

Address Line 2

Specify address line 2
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Field:

Do this:

Zip Select the zip code from the drop-down list.

Zip Extn Specify the extension of the zip code.

City Specify the city.

State Select the state from the drop-down list.

Phone 1 Specify phone number 1.

Exnt 1 Specify phone number 1 extension.

Phone 2 Specify phone number 2.

Extn2 Specify phone number 2 extension.

Fax Prefix1 Select fax prefix number 1 from the drop-down list.
Fax1 Specify fax number 1.

Fax Prefix2 Select fax prefix number 2 from the drop-down list.
Fax2 Specify fax number 2.

E-Mail Specify the producer mail address.

Loss Reserve Specify the loss reserve amount

Amount

Max Float Specify the value of maximum float allowed for the Producer.

A Float represents the application sourced by the producer that is
Funded and awaiting 'Title perfection' from the concerned authorities
for marking lien. If you do not know the exact value but want to
provide a maximum float, then specify the value as 99999.

Remaining Float

System automatically displays the available number of floats by
calculating the remaining float value based on 'Max Float' and Title
perfections under processing.

Enabled

Check this box to enable the product.

Subvention Partici

pation Details

Subvention
Participant

Check this box to maintain the producer as subvention participant

Collection Type

Select the collection type from the drop-down list.

Collection Select the collection frequency from the drop-down list.
Frequency

Refund Select the refund disbursement method from the drop-down list.
Disbursement

Method

Region Select the region of producer from the drop-down list.

Territory Select the territory of producer from the drop-down list.

ORACLE



Field: Do this:

License Details

Valid From Specify the date from when the producer’s license is valid.

Valid To Specify the date till when the producer’s license is valid.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

Oracle Financial Services Software recommends that you double-check the fax numbers
(especially the 10 digit number) and email addresses you enter on this screen, since the
system uses this information to send its system-generated underwriting decisions.

11.1.1 Payment Details

You can setup ACH as the payment mode for a dealer or producer on Payment Details sub
screen. The Payment Details sub screen stores information regarding the producer’s bank,
such as bank’s name, routing number, account type and account number. Once this sub
screen is completed, the information goes into effect immediately. To complete the Payment
Details

1. Click Collection— Collections— Producers—> Payment Details.

2. In the Payment Details section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Pmt Mode Select the payment mode from the drop-down list.

Bank Specify the ACH bank name.

Start Dt Select ACH start date if payment mode is ACH. You can even
select the date from adjoining Calendar icon.

Routing # Specify the ACH bank routing number.

Account Type Select the ACH bank account type from the drop-down list.

Account # Specify the ACH bank account number.

BIC Select the Business Identifier Code from the drop-down list.

The list displays the BIC codes defined in the system.
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11.1.2

Field: Do this:

IBAN Specify the IBAN (International Bank Account Number). IBAN
is used for identifying bank accounts across national borders
with a minimal of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation
based on modulo 97. On save, system automatically validates
the IBAN number length based on country code, characters,
white spaces, and checksum. Validation is also done during
posting non-monetary transaction (ACH Maintenance).

You can maintain the IBAN length and other details required
as per the country code in the user defined table (Setup >
Administration > System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is
defined by default with length of IBAN as 18.

Disbursement Select the disbursement currency from the drop-down list.
Currency

Perform any of the Basic Actions mentioned in Navigation chapter.

1. Compensation Plan sub screen

You can view additional details of the Compensation Plan, Chargeback Methods, and
Compensation/Chargeback Amounts in the sub screen.

e SubventionSubvention Receivables In the Subvention Receivables section, you can
view the following details. The Transactionsin the action block.All transactions relating
to Payment to / from Producers, Disbursements transactions from Holdback / Reserve
can be posted by selecting ‘Others’ option in the action block.

e Subvention Receivables / Payments and adjustments can be posted by selecting
‘Subvention’ option in the action block.

On selecting ‘Others’ or ‘Subvention’ option, click Add and specify the following field
information.

Click Post to post the transaction for processing.

Holdback/Loss ReserveHoldback/Loss Reserve Proceed Holdback and Loss Reserve
for the producer.

Holdback/Loss Reserve
1. Click Producers—> Holdback/Loss Reserve.

2. Inthe Proceed Holdback section, you can view the account and Holdback amount details.
In the Loss Reserve section, you can view Loss Reserve amount details.

Tracking Attributes

The Tracking Attributes sub screen allows you to link information to a producer who is not
tracked in the system, by default, however is part of company’s business practices.
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11.1.3

11.1.4

To complete the Tracking Attributes
1. Click Collection— Collections— Producers— Tracking Attributes.

2. In the Tracking section, you can edit the parameter and Value details.
Contacts

The Contacts sub screen allows you to record information regarding contacts associated with
a producer, such as employees at a dealership.

To complete the Contacts
1. Click Collection— Collections— Producers— Contacts sub tab.

2. On the Contacts sub screen, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Contact Type Select the producer contact type from the drop-down list.
Name Specify the producer contact name.

Phone Specify producer contact phone number.

Extn Enter phone number extension.

Fax Enter producer contact fax number.

Enabled Check this box to indicate this is a current contact.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
Comments

The Comments sub screen allows you to view and enter comments regarding the producer.

To enter a comment on the Comments
1. Click Collection— Collections— Producers— Comments sub tab.

2. Inthe Comments section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Comment Enter comment.
Comment By Displays user id.
Comment Dt Displays comment date.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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11.1.5

11.1.6

Summary

The display only Summary sub screen allows you to view summary information regarding the
producer.

To view summary on the Summary
1. Click Collection—> Collections— Producers— Summary sub tab.

2. In the Summary section, view the following information.

A brief description of the fields is given below:

Field: View this:

Year Month | The year and month.

Total Apps The application total status count.

Approved The application approved status count.

Conditioned | The application conditioned status count.

Rejected The application rejected status count.

Withdrawn The application rejected status count.

Funded The application withdrawn status count.

Amount The application funded status total amount.

Title Status Summary

The Title Status Summary screen displays the various stages of titles of assets for
applications sourced by the producer. The details are available for specific periods like last 1
day, 2 days, 5 days, 7 days and All (entire history) and results are displayed for selected
period with each date as new row.

For example, if user has selected 2 days and the system date is 2nd June 2014, then system
will group statuses in mentioned buckets and displays data for each 'Lien event date'.

To view Title Status Summary on the Summary
1. Click Collection— Collections— Producers— Summary sub tab.

2. Onthe Title Status Summary screen, perform any of the Basic Operations mentioned in
Navigation chapter.

3. Select the Title Status Summary period as 1 day/2 days/5 days/7 days/All.

A brief description of the fields are given below:

Field: View this:
New Status Displays lien status as 'New'
Perfection Displays lien status as either Sent for Perfection/ Sent for Re-

Processing Status perfection

Perfected Status Displays if lien status has 'Perfected Title'
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Field:

View this:

Release
Processing Status

Displays lien status as either Sent for Title Release/Re-sent for
Title Release

Released Status

Displays lien status as either Service Requested/Pending Delete

Hold Release

Displays lien Hold Release status

To be Released

Displays lien status if ‘To be released’

Closed Status

Displays lien status if ‘Deleted’

Exception Status

Displays lien status as either Pending Lien Holder/ Pending DMV

Lien Event Date

Displays lien Event Date attached against each status.
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12.1

12.1.1

12. Vendors

During the life of an account, a financial institution might require the use of specialized
services of a vendor for various purposes; for example, repossessing a vehicle, retaining an
attorney for bankruptcy court proceedings or making field calls. With the system’s Vendors
screen, you can:

e Maintain vendor information

e Maintain services offered by the vendor

e Assign tasks to the vendors and subsequently track and process those tasks
e Charge vendor expenses to customers

e Enter and update invoices raised by the vendors

e Post vendor transactions

e Process vendor payments

Once an invoice has been presented for a service performed by a vendor, you can enter

information on Vendor Management form and create a monetary transaction. You can then
choose if the customer should pay any particular expense or not.

Vendor Detail Screen

The Vendors screen allows you to set up vendor information. By default it will show current
address but if the vendor receives escrow disbursement at an address which is different from
current business address the information can be entered in Payment Details sub screen. Also,
the Payment Details sub screen allows you to enter number of days prior to the due date by
which payment to vendor must be processed.

Navigating to Vendor Detail Screen

1. On the Oracle Financial Services Lending and Leasing home screen, click
Collections— Collections— Vendors.

2. The system displays the Vendor screen. The details are grouped under four tabs:
e Vendors
e Work Orders
e Follow-up
e Invoices

Vendors tab

1. Click Collections— Collections — Vendors—> Vendors. The details in the screen are
grouped into the following tabs:

Payment Details

Vendor Groups

Tracking Attributes
e Comments
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2. Inthe Collections— Collections — Vendors— Vendors— Vendor Details section,
perform any of the Basic Operations mentioned in Navigation chapter:

oRacLe

% Financial Services Lending and Leasing

» DashBoard Yeudurs W
 Origination Vendors WorkOrders | Follow-up  Invoices
Servicing
r— Vendor Details badd | At | [Fvien | o auit
Customer Senvice views Fomat [ ([ Freeze f Detech wap @
Securitization a [729 [7'(‘9
s T Vendor # Name Status Company Branch Start Dt End Dt Contact Person Fed Tax # Email Enabled
:f:t DE;C C\ank: UNDEFINED 02/09/2016 Y
S e PR-01003 TESTIZ3 ACTIY DEMOBANKUSA  USREGIONL  12/14J21Ls TESTIS Y
PerE e PRO1004 QATEST DEMO BANKUSA S HEAD QUARTERS 12/14/2015 JAION Y
Oldeis atugenet PRO2003 TEST2 DEMOBANKIL  HLHEAD QUARTERS 12/15/2015 ABCD 13 N
Reports PR-05001 TEST_VEN_01 DEMO BANKUSA LS HEAD QUARTERS 12/22/2015 SR 00006789 SREGMAILCOM ¥
Producers PR-06002 AJITHA DEMO BANKUSA  US REGION 1 12/25/2015 JITHA Y
Vendors PR-09001 Xz DEMO_] TEST 01 ABC Y
Bath Trarsactions: 100001 DECATUR AUTO AUCTION DEVOBANKUSA LS HEAD QUARTERS 0 YA RICKSTH  xonodd? Y
Advances L0002 GRTR QUAD CITY AUTO AUCTION DEMO BANKLSA LS HEAD QUARTERS LA LVEANDERSON  xcooof08 Y
Payments 1L-00003 CRAIG PHELPS, TRUSTEE DEMO BANKUSA LS HEAD QUARTERS 01/01/1800 12/31/4000 RICK SMITH 0008907 Y b
Fees M Columns Hidden 14
oo Vendor Details
:m:::;‘;‘" [ sveandadd | [ saveandstay | [ soveand Return | {2 Retum
CASA Reconcliation
Conversion Accounts *Enabled 4 FedTax# Adress ¢
Vendor# UNDEFINED “ Crdit Doy 0 Address ne 1
" Phone 1 AddressLine 2
Status i Eitn1 “State
©Compaty X Phone 2 “Zp B
*Branch ' .
*statot 0203206 | B Ey‘:ﬂi ‘FE‘X:'
Bt /s B kot EH_;“‘
 Callections o * Country v
7 WEP Payment Details  Vendor Groups  Tracking Attibutes  Comments
> Tools
7 Setup Payment Details / it Vi i
A brief description of the fields is given below:
Field: Do this:
Enabled Check this box to enable the vendor.
Vendor # Displays the vendor number. The system generates the vendor
number by default.
Name Specify the vendor name.
Status Select the vendor status from the drop-down list.
Company Select the vendor portfolio company from the drop-down list.
Branch Select the vendor portfolio branch from the drop-down list.
Start Dt Specify the vendor start date. You can select data even from the
adjacent Calendar icon.
End Dt Specify the vendor end date. You can select data even from the

adjacent Calendar icon.

Contact Person | Specify the vendor contact name.

Fed Tax # If available, enter the vendor federal tax identification number. If the
organizational parameter UIX HIDE RESTRICTED DATA is set to
Y, this appears as a masked number; for example, XXXXX1234.

Credit Days Specify the credit days for the vendor invoice. This number is used
to check that Invoice Due Date is not more than the credit days from
Invoice Date.

Phone 1 Specify primary phone number.
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Field:

Do this:

Extn 1 Specify the primary phone extension.

Phone 2 Specify alternate phone number.

Extn 2 Specify the alternate phone’s extension.

Fax Specify the fax number.

Fax 2 Specify the fax number 2.

Country Select the country code from the drop-down list.

Address Line 1

Specify address line 1.

Address Line 2

Specify address line 2.

Zip Select the zip code from the drop-down list.
Zip Extn Specify the extension of the Zip code.

City Specify the city.

State Select the state from the drop-down list.
Email Specify the email address.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

12.1.1.1 Payment Details

Click Collections— Collections —Vendors— Vendors— Vendor Details— Payment
Details. The Payment Details sub tab allows you to set up automatic clearing house
information for vendors.

On the Payment Details sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Remittance section

Country Select the country code from the drop-down list.
City Specify city.
State Select state from the drop-down list.

Address Line 1 Specify address line 1.

Address Line 2 Specify address line 2.

Zip Specify zip code from the drop-down list.

Zip Extn Specify extension of the zip code.
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Field: Do this:

Pre-Process Days | Specify the remittance pre-process days. This is the number of
days prior to due date by which payment to the vendor must be
processed.

Payment Details section

Mode Select the mode of payment from the drop-down list.

Bank Specify the ACH bank.

Start Dt View ACH start date.

Routing # Specify the bank routing number.

Account Type Select the account type from the drop-down list.

Account # Specify the account number. If the organizational parameter UIX-

_HIDE RESTRICTED DATA is set to ‘Y’, this appears as a
masked number; for example, XXXXX1234.

BIC Select the Business Identifier Code from the drop-down list. The
list displays the BIC codes defined in the system.

IBAN Specify the IBAN (International Bank Account Number). IBAN is
used for identifying bank accounts across national borders with a
minimal of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation
based on modulo 97. On save, system automatically validates
the IBAN number length based on country code, characters,
white spaces, and checksum. Validation is also done during post-
ing non-monetary transaction (ACH Maintenance).

You can maintain the IBAN length and other details required as
per the country code in the user defined table (Setup > Adminis-
tration > System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is
defined by default with length of IBAN as 18.

Perform any of the Basic Actions mentioned in Navigation chapter.

12.1.1.2 Vendor Groups

Click Collections— Collections — Vendors— Vendors — Vendor Details — Vendor
Groups. The Vendors Groups allows you to set up vendor groups.

On the Vendor Groups section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Sort Specify sort sequence.
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12.1.1.3

121.1.4

Field: Do this:

Group Select the vendor type to which the vendor belongs from drop-down list,
based on services provided by the vendor.

Enabled Check this box to enable the vendor service.

Perform any of the Basic Actions mentioned in Navigation chapter.

Tracking Attributes

Click Collections— Collections —Vendors— Vendors— Vendor Details— Tracking
Attributes. The Tracking Attributes allows you to load tracking attributes and define the
parameter value for various parameters listed.

On the Tracking Attributes sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Sub-Param- | View the Sub-Parameter.

eter

Parameter View the listed Parameter.

Value Specify the required parameter value. By default, NA is displayed.

Perform any of the Basic Actions mentioned in Navigation chapter.

Comments

Click Collections—> Collections — Vendors— Vendors—> Vendor Details— Comments.
The Comments sub tab allows you to add comments and also view comments posted through

AP interface.

On the Comments sub tab, perform any of the Basic Operations mentioned in Navigation

chapter.

A brief description of the fields is given below:

Field: Do this:

Comment View or add the required comment.

Comment System automatically selects the logged in user details.
By

Comment System automatically displays the current date.

Dt

Perform any of the Basic Actions mentioned in Navigation chapter.
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12.1.2 Work Orders Tab

The Work Orders link allows you to assign an account to a vendor for a service that the vendor
provides.

1.

2.

e Services

e Tracking Attributes

any of the Basic Operations mentioned in Navigation chapter.

o vendors x

Vendors  Work Orders | Follow-up  Invoices

dwep @

Vendor

PR-D6002-AJITHA

Work Order
View~ Format~ [ Freeze 4 Detach
WorkOrder #  Account ateral
Description

UNDEFINED

W0:0007001 20120100010498:.

v 006001 20120100010315:.. 2012 2B4GP45GIX.
005001 20120100010406:... 2012 BMW 318i 2.
004001 20120100010373:... 2012 HYUNDAL EX.
003005 20151200012159:... 0 ASHLEY FALLS, .
003004 20151200011317:.. ,

W 003003 20120100010373:.

W0:0003001 20151200011333:.

W0:0003002 20120100010406:.

MI-00001-ESCRO.
CA-04004-5TAR §,
CA-02001-ANDRE.
CA-04004-5TAR .

CA-04002-HARRY.
000 YERMO, 92398 1L-00008-0MNIBU.
2012 BMW 3181 2. CA-D4002-HARRY

CA-04001-PHANIN

Work Order

Work Order

Work Order # UNDEFINED
Account
*Vendor
Company
Branch

* Status HEW

*Type

Company

us01
NLO2
uso1
us01
uso1
uso1
usn1
uso1
uso1

Branch

USRL
NLHQ
ushg
USHQ
USHQ
ushQ
USHQ
ushg
USHQ

Status Type
NEW SERVICING
NEW SERVICING
NEW BANKRUPTCY
NEW BANKRUPTCY
COMPLETED BANKRUPTCY
NEW SERVICING
NEW
cLose RECOVERY
cLose BANKRUPTCY
Work Order Details
Dt 02/09/2016

Status Dt 02/09/2016
Currency
Estimated 000
Billed Amt 0.00

Paid 0.00

Account Information

Collateral Description

Assigi
By

VA.
AN
K.
VL.
VI
VA..
PH.
VE
PH.
VE

[ Close
dpadd | ZEdt | 5 view | < Audit
Reference FollowupDt  Estimated  BilledAmt  Paid
0.00 0.00 0.00
01/12/2016 0.00 0.00 0.00
32344 11/10/2011 0.00 0.00 0.00
0.00 0.00 0.00
0.00 0.00 0.00
100.00 13777 11555
100.00 0.00 0.00
97835 0.00 0.00 0.00
MAC TEST 12/19/2015 20100 0.00 0.00
87875 12/21/2015 1,000.00 0.00 (XTI
»
& save and add Saveand Stay | [ Save and Retum | ¢ Retum
Reference =
Assigned By VAVAIDYA
Followup Dt b
Vendor Information
Contact
Phone
Bitn
Fax
Comment

Click Collections— Collections — Vendors— Work Order. The details are
categorized into two:

In the Collections— Collections —Vendors— Work Order— Work Order, perform

A brief description of the fields is given below:

Field:

Do this:

Work Order #

Displays the work order number.

Account

Select account number for the work order from the drop-down list.

Vendor

Select vendor who will service the work order from the drop-down
list.

Company

Displays the vendor company.

Branch

Displays the vendor branch.

Status

Select the service status from the drop-down list.

Type

Select the work order type from the drop-down list.

Work Order Details section

Dt

Displays the work order date.

Status Dt

Displays the last work order status change date.

Currency

Select currency for the work order from the drop-down list.
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Field: Do this:

Estimated Displays the estimated amount for the work order.
Billed Displays amount billed by the vendor for the work order.
Paid Displays amount paid to the vendor for the work order.

Account Information section

Collateral Select asset associated with the work order from the drop-down list.
Reference # Specify the vendor reference.

Assigned By Specify the user who created the work order.

Followup Dt Specify the next follow-up date. You can even select from the adjoin-

ing Calendar icon.

Vendor Information section

Contact Specify the vendor contact for the work order.

Phone Specify the vendor contact phone for the work order.

Extn Specify the vendor contact phone extension for the work order.
Fax Specify the vendor contact fax for the work order.

Comment Specify any comments regarding the work order.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
12.1.2.1 Services

In the Collections— Collections — Vendors— Work Order— Services, perform any of
the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Service Select the service type from the drop-down list (required).
Fee Type Select the vendor fee type from the drop-down list.
Currency Select the currency from the drop-down list.

Estimated Specify the estimated amount for the service.

Billed Amt Displays amount billed by the vendor for the service.

Paid Displays amount paid to the vendor for the service.
Status Select the status from the drop-down list.
Status Dt Displays the last service status change date.

Perform any of the Basic Actions mentioned in Navigation chapter.
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12.1.2.2 Tracking Attributes

12.1.3

Click Collections—> Collections —Vendors— Work Order— Tracking Attributes. The
Tracking Attributes allows you to load tracking attributes and define the parameter value for

various parameters listed.

On the Tracking Attributes sub tab, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Sub-Param- | View the Sub-Parameter.

eter

Parameter View the listed Parameter.

Value Specify the required parameter value. By default, NA is displayed.

Perform any of the Basic Actions mentioned in Navigation chapter.

Follow-up Tab

The Work Orders link lists the work orders that are not complete and hence require follow-up.

1. Click Collections— Collections — Vendors— Follow-up tab. The details are grouped

into two:
e Work Order Follow-up
e Assigned Services

2. Inthe Collections— Collections — Vendors— Follow-up—> Work Order Follow-up,
perform any of the Basic Operations mentioned in Navigation chapter except for creating

a new record.

Vendors

Vendors | Work Orders  Follow-up || Invoices

Wt

Work Order Follow-up AEit | Eview | o audit
Views Formatv B3 Freeze ) Detach ®
Company Branch Followup Dt ot Assignment Type  Account Vendor Status Status Dt AssignedBy  Estin
Uso1 UsHQ 121202015 /122015 COLLECTION 20150100011170:ROBERT BOREN PR-D1001-PINNACLE PARTS & SERVICE /05 VEROUTHU 00
uso1 usHQ 12/14/2015 121402015 BANKRUPTCY 20120100010406:LEWIS LESLIE/ JOHN  1L-00005- MICHAEL D. CLARK 1/14/2015  VINOARUM 1201
uso usHQ 12/29/2015 12/152015 SERVICING 20151200011333:BROOK BROOK CA-02001-ANDREWS TOWING 1152015 VAVAIDYA 1020
uso usHQ 12/18/2015 SERVICING 20151200011317:CHODA PHANINDRA . CA-04001-PHANINDRAL 12/19/2015 PHACHODA 1004
uso usHQ 12/12/2015 BANKRUPTCY 20150600011323:SMITH JOHN 11-00005- MICHAEL D, CLARK 12/12/2015 PHACHODA 1004
uso usHQ 12/14/2015 COLLECTION 20120100010373:ANDRE PETER / VICT.. 1L-00002-GRTR QUAD CITY AUTO AUC... NEW /9015 JANKAYA 0.0
uso usHQ 12/14/2015 SERVICING 20150100010023:BABU MADHU 11-00003-DECATUR AUTO AUCTION 114015 VBT 000
uso usHQ 12/18/2015 20120100010373:ANDRE PETER / VICT. 12/19/2015 VEROUTHU 0.0
uso usHQ 12/22/2015 BANKRUPTCY 20120100010373:ANDRE PETER | VICT. 1222015 VINOARUM 0.0
uso UsHQ 12/22/2015 BANKRUPTCY 20120100010406:LEWIS LESLIE { JOHN 1222015 VINOARUM 000

b

1
Work Order Follow-up

Work Order Follow-up

Company UsiL
Branch UskQ
Followup Ot 121272015 B
Work Drder # WO:0001011
ot 1/12/2015

Vendor PR-01001-PINNACLE PARTS & SERVICE

Status Dt 12/12/2015
Work Order

Currency US DOLLAR
Estimated 0.00

H saveandstay | [ saveand retum | aRetum

Paid 0.00
NEW v
Vendor Information
Contact GREGORY
Phone (573}539-4539
Bxtn
Comment

Assigned Services

Viewv Formatv &

Freeze R Detach

Account 20150100011170:ROBERT BOREN Billed Amt 000

g

4

A Eit | Eview | o Audt
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A brief description of the fields is given below:

Field: Do this:

Company Displays the vendor company.

Branch Displays the vendor branch.

Followup Dt Specify the next follow-up date. You can even select the date from
adjoining Calendar icon.

Work Order # Displays the work order number.

Dt Displays the work order date.

Account Displays the account associated with the work order.

Vendor Displays the vendor associated with the work order.

Status Select the work order status from the drop-down list.

Status Dt Displays the last work order status change date.

Work Order section

Currency Displays the currency for the work order.

Estimated Displays the estimated amount for the work order.
Billed Amt Displays amount billed by the vendor for the work order.
Paid Displays amount paid to the vendor for the work order.

Vendor Information section

Contact Displays the vendor contact name.

Phone Displays the vendor contact phone number.

Extn Displays the vendor contact phone number’s extension.
Comment Specify a comment.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

12.1.3.1 Assigned Services

In the Collections— Collections —Vendors— Follow-up—> Assigned Service, perform
any of the Basic Operations mentioned in Navigation chapter except for creating a new

record. A brief description of the fields is given below:

Field: Do this:

Services Displays the service provided by the vendor.
Currency Select currency for the vendor from the drop-down list.
Estimated Specify the estimated amount for the service.

Billed Amt Specify amount billed by the vendor for the service.
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Field: Do this:

Paid Specify amount paid to the vendor for the service.
Status Select the service status from the drop-down list.
Status Dt Specify the last service status change date. You can even select the

date from the adjoining Calendar icon.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

12.1.4 Invoices Tab

1. Click Collections—> Collections — Vendors—> Invoices tab. The details are grouped
into two:

e Details

— Payment Schedules sub tab

— Related Invoice/Work Orders sub tab
e Tracking Attributes

2. Inthe Collections— Collections — Vendors— Invoices— Invoice Information,
perform any of the Basic Operations mentioned in Navigation chapter.

vendors [ Close
Vendors | Waork Orders | Follov-up | Invoices
Invoice Information e add | A Edt | 5 view | of Audt
Vieww Formatw [ Freeze gl Detach wap @
Vendor Company Branch Invoice Invoice Dt Due Dt Status
CA-D4004-STAR SERVICES usi usH 8765 01/29/2016 01/29/2016 QPEN
CA-D4004-STAR SERVICES usi usH 28989 01/29/2016 01/29/2016 QPEN
CA-D4004-STAR SERVICES usi usH 1222015 12/2/2015 1/29/2015 CLOSE
CA-D4001-PHANINDRAL usi usH FSDFDS 12/21/2015 12/21/2015 QPEN

CA-04004-STAR SERVICES Us01 UsHQ 2309 12212015 12/21/2015 CLOSE

Invoice Information
[ saveandadd | | saveand stay | [ saveand Retum | 3 Retum

Tnvoice Dt B Address
‘ Invoice —— B Currency
Invoice Amt 0.00
Vendor & * Status ] Agreed Amt 0.00
Company Paid Amt 0.00
Details
Branch
* Invoice # Status Dt 02/03/2016
Details | Tracking Attributes
Invoice Details dpadd | AEdt | 5 View | o Audit
View~ Format [} Freeze  Eff Detach Wrap ]
Work Order = Inveice At Agreed Amt Paid Amt Tun Post Dt Status Status Dt Collectible

Mo data to display.

Payment Schedule | Related Invoice/Work Orders

3
=

Payment Schedules apadd | A Edt | [ view
View= Fomatv [ Freeze FiDetach  dwiep W

A brief description of the fields is given below:

Field: Do this:

Vendor Select the vendor name for whom the invoice is to be created.
Company Displays the vendor portfolio company.
Branch Displays the vendor portfolio branch.
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Field: Do this:

Invoice # Specify the invoice number.

The invoice number should be unique for every vendor. In case the
Invoice # already exists for Vendor, system displays a warning message.

Invoice Dt Specify the invoice date. You can even select the date from the adjoining
Calendar icon.

Due Date Select the due date. You can even select the date from the adjoining
Calendar icon.

Status Select the invoice status from the drop-down list.

Details section

Status Dt Displays the last invoice status change date.
Address Displays the vendor address.
Currency Select the currency from the drop-down list.

Invoice Amt | Displays the total invoice amount.

Agreed Amt | Displays the total agreed amount.

Paid Amt Displays the total paid amount.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Collections— Collections —Vendors— Invoices — Invoice Details, perform
any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Work Order | Select the work order from the drop-down list.

Invoice Amt | Specify the invoice amount.

Agreed Amt | Specify the agreed amount.

Paid Amt Displays the paid amount.

Txn Post Dt | Specify transaction effective date. You can even select the date from the
adjoining Calendar icon.

Status Select the status from the drop-down list.

Status Dt Displays the last status change date.

Collectible Check this box to collect the agreed amount from the customer.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Inthe Collections— Collections —Vendors— Invoices— Tracking Attributes. The
Tracking Attributes allows you to load tracking attributes and define the parameter value
for various parameters listed.
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On the Tracking Attributes sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Sub-Param- | View the Sub-Parameter.

eter

Parameter View the listed Parameter.

Value Specify the required parameter value. By default, NA is displayed.

Perform any of the Basic Actions mentioned in Navigation chapter.

7. Inthe Collections—> Collections — Vendors— Invoices— Payment Schedules,
perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Currency Select the currency from the drop-down list.

Payment Amt | Specify the payment amount.

Status Select the payment status from the drop-down list.

Payment Dt Specify the payment date. You can even select the date from the

adjoining Calendar icon.

Payment Ref-
erence

Specify the payment reference.

Payable Id

Specify the payable requisition Id.

Disbursement
Currency

Select the currency from the drop-down list.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

9. Inthe Collections— Collections — Vendors— Invoices—> Related Invoice/Work
Order Details, perform any of the Basic Operations mentioned in Navigation chapter:

A brief description of the fields is given below:

Field:

View this:

Invoice #

Displays the invoice number.

Invoice Status

Displays the invoice status.

Status Dt

Displays the invoice status date.

Currency

Displays the currency.

WO Estimated Amt | Displays the work order estimated amount.

WO Agreed Amt Displays the work order agreed amount.

WO Paid Amt

Displays the work order paid amount.
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Field:

View this:

WO Status

Displays the work order status.

10. Perform any of the Basic Actions mentioned in Navigation chapter.

12-13

ORACLE



A1

Appendix A: Transaction Parameters

The Customer Service screen’s Maintenance sub tab enables you to post an array of
monetary and nonmonetary transactions for any given account. The transactions that are
available depend on responsibility of the Oracle Financial Services Lending and Leasing user,
nature of account, and whether the account is a Lease.

Appendix A: This appendix catalogues the baseline transaction codes and parameters
available on Customer Service screen’s Maintenance sub tab. Instructions on how to use the
Maintenance sub tab are located in Customer Service chapter of this User Guide.

Monetary Transactions

This section catalogues the transaction codes and parameters required to complete the
following monetary tasks for Lease:

Apply, adjust, or waive servicing expenses

Adjust or waive late charges

Adjust or waive nonsufficient funds

Apply, adjust, or waive repossession expenses
Apply, adjust, or waive bankruptcy expenses
Apply or adjust phone pay fees

Change an index/margin rate

Apply, adjust, or cancel financed insurance
Generate a payoff quote

Payoff an account

Charge-off an account

Close an account

Apply, adjust, or waive an extension fee

Change payment amount

Adjust or waive a prepayment penalty

Reschedule an escrow payment

Adjust or waive an escrow payment

Adjust or waive a payoff quote fee

Place an account in a nonperforming condition
Reverse a nonperforming condition

Reschedule precomputed Lease to interest bearing Lease
Change profit rate

Refunding the payment

Non Refund GL

ACH Fee Maintenance

Adjust, charge-off, or waive the advance/principal balance
Adjust the interest balance

Stop interest accrual

Indicate a borrower as on or off active military duty
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A.1.1 Late Charges

ORACLE'
Financial Services Lending and Leasing

Py

y Dashﬂm% Customer Service . [Rcese
 Origination Search  Customer Service: 2015100001137 Review Request (Pendng: 0] »
Senvicing
Senkig Account(s): 20151000011137: K NAVIN ) ) ) e | it
Customer Senvice Vewv Fomaty Freeze o Detach W & @anentOshonal()aoupFolowp
Securitzaton Company Branch SubUrit Actount # Product DaysPast Due Currency PayOff Amt  Amount Due Status Oldest Due Dt
Transaction Authorization Usot s UNDEFINED IS5 EASE VEHICLE 9 D 9,322.00 2,520 ACTIVE:DELG 11/12/015
Post Date Checks:
Estton Jranaone Summary | Customer Service | Account Detals || Custoner Detals | Transacton Hitory | PrmtModes | Bankruptcy | RepojForedosure | Defiency | Collateral | Bureau | Crossylp Sl Actites
Account Documents
Colateral Management: 3
Rerts ) Alerts  Conditions
Producers
Vendors Account Details Other Information
Batch Transactions
Advances Dues Collateral Information
Paments b 01/12/201 DS s 10127015 Desaripton Identication # Vear AsetCass AsetType  SbType 0
Fees 34200 84200 84200 000 00 No data o dsply.
Interfaces
AP Transactions DelqDue 2,5%.00 TotalDue 2,586.00 FutrePmtDt 11/12/2015 .
6L Transactions LCDue 60.00 Todays Payoff 9,322.00 OldestDue Dt 11/12/2015 GIBGP nfariaton il
CASARecondlaton \6FDue 000 Fate Paoff 932200 AntPadExcess 000 O e Relaton 5l Dt Gender
Conversion Accounts Future Payoff Date 02/20/2016 000000... NAVINK PRIVARY — /117
Definquency Information 4| 1il | b
e 30 & 0 W1 B Category Days
i ¢ 2 E o 0 0 £l 9 Emal Disabity N Privacy Opt Qut N
Language ENGLISH Skip N Active Miltary Duty N
L) 0 NSFife) 0 Colector DEMOCOLL A 5 § I
) Colletions lfea) 0 Beien] & Corespondence
» WFP Activites
» Tools ActiveDt 12/10/2015 App2 000000I0I4 LastPmtAmt 842.00 Address Information
) Satup Last Actvity Dt 12/22/2015 pad Offot Charge Off Dt e oot ffz",‘ﬁmMawhng adfess e v

Late charges occur when payment is not made within the grace period or by the day after
payment is due. The due date is determined by the contract.

Late charges appear in LC Due field on the Dues section of Summary tab of the Customer
Service screen. This is the first screen to appear on the Customer Service screen when you

A2 ORACLE



load an account.

ORACLE'
Finanﬁa\ Services Lending and Leasing

e Customer Service (] Close
) Origination Search Customer Service: 2015100001137 Revin Request (Pendig: 0) -
Servicing
Senvicng Account(s): 20151000011137: K NAVIN Bren | aut
Customer Senice View~ Fomatv B [[Freem Hidebd  Jw @) & @curentCshon ) Group Folowup
Seauization Company ranch Sbunt Account & Product Days Past e Currency PayOffAmt  AmountDue Status Oldest Due Ot
Tiansaction Autharzation st Uso UDEFIED  20ISI000IHT  LEASEVEHICLE D 93200 168400 ACTIVEDELQ 1jpais
Post Date Checks
Escon Transactns Summary  Customer Senvice  AccountDetais  Customer Detals  Transaction Hstory | PmtModes Bankuptcy RepofForecsure  Defidency  Colateral  Bureay  CrossiUp Sel Actvites
Account Documents
Collateral Management =
) Nerts  Conditions
Reports
Producers
Vendors Account Details Other Information
Batch Transactions
Advances Dues Collateral Information
Payments W o ms s Descrption Uertfcaton 2 Yewr AsetClass  AsetTpe  SubType I
Fees 54200 84200 84200 o o Mo datato disly.
Intefaces
AP Transactions Delglue 168400 TEELDE () s ol [emm—
6L Transactions Todays Payoff §,322.00 OdestDueDt 11/12/2015 ”CD:” sotbbln i
CASA Recundiation NSF Due 0.00 Futwe Payoff 932200 AmtPaidExcess 0.00 SO Nane Relaton s BrthDt Gender
Comersion Accounts Other Due 0.00 Futre PayoffDate 01/01/2016 S R oo 0l
Definquency Information i ] i )
We B @ 0 10 0 Cabegory Do
! ! 0 0 0 0 0 9 Enal Discbity N Privacy OptOut N
. . Language ENGLISH Sip N Active Miitary Duty N
wlf) 0 NEFLAR) O Colectr DEMOCOLL PG o i i
) Collections Belfear) 0 Ftex) 0 Corresporvence
Az Actites
) Tools ActiveDt 12/10/2015 App# 0000001014 LastPmt Amt 84200 Address Information
) Setup Last Acity Dt 121202015 Pad OfF Ot Charge OFfDt Tpe ot e g i ot -
To adjust a late charge
Transaction Parameters
Adjustment To Late Charge - Add Txn Date Amount
Adjustment To Late Charge - Subtract Txn Date Amount
To waive a late charge
Transaction Parameters
Waive Late Charge Txn Date Amount

A.1.2 Nonsufficient Fund Fees

Nonsufficient fund fees are posted when a payment does not cover the amount owed. The fee
that the system automatically applies to an account is recorded during setup.

Nonsufficient fund fees appear in the NSF Due field on the Dues section of Summary tab of
Customer Service screen. This is the first screen to appear on the Customer Service screen

A3 ORACLE



A13

when you load an account.

ORACLE'
Financial Services Lending and Leasing
i "
T Customer Service [@cese
 Origination Searc  Customer Service: 2015100001137 | Review Request (Panding: ) o
Servicing
e Account(s): 20151000011137: K NAVIN Hew | Lot
i S Vewv Fomatr B [[Fee Hioewh  Juwm ) & @ curent O sron 4 O goup Folowp
Seaitzation Company Branch SubUrit Aot # Product Days Past Due Curency Pay Off Ant Amount Due Status OldestDue Dt
Transaction Authrization st 15HQ UNDEFINED DISIO0011137  LEASE VEHICLE AU 93200 1,684.00 ACTIVEDELQ 112215
Post Date Checks
Escaow Transactions Summary | Customer Service | AccountDetals | Customer Detals | Transaction History | Pt Modes  Baricuptey  RepofForeclosre | Defidency  Collteral | Bureau  CrossfUp Sel Actvties
‘Account Documents
Colateral Management. =
Repas 7 Alerts » Conditions
Producers
Vendors Account Details Other Information
Batch Transactons
Advances Dues Collateral Information
Payments f oyijms  nfRms RNl 10 Descpton Tentficaton # Ver AsmetCoss AwetType  SubType N
Fets 84200 200 8200 000 000 No data o dply.
Interfaces
18 Transactons DeqDue 168400 Totsl Due 1,74400 Future PmtDt 11/12/2015 . )
6L Transactons LCDue 6000 Todsys Payoff 5,322.00 OdestDue Dt 11/12/2015 CUEC‘“[:::; Infofiatcn
CASA Reconciiation Future Payoff 9,322.00 AntPaid Excess 0.00 & Neme Relation SN Birth Dt Gender
Conversion Accounts OtherDue 0.00 Futre PayoffDate 01/01/2016 S N e ol
Definquency Information 4 i B »
e 0 & 0 I 10 18 Category Das
E i o o o 0 o i 0 Emal Disabilty N Privacy OptOut N
Language ENGLISH Sp N Actve Mitary Duty N
Bf) 0 NeF(ife) 0 Collector DEWOCOLL . Sop i
S Colledtions BP{Year) 0 NgF{Year) 0 Correspondznce
i Actites
) Tools ActveDt 12/10/2015 App# 0000001014 LastPmtAmt 842.00 Address Information
) Setup LastActity Dt 12J22J2015 paid OffDt Charge OFfDt T et zevrmjs\rMamng e e =
To adjust a nonsufficient funds
Transaction Parameters

Adjustment To Nonsufficient Fund

Fee - Add

Txn Date Amount

Adjustment To Nonsufficient Fund
tract

Fee - Sub-

Txn Date Amount

To waive a nonsufficient funds

Transaction

Parameters

Waive Nonsufficient Fund Fee

Txn Date Amount

Repossession Expenses

Repossession expenses include any costs incurred while obtaining the asset, including legal

fees or storage costs.
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Repossession expenses appear in Other Due field on the Dues section of the Summary tab
of Customer Service screen. This is the first screen to appear on the Customer Service screen

when you load an account.

ORACLE
Financial Services Lending and Leasing

5 Dashm% Customer Service (o] dose
) Origination Search  Customer Service: 2015100001137  Revien Request (Penng: ) .
Servicing
senicng Account{s): 20151000011137: K NAVIN ) Hven | P auit
Customer Senvice Vewv Fomatv By [[Feee Hfidebh  Jdwen @) &  @curent(show D) GowFlowup
Securizaton Company Branch SubUrit Account # Product Days Past Due Currency Pay OffAnt  Amount Due Status Olcest Due Dt
Transacton Authorization Usot UsHo UNDEFINED IS0 EASE VEHICLE 90 UsD 93200 2,526.00 ACTVEDELQ 11/12/2015
Post Date Checks
Fewan Brops s Summary | Cisomer Sevice | AccountDetabs  CustonerDetals Trarsacionistory  PntModes Bakouptey Repofforedoswre Defideney  Coliterd  Buteau | CrosslUp Sl Adsites
Account Documents
Colatera Management 3
Reprs ) Alerts I Conditions
Producers
Vendors Account Details Other Information
Batch Transactions
Advances Dues Collateral Information
Payments g 0122016 12/12015 11/12/2015 10/12/015 Description Identification # Year AssetClass AssetType  SubType ‘
Fees 34200 84200 84200 000 00 No data to diplay.
Interfaces
AP Transactions DelgDue 2,526.00 Total Due 2,586.00 Future PmtDt 11122015 .
6L Transactions LCDe 60.00 Todays Payoff 5,322.00 OldestDueDt 14/12/2015 Gistogt Infaration T
CASARecondlaton 6FDue 000 Fute Payoff 932200 AntPadExcess 000 Cusmj N Relaton Y Brindt Gender
Conversion Accounts Future PayoffDate 02/20/2016 00000, NAVINK BRIMARY ] 012197
Definquency Information 4| 11 | }
Late 30 60 90 120 150 180 Category Days
L g 0 o 0 el Deablty N Privacy OptOut N
Language ENGLISH Sip N Active Miltary Duty N
B 0 NGF(if) 0 Colector DEMOCOLL T sop T
) Collections Blfear) 0 NeF{fear) 0 Correspondence
DI Adtiites
> Tools ActiveDt 12/10/2015 Appz DO0000I0I4 LastPmtAmt 842.00 Address Information
’ Setup Last Activity Dt 12/22/2015 Paid Off Dt Charge Off Dt e Curent ETPCMBW Addess thone v

The adjustments will also appear in the corresponding column of Customer Service screen’s
Account Balances screen for EXPENSE REPOSSESSION/FORECLOSURE Balance Type--
Waived, Charged Off, Adjusted (-), or Adjusted (+) -- depending on which of the following
transactions you perform. To post a repossession expense

Summary || Customer Service  Account Detals

Customer Defals  Transaction History Pt Modes

Bankruptey | Repo/Foredosure

Defidency  Colateral

Bureau  CrossiUp Sel Activities

Balances ' Transactons ~ Sale Transfer Transactions ~ PaymentRating ~ Due DateHstory — Repayment Schedule  VWork Orders
Balance Group
Balance Group Txn Period
{ ) Current Ba\ance'é_‘l)eﬁmencv Balance | )Non-Performing Balance | Terminate Balance 'é_‘l'IDfCFD‘ YD
View ¥ Format v ﬁ Freeze gj‘ Detach E@
Balance Type Opening Deficency Chg Off Posted Recovery Deficency Balance
 ADVANCE PRINCIPAL 0.00 15,000.00 2,967.52 1203248
INTEREST 0.00 1248 1248 0.00
FEE LATE CHARGE 0.00 0.00 0.00 0.00
FEENSF 0.00 0.00 0.00 0.00
FEE EXTENSION 0.00 0.00 0.00 0.00
FEE PREPAYMENT PENALTY 0.00 0.00 0.00 0.00
FEE PHONE PAY 0.00 0.00 0.00 0.00
FEE PERIODIC MAINTENANCE 0.00 0.00 0.00 0.00
RENTAL FEE 0.00 0.00 0.00 0.00
FEE DELAY 0.00 0.00 0.00 0.00
EXPENSE BANKRUPTCY 0.00 0.00 0.00 0.00
| EXPENSE REPOSESSION/FORECLOSLRE 0.00 0.00 0.00 0.00f
EXPENSE SERVICING 0.00 0.00 0.00 0.00
Defidency Balance Total 12,032.43
Transaction Parameters

Repossession Expenses

Txn Date Amount
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To adjust a repossession expense

Transaction Parameters

Adjustment To Repossession Expenses - Add Txn Date Amount

Adjustment To Repossession Expenses - Sub- | Txn Date Amount

tract

To waive a repossession expense
Transaction Parameters
Waive Repossession Expenses Txn Date Amount

A.1.4 Bankruptcy Expenses

Bankruptcy expenses include any costs incurred when an account holder declares
bankruptcy, such as legal fees or additional collection costs.

Bankruptcy expenses appear in the Other Due field on the Dues section of Summary tab of
Customer Service screen. This is the first screen to appear on the Customer Service screen
when you load an account.

ORACLE
Financial Services Lending and Leasing

T Dashsw% Customer Service [ Cce
) Origination Seorch  Customer Service: 2015100001137 Revien Reuest Pendig: 0) 2
Servicing
Senvidng Account(s): 20151000011137: K NAVIN EJven | o audt
Customes Service Vewv Fomatv B [[Free Hidebh e @) 8 @curentOshon a0 cowFolowup
Seauritization Company Branch Sub Unit Account % Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
Transaction Authoizaion Usot =00} UNDEFIED DIS000011137  EASE VEHICLE 90 UsD 9,3200 2,626.00 ACTVEDELG 11/12/215
Post Date Checks
s fransacis: Summary | Customer Senvice | Account Detals | Customer Detalls | TransactonHistory | PmtModes  Bankruptry  Repofforedosre | Defidency  Colatersl | Bureau | Crossylp Sel Acthities
‘Account Documents
Colateral Management E
e » Alerts » Conditions
Producers
Vendors Account Details Other Information
Batch Transactions
Advances Dues Colateral Information
Payments i 01122016 212015 11/12/2015 0/12f015 Desaription Identification # Yer  AssetClass AssetType  SubType 4
Fees 84200 842.00 842.00 0.00 000 No data to dsplay.
Interfaces
AP Transactions DelqDue 2,526.00 TotalDue 2,586.00 Future PmtDt 11122015 N
GL Transactions LCDue 60.00 Todays Payoff 8,322.00 OldestDue Dt 11/12/2015 CIEtoirgs Infoffhztion
CAGH Recclatin FDue 000 e Paoff 3,320 intPiidExess 000 C5T e Relaton s B0t Gonder
Conversion Accounts. Future PayoffDate 02/20/2016 000000, NAVINK PRIMARY sl 02/12/1867
Delfinquency Information { It }
Late 30 60 €0 120 150 180 Category Days
. ¢ : E o o 0 Ed hd Emai Disabiity N Privacy Opt Qut N
lanquage ENGLISH Sip N Active Miltary Duty N
BR{lfE) 0 NGF(Life) 0 Colector DEMOCOLL Verital Status Stop N T
» Collections BP{tear) 0 Nef{tear) 0 Corespondence
i Actvtis
> Tools AdiveDt 12/10/2015 App# 0000001014 LastPmtAmt 842,00 Address Information
) Setup Last Activity Dt 12/22/2015 Paid OFf Dt Charge OFf Dt oy Curent T“ET:S‘[Ma\\\ng Adress Phane o

The adjustments will also appear in the corresponding column of Customer Service screen’s
Account Balances screen for EXPENSE BANKRUPTCY Balance Type-- Waived, Charged Off,
Adjusted (-), or Adjusted (+) -- depending on which of the following transactions you perform.
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To post a bankruptcy expense
Summary | Customer Service  AccountDetals | CustomerDetals  Transaction History PmtModes Bankruptcy RepofForedoswre | Defidency Colateral  Bureau  Cross/Lp Sell Activities

Balances | Transactions | Sale Transfer Transactions | PaymentRating | Due Date History | Repayment Schedule  Work Orders

Balance Group
Balance Group Txn Period
: CurrentBalnce (@) eficency Balnce JNon-Performing Balance Teminate Babce (@) TOACTD YD
View v Format v ﬁ Freeze gj' Detach Wrap E@
Balance Type Opening Deficency Chg Off Posted Recovery Defidency Balance
ADVANCE /PRINCIPAL 0.00 15,000.00 2,967.52 1203248
INTEREST 0.00 4 4 0.00
FEE LATE CHARGE 0.00 0.00 0.00 0.00
FEENSF 0.00 0.00 0.00 0.00
FEE EXTENSION 0.00 0.00 0.00 0.00
FEE PREPAYMENT PENALTY 0.00 0.00 0.00 0.00
FEE PHONE PAY 0.00 0.00 0.00 0.00
FEE PERIODIC MAINTENANCE 0.00 0.00 0.00 0.00
RENTAL FEE 0.00 0.00 0.00 0.00
FEE DELAY 0.00 0.00 0.00 0.00
EXPENSE BANKRUPTCY 0.00 0.00 0.00 0.00
ENPENSE REPOSESSION/FORECLOSURE 0.00 0.00 0.00 D‘M
EXPENSE SERVICING 0.00 0.00 0.00 0.00
Deficency Balance Total 12,032.48
Transaction Parameters
Legal Bankruptcy Expenses Txn Date Amount

To adjust a bankruptcy expense

Transaction Parameters

Adjustment To Bankruptcy Expenses - Add | Txn Date Amount

Adjustment To Bankruptcy Expenses - Sub- | Txn Date Amount

tract

To waive a bankruptcy expense
Transaction Parameters
Waive legal Bankruptcy Txn Date Amount
Expenses

A.1.5 Phone Pay Fees

Phone pay fees are where a borrower calls the lender and arranges for a debit to their
checking or savings account to make a payment on a Lease account.

Phone pay fees appear in Other Due field on Dues section of the Summary tab of Customer

Service screen. This is the first screen to appear on the Customer Service screen when you
load an account.
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A.1.6

ORACLE
Financial Services Lending and Leasing

5 Dashm% Customer Service (o] dose
 Origination Sesdh Customer Service: 2015100001137 Revien Reguest Pendig: ) N
Servicing
senicng Account{s): 20151000011137: K NAVIN Hven | P auit
Customer Senvice Vewv Fomatv By [[Feee Hfidebh  Jdwen @) &  @curent(show D) GowFlowup
Searitzation Conpany Branch SubUrit Account # Product DaysPast Due Currency Pay OffAnt  Amount Due Status Oldst Due Dt
Transaction Authorizaion S0t 1=0] UNDEFINED WISWN00LILET  LEASEVEHICLE 90 UsD 93200 2,526.00 ACTVEDELQ 11/12/2015
Post Date Checks
Fewan Brops s Summary | Custome: Service | AccountDetas | CustonerDetals | TransacionHistory | PmtModes | Benvuptey | RepofForedoure || Defidency || Colateral | Bureau | Cross/p Sl Actvies
Account Documents
Colateral Management El
Reprs ) Alerts I Conditions
Producers
Vendors Account Details Other Information
Batch Transactions
Advances Dues Collateral Information
Payments g 0122016 12/12015 11/12/2015 10/12/015 Destription Identification # Year AssetClass AssetType  SubType A
Fees 84200 84200 8.0 000 000 No data to diplay. |
Interfaces
AP Transactions DelgDue 2,526.00 Total Due 2,586.00 Future PmtDt 11122015 .
L Tarsactons 1Chie 6000 TodarsPaaff 83200 Odthet s | CAOmer Information "
CASARecondlaton I5F e 000 Fute Payoff 932200 AntPadExcess 000 cusmz N Relaton Y Brindt Gender
Conversion Accounts Future PayoffDate 02/20/2016 00000, NAVINK BRIMARY ] 012197
Definquency Information { 11 }
Late 30 60 90 120 150 180 Category Days
Lo £t ol el Deablty N Privacy OptOut N
Language ENGLISH Sip N Active Mitary Duty N
B(LfE) 0 NSF(ife) 0 Coliector DEMOCOLL —— Stp T
) Collections Blfear) 0 NeF{fear) 0 Correspondence
) WFP Activities
> Tools ActveDt 12/10/2015 App# 0000001014 LastPmtAmt 842,00 Address Information
’ Setup Last Activity Dt 12/22/2015 Paid Off Dt Charge Off Dt Type firrent z‘emwMa\hng ekiess Phane v

To adjust a phone pay fee

Transaction

Parameters

Adjustment to Phone Pay Fee - Add

Txn Date Amount

Adjustment to Phone Pay Fee - Subtract

Txn Date Amount

To waive a phone pay fee

Transaction

Parameters

Waive Phone Pay Fee

Txn Date Amount

Financed Insurances

You can add financed insurance to an existing account with the INSURANCE ADDITION
transaction. This transaction adds insurance premium amount to advance/principal balance
on the Lease and adjusts the Lease receivables accordingly. The transaction also triggers the
process to re-compute repayment amount for Lease. After you post the transaction Lease will
be billed for newly computed payment amount and will be considered for delinquencies and
fees calculations based on information on the Contract link’s Contract screen. The newly
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added insurance information can be viewed on Customer Service drop-down link’s
Insurances link.

ORACLE'
Fi&ancia\ Services Lending and Leasing

B Close
 DashBoard Customer Service [Ee
 Origination Search  Customer Service: 2012100010917  Review Request (Pendng: 0)

Servidng
Senvidng Account(s): 20121100010917: WRIGHT JOHN / MARTY 5] vew | o Auit
Customer Service Vieww Fomatv [ freeme fiDetad  JJwn @) & @curentOshon A0 Group Folow-p
Seauritzaton Company Branch SubUrit Account £ Product Days Past Due Curency PayOffAnt  AnountDue Status OldestDue Dt
Transaction Authorization [ uso1 USHQ UNDEFINED 2121100010917 LEASEVEHICLE 0usD 0.00 0.00 PENDING
Post Date Checks
FartaN iepeccions Sumnary | Customer Service | Accounk Detaits | Customer Detals || TransactonHistory | PmtModes | Banicupley | RepoFForedosure | Defidency || Coleteral | Bureau | Cross|Ua Sel Actvies
Account Documents
Collateral Management Account Defals | Statements | Rate Schedule  Insurances | Contract Information
Reports
Producers .
Insurance Information [5iew | o hudit
Vendors 2 o S i
Batth Transactions Ve Fomatv B [[[Fre el dve | §
Advances Contractual Insurance Type Company Polcy # Effective Dt PremumAnt  Tem Status
b 4 lodatatodspay. b
Fees
Interfaces
AP Transactions Insurance Tracking JEit | Hien | of auit
6L Transactions Vieww Fomatv B freere HfiDetach  (Jwiem () o CreateTradng
CASA Recondliaion Sub-Parameter Parameter Vae
Conversion Accounts No data to dsplay.
» Collections
) Wi
» Tools
 Setup
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To add financed insurance

Transaction

Parameters

Insurance addi-
tion

Txn Date

Insurance Type

Single/Joint

Insurance Mode

Insurance Plan

Company Name

Phone #1

Extn #1

Phone #2

Extn #2

Policy #

Policy Effective Date

Premium Amount

Expiration Date

Primary Beneficiary

Secondary Beneficiary

Comment

You can cancel financed insurance on an existing account with the INSURANCE
CANCELLATION transaction. When you post this transaction, the system computes premium
refund amount based on the refund method associated with insurance item. If you enter a
value for PREMIUM AMOUNT parameter, the system overrides calculated refund amount
and adjusts advance/principal balance and Lease receivables accordingly. The INSURANCE
CANCELLATION transaction re-computes the repayment amount for Lease based on
remaining balances. After posting the transaction, Lease will be billed for newly computed
payment amount according information on the Contract tab’s Contract sub tab. The insurance
cancellation information can be viewed on the Contract link’s Insurances sub screen.

To cancel a financed insurance

Transaction

Parameters
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Insurance Addition | Txn Date

Insurance Type

Policy Effective Date

Insurance Refund Amount

Interest Refund Amount

Payment Amount

Cancellation Reason

You may rectify possible errors resulting from incorrect information entered on the
INSURANCE ADDITION transaction (such as an incorrect premium account) with the
monetary transaction INSURANCE MODIFICATION.

When you post the INSURANCE MODIFICATION transaction, Oracle Financial Services
Lending and Leasing re-computes the repayment amount using new premium amount and
adjusts advance/principal balance on Lease and Lease receivables.

To modify financed insurance information

Transaction Parameters

Insurance Modifications | Txn Date

Insurance Type

Policy Effective Date

Premium Amount

A.1.7 Index/Margin Rates

You can change the current index rate type and margin rate of a variable rate Lease using the
INDEX / MARGIN RATE CHANGE monetary transaction.

To change an index/margin rate

Transaction Parameters

Index/Margin Rate Change Effective Date

Index

Margin Rate

Reason
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A1.9

Payoff Quotes

A payoff quote is the amount still owed on account or amount needed to satisfy the Lease. It
can be generated anytime and may be requested during a call from a customer, dealer, or
insurance agent. The payoff quote appears in Results section of Maintenance screen.

ORACLE’
Financia\@er\/ices Lending and Leasing

i Close
S DashBoard Customer Service [
e Search  Customer Service: 2012010001148 | Review Request (Pending: 0)

Servicing

Servidng Account(s): 20120100011488: GIARDANO NICHOLAS / MIRIAM B view | 2 Audt
Customer Service: Viewv Formatv Freere L Detach rap W & ©curent)show Al Group Folow-up
Searitzation Company Branch Sub Lnit Account = Product Days Past Due Currency Pay OffAmt  Amount Due Status OldestDue Dt
Transaction Authorization usot usat UNDEFINED 12010011488 LEASE VEHICLE 1262 UsD 9,050.32 EXSERT \CTVEDELQSCHEDULED CHGOFE _[U/AUpTJ)
Post Date Chedks

Escrow Transactions Summary | Customer Service | AccountDetals | Customer Detals | Transaction History || PmtModes | Bankruptey | RepofForedosure | Defidency | Collateral | Bureau | Crossilp Sel Activities

Account Documents
Collateral Management: Call Activities ~ Maintenance Comments Promises ~Cheddists ~Trading Attributes References Corespondence  Letters ~ Document Trading
Reports
roducers . .
i Transaction Batch Information dpadd | et || Fvew | o At
endors
Batrh Trarsactors Veww Fomatv P Freeze Gl Detach = ) post [ vod
Advances Date. Monetary Transaction Status Batch
IR “« No data to display. ;
Fees
Interfaces
AP Transactions Parameters
6L Transactions Vew v Fomatv Freere EfiDetach s @
CASA Recondiaion Parameter Value Required
Conversion Accounts No data to display.
Result
Vews Fomaty B [|Feer iDetach o | @

‘Transaction Processing Details
SR No data to dplay
> WP
> Tools

> Setup.

To generate a payoff quote for an account Lease

Transaction | Parameters

Payoff Txn Date
Quote

Payoff Quote Valid Up To Date

Assess Payoff Quote Fee

Payoff Quote Ltr Print

Comment

Account Paidoff

An account is automatically paid off or marked for payoff processing by the system with a
batch transaction when the account balance is $0.00. You can also manually payoff an
account with the Maintenance screen. You can also pay off an account using the Consumer
Lending (Advance and Payment) form. For more information, see the Payment Processing
chapter.

When you payoff an account, the system changes the account’s status to PAID OFF. The date
the account was paid off appears in Activities section’s Paid Off Dt field on Account Details
screen.

The system also notes the amount of the principal that was waived when account was paid
off in the Waived column on Account Balances screen.
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To pay off an account

Transaction | Parameters

Paid off Txn Date

If you reverse the payoff payment using Customer Service form, then the pay-off is
automatically reversed. The system changes the account’s status from PAID OFF to ACTIVE
when you refresh the account.

Account Charge Off

Charging off an account refers to when a lender decides to take a loss on an account,
signalling that attempts to recover the Lease have failed. In calculating a charge off, the
system considers the total compensation amount (up front compensation plus remaining
compensation amount). It is different from the waive off process since a waive off is a
concession offered to the customer on payment of some component, such as a late fee. The
repayment of the original Lease still continues in waive off process.

When you charge off account, the system changes the status to CHARGED OFF. The balance
on the account appears on Customer Service form’s Balance screen when you choose
Deficiency Balance in the Balance Group section.

Summary  Account Detals ~Customer Detals Transaction History =~ PmtModes —Bankruptcy —Repo/Foreciosure = Defidency ~ Bureau | Cross/Up Sel Activities

Balances | Transactions =~ Sale Transfer Transactions = PaymentRating Due Date History ~ Repayment Schedule ~ Work Orders

Balance Group
Balance Group Txn Period
Q) Current Balance ©) Deficiency Balance(”) Non-Performing Balance ) Terminate Baance @ mD/cTD @) YTD
Views Fomatv [ Freeze & Detach wap (@

Balance Type Opening Balance Posted Pad Waived Adjusted (-)
ADVANCE | PRINCIPAL 0.00 5,000.00 0.00 0.00 5,000.00 0.00
INTEREST 0.00 11.65 0.00 0.00 11.65 0.00
FEE LATE CHARGE 0.00 0.00 0.00 0.00 0.00 0.00
FEE NSF 0.00 0.00 0.00 0.00 0.00 0.00
FEE EXTENSION 0.00 0.00 0.00 0.00 0.00 0.00
FEE PREPAYMENT PE... 0.00 0.00 0.00 0.00 0.00 0.00
FEE PHONE PAY 0.00 0.00 0.00 0.00 0.00 0.00
EXPENSE BANKRUPTCY 0.00 0.00 0.00 0.00 0.00 0.00
EXPENSE REPOSESSI... 0.00 0.00 0.00 0.00 0.00 0.00
EXPENSE SERVICING 0.00 0.00 0.00 0.00 0.00 0.00
Pl I b

Current Balance 0.00
Total
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The date of the charge off appears on Account Details screen in Activity section’s Chargeoff

Dt field.

ORACLE'
Financial Services Lending and Leasing

i Customer Service y, | Cydes ;| Colection Cyces (o ose
Origination Summary | Customer Service | ActountDefalls | Customer Detals ~ TransactionHistory | PmtModes Bankruptcy RepofForecosure | Deficency  Colateral | Bureau | Crossfp Sel Actvities fa
Origination
Salesead ) Alerts > Conditions
Simple Application Entry
Applcation Entry
Account Details Other Information
Underwitng
Funding .
’ Dues Collateral Information
Appication Retrieval
gan 040013 0y /1R 11/10/2012 10102012 Desripton Identification £ Vear AsetCass AsetType  SubTipe
I
0.00 0.00 0.00 0.00 0.00 No data to dplay.
Applcation Documents
Image Maintenance .
Repts Delg Due 0.00 TotalDue 0.00 Future Pmt Dt 03/10/2013 Gistome Tifarmation
LCDue 0.00 Todays Payoff 0.00 Oldest Due Dt 07/10/2012
Producers Fer
[ N&F Due 0.00 Future Payoff 0.00 AmtPaid Excess 0.00 - Nlame Relation SN Bith Dt Gender
Other Due 0.00 Future Payoff Date 01/03/2016 000000... EDWIN ASMITH PRIMARY Xexe-1021 0101/1560
[l Definquency Information 000000... KIMBSMITH SPOUSE XH0-1456 01/01/1980
‘
late X 60 90 jil 150 180 Category Days 4| Il » 3
1 1 1 1 0 0 8 180 0
Emal STEVEN@SSC.COM Disabilty N Privacy Opt Out Y
PR 0 NF(Lf) 0 Colector DAE Languzge ENGLISH S N Actve Miltary Duty N
Blfea) 0 Ner{year) 0 Mt Status Stop ¥ e Zone. AVERICA/CHICAGO
Correspendence
Activities
ActiveDt 11/01/2012 App # (0000000450 LastPmtAmt 9,822.12
Last Actuity Dt 12/24/2015 Paid OFfDt Tharge 0Tt 1229055 | Address
DueDay 10 Effective Dt 02/10/2012 Miitary Duty N Type ikt ::’c’:;s‘:Mmh”g Address Phone
 Senvicn LastPmtDt 06/18/2012 CurrentPmt 856,30 Customer Score 639 g 5 = S LR e
2 Customer Grade C Lestall At 7,946.70 Behaviour Scare 0 ZE : - 1'
> Collections HOME Y Y N 23423410124 PR-00772 (000)-423-4234
Producer 1L-00003 : SAM LEMAN CHRYSLER, PLYMOUTH MAZDA
tsid Due Date Ch:
> Tooks ue Date Change Employment Information
LastTun Dt Rem, Tun, Limit (Life) § Permissc
7 Setup Rem. Txn, Linit Year) 2 T Cment o Enploper Adress Phone -

However, you can select the ‘Do Not Auto Charge Off’ condition to ignore few account
conditions, for the charge-off processing batch job. When an account is marked with the
condition DO NOT CHARGE OFF, then batch job will not pick the account for charge off

processing.

You can add ‘Do Not Auto Charge Off’ condition in addition to the already existing condition.

To charge off an account

Transaction | Parameters

Charged Off | Txn Date

Account Closure

The system automatically closes an account when its status changes from ACTIVE status to
PAID or VOID. It is manually closed if it has status as CHARGE OFF. Accounts marked as
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CLOSED are not processed and after a period of time are purged from Oracle Financial

Services Lending and Leasing.

Summary | ‘Customer Service | Account Details | Customer Detail Transaction History  PmtModes  Bankruptcy | RepofForecosure  Defidency | Collatersl Bureau — Cross/Up Sell Actvities

Call Activiies  Maintenance | Comments  Promises  Checdists  Tracking Attibutes  References  Comespondence  Letters | DocumentTracking  Scenario Analysis

Transaction Batch Information

View v Fomat+ [P Freeze g Detach <J| Wrap 2] fohPost [ Vod
Date. Monetary Transaction
02/16/2016 ¥ ACCOUNT CLOSE
01/18/2016 N ADD CUSTOMER ADDRESS PHONE
01/18/2016 N ASSET MAINTENANCE
01/19/2016 ¥ PAID OFF
01/19/2015 N ASSET MAINTENANCE
Parameters
View~ Fomatv & Freeze o Detach 1| Wrap i)
Parameter Value
TXN DATE 0ij22f2016
Result

View v Format v ﬁ Freeze f:j'Detadw | Wrap @a

Transaction Processing Details
= Transaction Posting Successful =%

To close an account

Transaction Parameters

Account Close | Index Txn Date

Advance (Principal) Balance

okt || ZEit | Een | f At

Status Batch

POSTED N

POSTED N

POSTED N

POSTED N

POSTED N
Required
b

The advance (or principal) balance is posted automatically when you fund the contract on
Funding screen. You are not allowed to post the advance with Customer Service screen.
However, you can waive, charge off or adjust the advance or principal.

The adjustments will appears in the corresponding column of Customer Service screen’s
Account Balances sub tab for ADVANCE / PRINCIPAL Balance Type-- Waived, Charged Off,
Adjusted (-), or Adjusted (+) -- depending on which of the following transactions you perform.

Summary  Customer Service  AccountDetals | Customer Detals  Transaction History  PmtMoces  Bankruptcy | RepofForedosure  Defidency | Colateral  Bureau | CrossiUp Sel Actvities

Balances  Transactions ;ﬂLdiTransferTransamons Payment Rating  Due Date History  Repayment Schedule | Wark Orders

Balance Group
Balance Group

‘é'CurremBa\ance :‘Deﬁc\ency Balance :'NonPerfwm\ngBa\amce :'Term\nate Balance OFI'DICTD\’TD

View ™ Format ¥ E? Freeze dDerach d Wrap E@

Tin Period

11

Opening

Balance Type i Posted Paid Waived  Charge Off Adijusted () Adiusted (4) Balance
|| ADVANCE [ PRINCIPAL (.00 100,000.00 (.00 000 0.00 0.00 0.00 100,000.00
INTEREST 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
FEE LATE CHARGE 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
FEENSF 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
FEE EXTENSION 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
FEE PREPAYMENT PENALTY 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
FEE PHOKE PAY 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
FEE PERICDIC MAINTENANCE 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
RENTAL FEE 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
FEE DELAY 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
EXPENSE BANKRUPTCY 0.00 40.00 0.00 0.00 0.00 0.00 0.00 40.00
EXPENSE REPOSESSION/FORECLOSLRE 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00 B
EXPENSE SERVICING 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
Current Balance Total 100,040.00
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To adjust the advance/principal balance

Transaction Parameters

Adjustment To Advance/Principal - Add Txn Date Amount

Adjustment To Advance/Principal - Sub- Txn Date Amount
tract

To charge off the advance/principal balance

Transaction Parameters

Chgoff Advance/Principal Txn Date Amount

To waive the advance/principal balance

Transaction Parameters

Waive Advance/Principal Txn Date Amount

A.1.13 Interest

The interest is accrued or posted automatically when you post the payment on Advance
screen’s Advance Entry tab. You cannot post the interest in the Customer Service screen;
however, you can adjust or waive interest.

The adjustments will appears in the corresponding column of Customer Service form’s
Account Balances screen for INTEREST Balance Type-- Waived, Adjusted (-), or Adjusted (+)
-- depending on which of the following transactions you perform.

ORACLE'
Financial Services Lending and Leasing

— Customer Service [ Qoee
Origination h Seach  Customer Service: 2015100001137  Revien Request Pendi: )
Servicing
presmes Account(s): 20151000011137: K NAVIN ECARZ
Customer Senie Viewv Fomatv freere Hiveah ey @ & @orenrt )shon 1 roupFolowp
Seauritization Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
Transacton Autharizaton w01 s UDEFNED  DISI000LIS  LEASEVEHICLE o 2.0 168400 ACTIEDELG 1ij12/mi5
Post Date Cheks
bacron temeachons Summary | Customer Senice | AccountDetais | Customer Detais | Transaction History | Pt odes | Banknptey | RepojForedosire | Defidency | Colateral | Bureau | CrossjUp Sel Achvies
Account Documents
Colaterl Maragerert Balances | Transacions | Payment Ratng | Due DateHitory | Repayment Sehedue | Work Orders
Reparts
Fmdum Balance Group
Vet Balance Group Txn Period
ol Transactions
Advances @) Current gaance ) pefency Bdance () onPerfoming ance ( Teminate s @ oy (v
P View Formet  p [[|Freere fiDetach v ) {
I”;::ES Balance Type Opening Balance Posted Paid | Terminate Waived Charge Off Adiusted () Adjusted (+) Balance
EAE RECEIVABLE 000 10,1040 84200 000 00 00 00 9,200
¥ Yo FEELATE CHARGE 100 &0 10 10 00 20 o0 00
& T FEENSF 000 000 000 000 00 00 00 000
ChshReconcizion FEE ADVANCE 1) 00 1) 10 00 00 o0 o
kol FEE PHOIEPAY 00 000 000 000 00 00 00 00
SALES JUSAGETA 000 000 000 00 000 000 000 000
FEE DISPOSITION 000 000 000 000 00 000 00 000
FeE EXCESS USAGE 00 000 000 0 000 000 000 00
OTHER FEE ANDTAX 00 000 000 000 00 00 00 00
FEE EARLY TERMINATION 000 000 000 00 000 000 000 000
' Collections TERMINATION 000 000 000 000 00 00 00 000
TWENTORY 00 000 000 00 010 000 000 00
v CurrentBaance Totl §,322.00
) Tools
) Setup
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To adjust the interest

Transaction Parameters

Adjustment To Interest - Add Txn Date Amount

Adjustment To Interest - Sub- Txn Date Amount
tract
To waive the interest
Transaction Parameters
Waive Inter- Txn Date Amount
est

Interest Accrual

You can start or stop interest accrual on a Lease.

On the Lease Details screens, Stop Accrual box is selected in Interest and Accruals section.

Summa\yhtustumeriewice Account Details  Customer Detals | Transaction History | PmtModes  Bankiuptcy | RepofForedosure | Defidency  Collateral | Bureau  CrossjUp Sel Activities

Account Details | Statements | Rate Schedule | Insurances = Confract Information

Account Information Huew | of Audt
View v Formatv B} Freeze fi Detach wrep )
Index Type Index Rate Margin Rate Rate Last Rate Change Dt Acorual StartDt Last Acoruzl Dt al=statofthel | R oixae duboes) | £otiale Ueaies duit
Year (Year) (Life)
N PRIME RATE 5.00 49 999 01/21/2016 01/21/2016 9.9 0 0

{ I )

To remove Stop Accrual indicator, post the start ACCURAL transaction.

To start interest accrual for an account

Transaction | Parameters

Start Txn Date
Accrual

To stop interest accrual for an account

Transaction Parameters

Stop Accrual Txn Date

Active Military Duty

The Servicemembers Civil Relief Act of 2003 (SCRA), formerly known as the Soldiers and
Sailors Civil Relief Act of 1940 (SSCRA), is a federal law that gives military members some
important rights as they enter active duty military service. The law is designed for active duty
military personnel and reservists (and their spouse -- if applicable for joint credit accounts) to
receive, as a result of military service economic hardship(s), an interest rate reduction
(currently at 6.000%) for certain consumer and mortgage-related debt that was incurred prior
to entering military service, for the period of time that the servicemember is on active duty.
Under the law, the term’s interest includes service charges, renewal charges, fees, or any
other charges (except bona fide insurance) with respect to an obligation or liability. The law
also provides protection against certain legal actions during the term of active duty military
service. The SCRA function is currently available in the system for simple interest Lease.

Any account that has been identified under SCRA requirements as eligible for the allowable

benefits of active military duty for its primary borrower/spouse will have a new interest rate
calculation based upon the 6.000% limit set by the SCRA. However, this change is subject to
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exception in case of accounts that already have an interest rate less than 6.000%. In such
cases, the original interest rate that is less than 6.000% will continue.

To indicate that a borrower is on active military duty

Transaction

Parameters

Borrower On Military Duty

Txn Date

Borrowers Relation With Account

Active Duty Order Reference

After you post this transaction, the Military Duty box (Account Details screen Activities
section) and Active Military Duty box (Customer Details screen Military Service section) are
selected. Oracle Financial Services Lending and Leasing changes the condition of the
account to ON ACTIVE DUTY. Details of the transaction appear in the Military Services
section on Customer Details screen.

A
Summary Customer Service | AccountDetal  Customer Defals  Transaction History ~ PmtModes | Bankrupty | RepofForecoswe  Defidency Colaterd  Bureau | Cross/Up Sel Activities
E&/ Alerts » Conditions
Account Details Other Information
Dues Collateral Information
Description Tdentification # Year  AssetClass  AssetType  SubType
0.00 0.00 0.00 0.00 0.00 0TOYOTA COROLA 0 NEW VEHICLE CAR
DelgDue 0,00 Total Due 0.00 Future Pmt Dt 02/01/2016 i .
1COue 0.00 TodzysPaeff %0043 Otestouent ooy | Customer Information
Custo
NSF e 000 Futre Payoff 36,0549 AntPaidExces 0.0 S N Resion ] Dt Gender
03101 o
Other Due. 0.00 Futre PeyoffDate 0Y23{20%6 w0001, 7L PRIVARY sl 0G0 UNDETED =
Definquency Information ¢ 11l ) K
Late X 60 %0 1 150 180 Category Days i
4 Y i b b 1 i i Email Disahiity N Privacy Opt Y
: . Lanquage ENGLISH sip N Out
BR(LfE) 0 NeF(Life) 0 Colector DEMOCOLL Merita Stz Stp N Active Miitzry N
BP(fear) 0 NeF(fear) 0 Comespondence Duty
Time Zone  AMERICA/LOS_ANGELES
Activities
Active Dt 01/12/2016 App # 0000001269 Last Pt Amt 0,00
Last Actity Dt 01/12/2016 Paid OFFt Charge Ot Address Tnformation
DuzDay 1 Effectve Dt 01/12/2016 Vitary Duty N e  Crent z:[cm‘;s'cmmng Address Phone
al
LastPmt Dt CumentPmt 3,078.22 Customer Score 0 NGNGB
Customer Grade B LastBil Amt 0.00 Behaviour Score 0 HOME Y i } (000)-000-0000
CA-92398
Producer CA-00010 : SMART DEALER SERVICES
Due Date Change Employment Information
Last Tun Dt Rem, Txn, Limit (Life) 5 Permissic
Type Curent Employer Address Phone
Rem, Tan, Limit (Year) 2 L tocal POV ¥

If the interest rate was greater than 6%, Oracle Financial Services Lending and Leasing will
change the rate to 6% and adjust the payment accordingly. The CHANGE PAYMENT
AMOUNT and RATE CHANGE transactions on the Transactions screen.

To indicate that a borrower is no longer on active military duty

Transaction Parameters

Borrower off Military Duty Txn Date

Borrowers Relation With Account
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RACLE
Financial Services Lending and Leasing

ustomer Service Close

> DashBoard Gistomer Seivice E

> onigination Search  Customer Service  Review Request (Pending: 0)

Sarvicing

seveng Account(s) - v [ Pt

Customer Senvice View ~ Fomat~ B | [[[[Fresze {Detach wo @G OcreOshowa O oo Folowsn
Securitization Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
Transaction Authorization No data to display.
PostDate Chedks
Escron Transactons S| e tDetaie|| G Pt Modes

Baniquptey | RepoForedosure | Deficency | Bureau || Crossjup Sell Actvties
Account Documents

Colateral Management
Reports
Producers

Customer | Business

o Customer Information

Baich Transactions

ZEdt || [Elvew || £ auit

- View v Formatv [ | [[[Freeze gfiDetach @
Payments i Mother's Maiden
% Customer = Relation EcoA s Name BirthDt MaritalStatus  Enabled Language Education sl ‘
Fees
o data to disp
Interfaces " =
< il »
AP Transactons
6L Transactons
CASA Recondiiation Addresses | Telecons | Employments | Trading Attrbutes
Conversion Accourits
Address Information Fradd || LEdt | [Huew | @ audt
Viewv Formatv [y Freeze [fiDetach | ¢ wrap ®
Tie Current Permisson to Cal  Confirmed Maiing Country Address & city State Postal Address Type StreetPre Street Name:
Nodata to dispay.
> Collections <« il »
> WFP.
> Tools
> Setup

A.1.16 Due Date Change

You can change the due date of an account. When it is changed, the system determines next
bill date, as well as the next due date. The DUE DATE CHANGE transaction does not allow
next billing date to change such that it is less than the current billing date. The due date
change transaction has been extended to change the default ACH due day, provided that the
account due day and ACH due day match.

If a late fee is no longer applicable because of this due day change, Oracle Financial Services
Lending and Leasing will automatically remove the fee.

The new due day appears in Activities section Due Day field on the Account Details screen.

Summary ~ Customer Senvice | AccountDetais | Customer Detals ~ Transaction History  PmtModes Bankuptcy | RepofForecoswe  Deficency  Collsteral  Bureau  CrossiUp Sell Activites

 Nerts » Conditions
Account Details Other Information
Dues Colateral Information
Description Identification # Year AssetClass  AssetType  SubType
0.00 0.00 0.00 0.00 0.00 2015 TOYOTA CAMRY D15 HEW VEHICLE CAR
DelqDue 0.00 Total Due 0,00 Fubwre Pmt Dt 01/01/2016 Cust - i
LCDue 0.00 Todays Payoff 50,000.00 Oldest Due Dt 01/01/2046 Ucﬂg'lel' hionTawn
6F e 000 FuturePayoff 50,000.00 AntPaidExcess 0.00 S e Relaton s Gender
Other Due 0.00 Future Payoff Date 01/07/2015 a00000 BRIMARY e
Definquency Information { il )
Late ) 60 90 120 150 180 Category Days
g 0 ¢ i g $ ¢ ki Emal Disabilty N Privacy Opt Out N
i % ; Language ENGLISH Sip N Active Miitary Duty N
BR(ife) 0 NGF(Life) 0 Collector DEMOCOLL
s el i Marital Status Stop N Time Zone
BR(Year) 0 NSF(¥ear) 0 Comespondence
Activities
Actve Dt 12/28/2015 fop # 0000001230 LastPmt Ant 0.00 Address Information
LastActivity Dt 12/28/2015 Paid Off Dt Cherge OFf Dt Tie it ::'cmTMME“‘"g ot e
DueDay 1 Effective Dt 12/28/2015 Miitary Duty N 3
LastPmt Dt CurrentPmt 1,452.80 Customer Score 750 HOME Y Y ¥ BRI LR (009)-564-8741

Customer Grade A

Last Bl Amt 0.00

Producer CA-00002: RANDYS ALITO SALES

s R

Behaviour Score 0

Employment Information

PIEDRAS PR00771

The system also notes change on Lease Details screens in Extn and Due Dates section’s #
of Due Day Changes (Year), # of Due Day Changes (Life) and Due Day Chg Dt fields.
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To change a due date

Transaction Parameters

Due Date Change Txn Date
Due day
Due Date

A.1.17 Payment Refund Transaction

Payment refund transactions allows you to refund excess payment received from the
customer during life of the Lease. The Payment Refund transaction is posted at the
maintenance screen in servicing. The refund is posted only when the refund amount is equal

to Payment amount. Else an error message is displayed.

@mary Customer Service  AccountDetals | Customer Detals | Transaction History | PmtModes | Bankruptcy | RepofForedosure | Deficency | Bureau | Cross/Up Sel Activities

Cal Activities || Maintenance | Comments = Promises = Cheddists | Tracdng Attributes | References = Correspondence | Letters = DocumentTracking | Scenario Analysis

Transaction Batch Information

View v Formatv Ep Freeze i Detach lirap @ =R
Date Monetary Transactian
02/03/2015 ¥
12/17/2015 ¥ PAYOFF QUOTE
12/17/2015 ¥ ADIUSTMENT TO ACH FEE - ADD
12/15/2015 T PAYOFF QUOTE

Transaction Batch Information

Date 02/09/2016

* Monetary [¥]

Parameters

*Transaction

Batch ¥

View = Format~ B Freeze i Detach lirzp ®

Parameter
No data to display.

Result

View = Format~ [ Freeze pliDetach | ¢l Wrap W

Transaction Processing Detais
No data to display.

[ save and Add

Value

o add | Ed ] Ve 7 Audi
Status Batch
v
POSTED N
OPEN N
POSTED N

[ saveandstay | [ saveandReum | {aRetum

Status

m

Required

To refund the payment amount

Transaction Parameters
Payment Txn Date
Refund

Payment Amount

Payment Date

Refund Amount

A.1.18 Extensions

Extension transactions allow you to extend a Lease. An extension fee may be assessed when

an account receives an extension. In case of precomputed Lease, this is generally done to
recoup the interest lost.
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The system adjusts due date on Dues section’s Oldest Due Dt field on Account Details screen

to reflect the extension.

Summary | Customer Service  AccountDetals  CustomerDetals  TransactionHistory  PmtModes  Bankruptry RepofForedoswe  Deficency  Colatersl  Bureau  CrossiUp Sell Actvities

b Alertb " Conditions
Account Details { Other Information
Dues Colateral Information
0ot 12012015 11012015 10/01/2015 09j01/2015 Description Identification % Vear AssetClass  AssetType  SubType
0.00 0.00 0.00 0.00 0.00 ( TOYOTA CAMRY 123456 783A5DFGRTY 0 NEW VEHICLE CAR
Delg Due 0,00 Total Due 0.00 Future Pmt Dt 020012016 Cust pa—
[Chus 0,00 TodaysPayef 0.00 Oldest Due Dt 0201/2016 SRRSO
Custo
16 e 000 FutrePayoft 000 ntPadExcess 000 e Relson i BithDt Genter
Ofer e .0 FurePayoffDate 201215 % ooooon.. mecku Begy PRIVERY B T L
Definquency Information s Il |
Late 0 &0 Ll pvi] 150 180 Category Days
: : : ; ! ! § g Emal Disgbilty N Privacy Opt Out N
g s ; Lanquage ENGLISH Sip N Active Miitary Duty N
Bp(fe) 1 NF{Life) 2 Collector DEMOCOLL
. X o X et Marita Status Stop N Time Zone
B (Vear) 1 N&F{fear) 2 Comespandence
Activities
Actve Dt 12{07/2015 Aop2 0000001003 LsstemtAnt 6500000 Address Information
o . e
Last Activity Dt 01/22/2016 Paid Off Dt Charge Off Dt Tie et ;rcm\rcha“mg A e
Due Day 1 Effective Dt 01/01/2015 Miitary Duty N g
LastPat Dt 01120016 CurentPrt 313435 CstymerSere 700 t N W RMOEGREORIE. (o
[rietrmer Grada A I et il At 27 707 00 Rehauinir e N HAME v v ] ESERNDADBCHN = IS EITITFHLAS 0iN0A\RRATREY

It also notes the change with an entry on the Lease Details screen in the Extn and Due Dates
section’s # of Extensions (Year), # of Extensions (Life), # of Extension Term (Year) # of
Extension Term (Life) fields.

H]ancia\ Services Lending and Leasing
i Close
 DashBoard Customer Service @,
D auin Search  Customer Service: 0150900014283 Revien Recuest (Pending: 0)
Servicing
Senvidng Account(s): 20150900014283: RODRIGUEZ ROBINSON Even | o nuit
Custormer Service: Vewv Fomatv B [[Fee gfiDdad W @) &  (©curent(shon il D) aowFolonsp
Seauritization Company Branch Sub Unit Account # Product Days Past Due Currency Pay OffAmt Amount Due Status Oldest Due Dt
Transaction Authorization usot USHQ UNDEFINED 2015000014283 LEASE VEHICLE 114 UsD 1518.10 4,296,580 ACTIVE:DELQ 10/05/2015
Post Date Chede
Esaron Transactions Summary  Customer Service  Account Details | Customer Detals | TransactonHistory ~ PmtModes  Barkruptcy RepofForecosure  Defidency  Collteral  Bureau | Cross/Up Sell Actities
‘Account Documents
Colateral Management Account Details  Statements | RateSchedue  Insurances  Contract Information
Reports
Producers -
Account Information e | o Auit
Vendors o
Batch Transactions Ve famat~ B | [[[freae ine d | R
Advances Ebissas # of Extensions (ife) SulCimsTem) o Cuecatet=m RS S 1k ey QR St e e 2 o Due Day Change Dt TotalTem Paid Term Maturty Dt
Paments i {(ea) (tea) (F)  cemgesfes)  dunges(if)
0 0 0 0 0 0 5 1 11052016 !
Fees
Interfaces
[ Account Information
L Transactons {aketum
CASA Reconciiation
Conversion Accounts Extoand Due Dates Additional Details
#of Extensions (fear) 0 #of Due Day changes(Year) 0 TotalTerm 15
# of Extensions (Life) 0 #0fDue Day changes(Life) 0 PaidTerm 1
+ ofExtension Tem (fex) 0 Last EximDt VatrityDt 11052016
#of Extension Term (Life) 0 Due Day Change Dt
7 Collections
) WP
 Tooks
> Setup

A-21

ORACLE



To apply an extension

Transaction Parameters

EXTENSION Txn Date

Extension Term

Reason

Stop Accrual

While posting an extension, ensure that the minimum number of required payments, as
defined at contract level is met. Else, system displays an error message on verification. Also
while posting subsequent extension transactions, ensure that the minimum gap requirement
between two extensions is satisfied.

To adjust an extension fee

Transaction Parameters

ADJUSTMENT TO EXTENSION FEE - ADD TXN DATE AMOUNT

ADJUSTMENT TO EXTENSION FEE - SUBTRACT TXN DATE AMOUNT

To waive an extension fee

Transaction Parameters

WAIVE EXTENSION FEE TXN DATE AMOUNT

A.1.18.1 Extension Override

You can post ‘EXTENSION OVERRIDE’ transaction when you want the system to bypass
extension validations which are defined at contract level.

Note the following:

e You can post a ‘EXTENSION OVERRIDE' transaction only if you are authorized.
e There are no validations done when an extension override transaction is posted.

e Backdating an extension is allowed and also while backdating, system validates for the
number of payments as of Transaction date.

e If ‘EXTENSION OVERRIDE' transaction is posted on a backdated transaction which
has ‘TXN Date’ appearing before the transaction extension date, then all the
transactions from the date of previous extension will be reversed and re-posted. Here
again, no validation rules are checked.
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To apply an

extension

Transaction

Parameters

EXTENSION

Txn Date

Extension Term

A.1.19 Payment Amount

You can change the current payment amount of an account. The new payment amount has
to be calculated manually as Oracle Financial Services Lending and Leasing does not

perform any checks on the new payment amount.

If the transaction is backdated, due amounts for the affected periods are re-calculated. While
delinquency data could potentially change, prior statements are not to be changed. The next
ACH (if applicable) does not reflect changed payment amount if the account has already been
billed at time of posting the transaction. Payments will be re-applied causing changes to

account balances and late fees may be assessed (if applicable).

After you post the transaction, the new payment amount appears on Account Details screen

in Current Pmt field of the Activities section.

Financial Services Lending and Leasing
o Customer Service (] gose
» Origination 4
Yew | of Audt
il Account(s) _ _ _ Elten || P4
View Fomatv & Freeze i Detach wp @ & OourentCshon al Oeroup Followsp
Serviang
Company Branch SubUnit Account # Product Days Past Due Curency Pay Off Amt Amount Due Status Oldest Due Dt
Customer Service
No data to display.
Seaitzaton
Transaction Authorzation
Summary | Customer Service | AccountDetals  Customer Detals | Transactontistory | PtModes | Berknptry | RepofForecosure | Defidency | Bureau | Crosshp Sel Achvites
Post Date Chedks
Excrow Transactions
Account Documents D Alerts 7 Conditions
Collateral Management
Reparts Account Details Other Information =
Producers
Vendors
Dues .
Batch Transactons Customer Information
Mos [ Nocta todipy. OB e Reaton s Bt Gender
Payments i 7
2 No data to display.
o5 Delg Due Total Due Future Pt Dt
Interfaces ¢ 1) '
1CDue Todays Payoff Oldest Due Dt
§F e ¥ Due FuturePayoff AmtPad Excess
6L Transactons kb e Py Emal Disgbity Privacy Opt Out
CASA Recondiation . Language Sip Active Mitzry Duty
Conversion Accounts Definquency Information Vit Status Stop Tine Zone
Late k] 60 %0 10 150 180 Category Days Correspondence
No data to display.
Bp(fe) NGF(fe) Collctor Address Information
Bliea) ter(fea), T (| by kb Phone
toCal
» Collections Activities No data to display.
S WEP Actve Dt hp# Last Pt Amt
5 Tools Last Activity Dt Paid Off Dt Charge Off Dt Employment Information
DueDay Effectve Dt iltary Duty Permissid
) Setup LastPmt Dt Customer Sere Twe  Curent o Enploger Address Phone v
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To change the payment amount

Transaction Parameters

Change Payment Amount | Txn Date

Payment Amount

Payment Auto Computer

Indicator

A.1.20 Prepayment Penalty

A prepayment penalty is typically applied automatically by Oracle Financial Services Lending
and Leasing if the account is paid off prematurely.

The following transactions allow you to adjust or waive the prepayment penalty fee. The
adjustments will appears in the corresponding column of Customer Service screen’s Account
Balances screen for FEE PREPAYMENT PENALTY Balance Type-- Waive, Adjusted (-), or
Adjusted (+) -- depending on which of the following the transactions you perform.

ORACLE’
Financial Services Lending and Leasing

S Customer Service [x]Close
> Origination search| G x 1488 quest (Pending: 0)
Servicing
senvicng Account(s): 20120100011488: GIARDANO NICHOLAS / MIRIAM ) Elven | o auit
Customer Service Viewv Fomat+ [} Freeze i Detach irap W &8 ©@curentOshow a1 eroup Folowp
Seaitzation Company franch SubUnit Account # Product Days Past Due Currency Pay OFf Ant  Amount Due Status OkdestDue Dt
Transacton Autherization usot USRL UNDEFINED 2012010001488 LEASE VEHICLE 1262 USD 905032 [I3EEACTVEDELQSCHEDUED CHGOFF (o ulngi)
Post Date Chedts
EScro TPacin Summary | Customer Service | AccountDetais | Customer Detais  Transaction History | PmtModes | Bankruptey | RepofForedosure | Deficency | Colateral | Bureau | CrossjUp Sel Activities
Account Documents
Colateral Management. Balances | Transactons | PaymentRatng | Due Date Hstory | Repayment Schedue | Work Orders
Reports
Producers i B
Sendor Balance Group Tn Period
Batch Transactions
Advances @ current Balance (©) Defciency Balance (2 on fer forming Balance (©) Terminate Balance @ 1rojcrn @)
Eaments ! View v Fomat> Freeze i Detach T 1
Fees Balance Type Opering Balance Posted Paid / Terminate Waived Charge OFF Adiusted () Adiusted (+) Balance
RS LEASE RECEIVABLE 000 10699 2,080.54 00 000 000 000 8,519.%
48 T FEE LATE CHARGE 000 094 0.00 00 000 000 0.00 .94
G Trarsactans FEENSF 000 000 0.00 00 000 000 000 0.00
CASA REctn FEE ADVANCE 000 0.00 0.00 0.00 000 000 0.00 0.00
Corversen Al FEE PHONE PAY 000 000 0.00 0.0 000 000 0.0 0.00
SALES / USAGE TAX 000 0.00 0.00 00 000 000 000 0.00
FEE DISPOSITION 000 0.00 0.00 00 000 000 0.00 0.00
FEE EXCESS USAGE 000 000 0.00 0.00 000 000 000 0.00
OTHER FEE AND TAX 000 0.00 0.00 0.0 000 000 0.00 0.00
FEE EARLY TERMINATION 000 0.00 0.00 0.0 000 000 000 0.00
* Collections TERMINATION 000 000 0.00 00 000 000 000 0.00
5 INVENTORY 000 000 0.00 0.00 000 000 000 0.00
s Current Balance Total 9,050,32
> Tools
> Setup

To adjust a prepayment penalty

Transaction Parameters

Adjustment Prepayment Penalty - Add Txn Date Amount

Adjustment Prepayment Penalty - Subtract Txn Date Amount

To waive a prepayment penalty

Transaction Parameters

Waive Prepayment Penalty Txn Date Amount

A.1.21 Escrow Payment

The following monetary transactions allow you to specify escrow payment to be billed to the
customer each month. Rescheduling an escrow payment enables you to change the payment
rate (and hence rate and term) and define when change will begin. The “txn date” parameter
is when the new agreement starts.
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A.1.22

A.1.23

The following transactions allow you to adjust or waive the escrow advance.

The adjustments will appears in the corresponding column of Customer Service screen’s
Account Balances screen for ESCROW ADVANCE Balance Type-- Waive, Adjusted (-), or
Adjusted (+) -- depending on which of the following transactions you perform.

To adjust escrow advance

Transaction

Parameters

Adjustment to escrow advance - add

Txn Date Amount

Adjustment to escrow advance - subtract

Txn Date Amount

To waive escrow advance

Transaction Parameters

Waive Escrow Advance Txn Date Amount
To reschedule an escrow payment

Transaction Parameters

Reschedule Escrow Payment Txn Date Amount

Escrow balance refund

If an account is paid off resulting in a positive (greater than $0) escrow balance or the last item
being escrowed is removed resulting in a positive (greater than $0) escrow balance, then
Oracle Financial Services Lending and Leasing refunds the escrow and creates a check

requisition.

Pay Off Quote Fee

The PAYOFF QUOTE transaction on Maintenance screen includes the required parameter
ASSESS PAYOFF QUOTE FEE. If you select Y, Oracle Financial Services Lending and Leasing
assesses a payoff quote fee on Customer Service form’s Balances screen for Balance Type
FEE PAYOFF QUOTE. The amount of the payoff quote fee is based on contract setup.

The following transactions allow you to adjust or waive the pay off quote fee.
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The adjustments will appears in the corresponding column of Customer Service form’s
Balances screen for FEE PAYOFF QUOTE Balance Type-- Waive, Adjusted (-), or Adjusted (+)
-- depending on which of the following transactions you perform.

Summary | Customer Service  AccountDetals  Customer Detals  Transaction History = PmtModes  Bankruptry | RepofForeosure  Deficency  Collateral  Bureau  CrossiUp Sel Activities

Balances I%nsachuns PaymentRating  DueDateHstory  RepaymentSchedule  Work Orders

Balance Group
Balance Group Txn Period
Q) Current Balance | Defidency Balance Non-Performing Balance () Terminate Balance ~ (@/TTD/CTD YD
View ¥ Format ¥ ﬁf Freeze ﬁj‘ Detach Wrap @E}
Balance Type Opening Balance Posted Paid Balance Waived Charge Off Adjusted () Adjusted (4) Balance
ADVANCE | PRINCIPAL 0.00 30,000.00 0.00 0.00 0.00 0.00 0.00 3000000 » L
INTEREST 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 E
FEE LATE CHARGE 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
FEENSF 0.00 0.00 0.00 0.00 0.00 0.00 0.00 000z
FEE ADVANCE 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
FEE QVER CREDIT LIMIT 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
FEE MEMBERSHIP 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
FEE PHONE PAY 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
FEEDELAY 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
EXPENSE BANKRUPTCY 0.00 0.00 0.00 0.00 0.00 0.00 0.00 000 ¥
Current Balance Total 30,000.00
Promotion and Insurance Details [Een | o Audt
View ¥ Format ¥ ET Freeze fj' Detach Wrap @ﬂ

Promotion Type Rate Term Start Dt EndDt Insurance Status Sub Type
NONE NONE 0.00 0.00 2/24f015  12/31/4000

To adjust a pay off quote fee

Transaction Parameters

Adjustment to Payoff Quote Fee - Add Txn Date Amount

Adjustment to Payoff Quote Fee - Subtract | Txn Date Amount

To waive a pay off quote fee

Transaction Parameters

Waive Payoff Quote Fee Txn Date Amount

A.1.24 Nonperforming Accounts

Lease accounts can be placed in a nonperforming, or nonaccrual, condition. Once an account
is set to a nonperforming condition, the system makes the following modifications and
accounting entries:

e After the transaction date, Oracle Financial Services Lending and Leasing assesses no
late charge to this account.

e Stops general ledger entries for interest accrual.

e Transfers the existing principal balance on this account to the Non-Performing Balance
Group on Customer Service form’s Balance screen.

e Charges the unearned dealer compensation back to the dealer.

e Treats payments posted to this account as it does with a normal account; however, the
general ledger entries for allocation of these amounts towards principal and interest will
go towards the nonperforming balance.

The system’s general ledger (GL) is set up for the above items. There will be no impact on

balances of the account (principal, interest, fee and expense) as a result of the above
transactions.
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To place an account in a nonperforming condition

Transaction Parameters

Account Non Performing Txn Date

Non Performing Description

The following transaction removes nonperforming condition on an account and reverses the
nonperforming transactions explained above. General ledger entries for interest accrual,
stopped during nonaccrual stage, resume.

To reverse a nonperforming condition

Transaction Parameters

Resume Account Perform- | Txn Date
ing

A.1.25 Convert a Precomputed (PC) Lease into a Simple Interest (Sl) Lease

When converting a precomputed Lease into a simple interest Lease, Oracle Financial
Services Lending and Leasing assumes the following default values:

e Accrual Calculation Method - interest bearing (simple interest)
e Maturity Date - Computed from the term and next payment due date

e Monthly Payment Amount - Computed from the interest rate, new principal balance,
accrual start date, and term.

e All balances other than the Note balance are carried over to simple interest Lease.

The resulting ‘new’ simple interest Lease will have the same account number with details
entered/computed above.

Caution: The converting a precomputed Lease into a simple interest Lease transaction can
be performed only by closing the nonperforming condition.

To reschedule precomputed Lease to interest bearing Lease

Transaction Parameters

Reschedule Pre-Compute Lease to | Txn Date
Interest Bearing Lease

Reschedule Payment Start Date

Amount

Rate

Term

A.2 Nonmonetary Transactions

This section catalogues the transaction codes and parameters required to complete the
following nonmonetary tasks for Lease:

e Update a customer’s name

e Maintain customer details

e Mark a customer as a skipped debtor
e Mark a customer as deceased

A27 ORACLE



Change a customer’s Privacy Opt-Out indicator
Stop correspondence

Modify financed insurance information

ACH Maintenance

Reprint a statement (batch only)

Add or stop servicing of accounts with post dated checks as a repayment method

Stop an ACH for an account

Add ACH bank

Cancel or adjust an ESC

Apply a refund payment to an ESC
Cancel insurance (or reverse the insurance cancellation)
Add new escrow insurance details

Add new escrow tax details

Change insurance annual disbursement
Change insurance disbursement plan
Change escrow indicators of insurance
Change insurance expiration date
Change insurance maturity date
Change tax annual disbursement
Change tax disbursement plan
Change escrow indicators of tax
Resume escrow analysis

Resume escrow disbursements

Stop escrow analysis

Stop escrow disbursements

Refund or adjust insurance

Adjust Dealer Compensation

A.21 Customer Name Maintenance

You can update and change a customer’s name.
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To update a customer’s name

Transaction Parameters

Customer Name Maintenance Txn Date

Relation Type Code

Customer First Name

Customer Middle Name

Customer Last Name

Customer Generation

Code

The new details appear throughout the system; for example, in Customer Service screen’s
Customer(s) section and Customer Details screen’s Customer section.

oRACLE
Financial Services Lending and Leasing

- Close
> Dashieanl Customer Service x El
S origination Search | Customer Service: 20151200012836 | Review Request (Pending: 0)

Servicing
p— Account(s): 20151200012836: EATHAN EATHAN [ view || < auat
Customer Service Viewv Formatv [ Freeze i Detach mp | W & @ current O showall O Group Follow-up
SN Company Branch Sub Uit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
Transaction Authorization usot ushg UNDEFINED 2015120001283 LEASEVEHICLE 15 UsD 38,5063 0,00 ACTIVE 01/22/2016
Post Date Checls
Escrow Transactions
Summary | Customer Sendce. | Account Details  Customer Details | Transaction History || Pt Modes | Bankwuptcy | RepojForeclosure | Deficency | Collteral || Bureau | Crossfup Sell Actviies
Account Documents
Callateral Hanagement e
Reports
Producers
Vendors Customer Information
Batch Transactions. et || B vien | o audit
Advances
Views Format v Freeze  gf{Detach Wra
Payments & Ed o @ )
Fees i Customer Relation ECOA Name. s Bith ot Varital Status Enabled Language Education ;::‘m"f' Maiden
Interfaces 0000006022 PRIMARY INDIVIDUAL EATHAN EATHA xp0c2218 12/22/1850 ¥ ENGLISH |
AP Transactions 5
6L Transactions
CASA Reconciiation
Comversion Accounts Addresses | Telecoms | Employments | Tracking Attibutes

Address Information P aid || /et | 5 view | ¥ audt

Vieww Format v [ Freeze i Detach wap @
Type Current Permission to Call ~ Confirmed Mailing Country Address = City State Postal Address Type Street Pre Street Name
HolE i v (0 ¥ UNITEDSTATES 2300 VERMO CAUFGRNIA  NORMALADDRESS  NORTH

»
" Collections

> WP

> Tools

b setup

A.2.2 Customer Details Maintenance

You can update and change the following details regarding a customer: social security

number, marital status, disability indicator, driving license number, number of dependents,
and email address.
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A.2.3

To change other details about a customer

Transaction

Parameters

Customer Maintenance

Txn Date

Relation Type Code

Customer SSN

Customer Marital Status Code

Customer Disability Indicator

Customer Driving License Number

Customer Number of Dependents

Customer Email Address 1

Customer Birth Date

Customer Gender Code

Customer Language Code

Customer Driving Licence State Code

Customer Time Zone

The new details appear throughout the system.

Skipped Customers

When a customer cannot be located, the system enables you to mark that person as “skipped”
(as in, “the person is a skipped debtor.”) Marking a customer as skipped indicates that the
customer’s whereabouts are unknown.
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A2.4

To mark a customer as “skipped”

Transaction

Parameters

Customer Skip

Txn Date

Relation Type Code

Customer Skip Indicator

The Skip box is selected on the Customer Service screen’s Customer(s) section and
Customer Details screen’s Customer section.

ORACLE'

Financial Services Lending and Leasing

 DashBoard
Origination
Servidng %
Servidng
Customer Service
Securization
Transaction Authorzation
Post Date Chedss
Escrow Transactions
Account Documents
Collateral Management
Reports
Producers
Vendors
Batch Transactions
Advances
Payments
Fees
Interfaces
AP Transactons
6L Transactions
CASAReconclation
Conversion Accounts

> Collections
> WP

> Tools

> Setup

Customer Service

Sunmary | Customer Service | Account Detals

Customer  Business

Customer Details

Customer Information
View v Format~ [ Freeze pfiDetach
Customer # Relation ECOA s
No data to diplay. -
(] I
Customer Information
Customer
Custormer £
Relation
ECOA
Name
Birth Dt
Marital Status
Encbled _
Language
Education

Mother's Maiden Name

ClssType
Emal

Stop Correspondence _

Disabilty _

Transaction History || PmtModes | Bankrupicy | RepofForedosure | Defidency || Bureaus | Cross/p Sel Activities

Name

Passport #
Tssue Dt
Expiry Dt
Visa #
Nationilty
National D
s

License #
License State

Active Mitary Duty

Effective Dt

e

JEdt || Elven | o Audt

Mother's Maide
Bith Dt MattalStats  Enabled Languge Education -
)
Careum I
“
Identification Details e
Reference #
Status
FATCA
Birth Place
Birth Country
Permanent US Resident Status
Power of Attorney

Military Service
Power of Attormey __

Holder Name
Address

Framtr

To remove the Skip indicator, follow the above procedure. However, you can also type N in
the CUSTOMER SKIP INDICATOR parameter.

Mark Customer as Deceased

You can mark a particular customer as deceased by posting a non-monetary transaction.
Marking a customer as deceased indicates that the 'Account holder is deceased' and this
condition is posted on the account and an Alert is populated in Comments tab and Summary

tab.
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To mark a customer as “deceased”

Transaction

Parameters

Mark Customer as
Deceased

Deceased Date

Relation Type Code

ORACLE ¢, Welcome, VAVAIDYA ~ - Accessiility
Financial Services Lending and Leasing
Close
' DashBoard Customer Service [®d
> Origination search | G 2 quest (Pending: 0)
Servicing
saticng Account(s): 20150800012212: HOOD MARK Elvien || o auit
Customer Service Vieww Formatv [ Frezze Ef] Detach J Wrap W & @ curent O showall O Group Follow-up
Securitization Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
Transaction Authorization Uso1 USHQ 2015080012212  LOAN VEHICLE (FR) 3033305 0.00 ACTIVE 02/01/2016
Post Date Checks
Escron Transactions
Summary | Customer Service | Account Details  Customer Details  Transaction History | Pt Modes | Bankuptcy | RepofForeclosure | | Deficency | Collatersl | Bureau | Cross/Up Sel Actvities
Account Documents
Collaicsdl Maraicncit Call Activies  Maintenance || Comments  Promises | Checkists | Trackng Attibutes | References  Comespondence | Letters | Document Tracking | Scenario Anlysis
Reports
Producers
Vendors Transaction Batch Information Faid | Aedt | Evien | o Audt
Batch Transactions Vieww Formatv B [[Feeze Hioetad Jwam @ & Vid
Adces Date Honetary Transaction Status Batch
Pt 02/17j0i6 ¥ ¥
P ‘ 01/03/2016 N ASSET MAINTENANCE POSTED N
Interfaces 01/03/2016 N ACCOUNT SUB UNIT TRANSFER POSTED N 4
AP Transactions
6L Transactions . i Tiformadi
s neconcililicn Transaction Batch Information
—— E saveandadd | B saveandstay | B saveandRetum | GaRetum
9 Load Parameters
Date 02/17/2016 Transaction MARK CUSTONER AS DECEASED Status
Manetary— e
Parameters
Vieww Formatv [ Freeze Gf Detach e @
Parameter Value Required
> Collections DECEASED DATE Ul
> WFP. RELATION TYPE CODE PRIMARY v v
> Tools
> Setup

Result

You need to specify the deceased date of the customer and select the relation type code from
the drop-down list.

System identifies all the related accounts based on Customer ID and marks ‘the customer
deceased date’ on all accounts (primary or joint holder) held by the customer. If the
transaction is successful, a confirmation message is displayed in the Results section
displaying all the customer accounts on which this status is posted.

The Customer Deceased Date is also indicated on the Customer Details screen’s Military
Service section.

ORACLE' # Welcome, OFSUUSER +  pccessiility 1 Signout O
Financial Services Lending and Leasing
i Close.
e Customer Service x @
P LA Summary  Customer Sevice  Account Details  Customer Details  Transaction History | Pt Modes  Bankwuptcy | RepojForeclosure  Deficency | Collatersl | Bureaus | CrossUp Sel Actvities
Servicing
B Customer | Business
Senicing
Customer Senice
f‘“”‘f“‘z - Customer Information
Tansaction Authoriza
Post Date Checls 750 BB AT
Escrov Transactions View~ Fomatr [} Freeze i Detach wap @
Acegu:Qocuments Customer = Relation ECOR Name Ssh Bith Ot Warital Status~ Enabled Language Education Mothers Miden |1,
Collatral Managemert
Reports 0000005005 PRIMARY INDIVIDUAL SHANEK LINE SRIV 000005412 01/10/1985 SINGLE ¥ ENGLISH NORM#
Producers i k
Vendors.
Batch Transactons Customer Information
Advances
Payments Quetin
Fees
e .| Customer P
Interfaces Identification Details K¥e
AP Transadtions Customer # 0000005005
O Transations Relation PRIMARY Reference #
Ch ety ECOA TNDIVIDUAL Status
EAERALGY Nome SHANK LINE SRIV Expiy Dt
Bith Dt 01/10/1985 Visa # e
Marita Status SINGLE Natioality -
Enabled ¥ National 1D NAT-098-N0G7 ih frace
anguage. ENGUH s 000005412 Atk
o s Pemanent U Resident Staus
Hother's Mmd‘zw Name Hoswe Sate Power of Attorney
Class Type NORHAL
Military Se
’ Emai FESSHRERES Pover of Atorney_
top Conespondence_ :
> Collections s Acive Miltary Duty_— Fi! e
5 Sl Efective Ot Ao
> WP Slp_ :
Orter Ref # Sy
> Tools Bankruptcy - Nationality
Siee Privacy Opt Out— Telephone Number
Il Bisting CIF i
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A.2.5

A.2.6

Privacy Opt-Out Indicator

You can change the customer’s Privacy Opt-Out indicator

To change the customer’s privacy opt-out indicator

Transaction

Parameters

Customer Privacy Info Sharing Preference

Privacy Opt Out

Effective Date

Relation Type Code

The Primary Opt-Out box is selected on the Customer Service screen’s Customer(s) section

and Customer Details screen’s Customer section.

ORACLE
Financial Services Lending and Leasing

& Welcome, DEMOSUPR ~  Accessibility "8 Sign out

, Close
o — EE
2| Origination Resuits Customer Service Search Review Request (Pending: 0) =
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To remove the Primary Opt-Out indicator, follow above procedure. However, you can also
type N in the CUSTOMER STOP CORRESPONDENCE INDICATOR parameter.

Correspondence (stopping)

You can choose at any time to stop correspondence to a customer. When you do so, the
customer will receive no correspondence of any kind from the system.
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To stop correspondence with a customer

Transaction Parameters

Customer Stop Correspondence Txn Data

Relation Type Code

Customer Stop Corr Indicator

The Stop Correspondence box is selected on the Customer Service screen’s Customer(s)
section and Customer Details screen’s Customer section.
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To remove the Stop Correspondence indicator, follow the above procedure; However, you
can also type N in the CUSTOMER STOP CORRESPONDENCE INDICATOR parameter.

A.2.7 Financed Insurance (modifying)

You can change other insurance details entered on the INSURANCE ADDITION transaction
with nonmonetary INSURANCE DETAILS MODIFICATION transaction. The changed
insurance information can be viewed on Customer Service screen’s Insurances screen.

A-34 ORACLE



A.2.8

Note

In case any issues on existing Lease accounts, you can back port this functionality. Con-

tact your account manager.

Transaction

Parameters

Insurance Modification

Txn Date

Effective Date

Insurance Type

Policy Effective Date Com-
pany Name

Phone # 1

Extn # 1

Phone # 2

Extn # 2

Policy #

Expiration Date

Primary Beneficiary

Secondary Beneficiary

Refund Amount Received

Full Refund Received

Comment

ACH Maintenance

The ACH maintenance transaction is for updating the existing ACH Banks details and not to
define a new Ach Bank. The transaction is effective provided the ACH account no, ACH
routing no, account type are matching with the existing Ach Banks details. On successful
posting, the confirmation number will be generated.
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A.2.9

To update the existing ACH bank details

Transaction Parameters

ACH Maintenance ACH Account Number

ACH Account Type Code

ACH Payment Frequency Code

ACH

Status Code

ACH

Bank Name

ACH Bank Routing Number

ACH Default Indicator

ACH

End Date

ACH Payment Amount

ACH Payment Amount Excess

ACH

Payment Day

ACH

Start Date

Txn Date

This information appears in the ACH section of the Account Details screen.
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Stop an ACH

To stop an ACH for an account

Transaction

Parameters

Stop ACH Maintenance

Txn Date

Oracle Financial Services Lending and Leasing clears the information on the ACH section of

the Account Details screen.
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A.2.10 Statement Reprinting (batch only)

You can reprint a statement of account activity by defining the starting and closing dates
included within the statement.

To reprint a statement

Transaction Parameters
Statement Reprint Mainte- Txn Date
nance

Statement Closing Date

A.2.11 Add ACH Bank

You can add a new ach bank. This enables the customer to make a single payment from more
than one bank or monthly payments from different banks. On successful posting, the
confirmation number will be generated.
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To add a new ACH bank

Transaction

Parameters

ADD ACH BANK

ACH Account Number

ACH Account Type Code

ACH Payment Frequency Code

ACH Status Code

ACH Bank Name

ACH Bank Routing Number

ACH Default Indicator

ACH End Date

ACH Payment Amount

ACH Payment Amount Excess

A.2.12 Post Dated Checks

You can add or stop servicing of accounts with PDC as a repayment method.

The POST DATED CHEQUE MAINTENANCE transaction enables you to switch an account to
the post dated check method of repayment.

To add post dated checks as a method of repayment

Transaction Parameters
Post Dated Cheque Maintenance Txn Date
PDC Type

pdc Check Number

pdc Check Date

pdc No Of Checks

pdc Check Amount

pdc Bank Routing Number

pdc Account Type

pdc Account Number

pdc Bank Name

pdc Bank Branch Name

pdc Docket Code

pdc Comments

pdc Frequency
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A.2.13

A.2.14

The STOP POST DATED CHEQUE MAINTENANCE transaction stops processing the
payments on an account using Post dated checks. Once this transaction is posted, status of
all PDCs attached to a Lease account changes to VOID, indicating that the PDCs are of no
use.

To stop post dated checks as a method of repayment

Transaction Parameters

Stop Post Dated Cheque Maintenance Txn Date

Coupon Book Maintenance (batch only)

In reordering coupon books, you will need supply the first date of new coupons, the new
coupon start number, and number of new coupons to order.

To re-order coupon book (batch only)

Transaction Parameters

Coupon Book Maintenance Txn Date

Coupon First Payment Date

Coupon Start Number Coupon Count

To cancel the coupon book re-order before it is processed in the nightly batch, choose Void.

Extended Service Contract (ESC)

You can apply, cancel, or adjust a payment to an extended service contract.
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To cancel or adjust an ESC

Transaction

Parameters

Warranty Maintenance

Txn Date

Insurance/Warranty Cancel Indicator

Insurance/Warranty Cancel Date

Insurance/Warranty Remaining Term

Insurance/Warranty Refund Amount Estimate

Insurance/Warranty Refund Amount Received

Insurance/Warranty

Full Refund Received Indicator

Insurance/Warranty Itemization Code

To apply a refund payment to an ESC

Transaction

Parameters

Warranty Payment Mainte-
nance

Txn Date

Insurance/Warranty Refund Amount Received

Insurance/Warranty

Itemization Code

Note

A Warranty Refund transaction posted or reversed on the Maintenance screen should be

matched with a payment posting or reversal.
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A.2.15 Insurance Maintenance

To cancel insurance (or reverse the insurance cancellation)

Transaction Parameters
Insurance Mainte- Txn Date
nance

Insurance/Warranty Cancel Indicator

Insurance/Warranty Cancel Date

Insurance/Warranty Remaining Term

Insurance/Warranty Refund Amount Estimate

Insurance/Warranty Refund Amount Received

Insurance/Warranty Full Refund Received Indicator

Insurance/Warranty

Iltemization Code

The above refers to the account insurance and not asset or collateral insurance. For example,
‘Credit Life and Disability’.

A.2.16 Escrow Information and Maintenance

The following nonmonetary transactions allow you to add a new tax or insurance escrow to
an account.
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To add new escrow insurance details

Transaction Parameters
New Escrow Insurance Escrow Type
Details
Escrow Sub Type
Vendor #

Escrow Required (y/n)

Escrow Opt out (y/n)

Annual Disbursement Amount

Disbursement Rule

Transaction Date

Reference Account #

Insurance Policy #

Expiration Date

Maturity Date

Coverage Type

Coverage Term

Coverage Amount

Reason

Reference
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To add new escrow tax details

Transaction

Parameters

New Escrow Tax Details

Escrow Type

Escrow Sub Type

Vendor #

Escrow Required (y/n)

Escrow Opt out (y/n)

Annual Disbursement Amount

Disbursement Rule

Transaction Date

Reference Account #

Property Tax Type

Reason

Reference

The following nonmonetary transactions allow you to update any of the escrow information
regarding an existing tax and insurance.
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To change insurance annual disbursement

Transaction

Parameters

Change Insurance Annual Disburse-

Escrow Type

ment

Escrow Sub Type

Vendor #

Transaction Date

Annual Disbursement

Amount
Reason
Reference
To change insurance disbursement plan
Transaction Parameters

Change Insurance Disbursement Plan

Escrow Type

Escrow Sub Type

Vendor #

Transaction Date

Disbursement Rule

Reason
Reference
To change escrow indicators of insurance
Transaction Parameters
Change Escrow Indicators of Insur- Escrow Type
ance
Escrow Sub Type
Vendor #

Transaction Date

Escrow Required (y/n)

Escrow Opt Out (y/n)

Reason

Reference
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To change insurance expiration date

Transaction

Parameters

Change Insurance Expiration Date

Escrow Type

Escrow Sub Type

Vendor #

Transaction Date

Expiration Date

Reason
Reference
To change insurance maturity date
Transaction Parameters

Change Insurance Maturity Date

Escrow Type

Escrow Sub Type

Vendor #

Maturity Date

Reason
Reference
To change tax annual disbursement
Transaction Parameters

Change Tax Annual Disbursement

Escrow Type

Escrow Sub Type

Vendor #

Transaction Date

Annual Disbursement Amount

Reason

Reference
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To change tax disbursement plan

Transaction

Parameters

Change Tax Disbursement Plan

Escrow Type

Escrow Sub Type

Vendor #

Transaction Date

Disbursement Rule

Reason
Reference
To change escrow indicators of tax
Transaction Parameters

Change Escrow Indicators of
Tax

Escrow Type

Escrow Sub Type

Vendor #

Transaction Date

Escrow Required (y/n)

Escrow Opt Out (y/n)

Reason

Reference

A.2.17 Escrow Analysis Disbursements

The following nonmonetary transactions allow you to resume and stop escrow analysis and

disbursements.
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To resume escrow analysis

Transaction Parameters

Resume Escrow Analysis Transaction Date
Reason
Reference

To resume escrow disbursements

Transaction Parameters

Resume Escrow Disbursements Transaction Date

Reason
Reference
To stop escrow analysis
Transaction Parameters
Stop Escrow Analysis Transaction Date
Reason
Reference
To stop escrow disbursements
Transaction Parameters
Stop Escrow Disburse- Transaction Date
ments
Reason
Reference

A.2.18 Insurance Payment Maintenance

To refund or adjust insurance

Transaction Parameters
Insurance Payment Mainte- Txn Date
nance

Insurance/Warranty Refund Amount Received

Insurance/Warranty

Itemization Code

Insurance/Warranty For Full Refund Received

Note

The insurance refund posted or reversed on the Maintenance screen should be matched
by a payment posting or reversal.

A-47 ORACLE



A.2.19 Adjust Dealer Compensation

A3

A.3.1

The following two nonmonetary transactions allows you to adjust dealer compensation (add/
subtract) in servicing stage itself for ‘Upfront and Upfront Month end methods’.

Transaction Parameters

ADJUSTMENT TO COMPENSA- | COMPENSATION ADJUSTMENT AMOUNT
TION AMOUNT - ADD

COMMENTS

Transaction Parameters

ADJUSTMENT TO COMPENSA- | COMPENSATION ADJUSTMENT AMOUNT
TION AMOUNT - SUBTRACT

COMMENTS

Processing SCRA

SCRA (Servicemembers Civil Relief Act) is a United States federal law that protects soldiers,
sailors, airmen, Marines, Coast Guardsmen, commissioned officers in the Public Health
Service and National Oceanic and Atmospheric Administration, from being sued for payment
defaults.

The system is facilitated to be compliant with these SCRA laws. The following features are
supported:

e Interest Rate Limitation, Prevention of Acceleration of Principal during Borrower's
Military Duty

e Fees, Bankruptcy & Deferment rules applicable during Military Duty by the Account
holder/Borrower

e Reverting to pre-SCRA terms when Account holder/Borrower is OFF Military Duty
e Validations with respect to Account holder/Borrower reporting Military Duty and
e Validations with respect to Guarantor being on Military Duty.

To be compliant with the above SCRA features, you can setup;

e Transaction Posting checks

e Related configurations OFF MILITARY DUTY through a transaction which will revert to
original contractual terms for payment amount, interest rate and term.

Post the ‘OFF MILITARY DURY’ date, if payment is missed as per contracted billing
cycle, delinquency fee transaction is posted separately.

However, delinquency fees will not be applied for period of Borrower's Military duty.

Setting up Interest Rate for SCRA

You can define different interest rate which will be an input parameter for the ON ACTIVE
MILITARY DUTY transaction. The system enables you to override default rate values with the
values you define. However, if the values are not overridden, then system will pick the
transaction from system parameter TPE_SCRA_DEFAULT_INTEREST_RATE.
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A4

The system will apply lowest rate between contract and system default interest rate. However,
you can indicate to override the Rate with one entered in the transaction input parameter.

Access to the transaction and availability of the Override and Rate parameters are setup in
Transaction Codes Access Grid and Parameters, respectively.

When the transaction is under BORROWER ON ACTIVE MILITARY DUTY status, the system
facilitates setting up and validating the following:

e While posting On Military Duty transaction, provides flexibility to choose the Fee to be
applicable through Fee Assessment Access Grid, based on On Military Duty account
condition created in the account.

e You can not initiate Foreclosure / Repossession activities on active military duty
accounts.

e The monthly payment amount must not exceed the existing payment amount.

e During deferment period, enables you to define 'NO Interest to be charged' by defining
'Stop Accrual' to the 'EXTENSION transaction' for the same terms of Extension. A batch
job re-starts Interest Accrual, once the system posts comments for the same

Once the OFF MILITARY DUTY transaction is posted on account, system facilitates setting
up and validating the following:

e The contractual terms are returned once the SCRA condition is removed. That is, the
payment amount, terms, and interest rate must revert to their pre-SCRA state. Thus,
resulting in a balloon payment at the end of Lease.

e To extend On Military Duty benefits, you can perform any of the following:
— OFF Military Duty transaction must not be posted
— If already posted, OFF Military Duty transaction must be REVERSED

— Close current Military Duty by posting the OFF transaction and then opening a new
Duty period by posting the On Military Duty Transaction. Ensure not to overlap the
periods.

Black Book Interface

The system performs collateral valuation for all the active accounts at a set frequency.
However, valuation is not performed for collaterals with account status <ACTIVE> and Asset
Status <ACTIVE> and <PRIMARY>.

The source for the above valuation is Black book or any other Collateral Evaluator agency.
These valuation details are stored for each collateral in Collateral tables. If an account has
multiple collaterals, then the valuation details must be stored for each collateral.

You can run ‘BLACK BOOK INTERFACE’ batch to perform valuation for active accounts and
active collaterals. This batch job performs the following:

e Validates for current valuation in the Black Book interface tables and gets the latest
valuation

e After getting the valuation updates the collateral valuation with source as Source setup.
e Loads Black Book values

The system date is saved as Valuation Date along with other valuation details during batch
run. Once the batch is run, black book values will load process to Oracle Valuation Section
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Appendix B: Payment Amount Conversions

The following table contains the calculations Oracle Financial Services Lending and Leasing
uses to convert different payment frequencies (weekly, biweekly, semi monthly, and so on) to
standard monthly values for instalment accounts.

Payment Frequency:

Scheduled Monthly Income Amount:

D = Deferred

Zero fill

P = Single payment Lease

Zero fill

W = Weekly (due every week)

Multiple by 4.33

B = Biweekly (due every two weeks)

Multiple by 2.16

E = Semi-monthly (due twice a month) | Multiple by 2
M = Monthly (due every month) As given

L = Bimonthly (due every two months) | Divide by 2
Q = Quarterly (due every three Divide by 3
months)

T = Triannually (due every four Divide by 4
months)

S = Semi-annually (due twice a year) Divide by 6
Y = Annually (due every year) Divide by 12
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